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1 General Information

1.1 Safety Information

Before using these products, read the operating instructions for safe usage contained in the Product
Safety and RF Exposure booklet 6804113J25 for APAC & LACR and 6866537D37 for EMEA.

Your radio is restricted to occupational use only to satisfy ICNIRP RF energy exposure requirements. Before using
the products, read the RF energy awareness information and operating instructions in the Product Safety and RF
Exposure booklet to ensure compliance with RF energy exposure limits.

Keep this User Guide and the Product Safety and RF Exposure booklet in a safe place and make it available to
all operators.

1.2 Copyrights
The Motorola products described in this document may include copyrighted Motorola computer programs. Laws
in the United States and other countries preserve for Motorola certain exclusive rights for copyrighted computer
programs. Accordingly, any copyrighted Motorola computer programs contained in the Motorola products described
in this document may not be copied or reproduced in any manner without the express written permission of Motorola.

© 2013 Motorola Solutions, Inc. All Rights Reserved.

No part of this document may be reproduced, transmitted, stored in a retrieval system, or translated into any language
or computer language, in any form or by any means, without the prior written permission of Motorola Solutions, Inc.

Furthermore, the purchase of Motorola products shall not be deemed to grant either directly or by implication,
estoppel or otherwise, any license under the copyrights, patents or patent applications of Motorola, except for the
normal nonexclusive, royalty-free license to use that arises by operation of law in the sale of a product.

Disclaimer

Please note that certain features, facilities, and capabilities described in this document may not be applicable to
or licensed for use on a particular system, or may be dependent upon the characteristics of a particular mobile
subscriber unit or configuration of certain parameters. Please refer to your Motorola contact for further information.

Trademarks

MOTOROLA, MOTO, MOTOROLA SOLUTIONS, and the Stylized M Logo are trademarks or registered
trademarks of Motorola Trademark Holdings, LLC and are used under license. All other trademarks are the property
of their respective owners.
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European Union (EU) Waste of Electrical and Electronic Equipment
(WEEE) directive

The European Union's WEEE directive requires that products sold into EU countries must have the crossed out
trashbin label on the product (or the package in some cases).

As defined by the WEEE directive, this cross-out trashbin label means that customers and end-users in EU countries
should not dispose of electronic and electrical equipment or accessories in household waste.

Customers or end-users in EU countries should contact their local equipment supplier representative or service
centre for information about the waste collection system in their country.

1.3 Icon Conventions
The following graphic icons, which help identify situations or settings crucial to proper radio operation and user
safety, are used throughout this document:

The signal word DANGER with the associated safety icon indicates information that, if disregarded,
will result in death or serious injury.

The signal wordWARNING with the associated safety icon indicates information that, if disregarded,
could result in death or serious injury, or serious product damage.

The signal word CAUTION with the associated safety icon indicates information that, if disregarded,
may result in minor or moderate injury, or serious product damage.

The signal word CAUTION may be used without the safety icon to state potential damage or injury
that is not related to the product.

IMPORTANT statements contain information that is crucial to the discussion at hand, but is not CAUTION
or WARNING. There is no warning level associated with the IMPORTANT statement.
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1.4 Using this Guide

NOTE contains information more important than the surrounding text, such as exceptions or preconditions.
They also refer the reader elsewhere for additional information, remind the reader how to complete an
action (when it is not part of the current procedure, for instance), or tell the reader where something is
located on the screen. There is no warning level associated with a note.

SUGGESTION

SUGGESTION indicates a recommendation from Motorola that does not require to be followed, but might
be helpful. There is no warning level associated with SUGGESTION.

1.4 Using this Guide
This guide describes all available radio features. Your service provider may have customized your radio to
optimize its use for your individual needs. Check with you service provider to find out the differences from this
guide.Throughout the text in this publication, you notice the following special notations used to highlight certain
information or items:

Table 1-1 Special Notations

Example Description
MENU key or EMERGENCY button Capital letters indicate the name of a key or button.

Entering TMO tone Italic letters indicate the name of the tone.

Powering Off Bolded words indicate the soft menu items, MMI
strings, or messages displayed on the radio.

Setup → Tones → All Tones Bolded words with the arrow between indicate
navigation structure in the menu items.
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2 Getting Started
This chapter contains basic information on how to use the radio.

2.1 Product Technical Information
Table 2-1 Product Technical Information

Description Value
Maximum RF Power 10 Watts

Maximum Speaker Load 10 Watts at 4 Ohms

Antenna Impedance 50 Ohms

Ambient Temperature Range -30° C to +60° C

If the radio is in service, the surface temperature can rise up to
70° C. Do not touch the hot surface.

Operating Time Continuous/Intermittent

The communication system determines the radio transmit and receive time (operating cycle time). During
overload, or beyond the systems specifications at high ambient temperatures, the thermal control cuts down
the RF power output, which reduces the radio coverage range.
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2.2 Controls and Indicators
New Generation Control Head (NGCH) / Remote Ethernet Control
Head (RECH)

76543
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21 8

13 1412114109
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2.2 Controls and Indicators

Table 2-2 Controls and Indicators — New Generation Control Head (NGCH) / Remote Ethernet
Control Head (RECH)

Annotation Description
1 EMERGENCY button

Press and hold EMERGENCY button to enter Emergency operation. By default, when
your radio is off, press and hold to power on in Emergency Mode.

2 ROTARY KNOB

• Press and hold to turn your radio on.

• Rotate to set the volume.

• Press and rotate to select a different talkgroup.

• Press and hold the ROTARY KNOB to lock/unlock it. Powering off also unlocks a
locked ROTARY KNOB.

3 DISPLAY

Provides alphanumeric text and images within 65,536 colors and 640 x 480 pixels with
backlighting and scalable fonts.

Before using your radio for the first time, remove the plastic lens protector
from the display.

4 SOFT key

Press upper or lower SOFT key, to select the option that appears on the screen next to it.

5 ON/OFF/END/HOME key

• Press and hold to turn on/off your radio.

• Press to end calls.

• Press to return to the home screen.

6 NAVIGATION key

Press up, down, left or right NAVIGATION key for list scrolling, while moving around the
menu hierarchy, or for alphanumeric text editing.

From the home screen, press to activate one of the following:

• Down NAVIGATION key — enters Recent Calls menu item.

• Up NAVIGATION key — changesMy Groups talkgroup folder.

• Left and right NAVIGATION key — toggles through the talkgroups.

7 Alphanumeric KEYPAD

Use the keypad to enter alphanumeric characters for dialing, contact entries, and text
messages.

8 LED Status Indicator
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Table 2-2 Controls and Indicators — New Generation Control Head (NGCH) / Remote Ethernet Control
Head (RECH) (cont'd.)

Annotation Description
9 MOBILE MICROPHONE PORT

Provides connection for accessories such as fist microphone with PTT.

10 MENU key

Press to enter the main menu and the context-sensitive menu.

11 SEND key

Press to initiate or answer duplex calls, or send messages.

Press in home screen to enter Recent Dialed Calls.

12 FUNCTION key 1

By default:

• Short press — activates/deactivates the horn and lights feature.

• Long press — adjusts backlight.

13 FUNCTION key 2

By default:

• Short press — turns the speaker on/off.

• Long press — activates/deactivates screen saver.

14 FUNCTION key 3

By default:

• Short press — adjusts backlight.

• Long press — unassigned.

15 PTT (Push-To-Talk) button

• Press and hold to talk in simplex calls or to initiate a group call, release it to listen.

16 MICROPHONE

While pressing the expansion PTT (on the expansion head), other PTT press on an accessory connected to
the control head is ignored. This only applies to MTM5200, MTM5400, and MTM800 FuG.
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2.2 Controls and Indicators

Telephone Style Control Head (TSCH)
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Table 2-3 Controls and Indicators — Telephone Style Control Head (TSCH)

Annotation Description
1 DISPLAY

Provides alphanumeric text and images within 65,536 colors and 240 x 320 pixels with
backlighting and scalable fonts.

Before using your radio for the first time, remove the plastic lens protector
from the display.

2 MENU key

Press to enter the main menu and the context-sensitive menu.

3 SOFT keys

Press left or right SOFT key, to select the option that appears on the screen above it.

4 SEND key

Press to initiate or answer duplex calls, or send messages.

Press in home screen to enter Recent Dialed Calls.

5 Alphanumeric KEYPAD

Use the keypad to enter alphanumeric characters for dialing, contact entries, and text
messages.

6 FUNCTION key 1

By default:

• Short press — activates/deactivates the horn and lights feature.

• Long press — adjusts backlight.

7 FUNCTION key 2

By default:

• Short press — turns the speaker on/off.

• Long press — activates/deactivates screen saver.

8 ON/OFF/END/HOME key

• Press and hold to turn on/off your radio.

• Press to end calls.

• Press to return to the home screen.
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2.2 Controls and Indicators

Table 2-3 Controls and Indicators — Telephone Style Control Head (TSCH) (cont'd.)

Annotation Description
9 NAVIGATION key

Press up, down, left or right NAVIGATION key for list scrolling, while moving around the
menu hierarchy, or for alphanumeric text editing.

From the home screen, press to activate one of the following:

• Down NAVIGATION key — enters Recent Calls menu item.

• Up NAVIGATION key — changesMy Groups talkgroup folder.

• Left and right NAVIGATION key — toggles through the talkgroups.

10 MICRO USB PORT

Provides connection between the radio and a computer.

11 FUNCTION key 3

By default:

• Short press — adjusts backlight.

• Long press — unassigned.

12 EARPIECE

13 Upper PTT (Push-To-Talk) button

By default, this PTT button is disabled. However, your service provider can assign one
of the following functions to it:

• Upper PTT button works in the same way as the lower PTT button (you can use
both interchangeably).

• Upper PTT supports a roof speaker. Roof speaker allows sound to be transferred
through an external speaker connected to the transceiver.

14 Lower PTT (Push-To-Talk) button

• Press and hold to talk in simplex calls or to initiate a group call, release it to listen.

15 MICROPHONE
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Cradle

16

17

18

19

Table 2-4 Controls and Indicators — Cradle

Annotation Description
16 ROTARY KNOB

• Press and hold to turn your radio on.

• Rotate to set the volume.

• Press and rotate to select a different talkgroup.

• Press and hold the ROTARY KNOB to lock/unlock it. Powering off also unlocks a
locked ROTARY KNOB.

• Press to make the ROTARY KNOB operate like left/right navigation keys.

17 HOOK
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2.3 Display

Table 2-4 Controls and Indicators — Cradle (cont'd.)

Annotation Description
18 EMERGENCY button

Press and hold EMERGENCY button to enter Emergency operation. By default, when
your radio is off, press and hold to power on in Emergency Mode.

19 LED Status Indicator

• It is recommended to turn off the terminal before connecting any of the accessories.
• A detailed list of compatible accessories is included in Accessory Leaflet, part number:
68015000182. To obtain the document, contact your service provider.

Interactions between Control Heads

Dual Control Head

2.3 Display
This section presents the radio's home screen elements.

Table 2-5 Display

Annotation Description
1 Status icon area

2 Text display area

3 SOFT key area

4 MENU/Context sensitive icon

The color of the SOFT keys informs you about the mode or state that your radio is in.
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Table 2-6 Colors of the SOFT Keys

Color Mode or State
Light blue Normal TMO and DMO Modes

Light red Emergency Mode or Disaster Alert Call

Olive Local Site Trunking Mode

Yellow Call Out — Standby

Red Call Out — Alert

Green Call Out — Accepted

Blue Radio Messaging Service (RMS)

Grey Radio User Assignment (RUA) — Limited service

Display

Setting Time and Date on the Display

2.3.1 Display Orientation
The display on the Telephone Style Control Head can rotate, which increases its readability and facilitates operation.
By default:

• When the TSCH is off-hook, its display orientation is portrait.
• When the TSCH is on-hook, its display orientation can take one of the following positions (depending
on your service provider configuration):

– Fixed portrait
– Clockwise
– Counter clockwise

2.4 Status Icons
Status icons appear when your radio is engaged in certain activities or when you have activated certain features.

The icons can appear in normal or large size. To manually enable/disable large status icons, go toMenu → Setup
→ Display → Extended Status Icons.

Table 2-7 Status Icons

Icon Description
Trunked Mode Operation

In Service (Signal Strength) — Allows you to check signal strength. More bars indicate a
stronger signal.
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2.4 Status Icons

Table 2-7 Status Icons (cont'd.)

Icon Description
No Service

Migration — Displayed when your radio is registered to the foreign network.

Broadcast Call — Displayed when the radio is in the Broadcast Call.

Gateway Mode — Displayed when the radio is switched to work as a gateway in Gateway
Mode.

Scan — Indicates talkgroup scanning is activated in the radio.

Priority Scan — Indicates that priority scanning is activated in the radio.

Data Connected — Displayed when the Packet Data feature is activated and the external
device sets up data connection with the radio.

Data Transmit/Receive — Displayed when the Packet Data feature is activated and the
external device sets up data connection with the radio.

• No number — standby data session.

• Number 1, 2, 3, or 4 — indicates active data session with 25%, 50%, 75%, or
100% bandwidth.

Direct Mode Operation

Direct Mode Call – Displayed during a Direct Mode call; more bars indicate a stronger
signal.

Direct Mode — Displayed when the radio is in Direct Mode.

Repeater Mode — Displayed when the radio is switched to work as a repeater in Repeater
Mode.

DMO Gateway Communication Mode — Indicates that gateway is selected. The icon
has the following states:

• Solid — while the radio is synchronized with the gateway.

• Blinking — while the radio is not synchronized or during attachment.

• No icon — during a radio to radio and repeater call.

DMO Repeater Communication Mode — Displayed when the Repeater or GW + Rep
option in DMO Mode is selected. This icon has the following states:

• Solid — while the radio has detected the repeater (for example when the radio
receives a presence signal).

• Blinking — while the radio has not detected the repeater or during attachment.

• No icon — during a radio to radio and gateway call.

General Icons

All Tones Off and Duplex and Simplex Ring Muted — Indicates that all alert tones are off
and both duplex an simplex ring volume is set to 0.
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Table 2-7 Status Icons (cont'd.)

Icon Description
Simplex Ring Muted — Indicates that simplex ring volume is set to 0 and duplex ring
volume is set to more than 0.

Duplex Ring Muted — Indicates that duplex ring volume is set to 0 and simplex ring
volume is set to more than 0.

Speaker Off (Low Audio) — Indicates that audio will not sound through the speaker.

Earpiece Connected — Indicates that the earpiece is connected.

Horn and Lights — Indicates that an external alarm (for example, horn and lights) is
activated.

GPS — Indicates that a valid location coordinates are received.

RUI Logged on — Indicates that you are logged on into the radio.

RUI Pseudo Log On — Indicates that you are in pseudo logged on state.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is
activated and the external device sets up data connection with the radio.

• No number — standby data session.

• Number 1, 2, 3, or 4 — indicates active data session with 25%, 50%, 75%, or
100% bandwidth.

RUI Packet Data — Indicates Pseudo Log On state when the Packet Data feature is
activated and the external device sets up data connection with the radio.

Emergency — Appears while the radio is in Emergency Operation.

Disaster Alert Call — Appears while the radio is in the Disaster Alert Call.

List Scrolling — Displayed to indicate that the ROTARY KNOB is in list scrolling mode.

New Message Has Arrived — Indicates a new message just arrived.

New Message(s) in Inbox — Indicates that you have unread messages in your Inbox.

Unread (New) WAP Message — Indicates that new page was loaded to the browser.

Call-Out — Indicates Call-Out alert.

Call-Out Alert Arrived — Indicates a receipt of a new Call-Out message.

Call-Out Alert Unread — Indicates unread alert in the CO Box.

Encryption Off
Blinking, indicates that the SIM Card End-to-End Encryption is disabled in DMO and
TMO Modes.

Encryption On
Solid, indicates that the SIM Card End-to-End Encryption is enabled in TMO Mode.
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2.4 Status Icons

Table 2-7 Status Icons (cont'd.)

Icon Description

or Encryption On
Solid, indicates that the SIM Card End-to-End Encryption is enabled in DMO Mode.
Numbers 1 and 2 point to the type of DMO Encryption keys that has been selected.

Unread (New) WAP Message — Indicates that you have not enteredWAP Box since last
WAP message was received (Blinks when the priority is high).

WAP Message Icon — Displayed next to the priority in the message list view.

WAP Message Time — Displayed next to the create date in the message list view.

WAP Message Expiration — Displayed next to the expiry date in the message list view.

WAP Message Title Icon — Displayed next to the title along with the text in the message
list view.

Keys Locked — Indicates that keys are locked.

Non Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available when the radio:

• Is in the Local Site Trunking Mode.

• Attempts to connect to a gateway.

Not Secured Call — Air Encryption Unavailable
Alternately blinking, indicates that Air Encryption is not available when the radio:

• Is in TMO Mode.

• Communicates through a gateway.

Not Secured Call — Air Encryption Unavailable
Blinking, indicates that Air Encryption is not available in DMO Mode. The icon appears
after the PTT button is pressed.

Remote Control
Indicates that the radio is being remotely controlled and some commands are being
executed in the background. For example, when the radio is controlled via special SDS
messages or triggered to send a GPS location report.

Enhanced Dual Control Head

Dual Control Head — Indicates that Dual Control Head feature is enabled, and both
control heads are connected to the transceiver.

Single Control Head — Indicates that Dual Control Head feature is enabled, but only one
control head is connected to the transceiver.

Link Error — Indicates that connection between the control head and the transceiver
has been lost, for example, due to an error.

Key Press Token — In Dual Control Head operation, blinking icon indicates that key press
token is reserved by one of the control heads.

CH1 — Indicates that particular activities/settings apply to Control Head 1. Control Head
1 is a control head connected to port 1 on the expansion head.
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Table 2-7 Status Icons (cont'd.)

Icon Description
CH2 — Indicates that particular activities/settings apply to Control Head 2. Control Head
2 is a control head connected to port 2 on the expansion head.

Speaker 1 Off (Low Audio) — Indicates that audio will not sound through the speaker of
the Control Head 1.

Speaker 2 Off (Low Audio) — Indicates that audio will not sound through the speaker of
the Control Head 2.

Speakers Off (Low Audio) — Indicates that speakers of both control heads are off.

All Tones Off/Duplex and Simplex Ring Muted — Indicates that all alert tones are off,
or both simplex ring volume is set to 0 and duplex ring volume is set to 0. Applicable
to Control Head 1.

Simplex Ring Muted — Indicates that simplex ring volume is set to 0 and duplex ring
volume is set to more than 0. Applicable to Control Head 1.

Duplex Ring Muted — Indicates that duplex ring volume is set to 0 and simplex ring
volume is set to more than 0. Applicable to Control Head 1.

All Tones Off/Duplex and Simplex Ring Muted — Indicates that all alert tones are off,
or both simplex ring volume is set to 0 and duplex ring volume is set to 0. Applicable
to Control Head 2.

Simplex Ring Muted — Indicates that simplex ring volume is set to 0 and duplex ring
volume is set to more than 0. Applicable to Control Head 2.

Duplex Ring Muted — Indicates that duplex ring volume is set to 0 and simplex ring
volume is set to more than 0. Applicable to Control Head 2.
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2.5 Powering On the Radio

Air Encryption

2.5 Powering On the Radio
Procedure Steps

1 Press and hold ON button.

2 Your radio performs a self-check and registration routine.

3 After successful registration, your radio is in service.

Your radio powers on without visible and audible notification if Covert Mode is activated.

2.6 PIN Code Authentication
The radio has active PIN Code Authentication, which helps you increase security and protect your radio against
unauthorized use. The PIN code is read from the SIM card and cannot be changed nor disabled. If you are unable to
unlock the radio, you cannot send or receive any call, nor adjust the volume level with the ROTARY KNOB.

You are asked to enter the PIN code each time you turn on the radio.

Writing Text

2.6.1 Unblocking Your Radio
Prerequisites:
You blocked your radio by entering incorrect PIN code for three times (by default).
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Procedure Steps

1 Radio displays Unit BlockedEnter PUK.

2 Enter 8–digit PUK (Personal Unblocking Key) number.

The PUK is an eight-digit master code provided by your service provider.

3 Enter the new PIN code twice.

2.7 Locking/Unlocking the Keys/Buttons
Press MENU key and * key.

The EMERGENCY button is not locked. Entering Emergency Mode unlocks all keys.
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2.8 Entering TMO / DMO Mode

Keylock Setup

2.8 Entering TMO / DMO Mode
Procedure Steps

1 From the home screen, press Optns.

2 Select Trunked Mode / Direct Mode.

Networks

Selecting Network Operation Mode

2.9 Transmit Inhibit Mode
The Transmit Inhibit Mode is a mode in which the radio sends no radio transmissions. It is recommended to
activate the mode in RF sensitive areas, for example hospitals, airplanes, where safety can be jeopardized due
to transmission radiation.

To activate, selectMENU → Networks → TXI Mode → Activate.

In this mode, the radio does not transmit under any circumstances except for the Emergency Calls. All the functions
and keys which cause transmission, for example registration to the network, changing talkgroup or folder, sending
SDS messages, or pressing the PTT button are disabled. Any transmission trial causes the radio to display Not
Allowed In TXI Mode notification and to play a tone.

Your radio can still receive:

• Group calls.
• Messages — stored in the Inbox.
• Private call attempts — stored in theMissed Calls list, without the option to respond.

When no danger to safety exists anymore (for example, you leave the RF sensitive area), you can deactivate the
Transmit Inhibit Mode and the radio returns to standard operation.

You can deactivate the mode by selectingMENU→ Networks → TXI Mode → Deactivate, pressing One-Touch
button, or implicitly when initiating an Emergency Call.

RF Transmissions from the radio are prevented under the following conditions:

• TXI Mode is activated.
• The radio is turned off.
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2.10 Selecting a Talkgroup
From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.

• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.

• Select Optns → TG by Folder. Select a folder and then a talkgroup name.

• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.

If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Your radio can have an access up to three levels of the folder structure.

2.11 Using Timed Talkgroup Change
This feature allows you to switch between the original and the predefined talkgroup (TMO or DMO) for a predefined
time by using a One-Touch button. After the timer expires, your radio returns to the previously attached talkgroup.

Prerequisites:
Timed Talkgroup Change is assigned to One-Touch button.
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2.12 Activating Talkgroup Scanning

Procedure Steps

1 Press and hold the One-Touch button.

2 Your radio switches the talkgroup for a predefined amount of time.

To start a group call press PTT.

Your service provider can assign a function to the second press of the One-Touch button to:

• Return to original talkgroup

• Restart the predefined time

• No action

3 When the group call ends, your radio switches to the original talkgroup after the predefined time.

2.12 Activating Talkgroup Scanning
When and where to use:
If you want to monitor any TMO Group Call in the defined talkgroup list.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Group Setup → Scan → Scanning.

3 Select Select List and then a list name.
Step result: Your radio displays list name Selected.

4 Select Scanning → On.

Result:
Your radio is scanning on the predefined scan list.
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Scan

2.13 Broadcast Call
The Broadcast Group Call (also called Site Wide Call) is a high-priority group call from the console operator (or
dispatcher) to all users located at one or more sites. The radios are configured to monitor a Broadcast Call, but
you cannot talk back. The call can be received as a normal Broadcast Call or an Emergency Broadcast Call. The
Broadcast Call preempts an ongoing Group Call that has the same or lower call priority.

2.14 Ambience Listening (AL) Call
This feature allows a dispatcher to make a special call that allows listening to the conversations and background
noises within the range of a particular radio’s microphone. The call is set up without any indication to the affected
radio, and any lower priority ongoing voice call or packet data transfer may be preempted.

After accepting the call, the radio transmits in a simplex call without any action from or indication to the user.
The Ambience Listening Call automatically ends when you initiate any voice call, switch to Emergency or TXI
Mode, or send Emergency Alarm.

2.15 One-Touch Button Feature
To use One-Touch Button feature press and hold an assigned key to activate one of the following features:

Table 2-8 One-Touch Button Features

Feature Description
Backlight Switches backlight settings.

TMO Talkgroup Scan Turns on/off the Talkgroup Scan feature in TMO Mode.

DMO / TMO Switch Switches between TMO and DMO Mode.

Sending Status Sends a dedicated status message to a dedicated address.

Change Talkgroup Changes the talkgroup to the predefined by your service provider.

Hi/Low Audio Activates high/low audio.

Sending User Defined Message Sends a predefined/user defined template to a dedicated address.

Transmit Inhibit (TXI) Turns on/off TXI Mode.

Private Call Initiates a private call to a predefined entry in the contact list.

Phone Call Initiates a phone call to a predefined entry in the contact list.

PABX Call Initiates a PABX call to a predefined entry in the contact list.

Screen Saver Turns on/off the Screen Saver feature.

Display Time Shows time and date on a display.
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2.16 Terminal Temporary Disable/Enable

Table 2-8 One-Touch Button Features (cont'd.)

Feature Description
Covert Mode Turns on/off the Covert Mode.

Horn and Lights Turns on/off the Horn and Lights.

Initiate Call-Out Fallback Alert Sends Fallback Alert.

RUA / RUI Logs you in/out.

Previous Talkgroup Switches the radio to the previously used talkgroup.

Display OPTA Displays Operative Tactical Address.

SIM Card End-to-End Encryption Toggles on/off SIM Card End-to-End Encryption.

GPS Status Message Sends your GPS location in a message to a dedicated address.

Repeater Mode Turns on/off the Repeater Mode.

Gateway Mode Turns on/off the Gateway Mode.

Default Settings Resets all the radio settings to the default.

Speaker Enable / Disable Per Call Enables speaker during the call.

Timed Talkgroup Change Initiates the Timed Talkgroup Change feature. While in the
predefined talkgroup, it can be assigned to the second press function.

HSM (Hearer Speaker Microphone) Activates/deactivates the HSM Secondary Accessory.

Double Push PTT Sends the D- PTT tone to the talkgroup you are currently using.

If the One-Touch Button feature is enabled, the One-Touch Dial is disabled. If no feature is assigned to a
button, your radio displays theUnassigned Button message.

2.16 Terminal Temporary Disable/Enable
Your radio is provided with a feature that allows your service provider to disable it temporarily in case it is stolen.
When your radio is disabled or is powered up in disabled state, it looks and acts like it is turned off.

If your radio is found, your service provider can enable it again over the air. After your radio is enabled, you
may resume normal operation.

2.17 Terminal Permanent Disable
Your radio is provided with a feature that allows your service provider to disable it permanently in case it is stolen
or lost. When your radio is disabled permanently, it becomes inoperable. After a Permanent Disable your service
provider cannot enable your radio. It is recommended to Permanent Disable your radio only when you do not expect
to recover it. If it is recovered then a Permanent Disable radio can be reactivated by returning it to Motorola.
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2.18 During the Call
During the call, label of the right SOFT key indicates the next possible change. Accessory default setup is:

Table 2-9 During the Call

Soft Key Label Audio Setting
Spkr Audio goes to the main speaker (Speaker HIGH is displayed)

Erpce Audio goes to the earpiece (Speaker LOW is displayed)

2.19 Writing Text
Every time that you see text entry screen, refer to this section.

PIN Code Authentication

2.19.1 Selecting Text Entry Mode
Prerequisites:
Your radio displays the text entry screen.

Procedure Steps

1 Press MENU → Entry Mode.

2 Select one of the following:
• Primary— for entering alphanumeric characters.
• Numeric — for entering numbers only.
• Symbol — for entering symbols only.
• Secondary— for entering alphanumeric characters (this mode is optional and you have to add it to the

list). It is convenient when you use one language, and sometimes wish to switch to another one.

In the text entry screen, you can also press # key repeatedly to toggle through the entry modes.

2.19.2 Selecting Text Entry Method and Language
Prerequisites:
Your radio displays the text entry screen.
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2.19.3 Text Entry Icons

Procedure Steps

1 Press MENU → Entry Setup.

2 Select one of the following:
• TAP— Enter letters, numbers, and symbols by pressing an alphanumeric key one or more times.
• iTAP— Let the radio predict each word as you press an alphanumeric key.

You can use these methods in the languages programmed in the radio.

2.19.3 Text Entry Icons
In the text entry screen, icons tell you which text entry mode and method you are using. A character counter
displayed on the text entry icon, indicates the amount of characters that can be entered.

Press the # key to toggle through the text entry modes.

Table 2-10 Text Entry Screen Icons

Primary Icon Secondary Icons Description

TAP — no capitals

TAP — capitalise first letter only

TAP — all capitals

iTAP — no capitals

iTap — capitalise first letter only

iTap — all capitals

Numeric Icon Description

Enter numbers.

Symbolic Icon Description

Enter punctuation and symbols.

2.19.4 Keys Usage
List of keys and characters in Alphanumeric Mode (TAP/iTAP).
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Table 2-11 Keys Usage

Key Alphanumeric Mode (TAP/iTAP) Symbol Mode
0 to 9 keys Numeric Mode:

• Press to enter digit at insertion point.

• Press and hold any numeric key to enter TAP
alphanumeric mode.

• To exit TAP alphanumeric mode, press and
hold any numeric key.

0 key Press to cycle through single shift, caps lock, and
lower case.

+ - × * / \ [ ] = < > § #

1 key . , ? ! 0 1 @ ’ ” - ( ) / : _ ; + & % × * = < > € £ $ ¥ ¤ [ ] { } \ ~ ^ ¿ ¡ § #

2 key A B C 2
a b c 2

@ _ \

3 key D E F 3
d e f 3

/ , ;

4 key G H I 4
g h i 4

” & ’

5 key J K L 5
j k l 5

( ) [ ] { }

6 key M N O 6
m n o 6

¿ ¡ ~

7 key P Q R S 7
p q r s 7

= < >

8 key T U V 8
t u v 8

€ £ $ ¥ ¤

9 key W X Y Z 9
w x y z 9

# % *

Table 2-12 Other Keys

Key Description
Any numeric key • In TAP press any key to reject word completion and continue with text entry

A new completion will be displayed, if available, after the time-out for TAP
expires.

• Press and hold to enter Numeric mode from TAP or iTAP alphanumeric.

* key • Press to insert a space.

• In TAP press to dismiss a word completion and insert a space.

• Enter a newly created word into the user dictionary.

• Press and hold to enter a carriage return.

# key • Press once to cycle through all entry modes (Symbol, Numeric, Primary,
and Secondary (if configured).

• Press and hold to return to the default entry mode.
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2.19.5 Writing in iTAP Alphanumeric

Table 2-12 Other Keys (cont'd.)

Key Description
Select Press to select the highlighted choice and place it in the main text area.

Delete • Press once to delete the last entered character.

• Press and hold to clear the entire main text area.

Up NAVIGATION key • In TAP press to reject word completion and scroll up.

• In TAP press to change previously entered small letter to capital.

Down NAVIGATION key • In TAP press to reject word completion and scroll within the text area.

• In TAP press to change previously entered capital letter to small.

Left NAVIGATION key • Press to navigate to the left. Press and hold to repeat.

• In TAP, if a word completion is available, press to reject the completion.

Right NAVIGATION key • Press to navigate to the right. Press and hold to repeat.

• In TAP if a word completion is available, press to accept the word.

MENU If a context-sensitive menu is active, opens the Context Sensitive Menu.

2.19.5 Writing in iTAP Alphanumeric
Prerequisites:
Your radio displays the text entry screen.

When and where to use:
It allows you to write quicker. For example, try to write David 232!
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Procedure Steps

1 Press MENU → Entry Setup → Prim..

2 Select iTAPEnglish and press Back.

3 Press MENU → Entry Mode.

4 Select Primary.

5 Press 3 key.
Step result: The alternative row opens and shows D E F 3.

6 Continue entering the letters by pressing one key for each letter. Press 2, 8, 4, and 3 keys.

Automatic shift to upper case is used at the beginning of a message, after punctuation followed by space,
or for the first letter of a word created as a new contact entry.

Step result: The alternative row highlights David.

7 Press * key.

8 Press 2 key and scroll the alternative row by pressing right NAVIGATION key to reach 2.
Step result: It automatically changes the entry mode to Numeric.

9 Press 3 and 2 keys.

10 Press and hold 1 key until 0 at the end changes to ..
Step result: The alternative row highlights 232..

11 Scroll the alternative row by pressing the right NAVIGATION key to reach the required symbol.

12 Press Select.

Result:
You have entered David 232!.

2.19.6 Writing in TAP Alphanumeric
Prerequisites:
Your radio displays the text entry screen.
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2.19.7 Word Locking

Procedure Steps

1 Press MENU → Entry Setup → Seco..

2 Select TAPEnglish and press Back.

3 Press MENU → Entry Mode.

4 Select Secondary.

5 Press the key labeled with the desired character, once for the first character, twice for the second, and so on.

Example:
To enter letter s, press 7 key four times. To enter number 7, press the 7 key five times. If you do not press a key for a
few seconds, the character is accepted, and the cursor moves to the next position.

2.19.7 Word Locking
Prerequisites:
Your radio displays the text entry screen.

When and where to use:
To add the words that are not in the dictionary.

Procedure Steps

1 Press MENU → Entry Setup.

2 Select iTAPEnglish.

3 Try to enter the word. Scroll the alternate line for a word option. Each option is successively highlighted and
partially locked.

4 Enter the second part of the word. The first part remains unchanged (locked). The newly entered letters are
highlighted and then locked while you scroll to the next word option.

5 Press * key. The word is placed in the text area with a space and automatically added to the dictionary.

2.19.8 Adding Words to the Dictionary
Each language comes with its own dictionary. You can create words (including alphanumeric abbreviations). Once
you enter a word followed by space, it is automatically stored in the dictionary and appears as a choice whenever
you press the same key combination in the future.
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2.20 Home Display Text Message
Your radio is provided with a feature that allows your service provider to send special text messages to the display.
The message stays on the home screen until a new message is received. Power cycle your radio to replace the
Home Display message to the predefined one.
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3 Modes
This chapter contains information on available modes that the radio can operate in.

3.1 Using Networks
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks.

3 Select one of the following:
• Trunked Mode

• Direct Mode

• Repeater Mode

• Gateway Mode

• TXI Mode

Result:
Your radio switches to the selected mode.

3.2 Trunked Mode Operation
Trunked Mode Operation requires the switching and management infrastructure. This operation mode enables
various voice and data communication types (for example, group calls, short data service messages) and access to
the infrastructure-related features (for example, packet data).
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Figure 3-1 Trunked Mode Operation

3.2.1 Entering TMO Mode
Procedure Steps

1 From the home screen, press Optns.

2 Select Trunked Mode.

3.2.2 Selecting a Talkgroup
From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.

• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.

• Select Optns → TG by Folder. Select a folder and then a talkgroup name.

• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.

If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Your radio can have an access up to three levels of the folder structure.

3-2 -



3.2.3 Making a Group Call in TMO

3.2.3 Making a Group Call in TMO
The Group Call is received by all members of the selected group who have their units turned on and are in range.

Procedure Steps

1 Press and hold the PTT button.

2 Wait for the Talk Permit tone (if configured) and then speak into the microphone. Release the PTT button to
listen.

To cancel making a group call, do one the following actions before the talk permit is granted (depending on
your service provider’s settings):

• Release the PTT button.

• Press the END key (default).

When the call is canceled, your radio displays Call Cancelled message (if configured by your service
provider).

3.2.4 Receiving a Group Call in Idle
Procedure Steps

1 The radio receives a Group Call.

The incoming Group Call is signalled by a Receiving Group Call tone.

2 To respond, press and hold the PTT button.

3.2.5 Receiving a Group Call during an Ongoing Group Call
While in active Group Call, your radio receives a Group Call with a higher priority.

One of the following occurs:

• Your radio is forced to end the current group call and automatically join the incoming one.

• Your radio displays incoming group call screen with options:

– Join— ends current Group Call and starts the incoming one.

– End— cancels the incoming Group Call.
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3.2.6 Dynamic Group Number Assignment (DGNA)
DGNA allows the network operator to dynamically manage talkgroups on your radio over the air interface. Using
DGNA, the network operator can:

• Add talkgroups.

• Attach or select newly added talkgroups.

• Delete talkgroups.

• Modify parameters of existing talkgroups.

All the above operations are performed by transmitting data to your radio.

3.2.7 DGNA Reception
When a DGNA message is received, your radio plays a tone and displays a message Talkgroup list updated. If
enabled by your service provider, your radio displays all added and deleted talkgroup list.

When your service provider deletes (de-assigns) the currently selected talkgroup, depending on the settings, the
radio can do one of the following:

• Attach to the last selected talkgroup.

• Enter the “No Group” state.

However, if the first option is configured and the radio looses the last selected talkgroup (for example, after power
off/on cycle or when the talkgroup was deleted by the service provider), the radio also enters the “No Group” state.

If the DGNA message is received to delete all talkgroups, your radio displays All Talkgroups Deleted. To exit the
DGNA display, you can use the Back SOFT key or the END key.

3.2.8 DGNA Auto Select Group
If the DGNA Auto Select is configured, whenever your radio receives a DGNA, it switches to the added talkgroup.

3.2.9 DGNA Auto Reselect Group
If the DGNA Auto Reselect is configured, whenever a talkgroup assigned by the network operator via DGNA is
deassigned without the user action, the radio returns to the previously selected group.

3.2.10 Viewing DGNA Talkgroups
Prerequisites:
Your radio receives the DGNA message.
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3.2.11 Broadcast Call Initiated by User

Procedure Steps

1 To view the added talkgroups details press View.

2 Scroll through the list to select required talkgroup.

3 To select the DGNA group, press Attach.

3.2.11 Broadcast Call Initiated by User
This feature allows you to make a Broadcast Call from the radio that is initiated on the predefined talkgroup. Your
service provider predefines the alias and the priority of the Broadcast Call.

If the type of the encryption is defined by the SIM Card, the Broadcast Call is always clear. Otherwise if
the radio uses other encryption service the type of the encryption used for that Call is up to the encryption
settings of that service.

This feature is not supported on the Dimetra infrastructure.

3.2.12 Initializing Broadcast Call

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Services → Broadcast.
Step result: Your radio displays the predefined alias and the Broadcast Call icon.

3 To start the call press the PTT button.

3.2.13 Phone and PABX Calls
The Phone Call allows you to call a landline telephone number or a cellular mobile phone number. The Private
Automatic Branch Exchange (PABX) Call allows you to call local (office) extension numbers.
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3.2.14 Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other
radio can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.

• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The
radios are identified using its radio numbers.

Interaction with the accessories:

• Fist Microphone — during the Private Call, if you hang the microphone into the clip the call ends or the
audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

• Telephone Style Handset — during the Private Call, if you hand the handset into the holder, the call ends or
the audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

To end the Private Call if audio was switched to the speaker, press ON/OFF/END/HOME key.

To answer a Private Call, use one of the following methods:

• Press the PTT button.

• Take the Fist Microphone or Telephone Style Handset off hook. If the Handset is off hook, the radio’s
external speaker mutes and the Handset’s internal speaker activates.

• Press the SEND key on the control head. Audio is routed to audio input devices in the following order,
depending on their availability:

1. A visor microphone.

2. A microphone of the device that is off hook.

3. A microphone that was last in use (if two devices are off hook).
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3.2.15 Making a Private Call

3.2.15 Making a Private Call
Procedure Steps

1 From the home screen, enter the number.

2 If Private is not the first type of call presented, press Ctype repeatedly to select it.

3 When you are in the following mode:
a. TMO — For a simplex call, press and release the PTT button. You hear a ringing tone. Otherwise, press

and hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen.
For a duplex call, press and release SEND key. You hear a ringing tone.

b. DMO — Only simplex call is available. Press and hold the PTT button. Wait for the talk permit tone
before talking, and release the PTT button to listen.

4 To end the call, press the END key.

If you are using the fist microphone or the telephone style handset, replace it firmly on it's clip or holder
when done.

3.2.16 Assistance Call
This feature allows you make a private call to ask for assistance during normal and non-critical situations.

Your service provider can configure the number, priority, and the type of the call (simplex or duplex).

You can start an Assistance Call in one of the following way:

• Dial a predefined number and press SEND key.
• Menu → Services → Assistance Call

3.2.17 Call Modification
Call Modification is a feature that allows you and your service provider to modify the call in order to optimize it
and adjust to a current situation.

Modification can cover:

• Call priority — modified during call setup.
• Call type — modified during call setup.
• Call encryption — modified during an ongoing call (but not in the transmission phase).
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When the call is modified, your radio displays Call Modified message.

When a recently modified call requires the PTT button to transmit, your radio displays Call ModifiedUse PTT.

The majority of modifications is made by your service provider and the radio only follows them. You can modify
only SIM Card End-to-End Encryption for Group Calls — enable or disable it.

When call priority is changed to emergency:

• The display indicates that an Emergency Group Call has been received.

• The radio plays a special audio alert.

If a Group Call is modified into an Emergency Group Call, no emergency related features are triggered.

If call modification requested by your service provider cannot be followed by the radio (due to its settings), the radio
rejects it and displays Service Not Available message.

3.2.18 Enabling/Disabling SIM Card End-to-End Encryption
Prerequisites:

• The radio is not in an active call.

• You cannot press the PTT button.

To enable/disable SIM Card End-to-End Encryption, use one of the following ways:

• Press a One-Touch Button assigned to enabling/disabling SIM Card End-to-End Encryption.

• From the home screen, pressMENU → Crypto Menu → Crypto Function. Select Encryption On to
enable or Encryption Off to disable encryption.

Result: Your radio displays prompts indicating your current encryption state: an appropriate status icon and
Encryption On or Encryption Off message.

3.3 Local Site Trunking
This mode is also called as Fallback Mode and it allows more than one radio from the same site to communicate
when the link between the site and the network central controller fails. Entering and exiting Local Site Trunking
(that is, returning to System Wide Services) is done automatically. In this mode some services are unavailable.

Your service provider can disable this mode.
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3.3.1 Entering Local Site Trunking

3.3.1 Entering Local Site Trunking
When your radio receives a Local Site Trunking indication from the system, the following occurs:

• Your radio plays an Entering Local Site Trunking tone.
• Display shows the Local Area Service message.
• Display icons and soft keys turn olive.

Noticeable only on the color display.

• Any call in progress is dropped upon entering Local Site Trunking Mode.

If configured by your service provider, this message/alert is periodically repeated to remind you that your radio is
still operating in Local Site Trunking Mode. The following features are available:

• Registration
• Attachment
• Group Call
• Emergency Call
• Emergency Alarm

Your service provider can turn on/off all the visual and audio indications, when you enter Local Site
Trunking Mode.

3.3.2 Exiting Local Site Trunking
When the link with the central network controller is reestablished, your radio exits Local Site Trunking, and the
following occurs:

• Your radio plays an Exiting Local Site Trunking tone.
• Any call in progress during Local Site Trunking is dropped.
• Display icons and soft keys turn blue.

Your service provider can turn on/off all the visual and audio indications, when you exit Local Site
Trunking Mode.

3.4 Direct Mode Operation
Direct Mode Operation is a mode of simplex operation where radios communicate directly.
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Figure 3-2 Direct Mode Operation

3.4.1 Entering DMO Mode
To enter the DMO Mode:

• From the home screen, press the MENU key. Select Networks → Direct Mode.

• From the home screen, select Optns → Direct Mode.

3.4.2 Selecting a Talkgroup
From the home screen, use one of the following methods:

• Press left or right NAVIGATION key. Press Select to confirm.

• Select Optns → TG by abc. Enter a talkgroup name and select the talkgroup name from the list.

• Select Optns → TG by Folder. Select a folder and then a talkgroup name.

• Press ROTARY KNOB and rotate it until the required talkgroup name is displayed. Press Select to confirm.

If the ROTARY KNOB mode is set to Scroll, then you do not need to press it to enter the scrolling
mode.

Your radio can have an access up to three levels of the folder structure.
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3.4.3 Making a Group Call in DMO

3.4.3 Making a Group Call in DMO
The Group Call is received by all members of the selected group who have their units turned on and are in range.

Procedure Steps

1 Press and hold the PTT button.

2 Wait for the Talk Permit tone (if configured) and then speak into the microphone. Release the PTT button to
listen.

3.4.4 Receiving a Group Call in Idle
Procedure Steps

1 The radio receives a Group Call.

The incoming Group Call is signalled by a Receiving Group Call tone.

2 To respond, press and hold the PTT button.

3.4.5 Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other
radio can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.

• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The
radios are identified using its radio numbers.

Interaction with the accessories:

• Fist Microphone — during the Private Call, if you hang the microphone into the clip the call ends or the
audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

• Telephone Style Handset — during the Private Call, if you hand the handset into the holder, the call ends or
the audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

To end the Private Call if audio was switched to the speaker, press ON/OFF/END/HOME key.
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To answer a Private Call, use one of the following methods:

• Press the PTT button.

• Take the Fist Microphone or Telephone Style Handset off hook. If the Handset is off hook, the radio’s
external speaker mutes and the Handset’s internal speaker activates.

• Press the SEND key on the control head. Audio is routed to audio input devices in the following order,
depending on their availability:

1. A visor microphone.

2. A microphone of the device that is off hook.

3. A microphone that was last in use (if two devices are off hook).

3.4.6 Making a Private Call

Procedure Steps

1 From the home screen, enter the number.

2 If Private is not the first type of call presented, press Ctype repeatedly to select it.

3 When you are in the following mode:
a. TMO — For a simplex call, press and release the PTT button. You hear a ringing tone. Otherwise, press

and hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen.
For a duplex call, press and release SEND key. You hear a ringing tone.

b. DMO — Only simplex call is available. Press and hold the PTT button. Wait for the talk permit tone
before talking, and release the PTT button to listen.

4 To end the call, press the END key.

If you are using the fist microphone or the telephone style handset, replace it firmly on it's clip or holder
when done.

3.4.7 Private Call With Presence Check
This feature allows you to see if the calling party is available in DMO. When this feature is enabled, you can
only initiate a Private Call if the called radio is present on the same channel and responds with a presence check
acknowledgement.

Otherwise your radio displays Party Not Available.
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3.4.8 Talkgroup for Individual Calls

3.4.8 Talkgroup for Individual Calls
Talkgroup for Individual Calls is a talkgroup that operates on a separate frequency allocated for individual (private)
calls only. Using this talkgroup optimizes frequency resources and helps not to block other talkgroups. The only
supported call types are: private calls and emergency calls (both private and group). Use this talkgroup each time
you need to make a private call.

When you select a Talkgroup for Individual Calls, your radio is not able to receive or initiate any group or broadcast
calls with priority lower than Emergency.

When you have selected a Talkgroup for Individual Calls and press the PTT button to start a Group Call, the radio:

• Rejects the call

• Plays a tone

• Displays the Individual Calls Only message

3.4.9 Communication through Repeater
Radios that are out of range and cannot communicate directly one with another in DMO Mode can do it through
the repeater. The repeater is a radio that repeats all communication on a chosen channel, and as a result increases
radios’ DMO range.

DMODMO

When the radio connects to a repeater, it plays a tone, displays the Repeater available message, and shows an
appropriate icon. When the radio looses connection with the repeater, it plays a tone, displays the Repeater not
available message, and the repeater icon is blinking. Messages and sounds are configured by the service provider.

3.4.10 Communication through Gateway
Gateway provides connectivity between radios operating in DMO Mode and the TETRA network, so that the
DMO radios can communicate with the TMO radios.
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DMO

TMO

TMO

When the radio connects to a gateway, it plays a tone, displays the Gateway available message and shows an
appropriate icon. When the radio looses connection with the gateway, it plays a tone, displays the Gateway not
available message, and the gateway icon is blinking. Messages and sounds are configured by the service provider.

3.4.11 Selecting DMO Group Call Options
When and where to use:
Helps to communicate with other radio users on the same talkgroup through the Gateway or Repeater.
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3.5 Transmit Inhibit Mode

Procedure Steps

1 From the home screen, press Optns.

2 Press Config.

3 Select one of the following:
• MS - MS— Your radio can communicate only with other radios within its range.
• Gateway— Your radio uses a gateway to communicate with the infrastructure.

• Automatic— Your radio uses the first available gateway for that talkgroup.
• Specific— Your radio uses only the Gateway with the specified Gateway address for
that talkgroup. If your radio displays Selected Gateway:None, press Edit to enter the
current gateway address.

• Repeater— Uses the first available repeater for that talkgroup.
• GW + Rep— Uses the first available gateway or repeater for that talkgroup.

• Automatic— Uses the first available gateway for that talkgroup.
• Specific—Uses only the Gateway with the specified Gateway address for that talkgroup.
If your radio displays Selected Gateway:None, press Edit to enter the current Gateway
address.

When the Gateway and the Repeater cannot be communicated even though a talkgroup to use them is
configured, the radio attempts the direct MS-MS communication.
.

Result:
When your radio detects the appropriate Gateway and/or the Repeater, the Gateway and/or Repeater icons turns
solid, respectively.

3.5 Transmit Inhibit Mode
The Transmit Inhibit Mode is a mode in which the radio sends no radio transmissions. It is recommended to
activate the mode in RF sensitive areas, for example hospitals, airplanes, where safety can be jeopardized due
to transmission radiation.

To activate, selectMENU → Networks → TXI Mode → Activate.

In this mode, the radio does not transmit under any circumstances except for the Emergency Calls. All the functions
and keys which cause transmission, for example registration to the network, changing talkgroup or folder, sending
SDS messages, or pressing the PTT button are disabled. Any transmission trial causes the radio to display Not
Allowed In TXI Mode notification and to play a tone.

Your radio can still receive:

• Group calls.
• Messages — stored in the Inbox.
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• Private call attempts — stored in theMissed Calls list, without the option to respond.

When no danger to safety exists anymore (for example, you leave the RF sensitive area), you can deactivate the
Transmit Inhibit Mode and the radio returns to standard operation.

You can deactivate the mode by selectingMENU→ Networks → TXI Mode → Deactivate, pressing One-Touch
button, or implicitly when initiating an Emergency Call.

RF Transmissions from the radio are prevented under the following conditions:

• TXI Mode is activated.
• The radio is turned off.

3.6 Emergency Operations
Emergency Operations are used in critical situations.

Pressing and holding the EMERGENCY button, or entering the Emergency Number and pressing the SEND key,
activates one or more services (depending on your service provider settings):

• Emergency Alarm
• SDS Status
• Silent Emergency
• Hot Microphone operation
• Emergency Individual Call (Private or MS-ISDN)
• GPS location information

It is possible to turn on the radio by pressing the EMERGENCY button. Depending on the service provider
settings, the radio can start Emergency Operations automatically. If the radio is PIN-protected (except for
SIM PIN), Emergency Operations will bypass the PIN lock for the duration of the Emergency Operations.

When starting Emergency Operations, any ongoing voice call is aborted or cleared down, and any packet data
transfer in progress is aborted. However, the session is kept open.

During Emergency Operations, the radio rejects phone, PABX, and private calls, and does not monitor the talkgroups
in the selected scan list.

To terminate Emergency Operations, press the upperSOFT key.

3.6.1 Emergency Group Call
The Emergency Group Call has the highest communication priority that means it is the pre-emptive kind of call.
Emergency Group Call is available in both TMO and DMO. During Emergency Operations, Emergency Group
Call can be started by pressing pressing the EMERGENCY button. The radio can also support Hot Microphone
operation, which allows the Emergency Call to be conducted without pressing the PTT button.
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3.6.2 Making an Emergency Group Call

If the radio receives an incoming group call with emergency priority, the display shows that an emergency call
has been received, and a special audio alert is played.

An emergency group call can be configured as:

• A non-tactical call – initiated on a talkgroup preprogrammed by your service provider. When in non-tactical
emergency mode, you cannot switch talkgroups.

• A tactical call – initiated on the currently selected talkgroup.

In TMO, if the radio enters Emergency Operations while the Emergency Broadcast Call is active, the radio continues
on the call without initiating any calls and sends the Emergency Alarm.

When the Emergency Group Call you participate in terminates, your radio can behave in several ways, depending on
your service provider settings:

• If you are the call initiator, the radio can either stay in the Emergency Mode, or return to TMO.

• If you are not the call initiator, the radio always returns to TMO.

3.6.2 Making an Emergency Group Call
Prerequisites:
Ensure that your radio is in Emergency Mode.

Procedure Steps

1 Press and hold the PTT button.

2 Wait for the talk permit tone (if configured) and talk.

3 Release the PTT button to listen.

It is possible to cancel making an emergency group call in TMO. To do this, perform one of the following
actions before the talk permit is granted (depending on your service provider settings):

• Release the PTT button.

• Press the END key (default).

When the call is canceled, your radio displays Call Cancelled message (if configured by your service
provider).

3.6.3 Receiving an Emergency Group Call
The radio receives an Emergency Group Call from a selected pre-programmed group. An incoming call is indicated
by an appropriate tone, status icon, and red color of the display.
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3.6.4 Non-Tactical Emergency
In Non-Tactical Emergency the radio switches to a designated Emergency talkgroup when starting Emergency
Operations. This talkgroup is used for the complete duration of the Emergency Operations (you cannot change the
talkgroup).

In TMO, it is possible to configure the radio to make Emergency Non-Tactical Group Calls without sending
attachment. If this is set, the radio assumes implicit attachment after receiving a temporary address.

In DMO, the Non-Tactical Emergency proceeds on the same frequency as the previously selected talkgroup.
The service provider can designate any ITSI address to be used for Emergency Operations, (this can be an Open
Group – broadcast address).

After exiting from Non-Tactical Emergency, the radio goes back to the previously selected talkgroup.

3.6.5 Emergency Individual Calls (Private or MS-ISDN)
The Emergency Individual Calls are Simplex or Duplex Calls with emergency priority. On pressing the
EMERGENCY button, the radio initiates an Individual Call to the provisioned address (private or MS-ISDN).
During this kind of call all user indications are unavailable and all other services are rejected. Emergency Operation
ends as soon as the Emergency Individual Call is ended.

Private Call

MS-ISDN

3.6.6 Emergency Alarm
The Emergency Alarm is a special status message sent to the infrastructure while starting the Emergency Operations.
The radio can wait for infrastructure acknowledgment for this alarm and attempts retries.

Each time the radio enters the Emergency Operation, it sends the Emergency Alarm. When the Emergency Alarm is
sent successfully, the respective audible tone sounds.

In addition, once the radio is in the Emergency Operation on pressing the EMERGENCY button, an additional
emergency alarm is sent (exception: during Hot Microphone transmission).

The message can be dispatched both in TMO and DMO.

3.6.7 Emergency SDS Status
Radio sends a status message with a preprogrammed value to the destination address set by your service provider.
Emergency SDS Status is available in TMO only. If no status acknowledgment or negative acknowledgment is
received, the radio retries sending the message. Status is not resend if Emergency Alarm or Hot Microphone is
configured.
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3.6.8 Emergency Hot Microphone

3.6.8 Emergency Hot Microphone
The Hot Microphone allows you to talk without pressing the PTT button during Emergency Operations. The
transmission continues for a provisioned amount of time. Pressing the PTT button before the Hot Microphone time
expires ends the Hot Microphone operation. Then normal PTT operation in Emergency group call takes over (that is,
the transmission is ongoing for the time the PTT button is held).

Subsequent EMERGENCY button presses during the Emergency Operation restarts the Hot Microphone
transmission.

If a talk permit is granted to another member of the group, the Emergency Call received tone is played. If configured,
the radio automatically attempts to get talk permit again.

Pressing EndSOFT key or END key ends the Hot Microphone operation.

3.6.9 Alternating Hot Microphone
The Alternating Hot Microphone is an enhancement of the Hot Microphone. After activation, the radio alternately
enters transmission phases (your microphone is active) and reception phases (you can only listen) for an amount of
time precisely determined by your service provider.

If this feature is enabled, you can initiate the Alternating Hot Microphone by pressing the EMERGENCY button. If
you want to finish earlier or skip the transmission phase, press the END key.

The Alternating Hot Microphone terminates when one of the following conditions is met:

• The radio exits the Emergency Mode.
• The Alternating Hot Microphone timer expires.
• The PTT button is pressed.
• The upper SOFT key is pressed (only during the transmission phase).

When the radio goes out of the service, it enters the reception phase and the Alternating Hot Microphone
is on hold. When the radio is back to the service, the Hot Microphone transmission and the Alternating
Hot Microphone resume.

When you are in the Emergency Mode, pressing the EMERGENCY button restarts the Alternating Hot
Microphone.

3.6.10 Silent Emergency Mode
The Silent Emergency Mode is a type of emergency services that provides no audible indications and no keypad
tones at the entrance. All the display indications are as in the idle mode. However, the radio cannot use any
services except for:

• Receiving Ambience Listening
• Sending Silent Emergency Alarms
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• Sending GPS location reports

If you try to activate any other feature, it is blocked.

If the Silent Emergency feature is enabled, the radio enters Silent Emergency Mode on pressing the EMERGENCY
button. After entering this Mode the radio stays in TMO or switches to it, depending on the actual state. Once in
TMO, the radio sends Silent Emergency Alarm.

If the radio is in a private or group call, the radio waits until the call ends and then enters the Silent
Emergency Mode.

The radio keeps re-sending the alarm until successful sending is confirmed. After the alarm is successfully delivered,
the radio stays in Silent Emergency Mode and waits for the Ambience Listening.

Your radio exits the Silent Emergency Mode, under the following conditions:

• Press MENU and then # key within 3 seconds.
• Press MENU simultaneously with right NAVIGATION key.
• Press both SOFT keys simultaneously.
• No success in sending the Silent Emergency Alarm and the maximum number of retries has been reached.
• The control room terminates the Silent Ambience Listening.
• The Ambience Listening is disconnected due to another reason.

If you turn off the radio in the Silent Emergency Mode, the radio switches to pseudo power off state. In this state, the
radio appears to be turned off. However, the radio is still on and in the Silent Emergency Mode. On turning the radio
on during the pseudo power off state, the radio acts as during turning on and still is in the Silent Emergency Mode.

3.6.11 Invisible Emergency
It is possible for the service provider to disable visual and audible indications of performing Emergency Operations
on the radio. The purpose of this feature is to hide the fact of using Emergency Operations in a critical situation
(e.g. direct attack on the user) and thus to provide additional layer of safety.

3.6.12 Emergency Mode by Dialing
This feature allows you to trigger Emergency Mode by dialing a predefined number. It initiates the same Emergency
services as you would use the EMERGENCY button. Your radio can store up to eight Emergency numbers.

If this Emergency Mode was triggered by Emergency number (not by EMERGENCY button), you can
press the END key to exit the Emergency Mode.
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3.6.13 Disaster Alert

3.6.13 Disaster Alert
Disaster Alert call is a broadcast emergency call initiated by the radio, with emergency pre-emptive priority that
everyone in a broadcast area can hear. This feature is specifically designed for catastrophic situations, such as
earthquakes, and has the highest priority over other calls. All radios under Disaster Alert display emergency
notification on their screens. The alert message, its duration and destination talkgroup can be configured in
the codeplug.

In order to initiate Disaster Alert, switch the radio to Disaster Alert mode and press PTT button. When the call ends,
the radio will exit the Disaster Alert state.

During Disaster Alert, other functionality is impacted:

• When Disaster Alert begins, any other ongoing services are terminated.

• No other services can interrupt this type of call.

• Hot Mic functionality cannot be used.

• Speech can only be in Clear mode, even if any of the encryption services are enabled. The only exception is
E2E Encryption.

Not all infrastructures support this feature. Please consult with your service provider before enabling
this feature.

3.6.14 Initializing Disaster Alert Call

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Services → Disaster Alert.
Step result: Your radio enters Disaster Alert Mode and it displays Disaster Alert icon.

3 To start the call press PTT.
Step result: Your radio displays Disaster AlertIn Use.

3.6.15 Exiting Emergency Operations
Prerequisites:
Make sure that your radio is engaged in Emergency Operations.

- 3-21



Feature User Guide

Procedure Steps

1 If your radio screen displays Emergency Mic On, press End.

2 Press and hold Exit.

If an Emergency Operation was triggered by Emergency number (not by EMERGENCY button), you can
press the END key to exit the Emergency Operation.

3 If your radio displays Do you want to exit?, press Yes to exit.

Result:
Your radio exits Emergency Operations.

3.7 Repeater Mode
The Repeater Mode provides repeater connectivity between radios operating in the DMO Mode.

Only the radios on the same talkgroup can communicate with each other through the repeater.

Figure 3-3 Repeater Mode Operation

DMODMO
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3.7.1 Entering Repeater Mode

3.7.1 Entering Repeater Mode
To enter Repeater Mode, use one of the following ways:

• From the home screen, select Optns→ Repeater Mode.

• From the home screen, press MENU key. Select → Networks→ Repeater Mode.

3.7.2 Setting Monitor Option

Procedure Steps

1 From the home screen, press Optns.

2 Press Monitor.

3 Select one of the following:
• Off— Your radio works as a repeater only, no operation is available.
• Receive Only — Allows you to listen.
• Receive&Transmit— Allows you to listen and transmit by pressing PTT.

3.7.3 Encryption in Repeater Mode
While in the Repeater Mode, the radio supports Air Encryption and is able to repeat encrypted calls and messages.

If SCK keys installed on the radio are invalid:

• The radio transfers calls and messages without deciphering them (provided that the encryption level is
not the highest).

• The LED indicator turns orange.

• On pressing the PTT button, Channel Busy or DMSCK is Invalid message appears.

• You cannot make any call.

3.8 Gateway Mode
The Gateway Mode allows your radio to work as a gateway and thus provide connectivity among radios operating in
DMO and TMO Modes.
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Figure 3-4 Gateway Mode Operation

DMO

TMO

TMO

This is a selling feature.

3.8.1 Entering Gateway Mode
Procedure Steps

1 From the home screen, press Optns.

2 Select Gateway Mode.

When the Gateway Mode is enabled, you cannot make any call.

3.8.2 Standby Mode
Your radio enters Standby mode if there is another Gateway on the same DMO frequency. Gateway icon flashes and
no transmission is forwarded through the gateway. To exit Standby Mode you can:

• Choose another DMO talkgroup

• Wait untill the other gateway is out of coverage and is no longer present on that DMO talkgroup

3.8.3 Forwarding a Group Call
Your radio shows the source and destination talkgroup of the Group call.
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3.8.4 Setting Monitor Option

3.8.4 Setting Monitor Option

Procedure Steps

1 From the home screen, press Optns.

2 Press Config and Select one of the following:
• Off— Audio of the calls are not routed to the speakers of the gateway.
• Receive Only— Audio of the calls are routed to the speakers of the gateway.

3.8.5 Emergency Calls in Gateway Mode
Press the EMERGENCY button to enter the TMO Emergency mode and start an Emergency Group call. Check with
your service provider if the Emergency Group call starts on a tactical or non-tactical talkgroup. If the radio that is in
the Gateway mode receives an Emergency Group call, it forwards it to the respective TMO/DMO talkgroup that
is currently switched to.

3.8.6 Encryption in Gateway Mode
While in the Gateway Mode, the radio supports Air Encryption and is able to transmit encrypted calls among
radios operating in TMO and DMO.

If SCK keys installed on the radio are invalid, the radio cannot function as a gateway and transmit calls.
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4 GPS Location Service
The GPS Location Service feature uses information from Global Positioning System (GPS) satellites orbiting the
Earth to determine the approximate geographical location of your radio.

The GPS Location Service availability, accuracy, and the position calculation time vary depending on the
environment in which you use the radio. The GPS Location Service can assist your dispatcher or colleagues in many
ways such as more efficient deployment of resources or locating your radio when you trigger your emergency service.

The radio can display the location information directly on the screen or send it over the air to your Dispatcher to
display it in the control center. Check your radio configuration details with your service provider.

Where the signals from satellites are not available, the GPS Location Service does not work. This situation
usually happens when your radio cannot establish a view of a wide area of open sky, for example, when
your GPS antenna is covered or facing the ground. Such situations include being:

• In underground locations
• Inside buildings, trains, or other covered vehicles
• Under any other metal or concrete roof or structure
• Near a powerful radio or television tower
• In extreme temperature outside the operating limits of your radio

Even if your location information can be calculated in such situations, it may take longer to do so. Therefore, in any
emergency situation, always report your location to your dispatcher. Where adequate signals from multiple satellites
are available, your GPS Location Service feature provides a location, most probably near to your actual location.
For GPS feature performance, under ideal test conditions see Table “GPS Specification”

The radio can be triggered to send Location Reports in various circumstances, for example:

• Upon a request
• Entering Emergency Mode
• At specified time intervals
• At specified distance intervals

The Location Reports can be sent in two ways using:

• SDS
• Packet Data

If the Location Reports are sent over the Packet Data, a Packet Data icon is displayed when the message is being sent.

If the Location Reports are sent via SDS with User Defined Data Type-4 as a transport layer, either the ETSI
Location Information Protocol (LIP) or Motorola Location Request/Response Protocol (LRRP) GPS Location
Protocol is used. The LRRP GPS protocol either use SDS-TL (for added reliability) or Simple GPS with no SDS-TL
(for saving air interface resources). GPS Protocol Identifiers are:

• LRRP SDS TL = 131
• LRRP Simple GPS = 3
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• LIP GPS = 10

Location reports are sent in TMO and can also be provisioned to be sent in DMO. If the radio is provisioned to
provide user indications, the feature operational status is indicated on the radio display.

Depending on the radio configuration, viewing the radio position and the status of the visible satellites is available.
The position may consist of longitude and latitude, UK, or Irish grid coordinates. The GPS Location Service feature
can be enabled or disabled as a whole using the CPS. It is possible to configure the feature parameters using the
CPS, or over the air. The CPS configuration provides a default profile. The commands received over the air may
overwrite the default profile configuration. The profile assigned to the radio determines when to send location data,
what data to send with what accuracy and to what address. All data requests and configuration commands received
over the air are checked to confirm they have come from a trusted source. Location reports are accepted only from
authorized ISSIs or IPs, depending on the configured transport layer (SDS, Packet Data).

Ensure the application receiving location messages and the radio are configured in a corresponding way.
Otherwise the radio will reject all system GPS requests.

The radio supports GPS triggers functionalities (using LIP or LRRP) to report GPS positions when the radio meets a
set of criteria. The following triggers, together with their specific parameters, can be set up by service provider:

Table 4-1 GPS Triggers

Trigger Type Trigger Event
Power-up Radio powers up in TMO.

Power-down Radio powers down in TMO.

Emergency
condition

Radio enters emergency operations.

Periodic Given time interval after the last location report expires.

Moved Radio position has changed by at least the distance defined (the radio checks the movement
from the last known position at an interval).

TMO ON Successful registration on entering TMO from DMO.

DMO ON Before TMO deregistration, and before entering DMO.

Transmit Inhibit
Mode ON

Radio is about to enter TXI.

Transmit Inhibit
Mode OFF

Radio has successfully registered after leaving TXI.

Low battery Radio detects its battery level has reached or fallen below the level specified by service
provider.

Loss of GPS Radio detects a loss of GPS for a minimum duration defined by service provider.

Recovery of GPS Radio detects a recovery of GPS signal for a minimum duration defined by service provider.

Status entered Radio sends a status defined in the CP for location reporting by pre-programming.

DCK Connected Radio detects that a Car Kit has been connected.

DCK Disconnected Radio detects that a connected Car Kit has now been disconnected.

GPS ON Positioning device has been switched ON.
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4.1 Enhancing GPS Performance

Table 4-1 GPS Triggers (cont'd.)

Trigger Type Trigger Event
GPS OFF Positioning device in the radio is about to be switched OFF.

Emergency
Periodic Profile
(LRRP only)

Radio is in emergency operation and given time interval after the last location report expires.

This is a selling feature.

Location

4.1 Enhancing GPS Performance
Sometimes the GPS feature is unable to complete a location calculation successfully. You hear an audible tone
indicating that your radio cannot see the satellites.

The GPS feature works best where there is nothing between your radio and a large amount of open sky. To maximize
the ability of your radio to determine a location fix, avoid closed space, tall buildings, and foliage. If possible, do not
use GPS in underground parking lots, tunnels, under bridges, and close to high buildings.

4.2 Enabling GPS
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Location → Interface.

3 Select On.

Your service provider can enable this feature.

4.3 GPS Icon
When your radio receives a valid GPS location data, it displays a GPS icon.
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During Emergency Mode, your radio does not display the GPS icon even when receiving GPS location data.
If valid GPS location data is available when you leave Emergency Mode the GPS icon is displayed again.

4.4 GPS Different Location Displays
Table 4-2 Different Location Displays

Latitude /
Longitude UK Coordinates Irish Coordinates UTM Coordinates MGRS

Coordinates
Time Time Time Time Time

Latitude 2–Letter Code 1–Letter Code 3–Letter Code 3–Letter Code and
2–Letter Code

Longitude Easting and
Northing Coordinate

Easting and
Northing Coordinate

Easting and
Northing Coordinate

Easting and
Northing Coordinate

Altitude Altitude Altitude Altitude Altitude

Satellites Satellites Satellites Satellites Satellites

• Time — indicates when the last time the location was calculated. The time is provided in Universal Time
Coordinated.

• Letter Code — grid zone or square on the map for different coordinate standard

• Latitude — expressed in degrees, minutes, and seconds.

• Longitude — expressed in degrees, minutes, and seconds.

• Number of satellites — used to calculate the location. In general, more satellites make for better accuracy.
The maximum is 12 satellites.

• Easting — refers to the eastward-measured distance expressed in meters.

• Northing — refers to the northward-measured distance expressed in meters.

Skipping each digit of easting and northing coordinates decreases the accuracy by the factor of 10.
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4.5 Viewing Your Position

4.5 Viewing Your Position
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Location → Position.

3 Scroll to view the results about the last time your location was calculated.

To refresh your position:

• Select Position— the radio refreshes its position automatically

• Press Refresh

4.6 GPS – Things to Keep in Mind
Where adequate signals from multiple satellites are not available, the GPS feature of your radio does not work. Such
situations include but are not limited to:

• In underground locations

• Inside of buildings, trains, or other covered vehicles

• Under any other metal or concrete roof or structure

• Near a powerful radio or television tower

• When your GPS antenna is covered (for example, by your hand or other object) or facing the ground

• In temperature extremes outside the operating limits of your radio

Even where location information can be calculated in such situations, it may take longer to do so. Therefore, in any
emergency situation, confirm your location with your dispatcher.

Furthermore, please note that even where adequate signals from multiple satellites are available, your GPS feature
provides only an approximate location, often within 20–100 meters from your actual location.
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5 Main Menu
This chapter contains information on items in the main menu.

You can enter the menu items during a call. If you are viewing a menu when a new call starts, the radio
exits the menu.

5.1 Scrolling through the Menu
Procedure Steps

1 From the home screen, press the MENU key.

2 Scroll to the required item by pressing NAVIGATION keys. Press the SOFT key assigned as Select or right
NAVIGATION key to select.
If the menu item contains a further set of menu items, repeat step 2.

You can use shortcuts to access frequently used items.

Shortcuts

5.2 Menu Icons
The following icons make it easy to identify the menu items at first glance.

Table 5-1 Menu Icons

Menu Icon Description
Main Menu Items / Context Sensitive Menu
It is assigned to MENU when the main menu items / context-sensitive menu are active.

Messages

Send status messages,

Send text messages (free text or according to user defined or predefined templates),

Received messages in Inbox.
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Table 5-1 Menu Icons (cont'd.)

Menu Icon Description
Contacts
Add, search, edit, or erase entries in the contact list.

Browser
Starts the WAP browser.

Security
Lets you turn on/off and verify security features, and change passwords.

Setup
Allows you to customize your radio.

Group Setup
Contains additional menu items for Scanning Talkgroups features.

Favorites
Contains shortcuts to frequently used talkgroups and contact numbers.

My Info
Displays information about your radio and its numbers.

Recent Calls
Contains a list of recent calls.

Shortcuts
Allows you to view and manage shortcuts to menu items.

RUI
Allows you to log in and log out of the radio.

Networks
Allows you to select a network.

Location
Displays location of your radio.

Packet Data
Allows you to send data from your radio to other devices.

Crypto Menu
Allows you to manage SIM Card End-to-End Encryption.

Services
Allows you to manage Broadcast, Assistance and Disaster Calls.

5.3 Messages
This feature allows you to send and receive text messages. A message can contain up to 1000 characters, depending
on your service provider settings.
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5.3.1 New Message

When you receive a message that cannot be decrypted, your radio displays a notification entitled Incoming
SDS with the following information in its content:

• ISSI address of the sender.

• Decryption Failed: message.

• Decryption fail reason: Wrong Key, No Key, or SIM Error.

To close the notification, press the right SOFT key or the END key.

Pressing the PTT button when a message is highlighted can cause one of the following actions, depending on
your service provider settings:

• The radio ignores the PTT button request.

• The radio starts a Private Call with the message sender.

• The radio starts a Group Call on a currently selected talkgroup.

5.3.1 New Message
This menu item allows you to create a new message.
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5.3.1.1 Sending a Message to Private/Phone

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → New Message.

3 Enter your message and press Send.

4 If needed, select Private/Phone.

5 Enter recipient number or press abc to choose it from your contacts.

6 Press Send, or SEND key, or the PTT button.

5.3.1.2 Sending a Message to Group

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → New Message.

3 Type your message and press Send.

4 If needed, select Group.

5 Select a group to send the message.

5.3.1.3 Sending a Store and Forward Message
Prerequisites:
Your service provider enables the Store and Forward feature.
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5.3.1.4 Delivery Report

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → New Message.

3 Press MENU key and selectMessage Setup → On/Offline users.

4 Enter your message and press Send.

5 If asked for the Target selection, select one of the following:
• Private – enter the private number or press abc to choose the destination number from the contact list.
• Phone – enter the phone number or press abc to choose the destination number from the contact list.

Your service provider can enable to send a Store and Forward message to a talkgroup.

6 Select Send, or press SEND key or PTT button.

5.3.1.4 Delivery Report
Delivery Report is an acknowledgment that the radio can request upon sending a message to an individual recipient.
You can define what type of Delivery Report your radio requests, or turn on/off this feature.

If the Delivery Report is received shortly after the message was sent, the radio:

• Displays a pop-up with one of the following messages (depending on what Delivery Report was received):
Message Sent,Message Delivered,Message Read, orMessage Failed.

• Saves the Delivery Report in Outbox along with a copy of the message.

If the Delivery Report is received after a longer period of time, the radio:

• Saves the Delivery Report in Outbox along with a copy of the message.

• If Delivery Report Notifications functionality is configured by your service provider, the radio also:

– Temporarily saves a Delivery Report message in Inbox. The notification disappears after it is read.

– Displays New Message icon.

– Displays New Delivery Status notification screen (if possible).
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5.3.1.5 Viewing Delivery Report
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Inbox.

3 Find a required message and select Read.

4 Press MENU key.

5 Select Delivery Status.

5.3.1.6 Configuring Delivery Report
Prerequisites:
Your service provider enabled the delivery report configuration.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → New Message.

3 Press MENU key and select Delivery Report.

4 Select one of the following:
• None— the radio does not request any delivery report.
• Received— the radio requests reports on your messages that were received.
• Consumed— the radio requests reports on your messages that were read.
• Both— the radio requests reports on your messages that were received and read.

5.3.2 Inbox
It contains up to 100 new or old incoming messages.

Table 5-2 Inbox Icons

Icon Description
Unread (New) Message

Read (Old) Message
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5.3.2.1 Entering the Inbox

Table 5-2 Inbox Icons (cont'd.)

Icon Description
Sender Information in Message View — name or number

Time and Date Stamp in Message View — arrival time and date

Delivery Status Received — delivery status for Store & Forward messages

Messages sub-menu indicates the number of the messages. If the indication is for example 2/4, it means that
two unread and four read messages are in the Inbox.

5.3.2.1 Entering the Inbox

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Inbox.

The status (if any) of the list is displayed for a few seconds:

• No New or Old Messages— The screen returns to the previous display within a few seconds.

• Inbox Full — Select Ok.

5.3.2.2 Receiving New Message

Procedure Steps

1 New message received.
Step result: Your radio displays an animation and plays a New Mail Received tone.

2 Select one of the following:
• Read — opens the entire message.
• Back— dismisses the message. You can access the message later from the Inbox.

5.3.2.3 Using Submenu in Inbox and Outbox

Procedure Steps
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1 From the home screen, press the MENU key.

2 Select Messages → Inbox or Outbox.

3 Highlight the required message and press MENU key.

4 Select one of the following:
• Store— Saves a message as a template. Change the default template name and press Ok.
• Delete— Deletes the selected message. Press Yes to confirm.
• Delete All— Deletes all the messages in the Inbox/Outbox. Press Yes to confirm.
• Reply (only for Inbox) — Invokes the edit screen with the old message as default text and the message

originator as a recipient. After editing, press Send, the PTT button, or the SEND key to send.
• Resend (only for Outbox) — Invokes the edit screen with previously entered text with the same

recipient. After editing, press Send, the PTT button, or the SEND key to send.
• Forward— Invokes the edit screen with the old message to send it to a different participant. After

editing, press Send, the PTT button, or SEND key to send.
• Refresh— Re-orders the message list and displays the new messages.
• Delivery Status (only for Outbox) — Shows the date and time of the message when it sent, delivered,

read, and expired was not delivered, expired was not read, failed unknown.

5.3.2.4 Embedded Number
This feature allows you to call a number from a message or to start a group call with the message sender talkgroup.

5.3.2.5 Storing a Number from a Message
Prerequisites:
Embedded Number feature is enabled by your service provider.

When and where to use:
You can save the sender's or embedded number from the message to a new or existing contact.
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5.3.2.6 Calling a Number in a Message

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Inbox.

3 Highlight the required message and select Read.

4 Press the PTT button.

5 Radio displays a list of the numbers (including the senders number).

6 Highlight the required number and press Store.

7 Highlight required contact and press View.

To store a number for a new contact, select [New Contact] and fill out the required fields. Press Done
to save it..

8 Select Edit.

9 Choose the Type of the new number and press Done.

5.3.2.6 Calling a Number in a Message
Prerequisites:
Embedded Number feature is enabled by your service provider.

When and where to use:
You can return a voice call to the sender of a message or to any number that is embedded in the message text.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Inbox.

3 Highlight the required message and select Read.

4 Press the PTT button.

5 Radio displays a list of the numbers (including the senders number).

6 To call, highlight to the required number and press the PTT button or the SEND key.

7 Select Ctype to choose the type of call (Private, Phone, or PABX).

8 Press the PTT button or the SEND key.

5.3.2.7 Making a Group Call on a Talkgroup of the Message Sender
Prerequisites:
Embedded Number feature is enabled by your service provider.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Inbox.

3 Highlight the required message and press the PTT button.

5.3.2.8 Immediate Message
When the new immediate message is received, radio plays the New Mail Received tone and displays the content
overlapping your previous screen. All immediate messages are stored in the Inbox. If the radio is in PIN Lock state,
immediate message is displayed after correct PIN is entered.

This feature needs to be enabled by your service provider.
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5.3.3 Outbox

5.3.3 Outbox
Outbox stores all sent messages.

Table 5-3 Outbox Icons

Icon Description
Delivery in Progress

Delivery Accomplished

Delivery Failed

Successful Outgoing Message

Failed Outgoing Message

5.3.4 CO Box
CO Box contains incoming and outgoing Call-Out messages arranged chronologically with the newest at the top of
the list. Clicking Select on a Call-Out message headline displays more detailed information on the item.

When the radio is in normal mode, you are able to browse through all messages in the CO Box. However, if the
radio is in the Call-Out mode, you can only browse through the information regarding the currently ongoing
Call-Out message.

Call-Out

5.3.5 RMS Box
RMS Box stores all incoming and outgoing Radio Messaging System (RMS) messages, both Status messages
and Free Text messages.

5.3.6 WAP Box
Each WAP Push message can be loaded immediately or stored as a message inWAP Box. Then it can be accessed
by pressingMENU→Messages →WAP Box. All the WAP Push messages are passed to the browser.
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WAP

WAP Push

5.3.7 Templates
This feature is used to store up to 100 predefined and your message templates. Each of the Inbox and Outbox
message can be stored as a template. Each template name and text can be edited afterwards.
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5.3.7.1 Sending a User-Defined Template

5.3.7.1 Sending a User-Defined Template

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Templates.

3 Highlight the required template name and press Send.

4 Do one of the following:
• Enter the number or press abc to select the name from your contact list. Press Send.
• Select required talkgroup from the TalkGroup List.

5.3.7.2 Setting User-Defined Templates

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Templates.

3 Highlight the required template and press MENU.

4 Select one of the following:
• View — Displays template text.
• Delete — Deletes the template.
• Edit Text— Opens edit screen with the template text. Edit the text and press MENU. Select Save

Changes to save edited template, or Store to save the edited template as a new one.
• Edit Name—Opens edit screen with the template name. Press Ok to save the template.

5.3.8 Predefined Templates
Predefined message templates are programmed into your radio. You are allowed to perform limited edit operations
of the predefined template. You can send it, but you are not able to store the edited template or erase it from the
predefined template list.

5.3.8.1 Viewing Predefined Templates

Procedure Steps
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1 From the home screen, press the MENU key.

2 Select Messages → Predefined.

3 Highlight the required template and press MENU key.

4 Select View.

5.3.8.2 Sending Predefined Templates

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Predefined.

3 Highlight the required template and press Send, the PTT button, or the SEND key.

You can edit the predefined template before you send it. Press the MENU key and select Edit. Edit screen
opens with the template text. You are only allowed to replace the existing text.

5.3.9 Send Status

5.3.9.1 Viewing a Status Message Number

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Send Status.

3 Press the MENU key and select View.

5.3.9.2 Sending a Status Message to a Group
Prerequisites:
Switch to the desired talkgroup, to which you want to send a status message.
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5.3.9.3 Targeted Status

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Send Status.

3 Do one of the following:
• Highlight the required status message and press Select, the PTT button, or the SEND key.
• Enter 5 digit status message number and press Send.

If the radio displays Status list is empty, you can enter 5 digit status message and press SendTo.

5.3.9.3 Targeted Status
This feature allows you to send the status message to a private number or to user selected talkgroup.

Your service provider can disable to send a status message to a private number that is not in the Contacts.
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5.3.9.4 Sending a Targeted Status Message

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → Send Status.

3 Do one of the following:
• Highlight the required status message and press Select, the PTT button, or the SEND key.
• Enter 5 digit status message number and press Send.

If the radio displays Status list is empty, you can enter 5 digit status message and press SendTo.

4 Do one of the following:
• Enter the number or press abc to select the name from your contact list. Press Send.
• Select required talkgroup from the TalkGroup List.

Result:
The display shows on of the following delivery reports:

• Status Sent.
• Status Failed.

5.4 Contacts
This sub-menu stores all your contact numbers. Each entry requires the following information:

• Name— if you store more than one number to one contact, this entry is required.
• Type— each contact must be assigned to one of the following types:

Table 5-4 Contact Types

Contact Icon Description
Private
Cannot have a speed dial number.

Mobile

Home

Work

PABX
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5.4.1 Creating a Contact

Table 5-4 Contact Types (cont'd.)

Contact Icon Description
Other

Pickers
Indicate more than one number in a contact.

• # (number) — each contacts entry must contain a number.

• Speed #— accept the default Speed Dial number or change it.

5.4.1 Creating a Contact

Procedure Steps

1 From the home screen, select Contcs.

2 Select [New Contact].

3 Highlight Name and press Change. Enter the name of your contact and press Ok.

4 Highlight Type and press Change. Select the required type of your contact.

You can use the left and right NAVIGATION keys to select the type of your contact from the Contact
Details screen.

5 Highlight # (number) and press Change. Enter the number of your contact and press Ok.

6 If needed, highlight Speed # and press Change. Enter the speed dial number (1– 1000) of your contact and
press Ok.

If the entered number exist, the radio displays Overwrite? message. Press Yes to confirm, or No to enter
the speed dial number again.

7 Press Done.

Result:
You have create a contact with one number. To add additional number repeat steps 4–6.
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5.4.2 Editing a Contact

Procedure Steps

1 From the home screen, press Contcs.

2 Highlight the contact you want to edit.

3 Press the MENU key.

4 Press Edit.

5 Highlight one of the following entries and press Change to edit:
• Name

• Type

• # (number)
• Speed #

6 Press Done.

5.4.3 Deleting a Number

Procedure Steps

1 From the home screen, press Contcs.

2 Select a contact you want to edit.

3 Use left or right NAVIGATION keys to choose the required number.

4 Press MENU.

5 Select Delete number.

If an entry contains only one number, deleting the number deletes the entry.

6 Press Yes.
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5.4.4 Deleting a Contact

5.4.4 Deleting a Contact

Procedure Steps

1 From the home screen, select Contcs.

2 Highlight a contact you want to delete.

3 Press the MENU key.

4 Select Delete contact.

5 Select Yes.

5.4.5 Checking Capacity
When and where to use:
To see how many numbers are stored in the radio.
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Procedure Steps

1 From the home screen, select Contcs.

2 Press the MENU key.

3 Select Capacity.

4 Select one of the following:
• Private

• Phone / PABX

• Contact

5.4.6 Dialing through the Contact List

Procedure Steps

1 From the home screen, press Contcs.

2 To highlight the required contact, use up and down NAVIGATION keys, or enter up to 12 characters of the
contact name.

3 If the contact has more than one number, use left and right NAVIGATION keys to select the required number.

4 Press the PTT button to initiate a simplex call with a Private number. Otherwise use the SEND key to initiate a
duplex call.

5.5 Browser
This menu item activates a WAP browser that allows you to browse the Internet from your radio.

WAP

5.6 Security
This sub-menu stores all your security settings.
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5.6.1 Keylock Setup

5.6.1 Keylock Setup
The keypad lock feature allows locking the keypad to prevent accidental pressing of keys. The keypad lock/unlock
can be invoked using the menu or using a predefined menu shortcut. By default press MENU, and then * key.

Your service provider can determine which of the following elements are additionally inoperative while the keypad
lock feature is active:

• The PTT button

• Side buttons

• The ROTARY KNOB

The ON/OFF/END/HOME key is always inoperative and the EMERGENCY button is always operative.

Locking/Unlocking the Keys/Buttons

5.6.1.1 Keypad Lock Notification
When the keypad is locked, your service provider can configure one of the following instructions:

• None — no notification is displayed.

• Notification Only — Keys Locked is displayed.

• Notification and Instruction — Press Menu * to lock/unlock keypad is displayed.
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5.6.1.2 Setting Automatic Keylock Delay

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → Keylock Setup → Delay.

3 Use up and down NAVIGATION keys to change the minutes and press Done.

5.6.1.3 Setting Keylock on Startup

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → Keylock Setup → Start Locked.

3 Select On/Off.

5.6.2 Air Encryption
Air Encryption is a feature that enables encryption of entire communication between the radio and infrastructure,
which results in increased security of calls, messages, and data.

If configured by your service provider, the radio plays a sound and displays Call & Data Not Encrypted when
encryption is on and you receive a clear call (unencrypted). This feature provides service confidentiality between
you and the system.

In the TMO Mode, when Air Encryption is enabled on you radio but cannot be supported due to an infrastructure
failure, the following icon appears on the display: .
When encryption is not available in the DMO Mode, the radio displays: .

This menu item allows you only to view air encryption state.
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5.6.2.1 Viewing Air Encryption State

Status Icons

5.6.2.1 Viewing Air Encryption State

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → AirEncrypt.

3 Your radio displays:
a. Air Encryption Is Off.
b. Air Encryption Is On.

5.6.2.2 Air Encryption Key Deletion
Please check with your service provider whether the radio is provided with Air interface encryption keys. You can
delete the Air interface encryption keys from the radio by entering the following sequence: **00##.

• It takes a minute for this feature to delete all the encryption keys from the radio.

• Deletion is performed in idle TMO/DMO or Emergency Operation.

Using this feature will disable the radio, and your service provider will need to re-enable the radio.

5.6.3 K Validity
K (Key) is a secret key the infrastructure uses to authenticate the radio in the system. It is part of the authentication
that provides service confidentiality between your radio and the system.

- 5-23



Feature User Guide

5.6.3.1 Verifying K Validity

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → K Validity.

3 Your radio displays:

• K is Valid— the infrastructure can authenticate your radio.

• K is Invalid— the infrastructure is unable to authenticate your radio. Please call your service provider
to restore the key to your radio.

5.6.4 TMSCK Validity
SCK (Static Cipher Key) is a secret key the infrastructure uses to encrypt call and data in TMO Mode. Air
interface encryption provides service confidentiality between your radio and the system. Your radio is provided
with a set of SCKs.

5.6.4.1 Verifying TMSCK Validity

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → TMSCK Validity.

3 Your radio displays:

• TMSCK is Valid— your radio can work encrypted in TMO Mode.

• TMSCK is Invalid— your radio cannot work encrypted in TMO Mode. Please contact your service
provider to restore SCKs to your radio.

5.6.5 DMSCK Validity
This feature is used to provide the service confidentiality for your calls and data services in the DMO Mode.
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5.6.5.1 Verifying DMSCK Validity

5.6.5.1 Verifying DMSCK Validity

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → DMSCK Validity.

3 Your radio displays:

• DMSCK is Valid— your radio can work encrypted in DMO Mode.

• DMSCK is Invalid— your radio cannot work encrypted in DMO Mode. Please contact your service
provider to restore SCKs to your radio.

5.6.6 DMO SCK
Air interface encryption provides service confidentiality between your radio operating in Direct Mode and another
radio or a group of radios operating in Direct Mode. This feature allows you to enhance security.

This feature needs to be enabled by your service provider.
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5.6.6.1 Changing DMO SCK

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → DMO SCK.

3 Press Next.

4 Radio displays Change to version .

5 Select one of the following:
• Yes— to change the key. Your radio displays Key version changed.
• No— to leave the key. Your radio displays Code Not Changed.

5.6.7 Covert Mode
This feature enables you to completely shut down all visible and audible alerts and notifications making the radio
unnoticeable even in a silent and dark environment.

When your radio is in the Covert Mode, you cannot enter the following menu items of the Setup menu.

• Set Volume

• Tones

• Backlight (in Display menu item)

When the Covert Mode is turned on:

• All tones are set to Off (corresponding to All Tones menu entry).

• The private speaker is set to Off.

• The dimmer state is set to covert (this state is not selectable using the BACKLIGHT key.)

• The wallpaper is disabled.

• The screen saver is disabled.

• The Covert Mode color palette is activated.

The radio powers up in the mode set before turning off. Thus if the Covert Mode was set before turning off, the
radio turns on in the Covert Mode .

When the Covert Mode is turned off, all the changed settings are reverted to the previous state.

When using the Covert Mode, a low audio accessory should be connected to the radio. The correct low audio
accessory is the GCAI Handset, or the older style handset connected through the junction box.

This feature can be used as the One-Touch Button.
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5.6.7.1 Activating Covert Mode

5.6.7.1 Activating Covert Mode
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → Covert Mode.

3 Select one of the following:
• On— all tones are set to off, and the backlight and the LED are disabled immediately. The group audio

is routed to the earpiece. The radio displays Covert Mode On.
• Off— all settings for tones, backlight and audio are restored. The radio displays Covert Mode Off.

5.6.8 SDS Remote Control
SDS Remote Control is a feature that enables to remotely control behavior and configuration of the radio via special
SDS messages. The messages can be sent both in TMO and DMO by any radio capable of controlling other radios.
During execution of the Remote Control messages, depending on your service provider setting, the radio can play a
tone, vibrate, or display an appropriate icon in the status icon area.

This feature needs to be enabled by your service provider.

5.6.8.1 Setting SDS Remote Control
When and where to use:
To enable/disable support of special SDS messages that allow remote control of the radio.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Security → Remote Control.

3 Select On to enable, or Off to disable remote control.

5.7 Setup
This sub-menu allows you to change your radio configuration.

5.7.1 Ring Style
This sub-menu allows you to set the incoming call ring style.
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5.7.1.1 Setting Ring Style

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Ring Style.

3 Select one of the following:
• Duplex— To set the new ring style to all duplex calls.
• Simplex— To set the new ring style to all simplex calls.

Upon entry into this sub-menu, the display shows the current ring style used.

4 Scroll to the desired style and press Select.

New ring style is played immediately for a few seconds. If necessary, adjust the volume level.

5.7.2 Set Volume
This menu item allows you to adjust Voice, Duplex, Simplex, Keypad, and Tones volume for the Speaker and
the Earpiece.

5-28 -



5.7.2.1 Setting Volume

Volume Adjustment Mode

5.7.2.1 Setting Volume

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Set Volume.

3 Select Speaker or Earpiece.

4 Select one of the following:
• Voice — sets the volume level for voice.
• Duplex— sets the volume level for duplex ringtones.
• Simplex— sets the volume level for simplex ringtones.
• Keypad— sets the volume level for keypad tones.
• Tones— sets the volume level for alert tones.

If the display shows only one option Volume, you can adjust all of the above settings at once. You have the
option to change the settings individually when the Volume Adj. Mode is set to Individual.

5 Press right or left NAVIGATION key to change the value.

Setting Volume Adjustment Mode

5.7.3 Language
This sub-menu allows you to change the language of the radio.
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5.7.3.1 Setting Language

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Language.

3 Select desired language.

5.7.4 Data Setup
This menu item allows you to set up your radio to transmit and receive data from the external device.

To connect your radio accessory connector to the external device, use the PMKN4104 cable. The external device
must run an application complying with the TETRA standards.

• Data services are available only in TMO Mode.

• Data services are blocked in TXI Mode.

5.7.4.1 Setting Data Function

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Data Setup.

3 Select one of the following:
• Voice Only— Your radio receives and transmits voice calls only.
• Data Only— Your radio acts as a modem. It rejects incoming and outgoing voice calls (except for

Emergency Calls), status and text messages.
• Voice & Data— Your radio acts as a modem but voice calls have priority over data calls and can

interrupt them.

5.7.5 Audio
This menu item allows you to adjust your radio audio settings.
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5.7.5.1 Volume Adjustment Mode

5.7.5.1 Volume Adjustment Mode
You can set the volume to Individual or Common. When it is set to Individual, the volume level for Voice,
Duplex, Simplex, Earpiece, Speaker and Keypad can be set per user preferences. When set to Common, the audio
have one setting for all items.

Set Volume

5.7.5.2 Setting Volume Adjustment Mode

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Audio → Volume Adj. Mode.

3 Select one of the following:
• Individual— You can set Duplex, Simplex, Earpiece, Speaker and Keypad per your preferences

in MENU → Setup → Set Volume.
• Common—You can set one value for all the items inMENU→ Setup → Set Volume.

Setting Volume

5.7.6 Tones
This field sets the volume level for the tones set.

5.7.6.1 Keypad Tone
You can activate/deactivate keypad tone at every key press.
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5.7.6.2 Setting Keypad Tone

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → Keypad Tone.

3 Select one of the following:
• On — Activates keypad tone.
• Off — Deactivate keypad tone.

5.7.6.3 All Tones
You can activate/deactivate all tones.

5.7.6.4 Setting All Tones

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → All Tones.

3 Select one of the following:
a. On — Activates all the tones.
b. Off — Deactivates all the tones.

5.7.6.5 Talk Permit
You can set a different tone upon pressing the PTT button.
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5.7.6.6 Setting Talk Permit

5.7.6.6 Setting Talk Permit

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → Talk Permit.

3 Select one of the following:
• No Tone— No tone heard upon pressing the PTT button.
• Short Tone— Short tone heard upon pressing the PTT button.
• Normal Tone— Factory-default tone heard upon pressing the PTT button.

5.7.6.7 Clear to Send
You can activate/deactivate tone for the transmitting radio that the receiving radio is ready to accept the transmission.

5.7.6.8 Setting Clear to Send

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → Clear to send.

3 Select one of the following:
• Tone On — Activate clear to send tone.
• Tone Off— Deactivates clear to send tone.

5.7.6.9 Periodic Alert
You can activate/deactivate periodic tone indication for the missed calls and the unread messages. For each
notification, your radio generates an unread message tone with the amber LED color indication.
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5.7.6.10 Setting Periodic Alert
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → Periodic Alert.

3 Select one of the following:
• Alert— Activates/deactivates periodic tone.
• Period— Indicates the time between each periodic tone.

5.7.6.11 D-PTT Tones
This menu item contains the settings for the Double PTT feature.

The Double PTT feature allows you to send a tone pattern (single, double, or triple) when the radio is in idle or the
Group Call mode by pressing the PTT button twice.

After the D-PTT tone is played, the user can press and hold the PTT button once again to get the permission to talk.
Otherwise, if the user presses the PTT button while the D-PTT tone is played, it is ignored.

After the D-PTT tone is sent keeping the PTT button pressed, it results in permission to talk. The D-PTT tone is
not audible on a sending radio.

This feature needs to be enabled by your service provider.

5.7.6.12 Setting D-PTT Tones
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Tones → D-PTT Tones.

3 Select one of the following:
• D-PTT Mode— Activates/deactivates D-PTT tone.
• Tone Style— Indicates how many times the D-PTT tone is played.

5.7.7 Display
This menu item allows you to adjust your radio display settings.
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5.7.7.1 Setting Font Level

Display

Setting Time and Date on the Display

5.7.7.1 Setting Font Level
When and where to use:
To increase/decrease text size so you can adjust the interface readability to existing conditions.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Display → Font Level.

3 Select one of the following:
• 1 – default size of the text.
• 2 – large size of the text. Keep in mind that less text can be displayed.

In some languages number of available font levels can be decreased.

5.7.7.2 Setting Large Idle Font
When and where to use:
To enable/disable large font on the home screen.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Display → Large Idle Font.

3 Select On to enable, or Off to disable displaying large font on the idle screen.

Large Idle Font is not available in some languages.

5.7.7.3 Setting Extended Status Icons
Procedure Steps

1 From the home screen, press the MENU key.
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2 Select Setup → Display → Extended Status Icons.

3 Select one of the following:
• Disabled – the radio always displays icons in normal size.
• Idle Only – the radio displays enlarged icons only on the home screen.
• Always – the radio displays enlarged icons both on the home screen and when browsing though the

radio menu.

5.7.7.4 Setting Screen Saver

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Display → Screen Saver.

3 Select one of the following:
• Activate— To activate/deactivate this feature.
• Text— To set the text on the screen saver when this feature is activated.

5.7.7.5 Setting Backlight

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Display → Backlight.

3 Select one of the following:
• Auto – backlight is triggered by turning on the radio, by pressing any key on the device or on the

accessory that is connected to it. Also getting signal from the services like: Call-Out message, DGNA
and TX timeout during priority call are going to turn on the backlight.

• Semi Auto – backlight is turning on when you are switching on the radio or pressing a button assigned
to the backlight feature.

• Manual – backlight is toggled by pressing the BACKLIGHT key.
• On – backlight is always on.

Setting the backlight intensity level by pressing the BACKLIGHT key changes the LED, keypad
backlight, and EMERGENCY button backlight intensity.
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5.7.7.6 Setting Wallpaper

5.7.7.6 Setting Wallpaper
When and where to use:
To change the look of the idle screen.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Display → Wallpaper.

3 Select one of the following:
• On — To activate this feature.
• Off — To deactivate this feature.

5.7.8 Time and Date
This sub-menu controls the displayed time and date on the home screen.

If the Home Display Text Message feature is enabled, the time and date cannot be displayed.

Infrastructure synchronizes the time and date. When not within the infrastructure signal range you can
set the values manually.
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5.7.8.1 Setting Time and Date on the Display

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Display.

3 Select one of the following:
• Time & Date— Your radio displays time and date.
• Time Only— Your radio displays time only. Format Date sub-menu is disabled.
• Date Only— Your radio displays date only. Format Time sub-menu is disabled.
• Off— Your radio does not display time nor date. Format menu is disabled.

Display

Display

5.7.8.2 Setting Time Format
Prerequisites:
IfMENU → Setup → Time & Date → Display is set to Time & Date or Time Only.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Format → Format Time.

3 Select one of the following:
• 12-Hour— Displays the time with am (before noon) or pm (after noon) indication.
• 24-Hour.

5.7.8.3 Setting Time Manually
When and where to use:
If the time cannot update automatically through the infrastructure.
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5.7.8.4 Setting Date Format

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Set → Set Time.

3 Enter current time using NAVIGATION keys or keypad.

4 Press Done.

5.7.8.4 Setting Date Format
Prerequisites:
IfMENU → Setup → Time & Date → Display is set to Time & Date or Date Only.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Format → Format Date.

3 Select (D — day, M — month, Y — year):
• DD/MM/YY

• MM/DD/YY

• DD-MON-YY

• YY/MM/DD

5.7.8.5 Setting Date Manually
When and where to use:
If the time cannot update automatically through the infrastructure.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Set → Set Date.

3 Enter current time using NAVIGATION keys or keypad.

4 Press Done.
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5.7.8.6 Setting Time Offset

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → Set → Time Offset.

3 Enter time offset using NAVIGATION keys.

You can adjust the offset value, with 15 minute steps, up to 14 hours ahead or behind.

4 Press Done.

5.7.8.7 Setting Automatic Update for the Time and Date

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Time & Date → System Update.

3 Select one of the following:
• Off—All the infrastructure informations are ignored. The radio uses internal time and offset.
• Time Only— Time displayed is calculated from the offset programmed by your service provider

added or subtracted from the infrastructure time.
• Time & Offset— Time and offset are updated after receiving from the infrastructure.

5.7.9 Active Accry (Accessory) Type
This menu item allows you to choose which of the accessory selection mode is active.

5.7.9.1 Selecting Active Accessory (Accry) Type
When and where to use:
Use this menu item to determine which microphone has priority during Alternating Hot Microphone or Ambience
Listening.
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5.7.10 Volume Cntrl (Control)

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Active Accessory Type.

3 Select one of the following:
• Control Head Accry—Higher priority is given to the microphone connected to the control head.
• Transceiver Accry—Higher priority is given to the microphone connected to the transceiver.
• Control Head Accry— Higher priority is given to the microphone connected to the control head.

Applicable to RECH.
• Transceiver Accry — Higher priority is given to the microphone connected to the transceiver.

Applicable to RECH.
• Front Accry—Higher priority is given to the microphone connected to the front accessory connector.

Applicable to TSCH.
• Rear Accry— Higher priority is given to the microphone connected to the rear accessory connector.

Applicable to TSCH.

In case the PTT on any connected accessory is pressed, the highest priority is assigned to that accessory.

5.7.10 Volume Cntrl (Control)
This menu item allows you to determine which audio output device, speaker or earpiece, is being adjusted when
you turn the ROTARY KNOB.
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5.7.10.1 Setting Volume Cntrl (Control)

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Volume Cntrl.

3 Select one of the following:
• Earpiece— By turning the ROTARY KNOB you control earpiece volume.
• Speaker— By turning the ROTARY KNOB you control speaker volume.

5.7.11 Accry (Accessory) Setup
This menu item allows you to manually configure audio accessories that do not install automatically after plugging
them in. Accessories intended for the control head and the transceiver differ and are configured separately.

One control head can support only one external speaker at the same time, either a speaker connected to the
control head, or to the transceiver. When you select one external speaker, the other becomes unselectable
from the menu.

5.7.11.1 Configuring Control Head Accessories
When and where to use:
Use this menu item to configure audio accessories for the control head.
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5.7.11.2 Configuring Transceiver Accessories

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Accry Setup → CH Accry.

3 Select one of the following:
• GCAI Fronthead— Contains a list of preconfigured accessories that can be connected to the front

connector on the RECH.
• Secondary Accry— Contains a list of preconfigured accessories that can be connected to Hearer

Speaker Microphone (HSM).
• GCAI Backhead— Contains a list of preconfigured accessories that can be connected to the back

connector on the RECH.
• Visor Mic Backhead— Contains a list of preconfigured visor microphones that can be connected

to the back connector on the RECH.
• Ext Speaker Backhead— Contains a list of preconfigured external speakers that can be connected

to the back connector on the RECH.
• Second Mic Cradle— Contains a list of preconfigured microphones that can be connected to the

TSCH cradle.
• Ext Speaker Cradle— Contains a list of preconfigured speakers that can be connected to the TSCH

cradle.

Lists of accessories are configured by your service provider.

5.7.11.2 Configuring Transceiver Accessories
When and where to use:
Use this menu item to configure audio accessories for the transceiver.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Accry Setup → Transceiver Accry.

3 Select one of the following:
• Visor Mic Rear Accry— Contains a list of preconfigured visor microphones.
• Handset Rear Accry— Contains a list of preconfigured handsets.
• Fist Mic Rear Accry— Contains a list of preconfigured fist microphones.
• Ext Spkr Rear Accry— Contains a list of preconfigured external speakers.

All accessories from the above lists must be connected to the connector at the rear of the transceiver

Lists of accessories are configured by your service provider. Lists that do not contain any accessory
do not appear in the menu structure.

5.7.12 Book On
This menu item allows you to edit RUA/RUI feature settings to automatically accept or reject book on requests.
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5.7.12.1 Editing Book On Settings

RUA/RUI

RUI

5.7.12.1 Editing Book On Settings

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Book on Setup.

3 Select one of the following:
• Book on Accept— Radio accepts all the book on requests.
• Book on Reject— Radio rejects all the book on requests without any notification.

5.7.13 Rotary Knob
This menu item allows you to set all the related functionality of the ROTARY KNOB.
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5.7.13.1 Setting Rotary Knob Mode

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → Rotary Mode.

3 Select one of the following:
• Dual— Both modes are available. Turn the ROTARY KNOB to adjust the volume or press and then

turn to switch to different talkgroup.
• Volume— The knob is used only as a volume control. Turn it clockwise to increase the audio volume

level.
• Scroll— The knob is used only to change the talkgroup, or in the menu to scroll menu items.

If you choose Scroll and the display shows:

• Scroll Selected— To adjust volume level go to the main menu, select Setup → Set Volume.
• Function Keys are set to Adjust Volume—You can use your programmable SIDE buttons
to adjust volume.

5.7.13.2 Setting Rotary Lock

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → Rotary Lock.

3 Select one of the following:
• Locked— Locks ROTARY KNOB, you can unlock it by selecting Unlocked or by pressing and

holding ROTARY KNOB.
• Unlocked— Unlocks the ROTARY KNOB.
• Disabled— Locking function is unavailable. Your ROTARY KNOB is unlocked all the time.

5.7.13.3 Setting In Keypad Lock
When and where to use:
To set behavior of the rotary knob when the keypad is locked.

Procedure Steps
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5.7.13.4 Setting Rotary Knob Wrap Around

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → In Keypad Lock.

3 Select one of the following:
• Lock None— Scrolling and volume setting functionality is available.
• Lock Volume— ROTARY KNOB can be only used for scrolling.
• Lock Scroll— ROTARY KNOB can be only used for setting the volume.
• Lock Both— Scrolling and volume setting functionality is unavailable.

5.7.13.4 Setting Rotary Knob Wrap Around
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → Wrap Around.

3 Select one of the following:
• On— Scrolling through the talkgroup list is looped or is moved to the next folder.
• Off— Scrolling through the talkgroup list stops after reaching first or last talkgroup in the current

selected folder.

Only whenWrap Around is set to On and the Scroll Range is set to Scroll To Next, you are able to scroll
through all the talkgroups and folders.

5.7.13.5 Setting Rotary Knob Scroll Range
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → Scroll Range.

3 Select one of the following:
• Stay In Range— Scrolling through the talkgroups in the current folder only.
• Scroll To Next— Scrolling through all the talkgroups and folders.
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Only whenWrap Around is set to On and the Scroll Range is set to Scroll To Next, you are able to scroll
through all the talkgroups and folders.

5.7.13.6 Setting Rotary Knob Talkgroup Selection

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Setup → Rotary Knob → Confirm TG Sel..

3 Select one of the following:
• On— You need to confirm the talkgroup selection by pressing Select or pressing the PTT button

to immediately start a call on a new talkgroup.
• Off— Attaches to the selected talkgroup without any additional prompt

5.8 Group Setup
This sub-menu allows you to set the scanning and my groups folder.

5.8.1 Scan
This menu item allows you to activate/deactivate scanning, view the active scan list, and edit the scan lists. This
feature is available only for the TMO Mode. Your radio joins any group call as long as this group is defined in the
scan list and scan is turned on.

Activating Talkgroup Scanning

5.8.1.1 Activating Talkgroup Scanning
When and where to use:
If you want to monitor any TMO Group Call in the defined talkgroup list.
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5.8.1.2 Setting Talkgroups in the Active Scan List

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Group Setup → Scan → Scanning.

3 Select Select List and then a list name.
Step result: Your radio displays list name Selected.

4 Select Scanning → On.

Result:
Your radio is scanning on the predefined scan list.

Scan

5.8.1.2 Setting Talkgroups in the Active Scan List
When and where to use:
If you want to edit talkgroups in the active scan list.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Group Setup → Scan → Active List.

If Scanning is Off is displayed, go to Group Setup → Scan → Scanning → On to enable scanning.

3 Select View and highlight the required talkgroup.

4 Press MENU.

5 Select one of the following:
• Delete— Erases this group from the active scan list.
• Priority and select new priority to Low,Medium or High.

5.8.1.3 Setting Scan Lists
When and where to use:
If you want to set up any scan list.
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5.8.2 My Groups

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Group Setup → Scan → Scan Lists.

3 Highlight required scan list and press MENU to see additional settings:
• Rename— Enters new name for that scan list.
• Capacity—Displays the number of assigned and unassigned talkgroups for the scan list.
• Clear— Deletes all the talkgroup assigned to that scan list.
• Add Group—Adds a talkgroup to the scan list. Select one talkgroup from your talkgroup folders and

assign appropriate priority.
• Edit— Changes the priority of the required talkgroup or deletes it.

SUGGESTION

To delete a talkgroup from the scan list, select Edit and press MENU.

5.8.2 My Groups
In MR10.6.9 releaseMy Groups is equivalent to Favorites (next section). Both menu items contain shortcuts to
favorite talkgroups and contact numbers, as well as allow to perform the same operations. Thus, for a detailed
description of the feature, please refer to Favorites.

5.9 Favorites
Favorites contains shortcuts to frequently used talkgroups and contact numbers that are organized in favorite folders.

To quickly access favorite folders, from the home screen press the up NAVIGATION key. To scroll through items
inside favorite folders, you can either use the NAVIGATION keys or the ROTARY KNOB.

5.9.1 Favorite Folders
Favorite talkgroups and contact numbers are stored in favorite folders. The folders are common for all types of
talkgroups and contact numbers, which means that in one folder you can have items available in different modes.
Additionally, to indicate the type of each item, the radio displays a small icon next to it.

By default the radio has one favorite folder that can store up to 128 favorite items. However, you can create two
additional folders inside Favorites and give them meaningful names reflecting their content.

If Favorites contains only one favorite folder and it is empty, the only operations you can perform are adding an
item to the folder, renaming the folder, and creating a new folder.
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5.9.2 Favorite Talkgroups
You can add any talkgroup programmed in the radio to Favorites. The radio adjusts the mode it is in according to
the currently selected favorite talkgroup. For example, if the radio is in DMO and you select a TMO talkgroup, the
radio switches to TMO, and vice versa.

Scrolling through favorite talkgroups during an ongoing group call does not terminate the call. Also deleting a
currently selected talkgroup from Favorites during an ongoing call does not lead to the call termination.

If before powering off the last selected talkgroup was a talkgroup from Favorites, the radio:

• On powering up in DMO attaches to the last selected favorite DMO talkgroup.

• On powering up in TMO attaches to the last selected favorite TMO talkgroup.

To make a call on a favorite talkgroup, use the standard procedures for group calls described in this document.

5.9.3 Favorite Contact Numbers
You can add any contact number from Contacts to Favorites. In case of contacts containing more than one contact
number, you need to use the right or left NAVIGATION key to specify which particular contact number to add. There
are no limitations regarding adding single contact numbers assigned to one contact – you can add all contact numbers
as separate entries. Removing a single contact number from Contacts automatically removes it from Favorites.
Similarly, removing a contact from Contacts automatically removes all the related contact numbers from Favorites.

It is impossible to make a call to a favorite contact number during emergency operations.
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5.9.4 Making a Private Call to a Favorite Contact Number

5.9.4 Making a Private Call to a Favorite Contact Number

Procedure Steps

1 To select a contact number you want to call, from the home screen do one of the following:
• Press the right or left NAVIGATION key.
• Go to Optns → TG by Folder, select the required favorite folder, and highlight the contact number.

2 When you are in the following mode:
a. TMO — For a simplex call, press and release the PTT button. You hear a ringing tone. Otherwise, press

and hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen.
For a duplex call, press and release SEND key. You hear a ringing tone.

b. DMO — Only simplex call is available. Press and hold the PTT button. Wait for the talk permit tone
before talking, and release the PTT button to listen.

3 To end the call, press the END key.

If you are using the fist microphone or the telephone style handset, replace it firmly on it's clip or holder
when done.

5.9.5 Adding a Folder to Favorites
Prerequisites:
Favorites contains less than three favorite folders.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Favorites → [New Folder]

3 Enter a name and select Ok.

5.9.6 Adding a Contact Number to Favorites

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Contacts

3 Highlight a contact that you want to add to Favorites and using the left or right NAVIGATION key select the
required number.

4 Press the MENU key and select Add to Favorites.

5 Select a folder you want to add the contact number to and press Select.

5.9.7 Adding a Talkgroup to Favorites
Prerequisites:
To add a DMO talkgroup, ensure that the radio is in DMO.
To add a TMO talkgroup, ensure that the radio is in TMO.
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5.9.8 Managing a Folder in Favorites

Procedure Steps

1 From the home screen, press the Optns key.

2 Select one of the following:
• TG by Folder – contains talkgroups arranged by folders.
• TG by abc – contains talkgroups arranged alphabetically.

3 Find and highlight a talkgroup that you want to add to Favorites.

4 Press the MENU key and select Add to Favorites.

5 Select a folder you want to add the talkgroup to and press Select.

Entering DMO Mode

5.9.8 Managing a Folder in Favorites
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Favorites.

3 Highlight a required folder.

4 Press the MENU key.

5 Select one of the following:
• Rename Folder – changes the name of the folder. Enter a new folder name and press Ok.
• Delete Folder – removes the selected folder from Favorites. Press Yes to confirm deletion.

You cannot delete the last favorite folder or a folder that contains at least one non-erasable item.

5.9.9 Deleting an Item from a Favorite Folder
When and where to use:
To delete a single contact number or a talkgroup from a favorite folder.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Favorites.

3 Select a folder containing the item you want to remove.

4 Highlight the item and select Delete. Press Yes to confirm deletion.

5.9.10 Deleting All Items from a Favorite Folder
When and where to use:
To delete all contact numbers and talkgroups stored in a favorite folder.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Favorites.

3 Select a required folder.

4 Press the MENU key and select Delete All. Press Yes to confirm deletion.

5.10 My Info
This sub-menu allows you to view your own private, phone, and radio info.
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5.10.1 Viewing/Modifying Personal Information

5.10.1 Viewing/Modifying Personal Information

Procedure Steps

1 From the home screen, press the MENU key.

2 Select My Info.

3 Select one of the following:
• My Private Num— displays your radio private number.
• My Phone Num— displays your radio phone number.

To modify the displayed phone number, select Edit. Type the number and press Ok.
• Radio Info— displays radio information: manufacturer, product type, ISSI, TEI, Serial Number,

and OPTA.

OPTA information is optional.

5.11 Recent Calls
You can view the history of all calls:

• Dialed — calls you initiated.

• Received — calls you answered.

• Missed— calls you received but not answered or rejected.

Each list of calls may contain up to 50 numbers, the most recent call being at the top of the list. If the number of a
recent call is stored in the contact list, the name associated with the number appears in the recent calls list. A number
dialed more than once, appears only once in the list.

5.11.1 Viewing Recent Calls

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Recent Calls.
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3 Select one of the following:
• Dialed

• Received

• Missed

4 Select a required call from the list.

5 Press the MENU key.

6 Select View.

SUGGESTION

Press down NAVIGATION key to bypass first two steps.

Call time information is only available if the time and date are set in the radio. Call duration is not
available in the missed calls list.

5.11.2 Calling from Recent Calls

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Recent Calls.

3 Select one of the following:
• Dialed (from the home screen press SEND key to access Dialed Calls list)
• Received

• Missed

From the home screen press down NAVIGATION key, to access Recent Calls menu item.

4 Highlight the required call and press the PTT button for private calls or press theSEND key to make a phone call.

Phone calls are only available in TMO Mode.
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5.11.3 Storing Recent Calls to Contacts

5.11.3 Storing Recent Calls to Contacts

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Recent Calls.

3 Select Dialed, Received or Missed.

4 Press Store.

If Store is not assigned to the left SOFT key, the number is already stored in your contact list.

5 To store the number as a new entry, select [New Contact]. Or, to store the number to an existing entry, select
the entry, and press View then select Edit.

6 With the contact type field highlighted, scroll left or right to display the contact type you want to assign the
number.

7 Select Done.

5.11.4 Deleting Recent Calls

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Recent Calls.

3 Select Dialed, Received or Missed.

4 Press MENU on the required call.

5 Select Delete.

To erase all the calls, select Delete All.
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5.12 Shortcuts
This sub-menu allows you to set up shortcuts to access frequently used menu items.

Scrolling through the Menu

5.12.1 Creating a Menu Shortcut
When and where to use:
To assign a shortcut for the menu item.

Procedure Steps

1 From the home screen, press the MENU key.

2 Scroll to the item you want as a shortcut.

3 Press and hold MENU when the item is highlighted.

Example:
Creating a shortcut to the All Tones options.

1. From the home screen, press the MENU key.

2. Select Setup → Tones.

3. Highlight All Tones and press and hold MENU until Assign Shortcut for:All Tones is displayed.

4. Select Yes and ShortcutsKey:1 is displayed.

5. Press Done.

To use this shortcut, from the home screen, press MENU and the key 1.
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5.12.2 Editing a Menu Shortcut List

5.12.2 Editing a Menu Shortcut List

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Shortcuts.

3 Highlight a required shortcut and press MENU.

4 Select one of the following:
• Edit— Changes the assigned key. Type required number and press Ok.

Type a number between 1–20.
• Delete— Erases highlighted shortcut. Select Yes to confirm.
• Delete All— Erases all the shortcuts. Select Yes to confirm.

5.13 RUI
This menu item allows you to log in/out to the radio.
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RUA/RUI

Book On

5.13.1 Logging On

Procedure Steps

1 From the home screen, press the MENU key.

2 Select RUI → Log on.

3 Highlight:
• User ID and press Select to enter User ID List. If you are a new user on this radio, select [New User

ID] and enter your user ID. Otherwise select your user ID from the list.
• Second line and press Edit, to enter user ID and press Ok.

4 Select User PIN, enter your credentials, and press Ok.

5 Logging screen is displayed.

5.13.2 Logging Off

Procedure Steps

1 From the home screen, press the MENU key.

2 Select RUI → Log off.

3 Press Accept.

5.14 Networks
This menu item allows you to switch between the radio operation modes.
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5.14.1 Selecting Your Network

Entering TMO / DMO Mode

Selecting Network Operation Mode

5.14.1 Selecting Your Network

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks → Networks Sel → Home Only.

3 Your radio registers to the first network on the allowed network list.

5.14.2 Using the Select Net Registration

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks → Networks Sel → Select Net.

3 Select the required network from the list.

Result:
Your radio registers to the selected network.

5.14.3 Using the Foreign Network Registration
When and where to use:
Use this feature to migrate to another predefined network, when you are out of the range of your network and your
radio displays the No Service message.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks → Networks Sel → Foreign Nets.

5.14.4 Using Any Network
When and where to use:
Your radio has lost its home network coverage and can register to any network. Only clear authentication is
supported on any network.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks → Networks Sel → Any Network.

3 Your radio selects and registers to the network automatically from the predefined list.

5.14.5 Using the Migrate To Registration
When and where to use:
Use this feature to migrate to another predefined network, when you are out of the range of your network and your
radio displays the No Service message.
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5.14.6 Selecting Network Operation Mode

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks → Networks Sel and choose one of the following option:
• Migrate to... — Selects the required network form the list. To view the network ID press MENU

key then press Select.
• Auto— Your radio automatically attaches to the predefined network.

5.14.6 Selecting Network Operation Mode

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Networks.

3 Select one of the following:
• Trunked Mode— Switches to the mode using infrastructure.
• Direct Mode— Switches to the mode without using infrastructure.
• Repeater Mode— Switches to the Repeater Mode.
• Gateway Mode— Switches to Gateway Mode.
• TXI Mode— Select Activate to stop sending any radio transmission.

If the radio is in TXI Mode, it is not possible to switch from Direct Mode to Trunked Mode or
Repeater Mode, or Gateway Mode.

Networks

Entering TMO / DMO Mode

5.15 Location
See the GPS Location Service for more information.
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GPS Location Service

5.15.1 Viewing Your Position
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Location → Position.

3 Scroll to view the results about the last time your location was calculated.

To refresh your position:

• Select Position— the radio refreshes its position automatically
• Press Refresh

5.15.2 Viewing Testpage
Procedure Steps

1 From the home screen, press the MENU key.

2 Select Location → Testpage.

3 Select one of the following:
• Position – displays detailed information on radio’s current position: time, N (latitude), E (longitude),

H (height), Sats Used (a number of tracked satellites), B (bearing), HS (horizontal speed), LC (level
of confidence).

• Power – displays detailed information on a particular satellite: PRN code, Status, Mode, C/N
(carrier-to-noise ratio).

• Version – displays detailed information on GPS version: SW (software version), HW (hardware
version), ASIC (application-specific integrated circuit), RC (release code).

5.16 Packet Data
The Packet Data (PD) Service allows you to transfer data in a TETRA system using the Internet Protocol (IP).
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5.16 Packet Data

To transfer data from a standard computer over the air, connect the computer via the data cable PMKN4104
with your radio. Your service provider has to setup additional applications on your computer.

If set up by your service provider it is possible to accelerate the transmission by using the Multi-Slot Packet Data
(MSPD) Service.
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5.16.1 Viewing Data Statistics

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Packet Data.

Data services are only available in TMOMode. The data option must be set to Voice & Data or Data Only.

3 Select one of the following:
• Sent Data— the number of KBs sent and throughput since current Packet Data activation is displayed.
• Received Data— the number of KBs received and throughput since current Packet Data activation is

displayed.
• Bandwidth— active data session percentage is shown.
• Failed Transfer— the percentage of failed sent/received packets.

N.A. — standby packet data session.

5.16.2 Viewing Encryption Status

Procedure Steps

1 From the home screen, press the MENU key.

2 SelectMore . . . → Packet Data → Encryption.

3 The encryption state of the ongoing packet data session is displayed:
• Packet Data Channel Clear

• Packet Data Channel Encrypted

• EncryptionN/A (clear)

5.17 Crypto Menu
This sub-menu allows you to manage SIM card based End-to-End Encryption.
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5.17.1 Enabling/Disabling SIM Card End-to-End Encryption

The End-to-End Encryption is used for:

• Encryption of voice transmission in the DMO and TMO Modes.

• Encryption of messages transmission in the TMO Mode.

• Encryption of messages transmission in the DMO Mode (the radio cannot be in call).

• Encryption of position data (GPS) transmission in the TMO and DMO Modes.

• Transfer of Operational Tactical Address (OPTA) in the TMO and DMO Modes.

• Management of encryption keys in the TMO Mode.

SIM Card End-to-End Encryption

5.17.1 Enabling/Disabling SIM Card End-to-End Encryption
Prerequisites:

• The radio is not in an active call.

• You cannot press the PTT button.

To enable/disable SIM Card End-to-End Encryption, use one of the following ways:

• Press a One-Touch Button assigned to enabling/disabling SIM Card End-to-End Encryption.

• From the home screen, pressMENU → Crypto Menu → Crypto Function. Select Encryption On to
enable or Encryption Off to disable encryption.

Result: Your radio displays prompts indicating your current encryption state: an appropriate status icon and
Encryption On or Encryption Off message.

5.17.2 Setting Clear Call Alarm
When and where to use:
Use this menu item to configure an alarm tone notifying about any clear transmission.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → Clear Call Alarm.

3 Select Simplex Calls or Duplex Calls.

4 Select one of the following:
• Off – the alarm is disabled.
• Single – the alarm sounds once at the beginning of a clear call.
• Continuous – the alarm sounds periodically throughout a clear call.

5.17.3 Updating Encryption Keys
When and where to use:
Use this menu item to update old or incorrect encryption keys.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → Upd Encr Keys.

3 Select Upd Group Key to start the update.

You can update the encryption keys if the End-to-End Encryption is enabled. The keys cannot be updated
when the radio is in a call or in DMO.

5.17.4 Viewing OPTA
When and where to use:
Use this menu item to view Operational Tactical Address (OPTA) providing supplementary information about a
subscriber's organization and operational role.
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5.17.5 Setting OPTA Filter

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → Show OPTA.

5.17.5 Setting OPTA Filter
When and where to use:
Use this menu item to define which characters are masked when the OPTA name is displayed.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → OPTA Filter.

3 Highlight check boxes using the NAVIGATION keys and press Select to set which characters are masked when
the OPTA name is displayed.

4 Press Done to confirm the changes.

5.17.6 Starting Crypto Registration
Prerequisites:
Your radio cannot be in an active call nor in DMO.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → Crypto Registr.

3 Select Start Registr to start the registration.

5.17.7 Configuring Audio Settings
When and where to use:
Use this menu item to change the audio output for a group call when the call is encrypted but the End-to-End
Encryption is disabled.
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Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → Audio Settings.

3 Select Encr Audio On to enable or Encr Audio Off to mute the encrypted audio for clear mode.

5.17.8 Setting DMO Encryption Mode

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → DMO Encr Mode.

3 Select DMO 1 or DMO 2 to enable the required mode.

5.17.9 Setting Encryption Keys for SDS Messages
When and where to use:
Use this menu item to set the encryption keys for group and individual SDS messages.

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Crypto Menu → SDS Encr Mode.

3 Select Individual SDS or Group SDS.

4 Select Global Key or Group Key.
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6 Features

6.1 Private Call
The Private Call, also called point-to-point, or individual call, enables calling between two individuals. No other
radio can hear the conversation. This call type can be carried out in two ways:

• Duplex call (if the system allows), in TMO Mode. Both parties can speak at the same time.

• Simplex call, in TMO or DMO Mode. Only one party can speak at a time.

When a DMO Private Call takes place, radios not involved in this call receive the channel busy indication. The
radios are identified using its radio numbers.

Interaction with the accessories:

• Fist Microphone — during the Private Call, if you hang the microphone into the clip the call ends or the
audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

• Telephone Style Handset — during the Private Call, if you hand the handset into the holder, the call ends or
the audio switches to the speakers (if connected). Exact behavior depends on your service provider settings.

To end the Private Call if audio was switched to the speaker, press ON/OFF/END/HOME key.

To answer a Private Call, use one of the following methods:

• Press the PTT button.

• Take the Fist Microphone or Telephone Style Handset off hook. If the Handset is off hook, the radio’s
external speaker mutes and the Handset’s internal speaker activates.

• Press the SEND key on the control head. Audio is routed to audio input devices in the following order,
depending on their availability:

1. A visor microphone.

2. A microphone of the device that is off hook.

3. A microphone that was last in use (if two devices are off hook).

- 6-1



Feature User Guide

MS-ISDN

Emergency Individual Calls (Private or MS-ISDN)

6.1.1 Making a Private Call
Procedure Steps

1 From the home screen, enter the number.

2 If Private is not the first type of call presented, press Ctype repeatedly to select it.

3 When you are in the following mode:
a. TMO — For a simplex call, press and release the PTT button. You hear a ringing tone. Otherwise, press

and hold the PTT button. Wait for the talk permit tone before talking, and release the PTT button to listen.
For a duplex call, press and release SEND key. You hear a ringing tone.

b. DMO — Only simplex call is available. Press and hold the PTT button. Wait for the talk permit tone
before talking, and release the PTT button to listen.

4 To end the call, press the END key.

If you are using the fist microphone or the telephone style handset, replace it firmly on it's clip or holder
when done.

6.2 Radio Messaging System (RMS)
The Radio Messaging System (RMS) feature enables radio to receive and send RMS messages through the TETRA
network using the Short Data Service.

There are two types of RMS messages:

• RMS Status – a predefined code that is sent bidirectionally between the radio and the service provider. The
radio can have up to ten statuses that are assigned to numeric keys from 0 to 9. The latest received or sent
RMS status is kept on the home screen until the next power cycle. A received RMS status is displayed
in blue color font on the home screen.
RMS Free Text – a unidirectional message containing free text that is sent to the radio by the service
provider. Since this type of message is longer, the radio displays only its beginning on the home screen and
to read its remaining part, you need to go toMenu →Messages → RMS Box. The latest RMS free text is
kept on the home screen until the next power cycle.

RMS free text messages and incoming and outgoing RMS statuses (with the exception of RMS statuses sent) are
stored in the RMS Box. Its capacity is maximum ten entries for incoming and outgoing RMS messages. If the RMS
Box is full, any new incoming or outgoing RMS message overwrites the oldest message (received or sent).

The radio receives and sends RMS messages only from and to the numbers predefined by your service provider.
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6.2.1 RMS Icons

6.2.1 RMS Icons
Table 6-1 RMS Icons

Icon Description
RMS Status Received
Indicates a new RMS status message just arrived.

RMS Status Sent

RMS Box Read Message

RMS Box Unread Message

6.2.2 Sending an RMS Status
Prerequisites:
Your service provider enabled this feature and the radio is in the RMS mode.

When and where to use:
To send a predefined RMS status using numeric keys.

Procedure Steps

Press and hold a required key. If you press the key for too short, the radio initiates a Private/Phone/PABX call.

6.3 One-Touch Dial
This feature allows you to call by pressing and holding one of the keys (1-9).

If the One-Touch Button feature is enabled, One-Touch Dial is disabled. If no feature is assigned to a
button, your radio displays an Unassigned Button message.

6.4 Talkgroup Dialing by Index
This feature allows you to attach to any talkgroup by dialing its index, instead of choosing it from the talkgroup
folders and lists.

It is also known as Talkgroup Speed Dial.
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6.4.1 Viewing Talkgroup Speed Number

Procedure Steps

1 From the home screen, press Optns.

2 Select one of the following:
• TG by Folder then select the folder and highlight the required talkgroup.
• TG by abc enter up to 15 characters to narrow the talkgroup names and highlight the required talkgroup.

3 Press MENU → View.

Example:
Radio displays SpeedNum1*, which means that this talkgroup speed number is 1.

6.4.2 Selecting Talkgroup by Index

Procedure Steps

1 From the home screen, enter talkgroup speed number and *.

2 Press Attach.

SUGGESTION

To start a group call, press the PTT button.

6.5 Phone and PABX Calls
The Phone Call allows you to call a landline telephone number or a cellular mobile phone number. The Private
Automatic Branch Exchange (PABX) Call allows you to call local (office) extension numbers.
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6.5.1 Making a Phone or PABX Call

6.5.1 Making a Phone or PABX Call

Procedure Steps

1 From the home screen, enter the number.

2 If Phone or PABX are not the first type of call presented, press Ctype repeatedly to select it.

3 Press SEND key.

6.6 Phone/PABX Speed Dial
This feature allows you to dial Phone/PABX by a shortened number of up to three digits instead of the full number.
The Phone/PABX Speed # number is assigned when the dialed number is added in the contact list.

This feature is available only in TMO Mode.

6.6.1 Using Phone/PABX Speed Dial

Procedure Steps

1 From the home screen, enter the predefined Phone/PABX speed dial number and # key.

2 Press SEND key.

6.7 MS-ISDN
This feature adds to the radio ISDN number. You can choose between MS-ISDN and ISSI to address the call, send the
message or pre-defined templates. It works for both simplex and duplex calls, based on the assigned ISDN number.
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Private Call

Emergency Individual Calls (Private or MS-ISDN)

6.8 DTMF Overdial
This feature allows you to communicate with an automated answering device (for example, the voice mail or
answering machine) during an on-going private, phone or PABX call.

While in an on-going private, phone or PABX call, press the DTMF keys (0-9, *, #). When pressed, the DTMF key
sounds a tone and the entered digit is displayed on the screen.

6.9 Short Number Dial
This feature allows you to dial part of the full number of the person you wish to call. Your radio automatically
completes the number.

Example:
Your radio number is 4282564.

1. Dial 564 (instead of 4282564, the full number).

2. To place the call, press the PTT button or the SEND key.

6.10 Dual Control Head
This feature allows you to use two control heads with one transceiver. The control heads are of equal importance and
have almost identical functionality, the only difference is second PTT installed on the Telephone Style Control Head.

In Dual Control Head mode, when you pressMENU → Setup you can choose between two control heads: CH1
and CH2. Almost all menu items inside them are common for both control heads, except for: Set Volume, Accry
Setup, and Font Level (provided that control heads are different). These menu items are configured separately for
each control head.

If this feature is enabled by your service provider, appropriate icons appear on the display.

Check with your service provider default accessory selections and the radio behavior for all types of calls as
each control head can have different setup.

6-6 -



6.10.1 Interactions between Control Heads

Controls and Indicators

Menu Structure

6.10.1 Interactions between Control Heads
Your service provider can connect to one transceiver either two the same control heads (two Remote Ethernet
Control Heads, or two Telephone Style Control Heads), or two different control heads (one Remote Ethernet
Control Head and one Telephone Style Control Head).

You can use both control heads interchangeably for the same activity (for example, writing a message). If you start
an activity on one control head you can continue it on the second, provided that token is free.

Token is a right to use a key or button for a period of time. If you press a key/button on one control head, token
activates on it, and no one can press anything on the second control head until token time passes. After you release
the key/button, token becomes available again and can be taken over by the second control head. When token is
activated, Key Press Token icon is visible on the display. By default, token time is set to 3 seconds.

Token does not apply to EMERGENCY button and ON/OFF/END/HOME key. These can be pressed on
both control heads at any time.

If control heads are different, when you operate on one control head, the second one displays screen saver.

Controls and Indicators

6.10.2 Dual Control Head Link
Dual Control Head Link is a connection that occurs when both control heads are properly connected to the
transceiver and can communicate.

When the Dual Control Head Link is established, control heads play a tone and display Dual Control Head icon.
Full functionality is available on both devices.

When one control head cannot connect to the transceiver upon power up, the radio displays Single Control Head
icon and enters Single Control Head mode.

When one control head disconnects from the transceiver during operation:

• The active control head displays Link Error icon.

• The inactive control head displays Link Error and shows Link Error display (if power is available).

Turning on/off one control head results in simultaneous turning on/off the second control head.
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6.10.3 Audio Accessories
Depending on a call type, voice can be routed to control heads and audio accessories connected to them in different
ways.

During an outogoing group call, voice can be heard either on one control head or on both control heads (depending
on your service provider’s settings).

During an incoming group call, voice is always heard on both control heads. However, if two accessories are
connected to one control head (to the front and the rear connector), voice is transferred through only one of them, the
one with higher priority. Priority is following (from the highest): handset (must be off-hook), HSM, external speaker.

Private calls are always transferred to the control head that receives a call.

Only one microphone/PTT can be opened at a time. The microphone that is pressed as first is allowed to initiate
the transmission.

6.10.4 Keys Interactions
If any key except EMERGENCY button and ON/OFF/END/HOME key are pressed on any control head, Key Press
Token icon is displayed and all keys on the other control head are blocked. This behavior is called token and means
the right to use a key or button for a period of time.

Your service provider can adjust the time that the keypad is blocked on the other control head. At any time
EMERGENCY button and ON/OFF/END/HOME key can be pressed on both control heads.

6.11 SIM Card End-to-End Encryption
The table below presents interactions occurring between radios with and without SIM card. SIM card provides
End-to-End Encryption.

Table 6-2 Radios Interactions

Transmission Type Transmitting Radio Receiving Radio Result

Private Call SIM card No SIM card Call is not visible for the receiving
radio. The transmitting radio
displays Called Party Clear Only
message.

Private Call No SIM card SIM card Warning: clear call message
appears and the call is received.

Group Call SIM card No SIM card Call is not visible for the receiving
radio.

Group Call No SIM card SIM card Warning: clear call message
appears and the call is received.
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6.12 RUA/RUI

Table 6-2 Radios Interactions (cont'd.)

Message SIM card No SIM card Delivery failed notification
appears and the message is not
received.

Message No SIM card SIM card Message is received.

To send a message or call a non-SIM card radio, turn off the SIM card End-to-End Encryption.

Crypto Menu

6.12 RUA/RUI
Radio User Assignment (RUA) and Radio User Identity (RUI) enables authentication service. Only the successful
logon on any temporary radio, provides the full access and your permanent radio functionality, so you can be still
reached with your permanent number. A logon failure results in limited service.

You can differentiate the RUA/RUI state by the interface color:

• Blue — you are logged on

• Gray — you are logged off

Radio States

• Full Service — user logon was successful. Your radio has full functionality.

• Limited Service — user not logged on. Specified by the service provider.

• Pseudo Log On — occurs only in the Local Site Trunking (LST). You radio has full functionality available
(depending on the service provider settings) except some services like forwarding calls. The RUI Pseudo Log On
icon is displayed.

Book On

Your service provider assigns particular radio to one person for a predefined period of time. You are only going to
see the screen with your login and the full service is granted.

Force Off

Your service provider can log you off. Radio displays Force Off.
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Book On

RUI

6.13 WAP
Wireless Application Protocol (WAP) is a standard for application layer network communications in a wireless
communication environment such as TETRA network. The protocol is used to access the mobile web from a
radio through a WAP browser.

This is a selling feature.

WAP Push

WAP Box

6.13.1 WAP Browser
The Openwave Mobile Browser is a WAP-complaint user agent. The WAP browser provides all of the basic services
of a computer-based web browser. Whenever any preemptive display interrupts the browser session, the browser
needs manual reactivating to return. The WAP browser does not support right-to-left languages (as Arabic and
Hebrew); English is used instead. For the content in these languages, the characters are not displayed.

Depending on the radio configuration and the network conditions, the WAP browser may not display
images properly (or may display them with a delay).

6.13.2 Entering/Exiting the Browser
Prerequisites:
From the home screen, press the MENU key. Set Setup → Data Setup to Data Only or Voice & Data.
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6.13.3 Entering the Browser Menu Panes

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Browser.

6.13.3 Entering the Browser Menu Panes
Prerequisites:
You are in the browser.

Procedure Steps

1 Press Menu or MENU key.

2 Usually, it brings up the Navigate pane, or the last browser menu pane.

If the web page you navigated to has two or more soft keys/options, the Options pane pops up. From
here, you may scroll to other panes with the left or right navigation keys Or you may select Browser
Menu and then scroll to the required pane.

6.13.4 Tips for Browsing
Create and use the following for easy browsing.

6.13.4.1 Creating a Bookmark through Navigate Pane

Procedure Steps

1 Enter the browser and browse to the required page.

2 Press Menu to enter the browser menu.

3 Select Mark Page.

4 The screen displays the title and URL of the marked page.
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5 To save it:
a. Press Save (or Select) to save the page in bookmarks.
b. Select Menu and select an option:

• Save— Confirms the bookmark creation.
• Edit—Allows you to edit the title, folder, choice, and URL of the created bookmark.

6.13.4.2 Creating a Bookmark through Bookmarks Pane
Procedure Steps

1 Enter the browser.

2 Scroll to Bookmarks pane.

3 Select Organise (if there are no saved bookmarks), orMore... .

4 Select Menu.

5 Scroll to New Bookmark.

6 Enter the bookmark title and URL, and select its location.

7 Press Save.

6.13.4.3 Using a Bookmark
Procedure Steps

1 Enter the browser.

2 Scroll to Bookmarks pane.

3 Scroll to the required bookmark and select Go. The bookmark downloads the selected page from the web.

6.13.4.4 Creating a Hotkey
Procedure Steps

1 Enter the browser.
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6.13.4.5 Using a Hotkey

2 Scroll to Bookmarks pane.

3 Scroll to the required bookmark.

4 Press MENU. Select Hotkeys.

5 Select an unassigned key (0–9).

6 Click Assign. The display shows the bookmark and its assigned hotkey.

6.13.4.5 Using a Hotkey

Procedure Steps

1 Enter the browser.

2 Press and hold a hotkey to download the corresponding bookmarked page from the web.

6.13.4.6 Saving a Page
When and where to use:
Save a page for off-line browsing.
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Procedure Steps

1 Enter the browser and browse to the required page.

2 Press Menu.

3 Scroll to Tools pane.

4 Select Save Page. Edit the proposed page title if required. Scroll down and select Save. The page will be saved
in the Bookmarks Saved Pages folder.

6.13.4.7 Selecting a Saved Page
Procedure Steps

1 Enter the browser.

2 Scroll to Bookmarks pane.

3 Select Organise (if there are no saved bookmarks), orMore... .

4 Select Go to enter the Saved Pages folder.

5 Select a saved page and press Ok. The display shows the saved page. Depending on the saved page, you
may browse the web from here.

6.13.5 Disabled Packet Data Service
If there is no Packet Data Service, your radio displays Error:No Network Available when entering the browser for
the first time. Select left SOFT key to retry entering, or right SOFT key to enter the browser menu.

When re-entering the browser with previously available Packet Data, the radio displays the last browsed page, or the
last page to which you navigated off-line.

6.13.6 Disabled Browser Entry
Browser entry is disabled:

• During any type of voice call, except Ambience Listening Call
• In DMO Mode
• During Emergency Mode
• During PIN lock
• Service provider has not configured this feature
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6.13.7 Keys Usage

• When the radio is disabled

• Browser entry is enabled during Ambience Listening (AL) Call. If you navigate to previously
stored pages, the AL state remains.

• When you activate Packet Data for the first time, AL is disconnected, and you have the same
look and feel as if you were not in AL before.

6.13.7 Keys Usage
When the browser is active, the following usage described occurs inside or outside the editor.

Table 6-3 Browser Keys Usage

Key Press Action
0–9 key In the editor: enters a digit and/or character depending

on the text entry mode selected.

Outside the editor: in a numbered list, selects the
required item list.

0–9 key (hold) In the editor: standard use.

Outside the editor: hotkey for navigating to the
numbered bookmark.

* key (press or hold) In the editor, inserts a space.

# key (press or hold) Brings up the Text Input pane, while in editor.
Otherwise, sounds a wrong key press.

Left or right SOFT key Selects the option that appears in the display directly
above the left and right soft key (part of the page).

Up NAVIGATION key While in list of options, moves up one line.

Up NAVIGATION key (hold) Moves up on page.

Down NAVIGATION key While in list of options, moves down one line.

Down NAVIGATION key (hold) Moves down on page.

Left NAVIGATION key Moves to the previous pane.

In the editor: moves left.

Left NAVIGATION key (hold) Functions as backward.

Right NAVIGATION key Moves to the next pane.

In the editor: moves cursor to the right and inserts space
if at the end of the word.

Right NAVIGATION key (hold) Functions as forward.

Center of NAVIGATION keys (hold) Auto-repeat.

MENU key Brings up the browser menu.
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Table 6-3 Browser Keys Usage (cont'd.)

Key Press Action
END key Press to deactivate the browser.

SEND key Disabled in browser active state.

ROTARY KNOB Used for volume adjustment only.

EMERGENCY button Deactivates the browser. The radio enters Emergency
Mode.

6.13.8 Browser Menu Panes Overview
The browser menu includes the following panes:

Table 6-4 Browser Menu Panes

Menu Pane Description
Navigate Provides access to the home page and commonly used items.

Bookmarks Provides access, editing, and storage options to stored bookmarks and saved
pages.

History Provides access to recently visited pages and shows the position of the
currently loaded page in the history stack.

Tools Provides access to applications and utilities.

The following panes are displayed according to the context:

Table 6-5 Additional Menu Panes

Menu Pane Description
Options Displayed only when there are additional options for the pane or page.

Image Displayed only when an image is selected. Provides access to image details,
storage, and display use.

Input Text Displayed only in text entry mode. Provides access to text entry mode (for
example: symbol).

6.13.9 Navigate Pane
You can select one of the following items:

• Home — for loading the home page.
• Open Page — for entering the URL.
• Search — item disabled.
• Mark Page— for creating (saving) a bookmark for the current document. A title and URL for the bookmark
are displayed, and the root folder is chosen for the location.
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6.13.10 Advanced...

• Forward— for navigating to the document located one step forward in the navigation history. If there is no
forward history, this item is disabled.

• Reload— for reloading the current document.
• Advanced... — see following section.

6.13.10 Advanced...
From the Navigation pane select Advanced... to see the following options:

• Settings...

– Downloads— for setting download preferences. You may deactivate the downloading of images and
objects. The browser displays a special icon instead of the images and objects.

– Scroll Mode— for setting the scrolling mode and speed.
– Key Press Timeout— for setting key press time-out. This time-out is used for text entry.
– Set Proxy— select the WAP Proxy (1, 2, 3). The browser connects to the web via the selected proxy
or gateway. The network provider installs and configures the proxy. To establish a secure session,
select a secure proxy. Please ask your service provider which proxy is configured for a secure session.
Though you can choose your home page, the service provider may decide to force its own home page
on your terminal.

– Circuit Prompt— for turning on/off the circuit prompt.
– Resend Data Prompt— for turning on/off the data re-send prompt.

• Security...

– Secure Prompt— for enabling/disabling the browser to inform you that it replaced a non-secure
connection with a secure connection, and the other way around.

– Current Certificate— for viewing the digital certificate identifying the server that delivers the current
document. A Certificate Authority (CA) digitally signs and thus authenticates this certificate. Up to ten
additional custom WTLS certificates can be added to the default list of certificates installed. Please ask
your service provider if you wish to have these custom WTLS certificates added.

– CA Certificates— for viewing the digital certificates installed in the browser and digitally signed by
Certificate Authorities (CA).

– Send Referrer— for turning ON/OFF sending of the HTTP Referrer header as part of HTTP requests.
The Referrer header provides the URL of the link source to the server.

– Authentication — for turning ON/OFF the caching of HTTP Authentication credentials. HTTP
Authentication protects access to content on the server. If you try to access a protected content, you
enter your credentials (user name or password).

• Clear... — for clearing of browser data: history, cache cookies, or auto-fill.
• Restart Browser— for restarting the browser.
• About... — for showing the information about the current version of Openwave Mobile Browser.

6.13.11 Bookmarks Pane
If there are bookmarks in the root folder, selectMore... to access the Options pane. If the root folder is empty, select
Organise... then press MENU key to access the Options pane. The Options pane allows you to manage bookmarks.
The Saved Pages folder contains snapshots of saved pages.
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6.13.11.1 Working with the Options Pane for a Selected Bookmark

Procedure Steps

1 From the Bookmarks pane select More... .

2 Scroll to a bookmark.

3 Press MENU to open the Options pane for that bookmark.

4 Select one of the following:
• Back— for displaying the page associated with the bookmark (page is downloaded if not available

in cache).
• Details— for modifying the bookmark title and URL.
• Delete — for deleting the bookmark.
• New Bookmark— for creating a new bookmark.
• New Folder— for creating a new folder.
• Move— for moving this bookmark to a new folder (or in Bookmarks).
• Delete All— for deleting all bookmarks.
• Hotkeys— for assigning hotkeys to available bookmarks.

6.13.11.2 Working with the Saved Pages Folder

Procedure Steps

1 From the Bookmarks pane select Saved Pages folder.

2 The browser displays the page (snapshot) saved using Save Page in Tools pane.

3 Scroll to a saved page.

4 PressMenu to open the Options pane for the saved page.

5 Select one of the following:
a. Back— for displaying this page saved on its cache.
b. Details— for modifying the page title and URL of the saved page.
c. Update Page— for replacing the saved version with the current version (to be downloaded from server).
d. Delete— for deleting this page from its cache.
e. Delete All— for deleting all the saved pages from its cache.
f. Cancel— for exiting this pane and returning to the last page displayed.
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6.13.12 History Pane

6.13.12 History Pane
This pane displays the list of recently visited pages (up to nine history entries can be listed). Each history entry
shows its title, if present. Otherwise, No Title is displayed.

6.13.12.1 Navigating to the Recently Visited URL
Procedure Steps

1 Select the URL.

2 Press Ok.

6.13.13 Tools Pane
Procedure Steps

1 From the Tools pane select More...

2 Scroll to a document.

3 Select MENU key to open the Options pane for that document.

4 Select one of the following:
• Show URL— For displaying the current page URL.
• Save Page— For creating a snapshot for the current document.
• Find Text— For finding a text string in the current document.
• Copy Text— For copying text from the current document to the clipboard.

6.13.14 Options Pane
This pane is specific to the page or pane being displayed.

6.13.15 Image Pane
This pane appears in the browser menu when you enabled the download of images through Navigate pane >
Advanced... > Settings... .

The following items are available:

• Save— for saving the image in the terminal.
• [Send]— for sending the image to the destination of your choice.
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• Reload — for reloading the image.

• Details— for displaying the image details.

• Show Image— for showing the image on its own page.

6.13.16 Text Input Pane
Prerequisites:
This pane is visible when the browser menu is opened and text entry field is active.

When and where to use:
To input the text for the URL.

Procedure Steps

1 Select the URL.

2 Press abc.
Step result: The text input pane opens up.

3 Select www.

4 Scroll the required extension (for example: .com).

5 Press .com. The screen displays the URL with the selected extension.

Table 6-6 Browser Text Input Icons

Mode Soft Key Action

Alphabetic characters - lower case abc Enter text in lowercase.

Alphabetic characters - upper case ABC Enter text in uppercase.

Numeric 123 Enter numbers and symbols.

http mode www Enter

6.13.17 WAP Push
WAP push allows WAP content to be pushed to a radio. This push is carried out by sending a specially formatted
(Push Access Protocol) XML document to the Push Proxy Gateway, that in turn forwards the document to the radio.

A WAP push message is an encoded message including a link to a WAP address. On receiving a WAP push,
a WAP enabled radio automatically gives the option to access the WAP content. The implemented WAP push is
compliant to WAP 2.0 standard.

This is a selling feature.
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6.13.17.1 New WAP Messages

WAP

WAP Box

6.13.17.1 New WAP Messages
Types of the WAP Messages and their priorities:

Your service provider sets the priority of the message.

• Push Message

– High — animation and the icon (blinking) are displayed with the New WAP Message tone.

– Medium — animation and the icon are displayed with the New WAP Message tone.

– Low — icon is displayed with the New WAP Message tone.

– Delete — available only if you are is in WAP Box, the textWAPMessage deleted remotely is displayed,
otherwise there is no indication.

Animation is not displayed if you are in a call, or in Emergency Mode, or in Call Out, or in message
editor, or PIN lock state, or switching to DMO.

• Load Push Message

– High — browser opens to the user with the New WAP Message tone.

– Low — the icon is displayed with the New WAP Message tone.

Browser does not open if you are in a call, or in Emergency Mode, or in Call Out, or in message editor, or
PIN lock state, or switching to DMO.
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6.13.17.2 Viewing a WAP Message

Procedure Steps

1 From the home screen, press the MENU key.

2 Select Messages → WAP Box.

3 Select the required message.

4 Select Go to to view the message in the browser.

6.14 Call-Out
This feature allows you to receive Call-Out alerts. On receiving the Call-Out messages, the radio interrupts current
services and attends to the Call-Out alert without any further delay. After call-out alert has been cleared, the radio
exits Call-Out mode and reverts to normal mode. During Call-Out mode you are only able to receive Emergency
Calls.

To read an entire Call-Out message, scroll down the screen by pressing the down NAVIGATION key. The
length of the message is indicated by the vertical red bar on the left of the screen.

Figure 6-1 Call-Out Message

CO Box

6.14.1 Types of Call-Out Alerts
There are four types of the Call-Out alerts:

• Normal Call-Out – an alert message that is sent by a dispatcher either to a single radio or to a group of radios.
• Storm Plan – an alert message that is sent by a dispatcher to a group of radios. To raise its reliability, it
is sent several times. You are not able to respond to the Call-Out alert and any key press takes you to
the information phase.

6-22 -



6.14.2 Call-Out Modes Interaction

• Fallback Mode – an alert message that is limited only to voice communication. To initiate this type of
Call-Out, press a One-Touch key predefined by your service provider. It can be cleared manually.

Fallback is only possible when the radio is in Local Site Trunking.

• Test Call-Out – a special Call-Out alert that is sent by the dispatcher to test this feature. On receiving the
Test Call-Out, the radio plays a tone and displays Test Call-Out. To respond and clear the alert, press
the Test OK SOFT key.

6.14.2 Call-Out Modes Interaction
Call-Out feature operation is different in other modes:

• TXI Mode — you can read the message but you cannot respond to it. You have an option to leave the TXI
Mode by pressing soft key or reject the Call-Out message.

• DMO Mode — Call-Out is not supported.

• Emergency Mode — all Call-out alerts are ignored.

6.14.3 Call-Out Service Phases
In the Call-Out mode there are following phases:

• Alerting phase — receives a Call-Out message. The alarm tone indicates the message. Text is displayed
and you have following options to use: Accept, Reject or MENU. If you accept the alert, no other service
from this point can interrupt.

You can stop the alert tone by pressing PTT or any of the soft keys.

• Information phase — you are still in the Call-Out mode and you can receive more detailed information about
the incident that occurred through subsequent text or the voice message. You can query for more information
using voice group call or Call-Out text function which enables you to send a text message. You can always
respond and send back the text or the voice message using voice group call.
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Appendix A: Tones

The radio has two tone packs — New Tones (default) and Classic Tones. Your service provider decides
which one is enabled.

To listen to the audio signal tones samples, click .

Table A-1 Radio Tones

New Tone Classic Tone Tone Description

Default Beep — Played when pressing a key.

Duplex Volume Set — Played when adjusting duplex volume.

Invalid Action

Examples:

• Pressing an invalid key.

• Dialing an invalid number.

• Talk prohibit.

System Notification

Examples:

• The radio changed its status from out-of-range to in service.

• The radio returned to the home network.

• Toggling between the TMO and DMO modes.

System Error

Examples:

• The radio changed its status from in service to out-of-range.

• Call disconnected.

General Notification

Examples:

• Entering Local Site Trunking.

• Entering the Transmit Inhibit Mode.

Positive Notification — Message sending succeeded.

Negative Notification — Message sending failed.
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Table A-1 Radio Tones (cont'd.)

New Tone Classic Tone Tone Description

Item Received — A new message received.

Talk Permit — The radio user is allowed to transmit their message (after
pressing the PTT button).

Clear-to-send — Data transmission ready to begin.

Emergency — The Emergency Call received.

Over the Air 1 — Single D-PTT tone.

Over the Air 2— Double D-PTT tone.

Over the Air 3— Triple D-PTT tone.

Phone Busy — The called radio is busy.

Phone Ring Back — Played on the initiating phone when the Phone Call
is being setup.

Private Ring Back — Played on the initiating phone when the Private
Call is being setup.

Ringtone 1.

Ringtone 2.

Ringtone 3.

Ringtone 4.

Ringtone 5.

Simplex Volume Set — Played when adjusting simplex volume.

BSI Key Negotiation – Played during BSI key negotiation.

Remote Control – Played when the radio receives a new remote control
message.
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Appendix B: LED Indications
Table B-1 LED Indications

Indication Status
Solid green In use

Repeating call

Blinking green In service

Solid red Out of service

Blinking red Connecting to the network

Entering DMO

Solid orange Transmit inhibit in service

Channel busy in DMO

Blinking orange Incoming call

No indication Idle

Radio powered down
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Appendix C: Troubleshooting
Your radio displays the following messages:

Table C-1 Displayed Messages

Message Message Description
...-Received Call received but not answered, or rejected.

Attachment Failed Your radio could not perform talkgroup attachment. It keeps on
trying. If it does not succeed, try another talkgroup.

Authenticate Failure Your radio could not register on an authenticated system (for
example, the Authentication Key is incorrect, or authentication is
disabled).

Call Cancelled You have canceled the call.

Call Ended • Faulty channel. Please try later.

• You have ended the call.

Call Forwarding The radio you are trying to call is not available and the call is being
forwarded to another radio.

Call Modified The call you are participating in has been modified.

Call Preempted Channel being used for priority.

Decryption Failed: An error occurred while decrypting a message or call.

Emergency In Use
Wait For Mic

The Hot Microphone feature is active, but the channel transmit grant
has been given to another Emergency call on the same talkgroup.
Your radio microphone is not active during this time, but it
automatically tries to regain talk permit after a predetermined time.

Emgcy Mic Ended The Hot Microphone timer automatically expired, or you pressed
the PTT button to cancel the Hot Microphone feature.

Emergency Mic On The Hot Microphone feature is active, and your radio is
automatically transmitting hands free emergency audio.

Empty Entry The speed number you dialed does not exist, or the number exists
but the group is non-selectable.

Faulty Unit
Error

Self-test failed. An operational fault has been detected with your
radio. Record the error number. Turn your radio off and contact
service.

Gateway available Your radio has connected to a gateway.

Gateway not available Your radio cannot connect to a gateway, or connection has been lost.

This group already exists The group you are attempting to add exists in theMyGroups folder.

Individual Calls Only You can make only individual (private) calls.

Insufficient visible data Your radio is in the process of determining your location. This
process may take several minutes to complete.

Insufficient visible satellites Your radio is in the process of determining your location. This
process may take several minutes to complete.
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Table C-1 Displayed Messages (cont'd.)

Message Message Description
Invalid ID The entered number is not valid.

Invalid Shortcut Position The entered number is not valid.

Limited Service Emergency Calls, Emergency Alarms, and mobility operations (for
example group attachment) are allowed. All other incoming and
outgoing call and data services are blocked.

List Empty There are no programmed entries in the scrolling list. Type the entry.

List Not Attached All talkgroups in the scan list are not attached.

List Partially Attached The scan list is active, but not all talkgroups are attached to it.

Message Delivered Indicates mail successfully delivered.

Message Failed Indicates mail delivery failure.

New Delivery Status You have received a new Delivery Status.

No Service Your radio is outside coverage. Return to coverage.

My Groups
Is Empty

You cannot view/delete groups when the My Groups folder is
empty.

My Groups
Is Full

You are not allowed to add a group to theMy Groups folder as it
already contains the maximum allowed number of groups.

Network Trouble Network problems. Please try again later.

No Answer The called party does not answer.

No Entries This message is displayed when accessing an empty list.

No Group • Attachment failed. Your radio detached from current
talkgroup. Please wait until it attaches again to the current
talkgroup.

• Displayed when you are out of the normal coverage area of
your selected talkgroup. Please select a new talkgroup that
is valid for your working location.

• Indicates a favorite group was removed from the My
Groups folder.

No List The network list is empty.

No New or Old Messages Indicates there are no new or old messages in the Inbox.

No Selected Scan List You selected an empty network list.

No Service Your radio is out of coverage.

Not Allowed To Initiate Call You are not allowed to dial a number which is not in the address
book.

Not Allowed To Transmit Release the PTT button and try again later. You are not allowed to
send a text message or a status message to a number which is not in
the address book.

Single TalkGroup Only There is only one programmed entry in the scrolling list.

Overheating, Please Turn Radio Off Your radio turns off. Keep it turned off for 5 minutes.
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Table C-1 Displayed Messages (cont'd.)

Message Message Description
Party Busy Called radio is busy.

Party Not Available Called radio is out-of-range or turned off. Please try again later.

Please Try Again You could not call.

Please Wait Connecting A message during startup.

Registration Failure Your radio could not register within the system. Please try again
later.

Repeater available Your radio has connected to a repeater.

Repeater not available Your radio cannot connect to a repeater, or connection has been lost.

Service Denied Invalid number. Call your service provider.

Service Not Available This service is not available on the current network.

Service Restricted This service is restricted by your service provider, it has not been
purchased, or it is not available.

TalkGrp ... cannot be deleted Your service provider set this group so you cannot delete it from the
favorite talkgroup folder.

Try Again Later The requested service is temporarily unavailable.

Radio Disabled Check with your service provider.

Unit is OK
Warn:

Self-test error. A minor fault has been detected. Your radio is still
fully operative. If this error recur, note the error code and contact
service.

Unit Not Attached You radio could not attach to the system. The talkgroup may not be
defined in the system. Please try another group.

Unassigned Button The message is displayed when no feature is assigned to a button.
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1 Allgemeine Informationen

1.1 Sicherheitshinweise

VORSICHT

Bitte lesen Sie die im Heft über Produktsicherheit und Funkfrequenzstrahlung (6804113J25 für
APAC & LACR und 6866537D37 für EMEA) enthaltenen Hinweise für den sicheren Einsatz der
Produkte, bevor Sie sie in Betrieb nehmen.

Dieses Funkgerät bezieht sich nur auf die Nutzung in Arbeitsumgebungen und erfüllt die ICNIRP
HF-Funkfrequenzstrahlungsanforderungen. Lesen Sie vor Verwendung des Produkts die Vorsichtsinformationen zur
Funkfrequenzstrahlung und die Bedienungsanweisungen im Heft über Produktsicherheit und Funkfrequenzstrahlung
durch, um die Einhaltung der Belastungsgrenzwerte zu gewährleisten.

Bewahren Sie das Benutzerhandbuch und die Broschüren zur Produktsicherheit und HF-Belastung an einem
sicheren Ort auf, so dass diese Unterlagen allen Bedienern griffbereit zur Verfügung stehen.

1.2 Copyright
Die in diesem Dokument beschriebenen Motorola-Produkte können durch Copyright geschützte
Computerprogramme von Motorola enthalten. Nach den Gesetzen der USA und anderer Staaten sind bestimmte
exklusive Rechte an der urheberrechtlich geschützten Software der Firma Motorola vorbehalten. Demzufolge
dürfen urheberrechtlich geschützte Computerprogramme, die zusammen mit den in diesem Dokument
beschriebenen Produkten ausgeliefert werden, ohne die vorherige schriftliche Genehmigung von den Inhabern der
Urheberrechte weder kopiert noch in jeglicher Form reproduziert werden.

© 2013 Motorola Solutions Inc. Alle Rechte vorbehalten.

Die Vervielfältigung, Übertragung, Speicherung in einem Abrufsystem oder Übersetzung in eine Sprache oder
Computersprache ist für keinen Teil dieses Dokuments in keinerlei Form oder durch keinerlei Methode ohne
vorherige schriftliche Genehmigung von Motorola Solutions, Inc. gestattet.

Darüber hinaus werden mit dem Kauf von Produkten von Motorola weder ausdrücklich noch stillschweigend, durch
Rechtsverwirkung oder auf andere Weise Lizenzen unter dem Copyright, dem Patent oder den Patentanwendungen
von Software von Motorola ausgegeben, außer der Nutzung von normalen, nicht ausschließlich erteilten,
lizenzgebührenfreien Lizenzen, die sich aus der Anwendung der Gesetze beim Verkauf eines Produkts ergeben.

Haftungsausschluss

Beachten Sie, dass bestimmte Funktionen, Fähigkeiten und Möglichkeiten, die in diesem Dokument beschrieben
werden, für ein bestimmtes System möglicherweise nicht gelten oder nicht lizenziert sind, oder von den
Eigenschaften einer bestimmten mobilen Abonnenteneinheit oder von der Konfiguration bestimmter Parameter
abhängen können. Wenden Sie sich für weitere Informationen an Ihren Motorola-Ansprechpartner.
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Ausführliche Bedienungsanleitung

Marken

MOTOROLA, MOTO, MOTOROLA SOLUTIONS und das stilisierte M-Logo sind Marken oder eingetragene
Marken von Motorola Trademark Holdings, LLC und werden unter Lizenz verwendet. Alle anderen Marken
sind Eigentum ihrer jeweiligen Inhaber.

WEEE-Richtlinie der EU

Die WEEE-Richtlinie schreibt vor, dass Produkte, die in Ländern der EU verkauft werden, ein Etikett mit
dem Symbol eines durchgestrichenen Abfallbehälters am Gerät (oder in einigen Fällen auf der Verpackung)
tragen müssen.

Wie in der WEEE-Richtlinie festgelegt, bedeutet dieses Etikett, dass Kunden und Endverbraucher in EU-Ländern
elektrische und elektronische Geräte und Zubehör nicht mit dem Haushaltsmüll entsorgen sollten.

Endverbraucher in den Mitgliedsländern der Europäischen Union sind angehalten, bei ihrem lokalen Händler oder
beim Kundendienst des Herstellers Informationen zum Rücknahmesystem ihres Landes einzuholen.

1.3 Verwendete Symbole
In diesem Dokument werden die nachstehenden grafischen Symbole verwendet, anhand derer für einen
ordnungsgemäßen Funkbetrieb entscheidende Situationen oder Einstellungen identifiziert werden können:

GEFAHR

Das Signalwort GEFAHR und das entsprechende Sicherheitssymbol weisen auf Informationen hin,
die bei Nichteinhaltung zum Tode oder schweren Verletzungen führen können.

WARNUNG

Das Signalwort WARNUNG und das entsprechende Sicherheitssymbol weisen auf Informationen
hin, die bei Nichteinhaltung zum Tode oder schweren Verletzungen sowie zu schweren
Beschädigungen des Produkts führen können.

VORSICHT

Das Signalwort ACHTUNG und das entsprechende Sicherheitssymbol weisen auf Informationen
hin, die bei Nichteinhaltung zu leichten oder mittelschweren Verletzungen sowie zu schweren
Beschädigungen des Produkts führen können.

VORSICHT

Das Signalwort VORSICHT kann auch ohne das Sicherheitssymbol verwendet werden, um Sie
über potenzielle Schäden oder Verletzungsgefahr zu informieren, die nicht mit dem Produkt
in Zusammenhang stehen.
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1.4 Dieses Handbuch verwenden

WICHTIG

WICHTIGE Informationen, die für den aktuell beschriebenen Vorgang wichtig sind, jedoch nicht zu
den Kategorien VORSICHT und WARNUNG zählen. Inhalte, die als WICHTIG gekennzeichnet sind,
beinhalten keinerlei Warnungen.

HINWEIS

HINWEISE enthalten Informationen, die wichtiger sind als der umgebende Text, wie beispielsweise
Ausnahmen und Voraussetzungen. In Anmerkungen wird der Benutzer zudem auf zusätzliche
Informationen hingewiesen, dem Benutzer die Durchführung eines Vorgangs in Erinnerung gerufen (wenn
dieser beispielsweise nicht Teil des aktuell beschriebenen Vorgangs ist), oder dem Benutzer erklärt, wo
sich ein Element auf dem Bildschirm befindet. Eine Anmerkung beinhaltet keinerlei Warnhinweise.

VORSCHLAG

VORSCHLAG kennzeichnet eine Empfehlung von Motorola, die nicht befolgt werden muss, jedoch
hilfreich sein kann. Ein VORSCHLAG beinhaltet keinerlei Warnhinweise.

1.4 Dieses Handbuch verwenden
In diesem Handbuch werden alle verfügbaren Funkfunktionen beschrieben. Ihr Dienstanbieter hat Ihr Funkgerät
möglicherweise angepasst, um Ihre individuellen Anforderungen optimal zu erfüllen. Wenden Sie sich an
Ihren Dienstanbieter, um sich über die Unterschiede zu dieser Anleitung zu informieren.Im Text in diesem
Dokument werden Sie folgende besondere Formatierungen bemerken, die bestimmte Informationen oder Elemente
hervorheben sollen:

Tabelle 1-1 Besondere Formatierungen

Beispiel Beschreibung

MENÜTASTE, oder NOTRUF-Taste Großbuchstaben weisen auf den Namen einer Taste
oder Schaltfläche hin.

Eingabe TMO Ton Kursiv dargestellte Buchstaben kennzeichnen den
Namen des Tons.

Schaltet Aus Fett dargestellte Wörter weisen auf die weichen
Menüoptionen, auf MMI-Zeichenfolgen oder auf
Fehlermeldungen hin.

Einstellungen → Töne → Alle Töne Fett dargestellte Wörter mit einem Pfeil dazwischen
stellen die Navigationsstruktur innerhalb der
Menüoptionen dar.
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2 Inbetriebnahme des Geräts
Dieses Kapitel enthält grundlegende Informationen zur Verwendung des Funkgeräts.

2.1 Technische Produktinformationen
Tabelle 2-1 Technische Produktinformationen

Beschreibung Wert
Maximale Funkleistung 10 Watt

Maximale Lautsprecherlast 10 W bei 4 Ohm

Antennenimpedanz 50 Ohm

Umgebungstemperaturbereich -30 °C bis +60 °C

HINWEIS

Wenn das Funkgerät in Betrieb ist, kann die
Oberflächentemperatur bis auf 70° C steigen. Berühren Sie
nicht die heiße Oberfläche.

Betriebszeit Ununterbrochen/Mit Unterbrechungen

HINWEIS

Das Kommunikationssystem bestimmt die Funkgerätübertragungs- und Empfangszeit (Betriebszykluszeit).
Bei Überlastung oder Überschreiten der Systemspezifikationen bei hohen Umgebungstemperaturen
senkt die thermische Steuerung die RF-Ausgangsleistung. Dadurch verringert sich der Reichweite des
Funkgeräts.
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2.2 Bedienelemente und Anzeigen
NGCH (New Generation Control Head, Bedienkopf der neuesten
Generation)/RECH (Remote Ethernet Control Head, Remoter
Ethernet-Bedienkopf)

76543
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2.2 Bedienelemente und Anzeigen

Tabelle 2-2 Bedienelemente und Anzeigen - NGCH (New Generation Control Head, Bedienkopf
der neuesten Generation)/RECH (Remote Ethernet Control Head, Remoter Ethernet-Bedienkopf)

Kommentar Beschreibung
1 NOTRUF-Taste

Halten Sie die Taste NOTFALL gedrückt, um in den Notfallbetrieb zu wechseln. Wenn
Ihr Gerät ausgeschaltet ist, halten Sie die Taste gedrückt, um das Gerät im Notfallmodus
einzuschalten.

2 DREHKNOPF

• Halten Sie den Drehknopf gedrückt, um das Gerät einzuschalten.

• Drehen Sie den Drehknopf, um die Lautstärke zu regeln.

• Drücken und drehen Sie die Taste gleichzeitig, um eine andere Gesprächsgruppe
auszuwählen.

• Halten Sie den DREHKNOPF gedrückt, um ihn zu sperren/entsperren. Durch
Ausschalten des Geräts wird ein gesperrter DREHKNOPF wieder entsperrt.

3 DISPLAY

Zeigt alphanumerischen Text und Bilder in 65.536 Farben, mit 640 x 480 Pixel sowie
Hintergrundbeleuchtung und skalierbare Schriftarten an.

HINWEIS

Entfernen Sie vor der erstmaligen Verwendung des Geräts die Schutzabdeckung
vom Display.

4 SOFTKEY

Drücken Sie die obere oder untere AUSWAHLTASTE, um die Option auszuwählen,
die im Display daneben angezeigt wird.

5 EIN/AUS/ENDE/HOME-Taste

• Halten Sie die Taste gedrückt, um das Gerät ein- oder auszuschalten.

• Drücken Sie die Taste, um Anrufe zu beenden.

• Drücken Sie die Taste, um zum Startbildschirm zurückzukehren.

6 NAVIGATIONSTASTE

Drücken Sie die NAVIGATIONSTASTE nach oben, unten, links oder rechts, um durch die
Liste zu blättern, durch die Menühierarchie zu navigieren oder für die alphanumerische
Textbearbeitung.

Drücken Sie auf dem Startbildschirm darauf, um eine der folgenden Optionen zu
aktivieren:

• NAVIGATIONSTASTE nach unten: ruft den Menüpunkt Letzte Rufe auf.

• NAVIGATIONSTASTE nach oben: Ändert den GesprächsgruppenordnerMeine
Gruppen.

• Linke und rechte NAVIGATIONSTASTE: wechselt durch die Gesprächsgruppen.
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Tabelle 2-2 Bedienelemente und Anzeigen - NGCH (New Generation Control Head, Bedienkopf der
neuesten Generation)/RECH (Remote Ethernet Control Head, Remoter Ethernet-Bedienkopf) (Fortsetzung)

Kommentar Beschreibung
7 Alphanumerische TASTATUR

Mithilfe der Tastatur können Sie alphanumerische Zeichen für die Einwahl,
Kontakteinträge und Textnachrichten eingeben.

8 LED-Statusanzeige

9 MOBILMIKROFONANSCHLUSS

Bietet Anschlussmöglichkeiten für Zubehör, wie z. B. Handmikrofon mit PTT.

10 MENÜ-Taste

Drücken Sie auf die Taste, um das Hauptmenü und das Kontextmenü aufzurufen.

11 SENDETASTE

Drücken Sie diese Taste, um Duplex-Anrufe zu starten oder zu beantworten oder um
Nachrichten zu senden.

Drücken Sie die Taste im Startbildschirm, um die zuletzt gewählten Nummern anzuzeigen.

12 FUNKTIONSTASTE 1

Standardmäßig:

• Kurzer Tastendruck aktiviert/deaktiviert die Hup- und Lichtzeichenfunktion.

• Langer Tastendruck passt die Hintergrundbeleuchtung an.

13 FUNKTIONSTASTE 2

Standardmäßig:

• Kurzer Tastendruck schaltet den Lautsprecher ein/aus.

• Langer Tastendruck aktiviert/deaktiviert den Bildschirmschoner.

14 FUNKTIONSTASTE 3

Standardmäßig:

• Kurzer Tastendruck passt die Hintergrundbeleuchtung an.

• Langer Tastendruck ist nicht zugewiesen.

15 PTT (Sprechtaste)

• Halten Sie die Taste gedrückt, um Simplex-Anrufe zu tätigen oder einen
Gruppenanruf zu starten. Lassen Sie die Taste los, um zuzuhören.

16 MIKROFON
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2.2 Bedienelemente und Anzeigen

HINWEIS

Wenn Sie die Erweiterungs-PTT-Taste (auf dem Erweiterungskopf) drücken, wird die Betätigung anderer
PTT-Tasten auf mit dem Bedienkopf verbundenem Zubehör ignoriert. Dies gilt nur für MTM5200,
MTM5400 und MTM800 Fug.
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Ausführliche Bedienungsanleitung

Bedienteil in Telefonausführung (TSCH)

12

13

14

15

1

2

3 3

8
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11

7

6

10
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2.2 Bedienelemente und Anzeigen

Tabelle 2-3 Bedienelemente und Anzeigen - Telephone Style Control Head (TSCH)

Kommentar Beschreibung
1 DISPLAY

Bietet alphanumerischen Text und Bilder in 65.536 Farben und 240x320 Pixeln mit
skalierbaren Schriftarten und Hintergrundbeleuchtung.

HINWEIS

Entfernen Sie vor der erstmaligen Verwendung des Geräts die Schutzabdeckung
vom Display.

2 MENÜ-Taste

Drücken Sie auf die Taste, um das Hauptmenü und das Kontextmenü aufzurufen.

3 SOFTKEYS

Drücken Sie den SOFTKEY nach links oder rechts, um die Option auszuwählen, die auf
dem Bildschirm darüber angezeigt wird.

4 SENDETASTE

Drücken Sie diese Taste, um Duplex-Anrufe zu starten oder zu beantworten oder um
Nachrichten zu senden.

Drücken Sie die Taste im Startbildschirm, um die zuletzt gewählten Nummern anzuzeigen.

5 Alphanumerische TASTATUR

Mithilfe der Tastatur können Sie alphanumerische Zeichen für die Einwahl,
Kontakteinträge und Textnachrichten eingeben.

6 FUNKTIONSTASTE 1

Standardmäßig:

• Kurzer Tastendruck aktiviert/deaktiviert die Hup- und Lichtzeichenfunktion.

• Langer Tastendruck passt die Hintergrundbeleuchtung an.

7 FUNKTIONSTASTE 2

Standardmäßig:

• Kurzer Tastendruck schaltet den Lautsprecher ein/aus.

• Langer Tastendruck aktiviert/deaktiviert den Bildschirmschoner.

8 EIN/AUS/ENDE/HOME-Taste

• Halten Sie die Taste gedrückt, um das Gerät ein- oder auszuschalten.

• Drücken Sie die Taste, um Anrufe zu beenden.

• Drücken Sie die Taste, um zum Startbildschirm zurückzukehren.
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Ausführliche Bedienungsanleitung

Tabelle 2-3 Bedienelemente und Anzeigen - Telephone Style Control Head (TSCH) (Fortsetzung)

Kommentar Beschreibung
9 NAVIGATIONSTASTE

Drücken Sie die NAVIGATIONSTASTE nach oben, unten, links oder rechts, um durch die
Liste zu blättern, durch die Menühierarchie zu navigieren oder für die alphanumerische
Textbearbeitung.

Drücken Sie auf dem Startbildschirm darauf, um eine der folgenden Optionen zu
aktivieren:

• NAVIGATIONSTASTE nach unten: ruft den Menüpunkt Letzte Rufe auf.

• NAVIGATIONSTASTE nach oben: ändert den GesprächsgruppenordnerMeine
Gruppen.

• Linke und rechte NAVIGATIONSTASTE: wechselt durch die Gesprächsgruppen.

10 MICRO-USB-ANSCHLUSS

Ermöglicht den Anschluss des Funkgeräts an einen Computer.

11 FUNKTIONSTASTE 3

Standardmäßig:

• Kurzer Tastendruck passt die Hintergrundbeleuchtung an.

• Langer Tastendruck ist nicht zugewiesen.

12 OHRHÖRER

13 Obere PTT-Sprechtaste

Standardmäßig ist diese PTT-Taste deaktiviert. Ihr Dienstanbieter kann ihr jedoch eine der
folgenden Funktionen zuweisen:

• Obere PTT-Taste funktioniert auf die gleiche Weise wie die untere PTT-Taste (Sie
können beide gleichwertig verwenden).

• Die obere PTT-Taste unterstützt einen Dachlautsprecher. Dachlautsprecher
übertragen Ton über einen externen, am Transceiver angeschlossenen Lautsprecher.

14 Untere PTT-Sprechtaste

• Halten Sie die Taste gedrückt, um Simplex-Anrufe zu tätigen oder einen
Gruppenanruf zu starten. Lassen Sie die Taste los, um zuzuhören.

15 MIKROFON
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2.2 Bedienelemente und Anzeigen

Ladestation

16

17

18

19

Tabelle 2-4 Bedienelemente und Anzeigen - Ladestation

Kommentar Beschreibung
16 DREHKNOPF

• Halten Sie den Drehknopf gedrückt, um das Gerät einzuschalten.

• Drehen Sie den Drehknopf, um die Lautstärke zu regeln.

• Drücken und drehen Sie die Taste gleichzeitig, um eine andere Gesprächsgruppe
auszuwählen.

• Halten Sie den DREHKNOPF gedrückt, um ihn zu sperren/entsperren. Durch
Ausschalten des Geräts wird ein gesperrter DREHKNOPF wieder entsperrt.

• Wenn Sie die Taste drücken, funktioniert der DREHKNOPF wie die
Links/Rechts-Navigationstasten.

17 GABEL
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Ausführliche Bedienungsanleitung

Tabelle 2-4 Bedienelemente und Anzeigen - Ladestation (Fortsetzung)

Kommentar Beschreibung
18 NOTRUF-Taste

Halten Sie die Taste NOTFALL gedrückt, um in den Notfallbetrieb zu wechseln. Wenn
Ihr Gerät ausgeschaltet ist, halten Sie die Taste gedrückt, um das Gerät im Notfallmodus
einzuschalten.

19 LED-Statusanzeige

HINWEIS

• Es wird empfohlen, das Gerät vor dem Anschließen von Zubehör auszuschalten.

• Eine detaillierte Liste des kompatiblen Zubehörs finden Sie in der Zubehörbroschüre,
Artikelnummer: 68015000182. Das Dokument erhalten Sie von Ihrem Dienstanbieter.

SIEHE AUCH

Interaktionen zwischen Bedienköpfen

Doppelter Bedienkopf

2.3 display
In diesem Abschnitt werden die Elemente auf dem Startbildschirm Ihres Funkgeräts vorgestellt.

Tabelle 2-5 display

Kommentar Beschreibung
1 Bereich für Statussymbol

2 Bereich für Textanzeige

3 BEREICH FÜR AUSWAHLTASTE

4 MENÜ/Kontextmenü-Symbol
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2.3.1 Display-Ausrichtung

Die Farbe der AUSWAHLTASTEN informiert Sie über den Modus oder Zustand, in dem sich Ihr Gerät befindet.

Tabelle 2-6 Farben der AUSWAHLTASTEN

Farbe Modus oder Zustand
Hellblau Normaler TMO- und DMO-Modus

Hellrot Notfallmodus oder Katastrophenalarm-Anruf

Olivgrün Local Site Trunking-Modus (Bündelfunk in der lokalen Funkzelle)

Gelb Vorfall – Standby

Rot Vorfall – Alarm

Grün Vorfall – Angenommen

Blau Radio Messaging Service (RMS)

Grau Radio User Assignment (RUA) – Begrenzter Dienst

SIEHE AUCH

display

Datum und Uhrzeit auf dem Display einstellen

2.3.1 Display-Ausrichtung
Die Anzeige auf dem Telefon-Bedienkopf kann gedreht werden, wodurch sich die Lesbarkeit erhöht und der
Betrieb erleichtert wird. Standardmäßig:

• Wenn sich der TSCH nicht auf der Gabel befindet, ist die Display-Ausrichtung immer Hochformat.

• Wenn der TSCH sich auf der Gabel befindet, kann die Display-Ausrichtung eine der folgenden Positionen
einnehmen (je nach Konfiguration des Dienstanbieters):

– Festes Hochformat

– Im Uhrzeigersinn

– Gegen den Uhrzeigersinn

2.4 Statussymbole
Statussymbole werden angezeigt, wenn Ihr Funkgerät bestimmte Vorgänge durchführt oder wenn Sie bestimmte
Funktionen aktiviert haben.

Die Symbole können normal oder groß angezeigt werden. Um große Statussymbole manuell zu
aktivieren/deaktivieren, gehen Sie zuMenü → Einstellungen → Erweiterte StatussymbolenAnzeigeErweiterte
Statussymbole.
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Ausführliche Bedienungsanleitung

Tabelle 2-7 Statussymbole

Symbol Beschreibung

Bündelfunkbetrieb

In Betrieb (Signalstärke): Mit dieser Option können Sie die Signalstärke prüfen. Mehr
Balken zeigen ein stärkeres Signal an.

Kein Dienst

Migration: Wird angezeigt, wenn Ihr Funkgerät bei einem fremden Netzwerk registriert
wird.

Broadcast-Anruf: Wird angezeigt, wenn das Funkgerät einen Broadcast-Anruf tätigt.

Gateway-Modus: Wird angezeigt, wenn das Funkgerät als Gateway im Gateway-Modus
arbeitet.

Scannen: Weist darauf hin, dass für das Funkgerät das Gesprächsgruppen-Scanning
aktiviert wurde.

Prioritätssuche: Weist darauf hin, dass für das Funkgerät die Prioritätssuche aktiviert
wurde.

Daten verbunden: Wird angezeigt, wenn die Paketdatenfunktion aktiviert ist und das
externe Gerät eine Datenverbindung zum Funkgerät aufbaut.

Daten senden/empfangen: Wird angezeigt, wenn die Paketdatenfunktion aktiviert ist und
das externe Gerät eine Datenverbindung zum Funkgerät aufbaut.

• Keine Zahl: Standby-Datensitzung.

• Zahl 1, 2, 3 oder 4: Zeigt die aktive Datensitzungen mit 25 %, 50 %, 75 %, oder
100 % Bandbreite an.

Direktmodusbetrieb (DMO)

Direktmodus-Ruf: Wird während eines Anrufs im Direktmodus angezeigt; mehr Balken
bedeuten ein stärkeres Signal.

Direktmodus: Wird angezeigt, wenn sich das Funkgerät im Direktmodus befindet.

Repeater-Modus: Wird angezeigt, wenn das Funkgerät als Repeater im Repeater-Modus
arbeitet.

DMO-Gateway-Kommunikationsmodus: Zeigt an, dass ein Gateway ausgewählt ist. Das
Symbol kann folgende Zustände aufweisen:

• Durchgehend: Wenn das Funkgerät mit dem Gateway synchronisiert ist.

• Blinkt: Wenn das Funkgerät nicht synchronisiert ist oder beim Anschließen.

• Kein Symbol: Während eines Anrufs zwischen zwei Funkgeräten oder eines
Repeater-Anrufs.
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2.4 Statussymbole

Tabelle 2-7 Statussymbole (Fortsetzung)

Symbol Beschreibung

DMO-Repeater-Kommunikationsmodus: Wird angezeigt, wenn eine der Optionen
Repeater oder GW + Rep. im DMO-Modus ausgewählt ist. Dieses Symbol kann
folgende Zustände aufweisen:

• Durchgehend: Wenn das Funkgerät den Repeater erfasst hat (Beispiel: Das Gerät
empfängt ein Präsenzsignal).

• Blinkt: wenn das Funkgerät den Repeater nicht erkannt hat oder beim Anschließen.

• Kein Symbol: während eines Anrufs zwischen zwei Funkgeräten oder eines
Gateway-Anrufs.

Allgemeine Symbole

Alle Töne aus/Duplex- und Simplex-Ton stummgeschaltet: Zeigt an, dass alle Alarmtöne
ausgeschaltet und die Lautstärken der Simplex- /Duplex-Klingeltöne auf 0 gesetzt sind.

Simplex-Ton stummgeschaltet: Zeigt an, dass die Simplex-Klingeltonlautstärke auf 0
gesetzt ist und die Duplex-Klingeltonlautstärke größer als 0 ist.

Duplex-Ton stummgeschaltet: Zeigt an, dass die Duplex-Klingeltonlautstärke auf 0 gesetzt
ist und die Simplex-Klingeltonlautstärke größer als 0 ist.

Lautsprecher aus (Leise): Zeigt an, dass kein Audio über den Lautsprecher ausgegeben
wird.

Kopfhörer angeschlossen: Zeigt an, dass der Kopfhörer angeschlossen ist.

Hupsignal und Lichtzeichen: Zeigt an, dass ein externer Alarm (z. B. Hupsignal und
Lichtzeichen) aktiviert ist.

GPS: Weist darauf hin, dass gültige Positionskoordinaten empfangen werden.

RUI angemeldet: Gibt an, dass Sie sich beim Funkgerät angemeldet haben.

RUI Pseudo-Anmeldung: Zeigt an, dass Sie sich im Pseudo-Anmeldestatus befinden.

RUI-Paketdaten: Zeigt den Pseudo-Anmeldestatus an, wenn die Paketdatenfunktion
aktiviert ist und das externe Gerät eine Datenverbindung mit dem Funkgerät herstellt.

• Keine Zahl: Standby-Datensitzung.

• Zahl 1, 2, 3 oder 4: Zeigt die aktive Datensitzungen mit 25 %, 50 %, 75 %, oder
100 % Bandbreite an.

RUI-Paketdaten: Zeigt den Pseudo-Anmeldestatus an, wenn die Paketdatenfunktion
aktiviert ist und das externe Gerät eine Datenverbindung mit dem Funkgerät herstellt.

Notfall: Wird angezeigt, wenn das Funkgerät im Notrufbetrieb ist.

Alarmruf bei Katastrophen: Wird angezeigt, während das Funkgerät im Alarmzustand
bei Katastrophen ist.

Liste durchblättern: Wird angezeigt, um darauf hinzuweisen, dass der DREHKNOPF
im Modus Liste durchblättern ist.

Neue Nachricht empfangen: Zeigt ein neue Nachricht an.
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Ausführliche Bedienungsanleitung

Tabelle 2-7 Statussymbole (Fortsetzung)

Symbol Beschreibung

Neue Nachricht(en) in Eingang: Zeigt an, dass Sie ungelesene Nachrichten in Ihrem
Eingang haben.

Ungelesene (Neue) WAP-Nachricht: Zeigt an, dass eine neue Seite in den Browser
geladen wurde.

Vorfall: Zeigt eine Vorfallwarnung an.

Vorfall-Alarm eingegangen: Zeigt den Eingang einer neuen Vorfall-Nachricht an.

Vorfall-Alarm ungelesen: Zeigt eine ungelesene Warnung in der Vorf.Mld-Box an.

Verschlüsselung aus
Blinkt, um darauf hinzuweisen, dass die End-to-End-Verschlüsselung der SIM-Karte im
DMO- und TMO-Modus deaktiviert ist.

Verschlüsselung an
Durchgehend, um darauf hinzuweisen, dass die End-to-End-Verschlüsselung der
SIM-Karte im TMO-Modus aktiviert ist.

oder Verschlüsselung an
Durchgehend, um darauf hinzuweisen, dass die End-to-End-Verschlüsselung der
SIM-Karte im DMO-Modus aktiviert ist. Die Zahlen 1 und 2 weisen auf den ausgewählten
Typ der DMO-Verschlüsselungsschlüssel hin.

Ungelesene (Neue) WAP-Nachricht – Weist darauf hin, dass sie dieWAP-Box noch nicht
aufgerufen haben, seit die letzte WAP-Nachricht empfangen wurde (blinkt, wenn die
Priorität Hoch ist).

WAP-Nachrichtensymbol: Wird neben der Priorität in der Nachrichtenliste angezeigt.

WAP-Nachrichtenzeit: Wird neben dem Erstellungsdatum in der Nachrichtenliste
angezeigt.

WAP-Nachrichtenablauf: Wird neben dem Ablaufdatum in der Nachrichtenliste angezeigt.

WAP-Nachrichtentitelsymbol – Wird neben der Überschrift und dem Text in der
Nachrichtenliste angezeigt.

Tasten gesperrt: Zeigt an, dass Tasten gesperrt wurden.

Nicht sicherer Anruf: Drahtlose Verschlüsselung nicht verfügbar
Blinkt, um darauf hinzuweisen, dass keine drahtlose Verschlüsselung verfügbar ist, wenn
das Funkgerät:

• Befindet sich im Local Site Trunking-Modus.

• Versucht, eine Verbindung zu einem Gateway herzustellen.

Nicht sicherer Anruf: Drahtlose Verschlüsselung nicht verfügbar
Blinkt abwechselnd, um darauf hinzuweisen, dass keine drahtlose Verschlüsselung
verfügbar ist, wenn das Funkgerät:

• im TMO-Modus ist

• über ein Gateway kommuniziert
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2.4 Statussymbole

Tabelle 2-7 Statussymbole (Fortsetzung)

Symbol Beschreibung

Nicht sicherer Anruf: Drahtlose Verschlüsselung nicht verfügbar
Blinkt, um darauf hinzuweisen, dass keine drahtlose Verschlüsselung im DMO-Modus
verfügbar ist. Das Symbol wird angezeigt, nachdem die PTT-Taste gedrückt wurde.

Fernsteuerung
Zeigt an, dass das Gerät per Remote-Zugriff gesteuert und einige Befehle im Hintergrund
ausgeführt werden. Beispiel: Das Gerät wird über spezielle SDS-Nachrichten gesteuert,
oder das Senden eines GPS-Standortberichts wird ausgelöst.

Erweiterter Doppelbedienkopf

Doppelter Bedienkopf: Weist darauf hin, dass die doppelte Bedienkopf-Funktion aktiviert
ist und beide Bedienköpfe mit dem Transceiver verbunden sind.

Einzelner Bedienkopf: Weist darauf hin, dass die doppelte Bedienkopf-Funktion aktiviert
ist, aber nur ein Bedienkopf mit dem Transceiver verbunden ist.

Verbindungsfehler – Zeigt an, dass die Verbindung zwischen dem Bedienkopf und dem
Transceiver unterbrochen ist, z. B. aufgrund eines Fehlers.

Tastendruck-Token: Gibt im doppelten Bedienkopf-Betrieb durch ein blinkendes Symbol
an, dass das Tastendruck-Token durch einen der Bedienköpfe reserviert ist.

CH1: Weist darauf hin, dass Aktivitäten/Einstellungen für Bedienkopf 1 gelten.
Bedienkopf 1 ist ein Bedienkopf, der mit Anschluss 1 des Erweiterungskopfes verbunden
ist.

CH2: Weist darauf hin, dass Aktivitäten/Einstellungen für Bedienkopf 2 gelten.
Bedienkopf 2 ist ein Bedienkopf, der mit Anschluss 2 des Erweiterungskopfes verbunden
ist.

Lautsprecher 1 aus (Leise): Gibt an, dass der Ton nicht über den Lautsprecher von
Bedienkopf 1 ausgegeben wird.

Lautsprecher 2 aus (Leise): Gibt an, dass der Ton nicht über den Lautsprecher von
Bedienkopf 2 ausgegeben wird.

Lautsprecher aus (Leise): Gibt an, dass die Lautsprecher der beiden Bedienköpfe
ausgeschaltet sind.

Alle Töne aus/Duplex- und Simplex-Ton stummgeschaltet: Zeigt an, dass alle
Alarmtöne ausgeschaltet sind oder die Simplex-Klingeltonlautstärke auf 0 gesetzt ist und
Duplex-Klingeltonlautstärke auf 0 gesetzt ist. Gilt für Bedienkopf 1.

Simplex-Ton stummgeschaltet: Zeigt an, dass die Simplex-Klingeltonlautstärke auf 0
gesetzt ist und die Duplex-Klingeltonlautstärke größer als 0 ist. Gilt für Bedienkopf 1.

Duplex-Ton stummgeschaltet: Zeigt an, dass die Duplex-Klingeltonlautstärke auf 0 gesetzt
ist und die Simplex-Klingeltonlautstärke größer als 0 ist. Gilt für Bedienkopf 1.

Alle Töne aus/Duplex- und Simplex-Ton stummgeschaltet: Zeigt an, dass alle
Alarmtöne ausgeschaltet sind oder die Simplex-Klingeltonlautstärke auf 0 gesetzt ist und
Duplex-Klingeltonlautstärke auf 0 gesetzt ist. Gilt für Bedienkopf 2.
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Ausführliche Bedienungsanleitung

Tabelle 2-7 Statussymbole (Fortsetzung)

Symbol Beschreibung

Simplex-Ton stummgeschaltet: Zeigt an, dass die Simplex-Klingeltonlautstärke auf 0
gesetzt ist und die Duplex-Klingeltonlautstärke größer als 0 ist. Gilt für Bedienkopf 2.

Duplex-Ton stummgeschaltet: Zeigt an, dass die Duplex-Klingeltonlautstärke auf 0 gesetzt
ist und die Simplex-Klingeltonlautstärke größer als 0 ist. Gilt für Bedienkopf 2.

SIEHE AUCH

Drahtlose Verschlüsselung

2.5 Das Funkgerät einschalten
Durchzuführende Schritte

1 Halten Sie die EINSCHALTETASTE gedrückt,.

2 Ihr Funkgerät führt eine Selbstdiagnose und Registrierungsroutine durch.

3 Nach der erfolgreichen Registrierung ist das Funkgerät in Betrieb.

HINWEIS

Das Funkgerät schaltet sich ohne sichtbare und akustische Signale ein, wenn verdeckter Modus aktiviert ist.

2.6 PIN-Code-Authentifizierung
Das Funkgerät verfügt über aktive PIN-Code-Authentifizierung, um die Sicherheit zu erhöhen und Ihr Funkgerät
vor unbefugter Nutzung zu schützen. Der PIN-Code wird aus der SIM-Karte gelesen und kann nicht geändert oder
deaktiviert werden. Wenn Sie die Sperre des Funkmoduls nicht aufheben können, können Sie keine Anrufe senden
oder empfangen und auch nicht mit dem DREHKNOPF die Lautstärke einstellen.

Sie werden jedes Mal aufgefordert, den PIN-Code einzugeben, wenn Sie das Funkgerät einschalten.

SIEHE AUCH

Text schreiben

2.6.1 Die Blockierung des Geräts aufheben
Voraussetzung:
Sie haben das Funkgerät durch dreimalige Eingabe eines falschen PIN-Codes blockiert (standardmäßig aktiviert).
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2.7 Die Tasten sperren/entsperren

Durchzuführende Schritte

1 Das Funkgerät zeigt Gerät blockiertPUK eing. an.

2 Geben Sie den 8-stelligen PUK-Code (persönlicher Entsperrungscode) ein.

HINWEIS

Der PUK-Code ist ein 8-stelliger Master-Code, der von Ihrem Dienstanbieter zur Verfügung gestellt wurde.

3 Geben Sie den neuen PIN-Code zweimal ein.

2.7 Die Tasten sperren/entsperren
Drücken Sie MENÜ und * .

HINWEIS

Die Taste NOTFALL ist nicht gesperrt. Bei Aufrufen des Notfallmodus werden alle Tasten entsperrt.
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Ausführliche Bedienungsanleitung

SIEHE AUCH

Die Tastensperre einrichten

2.8 Den TMO/DMO-Modus aufrufen
Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Wählen Sie Trunk-Modus/Direkt-Modus.

SIEHE AUCH

Netzwerke

Den Netzwerkbetriebsmodus verwenden

2.9 Sendesperrenmodus
Im Sendesperrenmodus sendet das Funkgerät keine Funkübertragungen. Es wird empfohlen, diesen Modus in
RF-empfindlichen Bereichen zu aktivieren, in denen die Sicherheit aufgrund der Strahlung gefährdet werden kann,
z. B. in Krankenhäusern und Flugzeugen.

Wählen Sie zum Aktivieren des ModusMENÜ→ Netze → TXI-Modus → Deaktivieren.

In diesem Modus sendet das Gerät unter keinen Umständen Übertragungen, außer bei einem Notruf. Alle
Funktionen und Tasten, die eine Übertragung auslösen würden, sind deaktiviert, z. B Registrierung am Netzwerk,
Ändern der Gesprächsgruppe oder des Ordners, Senden von SDS-Nachrichten oder die PTT-Taste. Wenn versucht
wird, eine Übertragung zu senden, wird im Gerät die Meldung Im TXI-Mod. nicht erlaubt angezeigt und ein
Signalton ausgegeben.

Folgendes kann von Ihrem Gerät weiterhin empfangen werden:

• Gruppenrufe.

• Gespeicherte Nachrichten im Eingang.

• Private Anrufversuche, die in der Liste Verpaßte Rufe gespeichert werden, wobei diese nicht beantwortet
werden können.

Wenn keine Gefahr mehr für die Sicherheit besteht (wenn Sie beispielsweise den RF-empfindlichen Bereich
verlassen), können Sie den Sendesperrenmodus wieder deaktivieren. Das Gerät wechselt daraufhin in den
Normalbetrieb zurück.

Sie können den Modus deaktivieren durch Auswahl vonMENÜ→ Netzwerke → TXI-Modus → Deaktivieren,
durch Drücken der Zielwahltaste oder implizit durch Starten eines Notrufs.
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2.10 Eine Gesprächsgruppe auswählen

HINWEIS

RF-Übertragungen vom Gerät werden unter folgenden Bedingungen verhindert:

• Der TXI-Modus ist aktiviert.

• Das Funkgerät ist ausgeschaltet.

2.10 Eine Gesprächsgruppe auswählen
Verwenden Sie auf dem Startbildschirm eine der folgenden Methoden:

• Drücken Sie die NAVIGATIONSTASTEN nach links oder rechts. Drücken Sie aufWählen, um die
Auswahl zu bestätigen.

• Wählen Sie Option → Grp n. ABC. Geben Sie einen Gesprächsgruppennamen ein und wählen Sie die
Gesprächsgruppe aus der Liste aus.

• Wählen Sie Option → Grp nach Ord.. Wählen Sie einen Ordner und dann einen Gesprächsgruppennamen
aus.

• Drücken Sie den DREHKNOPF und drehen Sie ihn, bis der erforderliche Gesprächsgruppenname angezeigt
wird. Drücken Sie aufWählen, um die Auswahl zu bestätigen.

HINWEIS

Wenn der DREHKNOPF-Modus auf die Einstellung Blättern gesetzt ist, dann brauchen Sie ihn
nicht zu drücken, um diesen Modus einzustellen.

HINWEIS

Das Funkgerät kann auf bis zu drei Ebenen der Ordnerstruktur Zugriff haben.

2.11 Den zeitgesteuerten Gesprächsgruppenwechsel
verwenden

Diese Funktion ermöglicht Ihnen das Wechseln zwischen der ursprünglichen und einer vordefinierten
Gesprächsgruppe (TMO oder DMO) für eine bestimmte Zeit mit einer One-Touch-Taste. Nach Ablauf des
Zeitgebers kehrt das Gerät zu der zuvor angehängten Gesprächsgruppe zurück.

Voraussetzung:
Der zeitgesteuerte Gesprächsgruppenwechsel wurde der One-Touch-Tastezugeordnet.
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Durchzuführende Schritte

1 Drücken Sie und halten Sie die One-Touch-Taste gedrückt.

2 Ihr Gerät schaltet für eine bestimmte Zeit zu der anderen Gesprächsgruppe um.

HINWEIS

Drücken Sie zum Starten eines Gruppenanrufs auf PTT.

Ihr Dienstanbieter kann einem zweiten Druck der One-Touch-Taste eine der folgenden Funktionen
zuweisen:

• Zur ursprünglichen Gesprächsgruppe zurückkehren

• Vorgegebene Zeit neu starten

• Keine Aktion

3 Wenn der Gruppenanruf beendet ist, kehrt das Gerät nach Ablauf der festgelegten Zeit zur ursprünglichen
Gesprächsgruppe zurück.

2.12 Den Gesprächsgruppen-Scan aktivieren
Anwendungsgebiete:
Wenn Sie alle TMO-Gruppenanruf in der definierten Gesprächsgruppenliste überwachen möchten.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Gruppen-Einst. → Scan → Scannen.

3 Wählen Sie Liste wählen und danach einen Listenamen aus.
Schrittergebnis: Ihr Funkgerät zeigt den Listenamen als Gewählt an.

4 Wählen Sie Scannen → Ein.

Ergebnis:
Das Funkgerät scannt die vordefinierte Scan-Liste.
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2.13 Ansageanruf

SIEHE AUCH

Scannen

2.13 Ansageanruf
Der Gruppenansageanruf (auch als standortübergreifender Anruf bezeichnet) ist ein Gruppenanruf mit hoher
Priorität, den der Konsolenbediener (oder Verteiler) an alle Benutzer eines oder mehrerer Standorte absetzt. Die
Geräte sind so konfiguriert, dass sie einen Ansageanruf empfangen, aber nicht darauf antworten können. Der Anruf
kann als normaler Ansageanruf oder als Notrufansage empfangen werden. Der Ansageanruf hat Vorrang gegenüber
aktuell durchgeführten Gruppenanrufen, die die gleiche oder eine niedrigere Priorität aufweisen.

2.14 Mithöranruf
Diese Funktion erlaubt es dem Dispatcher, einen speziellen Anruf zu tätigen, dank dem er die Gespräche und die
Hintergrundgeräusche im Bereich eines bestimmten Gerätemikrofons mithören kann. Der Anruf wird ohne eine
entsprechende Anzeige an dem jeweiligen Funkgerät eingeleitet und kann laufende Sprachanrufe mit geringerer
Priorität oder die Übertragung von Paketdaten vorzeitig abbrechen.

Nach der Annahme des Anrufs erfolgt die Übertragung von dem Gerät als Simplex-Anruf. Der Benutzer muss
hierfür keine Maßnahmen treffen, und er wird von der Übertragung auch nicht in Kenntnis gesetzt. Der Mithöranruf
wird automatisch beendet, wenn Sie einen Sprachanruf einleiten, in den Notfall- oder TXI-Modus wechseln,
oder einen Notfallalarm senden.

2.15 One-Touch-Tastenfunktion
Halten Sie zum Verwenden der One-Touch-Tastenfunktion eine zugewiesene Taste gedrückt, um eine der folgenden
Funktionen zu aktivieren:

Tabelle 2-8 One-Touch-Tastenfunktionen

Funktion Beschreibung
Beleuchtung Schaltet die Einstellungen der Hintergrundbeleuchtung ein und aus.

TMO-Gesprächsgruppenscan Schaltet die Funktion „Gesprächsgruppen-Scan“ im TMO-Modus
ein oder aus.

DMO/TMO-Schalter Wechselt zwischen TMO- und DMO-Modus.

Status senden Sendet eine dedizierte Statusmeldung an eine dedizierte Adresse.

Gesprächsgruppe wechseln Ändert die Gesprächsgruppe in die von Ihrem Dienstanbieter
vordefinierte Gesprächsgruppe.

Geringe/Hohe Lautstärke Setzt die Lautstärke auf laut oder leise.

Benutzerdefinierte Nachricht senden Sendet eine vordefinierte/benutzerdefinierte Vorlage an eine
dedizierte Adresse.

Sendesperre (TXI) Schaltet den TXI-Modus ein oder aus.
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Tabelle 2-8 One-Touch-Tastenfunktionen (Fortsetzung)

Funktion Beschreibung
Privatanruf Startet einen Privatanruf an einen vordefinierten Eintrag der

Kontaktliste.

Telefonruf Startet einen Telefonanruf an einen vordefinierten Eintrag der
Kontaktliste.

Nebenstellenruf Startet einen Nebenstellenanruf an einen vordefinierten Eintrag der
Kontaktliste.

Screensaver Schaltet den Bildschirmschoner ein oder aus.

Zeit anzeigen Zeigt Uhrzeit und Datum im Display an.

Tarnmodus (Verdeckter Modus) Schaltet den verdeckten Modus ein oder aus.

Hupsignal und Lichtzeichen Schaltet Hupsignal und Lichtzeichen ein oder aus.

Vorfall-Fallback-Alarm auslösen Sendet einen Fallback-Alarm.

RUA/RUI Meldet Sie an oder ab.

Vorherige Gesprächsgruppe Schaltet das Gerät zurück in die zuvor verwendete Gesprächsgruppe.

OPTA anzeigen Zeigt die operative taktische Adresse an.

End-to-End-Verschlüsselung der
SIM-Karte

Schaltet die End-to-End-Verschlüsselung der SIM-Karte ein oder
aus.

GPS-Statusmeldung Sendet Ihre GPS-Position in Form einer Meldung an eine dedizierte
Adresse.

Repeater-Modus Schaltet den Repeater-Modus ein oder aus.

Gateway-Modus Schaltet den Gateway-Modus ein oder aus.

Standardeinstellungen Setzt alle Geräteeinstellungen auf die Standardeinstellungen zurück.

Lautsprecher beim Anruf
aktivieren/deaktivieren

Ermöglicht die Lautsprecherfunktion während des Anrufs.

Zeitgesteuerte Gesprächsgruppe ändern Ruft die Funktion „Zeitgesteuerte Gesprächsgruppe ändern“ auf.
Während Sie sich in der vordefinierten Gesprächsgruppe befinden,
kann diese der Funktion zugewiesen werden, die beim zweiten
Drücken aktiviert wird.

HSM (Hearer Speaker Microphone) Hörer,
Mikrofon und Lautsprecher

Aktiviert bzw. deaktiviert das HSM-Sekundärzubehör.

PTT-Doppeldruck Sendet den D-PTT-Ton an die aktuell verwendete Gesprächsgruppe.

HINWEIS

Wenn die One-Touch-Tastenfunktion aktiviert ist, ist die Kurzwahl deaktiviert. Wenn einer Taste keine
Funktion zugewiesen ist, zeigt das Gerät die Meldung Taste ohne Zuweisung an.
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2.16 Das Terminal vorübergehend aktivieren/deaktivieren

2.16 Das Terminal vorübergehend
aktivieren/deaktivieren

Ihr Funkgerät ist mit einer Funktion ausgestattet, die es dem Dienstanbieter ermöglicht, das Gerät bei Diebstahl
vorübergehend zu deaktivieren. Wenn Ihr Funkgerät deaktiviert ist oder im deaktivierten Zustand eingeschaltet
wird, verhält es sich optisch und funktional so, als sei es ausgeschaltet.

Wenn Ihr Gerät gefunden wird, kann der Dienstanbieter es wieder drahtlos aktivieren. Nachdem Ihr Gerät wieder
aktiviert wurde, können Sie den normalen Betrieb wieder aufnehmen.

2.17 Terminal dauerhaft deaktivieren
Ihr Funkgerät ist mit einer Funktion ausgestattet, die es dem Dienstanbieter ermöglicht, das Gerät bei Diebstahl
oder Verlust dauerhaft zu deaktivieren. Wenn Ihr Funkgerät dauerhaft deaktiviert wird, kann es nicht mehr
verwendet werden,. Nach einer dauerhaften Deaktivierung kann der Dienstanbieter das Gerät nicht mehr aktivieren.
Es wird empfohlen, die dauerhafte Deaktivierung nur dann zu verwenden, wenn Sie sicher sind, dass das Gerät
nicht wiedergefunden wird. Wenn ein dauerhaft deaktiviertes Gerät wiedergefunden wird, kann es nur neu aktiviert
werden, indem Sie es an Motorola senden.

2.18 Während des Anrufs
Während eines Anrufs weist die Bezeichnung der rechten AUSWAHLTASTE auf die nächste mögliche Änderung
hin. Die Standardeinstellung für Zubehör ist:

Tabelle 2-9 Während des Anrufs

Bezeichnung der
Auswahltaste Audio-Einstellung

Lautsp Die Audio-Ausgabe erfolgt über den Hauptlautsprecher (Lautspr HOCH
wird angezeigt)

Hörer Die Audio-Ausgabe erfolgt am Ohrhörer (Lautspr NIEDRIG wird angezeigt)

2.19 Text schreiben
Immer wenn Sie den Bildschirm für Texteingaben sehen finden Sie weitere Details in diesem Abschnitt.
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SIEHE AUCH

PIN-Code-Authentifizierung

2.19.1 Den Texteingabemodus auswählen
Voraussetzung:
Ihr Funkgerät zeigt den Texteingabeschirm an.

Durchzuführende Schritte

1 Drücken Sie MENÜ → Eingabemodus.

2 Wählen Sie eine der folgenden Optionen aus:
• Primär: Zur Eingabe alphanumerischer Zeichen.
• Numerisch: Zur Eingabe von Zahlen.
• Symbol: Zur Eingabe von Symbolen.
• Sekundär: Zur Eingabe alphanumerischer Zeichen (dieser Modus ist optional; Sie müssen ihn zur Liste

hinzuzufügen). Manchmal kann es erforderlich sein, von einer Sprache in eine andere zu wechseln.

HINWEIS

Sie können im Texteingabebildschirm auch mehrmals auf die Taste # drücken, um zwischen den
verschiedenen Eingabemodi zu wechseln.

2.19.2 Den Texteingabemodus und die Sprache auswählen
Voraussetzung:
Ihr Funkgerät zeigt den Texteingabeschirm an.
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2.19.3 Texteingabesymbole

Durchzuführende Schritte

1 Drücken Sie MENÜ → Eing.Setup.

2 Wählen Sie eine der folgenden Optionen aus:
• TAP: Geben Sie Buchstaben, Zahlen und Symbole durch einfaches oder mehrfaches Drücken einer

alphanumerischen Taste ein.
• iTAP: Das Gerät versucht, die einzelnen Wörter zu erkennen, während Sie auf die alphanumerische

Taste drücken.

HINWEIS

Sie können diese Methoden in den im Gerät programmierten Sprachen verwenden.

2.19.3 Texteingabesymbole
Im Texteingabebildschirm verraten Ihnen Symbole, welcher Modus und welche Methode zur Texteingabe aktiv
sind. Ein Zeichenzähler auf dem Texteingabesymbol zeigt an, welche Anzahl an Zeichen eingegeben werden kann.

Drücken Sie die Taste #, um durch die Texteingabemodi zu wechseln.

Tabelle 2-10 Symbole auf dem Texteingabebildschirm

Primäres Symbol Weitere Symbole Beschreibung

TAP: keine Großbuchstaben

TAP: nur erster Buchstabe groß

TAP: alles Großbuchstaben

iTAP: keine Großbuchstaben

iTAP: nur erster Buchstabe groß

iTAP: alles Großbuchstaben

Numerisches Symbol Beschreibung

Zahlen eingeben.

Symbolisches Symbol Beschreibung

Satzzeichen und Symbole eingeben.
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2.19.4 Tastenverwendung
Liste der Tasten und Zeichen im alphanumerischem Modus (TAP/iTAP).

Tabelle 2-11 Tastenverwendung

Schlüssel Alphanumerischer Modus (TAP/iTAP) Symbolmodus
Tasten 0 bis 9 Numerischer Modus:

• Drücken Sie, um eine Zahl am Einfügepunkt
einzufügen.

• Drücken und halten Sie eine beliebige
Zifferntaste, um den alphanumerischem
TAP-Modus aufzurufen.

• Zum Beenden des alphanumerischem
TAP-Modus halten Sie eine Zifferntaste
gedrückt.

Taste 0 Drücken, um zwischen Einzel-Shift, Feststelltaste
und Kleinbuchstaben zu wechseln.

+ - × * / \ [ ] = < > § #

Taste 1 . , ? ! 0 1 @ ’ ” - ( ) / : _ ; + & % × * = < > € £ $ ¥ ¤ [ ] { } \ ~ ^ ¿ ¡ § #

Taste 2 A B C 2
a b c 2

@ _ \

Taste 3 D E F 3
d e f 3

/ , ;

Taste 4 G H I 4
g h i 4

” & ’

Taste 5 J K L 5
j k l 5

( ) [ ] { }

Taste 6 M N O 6
m n o 6

¿ ¡ ~

Taste 7 P Q R S 7
p q r s 7

= < >

Taste 8 T U V 8
t u v 8

€ £ $ ¥ ¤

Taste 9 W X Y Z 9
w x y z 9

# % *
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2.19.4 Tastenverwendung

Tabelle 2-12 Andere Tasten

Schlüssel Beschreibung

Eine beliebige
Zifferntaste

• Drücken Sie im TAP-Modus eine beliebige Taste, um die Vervollständigung
von Wörtern abzulehnen, und fahren Sie mit der Texteingabe fort. Falls
verfügbar, wird eine neue Vervollständigung angezeigt, nachdem die
Zeitüberschreitung für TAP abläuft.

• Halten Sie die Taste gedrückt, um von TAP oder iTAP alphanumerisch zum
numerischen Modus zu wechseln.

Taste * • Drücken Sie, um ein Leerzeichen einzufügen.

• Drücken Sie die Taste in TAP, um eine Vervollständigung von Wörtern
abzulehnen und ein Leerzeichen einzufügen.

• Geben Sie ein neu erstelltes Wort in das Benutzerwörterbuch ein.

• Gedrückt halten, um einen Zeilenbruch einzufügen.

Taste # • Drücken Sie die Taste einmal, um alle Eingabemodi (Symbol, Numerisch,
Primärund Sekundär (falls konfiguriert) zu durchlaufen.

• Halten Sie sie gedrückt, um zum Standardeingabemodus zurückzukehren.

Wählen Drücken Sie die Taste, um die markierte Auswahl auszuwählen und im
Haupttextbereich abzulegen.

Löschen • Drücken Sie die Taste einmal, um das letzte eingegebene Zeichen zu löschen.

• Halten Sie zum Löschen des gesamten Haupttextbereichs die Taste gedrückt.

NAVIGATIONSTASTE
nach oben

• Drücken Sie diese Taste in TAP, um die Vervollständigung von Wörtern
abzulehnen und nach oben zu blättern.

• Drücken Sie diese Taste in TAP, um einen zuvor eingegebenen
Kleinbuchstaben in einen Großbuchstaben umzuwandeln.

NAVIGATIONSTASTE
nach unten

• Drücken Sie diese Taste in TAP, um die Vervollständigung von Wörtern
abzulehnen und im Textbereich zu blättern.

• Drücken Sie diese Taste in TAP, um einen zuvor eingegebenen
Großbuchstaben in einen Kleinbuchstaben umzuwandeln.

Linke NAVIGATION-
STASTE

• Drücken Sie diese Taste, um nach links zu navigieren. Halten Sie die Taste
gedrückt, um zu wiederholen.

• Wenn in TAP eine Wortvervollständigung verfügbar ist, drücken Sie, um
die Vervollständigung abzulehnen.

Rechte NAVIGATION-
STASTE

• Drücken Sie diese Taste, um nach rechts zu navigieren. Halten Sie die Taste
gedrückt, um zu wiederholen.

• Wenn in TAP eine Wortvervollständigung verfügbar ist, drücken Sie, um die
Vervollständigung zu übernehmen.

MENÜ Wenn ein Kontextmenü aktiv ist, öffnet diese Taste das Kontextmenü.
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2.19.5 Text im alphanumerischen iTAP-Modus schreiben
Voraussetzung:
Ihr Funkgerät zeigt den Texteingabeschirm an.

Anwendungsgebiete:
In diesem Modus können Sie schneller schreiben. Versuchen Sie, Folgendes zu schreiben: David 232!
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2.19.6 Text im alphanumerischen TAP-Modus schreiben

Durchzuführende Schritte

1 Drücken SieMENÜ → Eing.Setup → Prim..

2 Wählen Sie iTAPDeutsch, und drücken Sie auf Zurück.

3 Drücken Sie MENÜ → Eingabemodus.

4 Wählen Sie Primär.

5 Drücken Sie 3.
Schrittergebnis: Die alternative Zeile wird geöffnet und zeigt D E F 3.

6 Fahren Sie mit der Eingabe der Buchstaben fort, und drücken Sie pro Buchstabe eine Taste. Drücken Sie
die Tasten 2, 8, 4 und 3.

HINWEIS

Am Anfang der Nachricht, nach von einem Leerzeichen gefolgten Punkten, und beim ersten Buchstaben
eines Worts, das als neuer Kontakteintrag erzeugt wurde, werden automatisch Großbuchstaben verwendet.

Schrittergebnis: Die alternative Zeile markiert Folgendes: David.

7 Drücken Sie die *-Taste.

8 Drücken Sie auf die Taste 2, und blättern Sie in der alternativen Zeile, indem Sie die rechte
NAVIGATIONSTASTE drücken, bis Sie folgende Stelle erreicht haben: 2.
Schrittergebnis: Der Eingabemodus wechselt automatisch zu Numerisch.

9 Drücken Sie die Tasten 3 und 2.

10 Drücken und halten Sie 1 gedrückt, bis 0 am Ende zu .wechselt.
Schrittergebnis: Die alternative Zeile markiert Folgendes: 232..

11 Blättern Sie in der alternativen Zeile, indem Sie auf die rechte NAVIGATIONSTASTE drücken, bis Sie das
gewünschte Symbol erreicht haben.

12 Drücken Sie auf Wählen.

Ergebnis:
Sie haben Folgendes eingegeben: David 232!.

2.19.6 Text im alphanumerischen TAP-Modus schreiben
Voraussetzung:
Ihr Funkgerät zeigt den Texteingabeschirm an.
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Durchzuführende Schritte

1 Drücken SieMENÜ → Eing.Setup → Seku..

2 Wählen Sie TAPDeutsch, und drücken Sie auf Zurück.

3 Drücken Sie MENÜ → Eingabemodus.

4 Wählen Sie Sekundär.

5 Drücken Sie auf die Taste mit dem gewünschten Zeichen: einmal für das erste Zeichen, zweimal für das
zweite Zeichen und so weiter.

Beispiel:
Wenn Sie den Buchstaben S eingeben möchten, drücken Sie viermal auf die Taste 7. Um die Zahl 7 einzugeben,
drücken Sie fünfmal auf die Taste 7. Wenn Sie für ein paar Sekunden keine Taste mehr drücken, wird das Zeichen
übernommen, und der Cursor wechselt zur nächsten Position.

2.19.7 Wörter sperren
Voraussetzung:
Ihr Funkgerät zeigt den Texteingabeschirm an.

Anwendungsgebiete:
Dient zum Hinzufügen von Wörtern, die nicht im Wörterbuch vorkommen.

Durchzuführende Schritte

1 Drücken Sie MENÜ → Eing.Setup.

2 Wählen Sie iTAPDeutsch.

3 Versuchen Sie, das gewünschte Wort einzugeben. Blättern Sie durch die alternative Zeile, um eine Wortoption
auszuwählen. Die einzelnen Optionen werden sukzessive markiert und teilweise gesperrt.

4 Geben Sie den zweiten Teil des Wortes ein. Der erste Teil bleibt unverändert (gesperrt). Die neu eingetragenen
Buchstaben werden markiert und dann gesperrt, während Sie zur nächsten Wortoption blättern.

5 Drücken Sie die *-Taste. Das Wort wird mit einem Leerzeichen in den Textbereich platziert und automatisch
zum Wörterbuch hinzugefügt.

2.19.8 Wörter zum Wörterbuch hinzufügen
Jede Sprache verfügt über ein eigenes Wörterbuch. Sie können Wörter erstellen (einschließlich alphanumerische
Abkürzungen). Wenn Sie ein Wort gefolgt von einem Leerzeichen eingeben, wird es automatisch im Wörterbuch
gespeichert und erscheint als Auswahl, wenn Sie in Zukunft dieselbe Tastenkombination drücken.
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2.20 Textnachricht auf dem Startdisplay

2.20 Textnachricht auf dem Startdisplay
Ihr Gerät ist mit einer Funktion ausgestattet, die es Ihrem Dienstanbieter ermöglicht, spezielle Textnachrichten an Ihr
Display zu senden. Die Nachricht verbleibt so lange auf der Startseite, bis eine neue Nachricht eingeht. Schalten Sie
Ihr Gerät aus und wieder ein, um die Nachricht auf dem Startdisplay durch die voreingestellte Nachricht zu ersetzen.
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3 Modi
Dieses Kapitel enthält Informationen zu den verfügbaren Modi, in denen das Funkgerät betrieben werden kann.

3.1 Netzwerke verwenden
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze.

3 Wählen Sie eine der folgenden Optionen aus:
• Trunk-Modus

• Direkt-Modus

• Repeater-Mod.

• Gateway

• TXI-Modus

Ergebnis:
Das Gerät wechselt in den ausgewählten Modus.

3.2 Bündelfunkbetrieb
Der Bündelfunkbetrieb erfordert eine Schalt- und Verwaltungsinfrastruktur. Diese Betriebsart ermöglicht
verschiedene Sprach- und Datenkommunikationstypen (darunter Gruppenrufe undShort Data Service-Nachrichten)
und den Zugriff auf infrastrukturrelevante Funktionen (z. B. Paketdaten).
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Abbildung 3-1 Bündelfunkbetrieb

3.2.1 Den TMO-Modus aufrufen

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Wählen Sie Trunk-Modus aus.

3.2.2 Eine Gesprächsgruppe auswählen
Verwenden Sie auf dem Startbildschirm eine der folgenden Methoden:

• Drücken Sie die NAVIGATIONSTASTEN nach links oder rechts. Drücken Sie aufWählen, um die
Auswahl zu bestätigen.

• Wählen Sie Option → Grp n. ABC. Geben Sie einen Gesprächsgruppennamen ein und wählen Sie die
Gesprächsgruppe aus der Liste aus.

• Wählen Sie Option → Grp nach Ord.. Wählen Sie einen Ordner und dann einen Gesprächsgruppennamen
aus.

• Drücken Sie den DREHKNOPF und drehen Sie ihn, bis der erforderliche Gesprächsgruppenname angezeigt
wird. Drücken Sie aufWählen, um die Auswahl zu bestätigen.

HINWEIS

Wenn der DREHKNOPF-Modus auf die Einstellung Blättern gesetzt ist, dann brauchen Sie ihn
nicht zu drücken, um diesen Modus einzustellen.
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3.2.3 Einen Gruppenanruf im TMO-Modus tätigen

HINWEIS

Das Funkgerät kann auf bis zu drei Ebenen der Ordnerstruktur Zugriff haben.

3.2.3 Einen Gruppenanruf im TMO-Modus tätigen
Der Gruppenanruf wird von allen Mitgliedern der ausgewählten Gruppe empfangen, deren Gerät eingeschaltet ist
und sich in Reichweite befindet.

Durchzuführende Schritte

1 Halten Sie die Sendetaste PTT gedrückt.

2 Warten Sie, bis der Signalton für Gesprächsberechtigung ertönt (falls konfiguriert), und sprechen Sie dann in
das Mikrofon. Lassen Sie die PTT-Taste los, um zuzuhören.

HINWEIS

Wenn Sie einen Gruppenanruf abbrechen möchten, führen Sie einen der folgenden Schritte aus, bevor die
Gesprächsgenehmigung erteilt wird (je nach Dienstanbieter-Einstellungen):

• Lassen Sie die PTT-Taste los.
• Drücken Sie die Taste ENDE (Standardeinstellung).

Nachdem der Anruf abgebrochen wurde, zeigt das Gerät Ruf abgebrochen an (sofern von Ihrem
Dienstanbieter konfiguriert).

3.2.4 Einen Gruppenanruf im inaktiven Zustand empfangen
Durchzuführende Schritte

1 Das Funkgerät erhält einen Gruppenanruf.

HINWEIS

Der eingehende Gruppenanruf wird durch den Ton Gruppenanruf empfangen signalisiert.

2 Um zu antworten, halten Sie die PTT-Taste gedrückt.

3.2.5 Einen Gruppenanruf während eines laufenden
Gruppenanrufs empfangen

Während ein Gruppenruf läuft empfängt Ihr Funkgerät einen Gruppenruf mit einer höheren Priorität.
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Eines der folgenden Ereignisse tritt ein:

• Das Funkgerät ist gezwungen, den aktuellen Gruppenanruf zu beenden und automatisch den ankommenden
anzunehmen.

• Das Funkgerät zeigt einen eingehenden Gruppenanruf auf dem Bildschirm mit Optionen an:

– Beitret.: Beendet den aktuellen Gruppenanruf und startet den ankommenden.

– Ende: Bricht den eingehenden Gruppenanruf ab.

3.2.6 Dynamische Gruppennummernvergabe (DGNA)
Mithilfe von DGNA können Netzbetreiber die Gesprächsgruppen auf Ihrem Gerät dynamisch über die
Luftschnittstelle verwalten. Mithilfe von DGNA kann der Netzbetreiber folgende Aktionen durchführen:

• Gesprächsgruppen hinzufügen

• Gesprächsgruppen anhängen oder neu hinzugefügte Gesprächsgruppen auswählen

• Gesprächsgruppen löschen

• Parameter vorhandener Gesprächsgruppen ändern

All diese Maßnahmen werden durch Übertragen von Daten an Ihr Gerät durchgeführt.

3.2.7 DGNA-Empfang
Beim Empfang einer DGNA-Meldung gibt das Gerät einen Signalton aus, und die Meldung Gruppenliste
aktualisiert wird angezeigt. Sofern diese Option von Ihrem Dienstanbieter aktiviert wurde, zeigt Ihr Gerät alle
hinzugefügten und gelöschten Gesprächsgruppenlisten an.

Wenn Ihr Dienstanbieter die aktuell gewählte Gesprächsgruppe löscht (die Zuordnung aufhebt), führt das
Funkgerät, je nach Einstellung, folgende Schritte aus:

• Es schließt sich der zuletzt gewählten Gesprächsgruppe an.

• Es wechselt in den Keine Gruppe-Status.

Wenn allerdings die erste Option konfiguriert wurde und das Funkgerät die zuletzt gewählte Gesprächsgruppe
verliert (Beispiele: Nach einem Aus-/Einschalten oder wenn die Gesprächsgruppe vom Dienstanbieter gelöscht
wurde), wechselt das Funkgerät auch in den Keine Gruppe-Status.

Wenn eine DGNA-Meldung zum Löschen aller Gesprächsgruppen empfangen wird, zeigt Ihr Gerät die Meldung
Alle Gruppen gelöscht an. Sie können die DGNA-Anzeige mit dem SOFTKEYZurück oder der Taste ENDE
verlassen.

3.2.8 DGNA Automatische Gruppenauswahl
Wenn die automatische DGNA-Auswahl konfiguriert ist, wechselt das Funkgerät beim Empfang einer DGNA zur
hinzugefügten Gesprächsgruppe.
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3.2.9 DGNA Gruppe automatisch neu auswählen

3.2.9 DGNA Gruppe automatisch neu auswählen
Wenn die DGNA-Funktion zur automatischen Wiederauswahl konfiguriert ist, kehrt das Funkgerät immer, wenn
eine Gesprächsgruppe vom Netzwerkbetreiber über DGNA ohne Benutzeraktion getrennt wird, zu der zuvor
gewählten Gruppe zurück.

3.2.10 DGNA-Gesprächsgruppen anzeigen
Voraussetzung:
Das Funkgerät empfängt die DGNA-Nachricht.

Durchzuführende Schritte

1 Zum Anzeigen der hinzugefügten Gesprächsgruppendetails drücken Sie Zeigen.

2 Blättern Sie durch die Liste zur Auswahl der gewünschten Gesprächsgruppe.

3 Um die DGNA-Gruppe auszuwählen, drücken Sie Anlage.

3.2.11 Broadcast-Anruf durch Benutzer eingeleitet
Mit dieser Funktion können Sie einen Broadcast-Anruf vom Funkgerät tätigen, der in der vordefinierten
Gesprächsgruppe gestartet wird. Ihr Dienstanbieter definiert den Aliasnamen und die Priorität des Broadcast-Anrufs.

HINWEIS

Wenn der Typ der Verschlüsselung von der SIM-Karte definiert wird, ist der Broadcast-Anruf immer
unverschlüsselt. Andernfalls, wenn das Funkgerät einen anderen Verschlüsselungsdienst verwendet,
hängt der verwendete Verschlüsselungstyp während des Anrufs von den Verschlüsselungseinstellungen
des Dienstes ab.

HINWEIS

Diese Funktion wird in der Dimetra-Infrastruktur nicht unterstützt.
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3.2.12 Einen Ansageanruf initialisieren
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sonderrufe → Durchsageruf.
Schrittergebnis: Ihr Gerät zeigt die vordefinierten Aliasnamen und das Symbol für den Ansageanruf an.

3 Um den Anruf zu starten, drücken Sie die PTT-Taste.

3.2.13 Telefon- und TK-Anrufe
Mit Telefonanrufen können Sie Festnetznummern oder ein Mobiltelefonnummern anrufen. Mit TK-Anrufen
(Nebenstellenanlage) können Sie lokale Nebenstellennummern (z. B. Büro) anrufen.

3.2.14 Privatanruf
Der Privatanruf, auch als Point-to-Point- oder individueller Anruf bezeichnet, ermöglicht Anrufe zwischen zwei
Personen. Keine anderes Funkmodul kann die Unterhaltung hören. Diese Anruftyp kann grundsätzlich über
zwei Wege erfolgen:

• Duplex-Anruf (sofern durch System zugelassen) im TMO-Modus. Beide Parteien können gleichzeitig
sprechen.

• Simplex-Anruf im TMO- oder DMO-Modus. Nur eine Seite kann sprechen.

Wenn ein DMO-Privatanruf erfolgt, empfangen Funkmodule, die nicht an diesem Anruf beteiligt sind, das
Besetztzeichen für den Kanal. Die Funkgeräte werden über die Funkgerätenummer identifiziert.

Zusammenspiel mit Zubehörgeräten:

• Erstes Mikrofon — falls Sie während des Privatanrufs das Mikrofon am Clip einhängen, wird das Gespräch
beendet oder die Sprachausgabe Audio schaltet auf die Lautsprecher (falls vorhanden) um. Das genaue
Verhalten hängt von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

• Telefon-Handapparat: Wenn Sie während des Privatanrufs den Handapparat in den Halter stecken, wird das
Gespräch beendet oder der Ton schaltet auf die Lautsprecher (falls vorhanden). Das genaue Verhalten hängt
von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

HINWEIS

Um den Privatanruf zu beenden, wenn die Sprachausgabe auf den Lautsprecher umgeschaltet wurde,
drücken Sie die Taste EIN/AUS/ENDE/BEENDEN.

Um einen Privatanruf anzunehmen, verwenden Sie eine der folgenden Methoden:

• Drücken Sie auf die PTT-Taste.
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3.2.15 Durchführen eines Privatanrufs

• Nehmen Sie das erste Mikrofon oder Telefon-Mobilteil ab. Wenn sich das Mobilteil nicht auf der Gabel
befindet, wird der externe Lautsprecher des Funkmoduls stummgeschaltet und der interne Lautsprecher
des Mobilteils aktiviert.

• Drücken Sie die Taste SENDEN am Bedienkopf. Sprache wird zu den Audio-Eingangsgeräten in der
folgenden Reihenfolge weitergeleitet, je nach Verfügbarkeit:

1. Gesichtsvisier-Mikrofon.

2. Mikrofon des Geräts, das abgenommen wurde.

3. Das Mikrofon, das zuletzt verwendet wurde (wenn zwei Geräte abgenommen wurden).

3.2.15 Durchführen eines Privatanrufs
Durchzuführende Schritte

1 Drücken/Halten Sie auf der Startseite und geben Sie die Nummer ein.

2 Wenn Einzelruf nicht als erster Anruftyp angezeigt wird, drücken Sie solange auf R-Typ, bis der gewünschte
Typ angezeigt wird, und wählen Sie ihn aus.

3 Gehen Sie in den jeweiligen Modi folgendermaßen vor:
a. TMO: Drücken Sie zum Durchführen eines Simplex-Anrufs kurz die PTT-Taste. Sie hören ein

Rufzeichen. Halten Sie anderenfalls die PTT-Taste gedrückt. Warten Sie, bis das Zeichen für die erteilte
Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die PTT-Taste los, um
zuzuhören. Drücken Sie zum Durchführen eines Duplex-Anrufs kurz die SENDETASTE. Sie hören
ein Rufzeichen.

b. DMO: Nur Simplex-Anrufe sind möglich. Halten Sie die Sendetaste PTT gedrückt. Warten Sie, bis das
Zeichen für die erteilte Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die
PTT-Taste los, um zuzuhören.

4 Um den Anruf zu beenden, drücken Sie die Taste ENDE.

HINWEIS

Wenn Sie das erste Mikrofon oder das Telefon-Mobilteil verwenden, setzen Sie es nach Gebrauch wieder
fest in seinen Clip oder Halter ein.

3.2.16 Supportruf
Mit dieser Funktion können Sie einen privaten Anruf tätigen, um während normaler und unkritischer Situationen
um Hilfestellung zu bitten.

HINWEIS

Ihr Dienstanbieter kann Anzahl, Priorität und die Art des Anrufs (simplex oder duplex) konfigurieren.
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Sie starten einen Supportruf auf folgende Weise:

• Wählen Sie eine vordefinierte Nummer, und drücken Sie die Taste SENDEN.
• Menü → Sonderrufe → Hilferuf

3.2.17 Rufänderung
Rufänderung ist eine Funktion, die es Ihnen und Ihrem Dienstanbieter ermöglicht, den Anruf zu ändern, um ihn zu
optimieren und an die aktuelle Situation anzupassen.

Änderungen umfassen:

• Anrufpriorität: modifiziert während des Verbindungsaufbaus.
• Anruftyp: modifiziert während des Verbindungsaufbaus.
• Anrufverschlüsselung: modifiziert während eines bereits aktiven Anrufs (jedoch nicht in der Übertragungsphase).

Wird der Anruf geändert, zeigt das Funkgerät die Meldung Ruf geändert an.

Wenn ein kürzlich geänderter Anruf die PTT-Taste zur Übertragung erfordert, zeigt das Funkgerät Ruf
geändertPTT verwenden an.

Die meisten Änderungen erfolgen durch den Dienstanbieter, und das Funkgerät übernimmt sie nur. Sie können nur
End-to-End-Verschlüsselung der SIM-Karte für Gruppenanrufe verändern: aktivieren bzw. deaktivieren.

Wenn die Priorität auf Notruf geändert wird:

• Die Anzeige gibt an, dass ein Gruppennotruf empfangen wurde.
• Das Funkgerät gibt ein spezielles Audiosignal aus.

HINWEIS

Wenn ein Gruppenanruf in einen Gruppennotruf geändert wird, werden keine notfallbezogenen
Funktionen ausgelöst.

Wenn die von Ihrem Dienstanbieter angeforderte Änderung vom Funkgerät nicht übernommen werden kann
(aufgrund der Einstellungen), lehnt das Funkgerät sie ab und zeigt Dienst nicht verfügbar an.

3.2.18 Die End-to-End-Verschlüsselung der SIM-Karte
aktivieren/deaktivieren

Voraussetzungen:

• Das Funkgerät führt keinen aktiven Anruf aus.
• Sie können die PTT- Taste nicht betätigen.

Aktivieren/deaktivieren Sie die End-to-End-Verschlüsselung der SIM-Karte mit einer der folgenden Möglichkeiten:

• Drücken Sie eine One-Touch-Taste zum Aktivieren/Deaktivieren der End-to-End-Verschlüsselung der
SIM-Karte.

• Drücken Sie im Startbildschirm auf MENÜ → Kryptomenü → Kryptofunktion. Wählen Sie
Verschlüsselung ein zum Aktivieren oder Verschlüsselung aus zum Deaktivieren der Verschlüsselung.
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3.3 Lokales Trunking

Ergebnis: Ihr Funkgerät zeigt Anweisungen zum aktuellen Verschlüsselungsstatus an: das entsprechende
Statussymbol und die Meldung Verschlüsselung ein oder Verschlüsselung aus.

3.3 Lokales Trunking
Dieser Modus wird auch als Fallback-Modus bezeichnet und ermöglicht die Kommunikation zwischen mehreren
Geräten desselben Standorts, wenn die Verbindung zwischen dem Standort und dem zentralen Netzwerk-Controller
ausgefallen ist. Das Aufrufen und Beenden des lokalen Bündelfunks (d. h. das Zurückkehren zu den systemweiten
Diensten) erfolgt automatisch. In diesem Modus sind einige Dienste nicht verfügbar.

HINWEIS

Ihr Dienstanbieter kann diesen Modus deaktivieren.

3.3.1 Local Site Trunking (Bündelfunk in der lokalen
Funkzelle) aufrufen

Wenn Ihr Funkgerät eine Local Site Trunking-Meldung empfängt, geschieht Folgendes:

• Ihr Gerät gibt einen Signalton aus, der den Wechsel in den LST-Modus bestätigt.

• Im Display wird die Meldung Lokales Netz angezeigt.

• Die Symbole im Display und die Auswahltasten werden olivgrün angezeigt.

HINWEIS

Dies ist nur auf einem Farbdisplay erkennbar.

• Alle aktuellen Anrufe werden beim Wechsel in den lokalen Bündelfunkmodus unterbrochen.

Bei entsprechender Konfiguration durch Ihren Dienstanbieter wird diese Meldung/Alarmierung in regelmäßigen
Abständen wiederholt, um Sie daran zu erinnern, dass sich Ihr Gerät nach wie vor im lokalen Bündelfunkmodus
befindet. Die folgenden Funktionen sind verfügbar:

• Registrierung

• Anhängung

• Gruppenruf

• Notruf

• Notsignal

HINWEIS

Ihr Dienstanbieter kann alle optischen und akustischen Signale, die beim Wechsel in den lokalen
Bündelfunkmodus wiedergegeben werden, aktivieren oder deaktivieren.
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3.3.2 Bündelfunk in der lokalen Funkzelle beenden
Wenn die Verbindung mit dem zentralen Netzwerk-Controller wiederhergestellt wurde, beendet das Funkgerät
das Local Site Trunking, und es geschieht Folgendes:

• Das Funkgerät spielt einen Ton zum Beenden des Local Site Trunking ab.

• Laufende Anrufe während des Local Site Trunking werden beendet.

• Display-Symbole und Softkeys werden blau dargestellt.

HINWEIS

Ihr Dienstanbieter kann beim Beenden des Local Site Trunking-Modus alle Bild- und Tonindikationen
ein- oder ausschalten.

3.4 Direktmodusbetrieb (DMO)
Der Direktmodusbetrieb ist ein Modus des Simplex-Betriebs, bei dem die Geräte direkt miteinander kommunizieren.

Abbildung 3-2 Direktmodusbetrieb (DMO)

3.4.1 Den DMO-Modus aufrufen
So rufen Sie den DMO-Modus auf:

• Drücken Sie auf dem Startbildschirm die MENÜ-Taste. Wählen Sie Netze → Direkt-Modus.

• Von der Startseite Wählen Sie Option → Direkt-Modus.
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3.4.2 Eine Gesprächsgruppe auswählen

3.4.2 Eine Gesprächsgruppe auswählen
Verwenden Sie auf dem Startbildschirm eine der folgenden Methoden:

• Drücken Sie die NAVIGATIONSTASTEN nach links oder rechts. Drücken Sie aufWählen, um die
Auswahl zu bestätigen.

• Wählen Sie Option → Grp n. ABC. Geben Sie einen Gesprächsgruppennamen ein und wählen Sie die
Gesprächsgruppe aus der Liste aus.

• Wählen Sie Option → Grp nach Ord.. Wählen Sie einen Ordner und dann einen Gesprächsgruppennamen
aus.

• Drücken Sie den DREHKNOPF und drehen Sie ihn, bis der erforderliche Gesprächsgruppenname angezeigt
wird. Drücken Sie aufWählen, um die Auswahl zu bestätigen.

HINWEIS

Wenn der DREHKNOPF-Modus auf die Einstellung Blättern gesetzt ist, dann brauchen Sie ihn
nicht zu drücken, um diesen Modus einzustellen.

HINWEIS

Das Funkgerät kann auf bis zu drei Ebenen der Ordnerstruktur Zugriff haben.

3.4.3 Einen Gruppenanruf im DMO-Modus tätigen
Der Gruppenanruf wird von allen Mitgliedern der ausgewählten Gruppe empfangen, deren Gerät eingeschaltet ist
und sich in Reichweite befindet.
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Durchzuführende Schritte

1 Halten Sie die Sendetaste PTT gedrückt.

2 Warten Sie, bis der Signalton für Gesprächsberechtigung ertönt (falls konfiguriert), und sprechen Sie dann in
das Mikrofon. Lassen Sie die PTT-Taste los, um zuzuhören.

3.4.4 Einen Gruppenanruf im inaktiven Zustand empfangen
Durchzuführende Schritte

1 Das Funkgerät erhält einen Gruppenanruf.

HINWEIS

Der eingehende Gruppenanruf wird durch den Ton Gruppenanruf empfangen signalisiert.

2 Um zu antworten, halten Sie die PTT-Taste gedrückt.

3.4.5 Privatanruf
Der Privatanruf, auch als Point-to-Point- oder individueller Anruf bezeichnet, ermöglicht Anrufe zwischen zwei
Personen. Keine anderes Funkmodul kann die Unterhaltung hören. Diese Anruftyp kann grundsätzlich über
zwei Wege erfolgen:

• Duplex-Anruf (sofern durch System zugelassen) im TMO-Modus. Beide Parteien können gleichzeitig
sprechen.

• Simplex-Anruf im TMO- oder DMO-Modus. Nur eine Seite kann sprechen.

Wenn ein DMO-Privatanruf erfolgt, empfangen Funkmodule, die nicht an diesem Anruf beteiligt sind, das
Besetztzeichen für den Kanal. Die Funkgeräte werden über die Funkgerätenummer identifiziert.

Zusammenspiel mit Zubehörgeräten:

• Erstes Mikrofon — falls Sie während des Privatanrufs das Mikrofon am Clip einhängen, wird das Gespräch
beendet oder die Sprachausgabe Audio schaltet auf die Lautsprecher (falls vorhanden) um. Das genaue
Verhalten hängt von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

• Telefon-Handapparat: Wenn Sie während des Privatanrufs den Handapparat in den Halter stecken, wird das
Gespräch beendet oder der Ton schaltet auf die Lautsprecher (falls vorhanden). Das genaue Verhalten hängt
von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

HINWEIS

Um den Privatanruf zu beenden, wenn die Sprachausgabe auf den Lautsprecher umgeschaltet wurde,
drücken Sie die Taste EIN/AUS/ENDE/BEENDEN.
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3.4.6 Durchführen eines Privatanrufs

Um einen Privatanruf anzunehmen, verwenden Sie eine der folgenden Methoden:

• Drücken Sie auf die PTT-Taste.
• Nehmen Sie das erste Mikrofon oder Telefon-Mobilteil ab. Wenn sich das Mobilteil nicht auf der Gabel
befindet, wird der externe Lautsprecher des Funkmoduls stummgeschaltet und der interne Lautsprecher
des Mobilteils aktiviert.

• Drücken Sie die Taste SENDEN am Bedienkopf. Sprache wird zu den Audio-Eingangsgeräten in der
folgenden Reihenfolge weitergeleitet, je nach Verfügbarkeit:

1. Gesichtsvisier-Mikrofon.
2. Mikrofon des Geräts, das abgenommen wurde.
3. Das Mikrofon, das zuletzt verwendet wurde (wenn zwei Geräte abgenommen wurden).

3.4.6 Durchführen eines Privatanrufs
Durchzuführende Schritte

1 Drücken/Halten Sie auf der Startseite und geben Sie die Nummer ein.

2 Wenn Einzelruf nicht als erster Anruftyp angezeigt wird, drücken Sie solange auf R-Typ, bis der gewünschte
Typ angezeigt wird, und wählen Sie ihn aus.

3 Gehen Sie in den jeweiligen Modi folgendermaßen vor:
a. TMO: Drücken Sie zum Durchführen eines Simplex-Anrufs kurz die PTT-Taste. Sie hören ein

Rufzeichen. Halten Sie anderenfalls die PTT-Taste gedrückt. Warten Sie, bis das Zeichen für die erteilte
Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die PTT-Taste los, um
zuzuhören. Drücken Sie zum Durchführen eines Duplex-Anrufs kurz die SENDETASTE. Sie hören
ein Rufzeichen.

b. DMO: Nur Simplex-Anrufe sind möglich. Halten Sie die Sendetaste PTT gedrückt. Warten Sie, bis das
Zeichen für die erteilte Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die
PTT-Taste los, um zuzuhören.

4 Um den Anruf zu beenden, drücken Sie die Taste ENDE.

HINWEIS

Wenn Sie das erste Mikrofon oder das Telefon-Mobilteil verwenden, setzen Sie es nach Gebrauch wieder
fest in seinen Clip oder Halter ein.

3.4.7 Privatgespräch mit Präsenzprüfung
Mit dieser Funktion können Sie feststellen, ob der anrufende Teilnehmer in DMO verfügbar ist. Wenn diese
Funktion aktiviert ist, können Sie nur einen Privatanruf initiieren, wenn das angerufene Funkgerät auf demselben
Kanal vorhanden ist und mit einer Präsenzprüfungsbestätigung antwortet.

Andernfalls zeigt das Funkgerät Teiln. nicht verfügb. an.
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3.4.8 Gesprächsgruppe für Einzelrufe
Die Gesprächsgruppe für Einzelrufe ist eine Gesprächsgruppe, die auf einer separat zugeteilten Frequenz für
einzelne (private) Anrufe arbeitet. Mit dieser Gesprächsgruppe werden die Frequenzressourcen optimiert und dafür
gesorgt, dass andere Gesprächsgruppen nicht blockiert werden. Folgende Anrufarten werden unterstützt: private
Gespräche und Notrufe (sowohl privat als auch Gruppe). Verwenden Sie diese Gesprächsgruppe jedes Mal,
wenn Sie einen Privatanruf tätigen möchten.

Wenn Sie eine Gesprächsgruppe für Einzelrufe auswählen, kann das Funkgerät keine Gruppenruf oder Durchsagen
mit einer geringeren Priorität als Notruf empfangen oder starten.

Nach der Auswahl einer Gesprächsgruppe für Einzelrufe und Drücken der PTT-Taste, um einen Gruppenanruf zu
starten, verhält sich das Funkgerät wie folgt:

• Lehnt den Anruf ab
• Gibt einen Ton aus
• Zeigt die Nachricht Nur Einzelrufe an

3.4.9 Kommunikation über Repeater
Funkgeräte, die sich außerhalb des Abdeckungsbereichs befinden und nicht direkt miteinander im DMO-Modus
kommunizieren können, können über Repeater kommunizieren. Der Repeater ist ein Funkgerät, das die gesamte
Kommunikation auf einem ausgewählten Kanal wiederholt und als Ergebnis den DMO-Bereich des Funkgeräts
erweitert.

DMODMO

Wenn das Funkgerät eine Verbindung zu einem Repeater aufbaut, dann spielt es einen Ton ab und zeigt die
Nachricht Repeater nutzbar sowie ein entsprechendes Symbol an. Wird die Verbindung zwischen Funkgerät und
Repeater unterbrochen, dann spielt das Gerät einen Ton ab und zeigt die Nachricht Repeater nicht nutzbar sowie
ein blinkendes Repeater-Symbol an Meldungen und Signaltöne werden vom Dienstanbieter konfiguriert.

3.4.10 Kommunikation über Gateway
Das Gateway stellt eine Verbindung zwischen Funkgeräten, die sich im DMO-Modus befinden, und dem
TETRA-Netzwerk her, sodass DMO-Funkgeräte mit den TMO-Funkgeräten kommunizieren können.
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3.4.11 Optionen für DMO-Gruppenanruf auswählen

DMO

TMO

TMO

Wenn das Funkgerät eine Verbindung zu einem Gateway herstellt, dann spielt es einen Ton ab und zeigt die
Nachricht Gateway nutzbar sowie ein entsprechendes Symbol an. Wird die Verbindung zwischen Funkgerät und
Gateway unterbrochen, dann spielt das Gerät einen Ton ab und zeigt die Nachricht Gateway nicht nutzbar sowie
ein blinkendes Symbol an. Meldungen und Signaltöne werden vom Dienstanbieter konfiguriert.

3.4.11 Optionen für DMO-Gruppenanruf auswählen
Anwendungsgebiete:
Unterstützt die Kommunikation mit anderen Funkbenutzern derselben Gesprächsgruppe über das Gateway oder
den Repeater.
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Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Drücken Sie auf Konfig..

3 Wählen Sie eine der folgenden Optionen aus:
• MS - MS: Ihr Gerät kann nur mit anderen Geräten innerhalb seines Bereichs kommunizieren.
• Gateway: Ihr Gerät verwendet für die Kommunikation mit der Infrastruktur ein Gateway.

• Automatisch: Ihr Gerät verwendet das erste verfügbare Gateway für diese
Gesprächsgruppe.

• Spezifisch: Ihr Gerät verwendet nur das Gateway mit der für diese Gesprächsgruppe
spezifizierten Gateway-Adresse. Wenn Ihr Gerät Gewählt Gateway: Kein anzeigt,
drücken Sie auf Bearb, um die aktuelle Gateway-Adresse einzugeben.

• Repeater: Verwendet den ersten verfügbaren Repeater für diese Gesprächsgruppe.
• GW + Rep.: Verwendet das erste verfügbare Gateway bzw. den ersten verfügbaren Repeater für

diese Gesprächsgruppe.

• Automatisch: Verwendet das erste verfügbare Gateway für diese Gesprächsgruppe.

• Spezifisch: Verwendet nur das Gateway mit der für diese Gesprächsgruppe spezifizierten
Gateway-Adresse. Wenn Ihr Gerät Gewählt Gateway: Kein anzeigt, drücken Sie auf
Bearb, um die aktuelle Gateway-Adresse einzugeben.

HINWEIS

Wenn nicht über das Gateway oder den Repeater kommuniziert werden kann, obwohl eine
Gesprächsgruppe für deren Verwendung konfiguriert ist, versucht das Gerät die direkte
MS-MS-Kommunikation.
.

Ergebnis:
Wenn Ihr Gerät das jeweilige Gateway und/oder den Repeater erkennt, leuchten die jeweiligen Symbole durchgängig.

3.5 Sendesperrenmodus
Im Sendesperrenmodus sendet das Funkgerät keine Funkübertragungen. Es wird empfohlen, diesen Modus in
RF-empfindlichen Bereichen zu aktivieren, in denen die Sicherheit aufgrund der Strahlung gefährdet werden kann,
z. B. in Krankenhäusern und Flugzeugen.

Wählen Sie zum Aktivieren des ModusMENÜ→ Netze → TXI-Modus → Deaktivieren.

In diesem Modus sendet das Gerät unter keinen Umständen Übertragungen, außer bei einem Notruf. Alle
Funktionen und Tasten, die eine Übertragung auslösen würden, sind deaktiviert, z. B Registrierung am Netzwerk,
Ändern der Gesprächsgruppe oder des Ordners, Senden von SDS-Nachrichten oder die PTT-Taste. Wenn versucht
wird, eine Übertragung zu senden, wird im Gerät die Meldung Im TXI-Mod. nicht erlaubt angezeigt und ein
Signalton ausgegeben.
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3.6 Notfallmodus

Folgendes kann von Ihrem Gerät weiterhin empfangen werden:

• Gruppenrufe.

• Gespeicherte Nachrichten im Eingang.

• Private Anrufversuche, die in der Liste Verpaßte Rufe gespeichert werden, wobei diese nicht beantwortet
werden können.

Wenn keine Gefahr mehr für die Sicherheit besteht (wenn Sie beispielsweise den RF-empfindlichen Bereich
verlassen), können Sie den Sendesperrenmodus wieder deaktivieren. Das Gerät wechselt daraufhin in den
Normalbetrieb zurück.

Sie können den Modus deaktivieren durch Auswahl vonMENÜ→ Netzwerke → TXI-Modus → Deaktivieren,
durch Drücken der Zielwahltaste oder implizit durch Starten eines Notrufs.

HINWEIS

RF-Übertragungen vom Gerät werden unter folgenden Bedingungen verhindert:

• Der TXI-Modus ist aktiviert.

• Das Funkgerät ist ausgeschaltet.

3.6 Notfallmodus
Der Notfallmodus wird in kritischen Situationen verwendet.

Durch Drücken und Halten der NOTRUFTASTE oder durch die Eingabe der Notrufnummer und die Betätigung der
Taste SENDEN werden ein oder mehrere Dienste aktiviert (je nach den Einstellungen Ihres Dienstanbieters):

• Notsignal

• SDS-Status

• Stiller Notruf

• Einsatz des Notrufmikrofons

• Einzelrufe im Notfallmodus (Privat- oder MS-ISDN-Anrufe)

• GPS-Standortinformationen

HINWEIS

Das Funkgerät kann durch Drücken der NOTRUFTASTE eingeschaltet werden. Je nach den Einstellungen
des Dienstanbieters kann das Funkgerät den Notfallmodus automatisch starten. Wenn das Funkgerät
durch eine PIN geschützt wird (Ausnahme: SIM-PIN), dann wird im Notfallbetrieb die PIN-Sperre im
Notfallmodus umgangen.

Beim Start des Notfallmodus werden alle laufenden Sprachanrufe abgebrochen oder gelöscht, und alle laufenden
Datenübertragungen werden abgebrochen. Die Sitzung wird jedoch beibehalten.

Im Notfallmodus verweigert das Gerät automatisch alle Telefon-, Nebenstellen- und Privatanrufe, und die
Gesprächsgruppen in der ausgewählten Scan-Liste werden nicht überwacht.

Um den Notfallmodus zu beenden, drücken Sie den oberenSOFTKEY.
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3.6.1 Gruppennotruf
Der Gruppennotruf hat die höchste Kommunikationspriorität, das bedeutet, dieser Anruftyp hat immer Vorrang.
Gruppennotrufe sind sowohl im TMO- als auch im DMO-Modus verfügbar. In Notsituationen können
Gruppennotrufe durch einen Druck auf die NOTRUFTASTE gestartet werden. Das Funkgerät kann zudem den
Betrieb eines Notrufmikros unterstützen. Dann kann der Notruf ohne die Betätigung der PTT-Taste durchgeführt
werden.

Wenn ein Funkgerät einen eingehenden Gruppenanruf mit Notfallpriorität erhält, wird im Display angezeigt, dass
ein Notruf empfangen wurde, und ein spezielles Audiosignal wird wiedergegeben.

Gruppennotrufe können folgendermaßen konfiguriert werden:

• Als nicht-taktischer Anruf: Über eine von Ihrem Dienstanbieter vorprogrammierte Gesprächsgruppe
initiiert. Im nicht-taktischen Notrufmodus können Sie nicht zwischen Gesprächsgruppen umschalten.

• Als taktischer Anruf: Über die aktuell aktive Gesprächsgruppe initiiert.

Wenn das Funkgerät im TMO-Modus in den Notrufmodus schaltet, während eine Notruf-Durchsage aktiv ist, setzt
das Funkgerät den Anruf fort, ohne Anrufe zu initialisieren, und sendet ein Notrufsignal.

Wenn der Gruppennotruf, an dem Sie teilnehmen, beendet wird, kann sich das Funkgerät auf verschiedene Arten
verhalten, abhängig von Ihren Dienstanbietereinstellungen:

• Wenn Sie den Notruf ausgelöst haben, bleibt das Funkgerät entweder im Notrufmodus oder kehrt zum
TMO-Modus zurück.

• Wenn Sie den Notruf nicht ausgelöst haben, kehrt das Funkgerät immer zum TMO-Modus zurück.

3.6.2 Einen Gruppennotruf absetzen
Voraussetzung:
Stellen Sie sicher, dass sich Ihr Gerät im Notfallmodus befindet.
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3.6.3 Einen Gruppennotruf empfangen

Durchzuführende Schritte

1 Halten Sie die Sendetaste PTT gedrückt.

2 Warten Sie auf den Gesprächsgenehmigungston (falls konfiguriert), und sprechen Sie.

3 Lassen Sie die PTT-Taste los, um zuzuhören.

HINWEIS

Im TMO-Modus ist es möglich, einen Gruppennotruf abzubrechen. Führen Sie hierzu eine der folgenden
Aktionen aus, bevor die Sprechgenehmigung erteilt wurde (je nach den Einstellungen des Dienstanbieters):

• Lassen Sie die PTT-Taste los.
• Drücken Sie die Taste ENDE (Standardeinstellung).

Nachdem der Anruf abgebrochen wurde, zeigt das Gerät Ruf abgebrochen an (sofern von Ihrem
Dienstanbieter konfiguriert).

3.6.3 Einen Gruppennotruf empfangen
Ein Funkgerät empfängt einen Gruppennotruf von der ausgewählten vorprogrammierten Gruppe. Eingehende
Anruf werden durch den entsprechenden Ton, das Statussymbol, und die Rotfärbung des Displays angekündigt.

3.6.4 Nicht-Taktischer Notfall
Im Modus des Nicht-Taktischen Notfalls wechselt das Funkgerät zu einer bestimmten Notfall-Gesprächsgruppe,
sobald es in den Notbetrieb wechselt. Diese Gesprächsgruppe wird während der kompletten Dauer des Notbetriebs
verwendet (die Gesprächsgruppe kann nicht gewechselt werden).

Im TMO-Modus kann das Funkgerät so konfiguriert werden, dass nicht-taktische Gruppenrufe ohne Anhang
getätigt werden können. Ist diese Option eingerichtet, geht das Funkgerät nach Erhalt einer temporären Adresse von
einer erfolgten Zuweisung aus.

Im DMO-Modus wird der nicht-taktische Notruf auf der Frequenz der zuvor gewählten Gesprächsgruppe
durchgeführt. Der Dienstanbieter kann für den Notruf eine beliebige ITSI-Adresse bestimmen (dies kann die
Sendeadresse einer offenen Gruppe sein).

Nachdem ein nicht-taktischer Notruf beendet wurde, wechselt das Funkgerät wieder zu der zuvor gewählten
Gesprächsgruppe.

3.6.5 Einzelrufe im Notfallmodus (Privat- oder
MS-ISDN-Anrufe)

Einzelrufe im Notfallmodus sind Simplex- oder Duplex-Privatgespräche mit Notfallpriorität. Nach Betätigen der
NOTRUFTASTE initiiert das Funkgerät einen Einzelruf an die eingerichtete Adresse (privat oder MS-ISDN).
Während dieser Art Anruf stehen keinerlei Benutzeranzeigen zur Verfügung, und alle anderen Dienste werden
verworfen. Der Notfallmodus wird beendet, sobald der Einzelruf im Notfallmodus beendet wird.
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SIEHE AUCH

Privatanruf

MS-ISDN

3.6.6 Notsignal
Das Notsignal ist eine besondere Statusmeldung, die beim Wechsel in den Notfallmodus an die Infrastruktur
gesendet wird. Das Funkgerät muss unter Umständen warten, bis die Infrastruktur den Alarm bestätigt, und
ggf. mehrere Wiederholungen einleiten.

Jedes Mal, wenn das Gerät in den Notfallmodus wechselt, wird ein Notsignal gesendet. Sobald das Notsignal
erfolgreich versendet wurde, wird das relevante akustische Signal abgespielt.

Außerdem wird, sobald das Funkgerät durch Betätigung der NOTRUFTASTE in den Notfallmodus wechselt, ein
zusätzliches Notsignal gesendet (außer bei aktivem Notfallmikrofon).

Die Nachricht kann sowohl im TMO- als auch im DMO-Modus gesendet werden.

3.6.7 Notfall SDS-Status
Das Funkgerät sendet eine Statusmeldung mit einem vorprogrammierten Wert an eine von Ihrem Dienstanbieter
festgelegte Zieladresse. Der Notfall SDS-Status ist nur im TMO-Modus verfügbar. Wenn keine oder eine negative
Statusbestätigung eintrifft, versucht das Funkgerät, die Nachricht erneut zu senden. Der Status wird nicht erneut
übermittelt, wenn die Notsignal- oder Notfall-Mikrofon-Option konfiguriert wurde.

3.6.8 Notrufmikrofon
Ist das Notrufmikrofon aktiv, so können Sie im Notfallmodus telefonieren, ohne die PTT-Taste zu drücken. Die
Übertragung wird für einen festgelegten Zeitraum gesichert. Durch Drücken der PTT-Taste vor Ablauf der für
das Notrufmikrofon festgelegten Zeitdauer wird die Übertragung beendet. Anschließend wechselt das Gerät
in den für die Notfallgruppe normalen PTT-Betrieb (d. h. die Übertragung dauert an, solange die PTT-Taste
gedrückt gehalten wird).

Wird die Notfalltaste im Notfallmodus erneut gedrückt, so wird die Übertragung über das Notrufmikrofon erneut
gestartet.

Wird einem anderen Mitglied der Gruppe eine Gesprächsgenehmigung erteilt, wird der Notruf-Empfangston
wiedergegeben. Sofern konfiguriert, versucht das Gerät automatisch, die Gesprächsgenehmigung erneut zu erhalten.

Drücken Sie den Softkey Ende oder die Taste ENDE, um den Einsatz des Notrufmikrofons zu beenden.

3.6.9 Notrufmikrofon umschalten
Die Funktion „Notrufmikrofon umschalten“ ist eine Erweiterung der Notrufmikrofon-Funktion. Nach der
Aktivierung wechselt das Funkgerät für eine exakt von Ihrem Dienstanbieter bestimmte Dauer zwischen
Übertragungs- (das Mikrofon ist aktiv) und Empfangsphasen (Sie können nur zuhören).

Wenn diese Funktion aktiviert ist, können Sie das Umschalten des Notrufmikrofons initiieren, indem Sie NOTRUF
drücken. Wenn Sie eine Phase früher beenden oder die Übertragungsphase überspringen wollen, drücken Sie ENDE.
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3.6.10 Stiller Notfallmodus

Die Funktion „Notrufmikrofon umschalten“ wird beendet, wenn eine der folgenden Bedingungen erfüllt ist:

• Das Funkgerät beendet den Notrufmodus.
• Der Timer für die Funktion „Notrufmikrofon umschalten“ schaltet sich gleich ab.
• Die SPRECHTASTE (PTT) wird gedrückt.
• Der obere SOFTKEY wird gedrückt (nur während der Übertragungsphase).

HINWEIS

Wenn das Funkgerät außer Betrieb gesetzt wird, geht es in den Empfangsmodus über, und die Funktion
„Notrufmikrofon umschalten“ setzt aus. Wenn das Funkgerät wieder betriebsbereit ist, wird die
Übertragung über das Notrufmikrofon und die Funktion „Notrufmikrofon umschalten“ wieder aktiviert.

HINWEIS

Wenn Sie sich im Notfallmodus befinden, wird die Funktion „Notrufmikrofon umschalten“ durch das
Drücken der NOTRUFTASTE erneut gestartet.

3.6.10 Stiller Notfallmodus
Der stille Notfallmodus ist ein Notfalldienst, bei dem keine Tonsignale oder Tastengeräusche erzeugt werden, wenn
der Modus aufgerufen wird. Alle Displayanzeigen verhalten sich wie im Ruhezustand. Das Gerät kann jedoch,
außer den folgenden Diensten, keine weiteren Dienste nutzen:

• Empfang einer Fernaktivierung mit Mikrofonfreischaltung (Ambience Listening, AL)
• Senden von stillen Notrufsignalen
• Senden von GPS-Standortberichten

HINWEIS

Wenn Sie versuchen, eine andere Funktion zu aktivieren, so ist diese blockiert.

Wenn der stille Notfallmodus aktiviert ist, wechselt das Gerät in den stillen Notfallmodus, sobald die Notruftaste
gedrückt wird. Nach dem Aufruf dieses Modus bleibt das Funkgerät im TMO-Modus oder wechselt in diesen, je
nach seinem aktuellen Status. Sobald sich das Gerät im TMO-Modus befindet, sendet es einen stillen Notfallalarm.

HINWEIS

Befindet sich das Gerät in einem Gruppen- oder Privatanruf, wartet das Gerät das Ende des Anrufs ab
und wechselt dann in den stillen Notfallmodus.

Das Gerät sendet den Alarm so oft, bis das erfolgreiche Senden bestätigt wird. Nachdem der Alarm erfolgreich
gesendet wurde, verbleibt das Gerät im stillen Notfallmodus und wartet auf den Mithöranruf.

So beenden Sie den stillen Notfallmodus:

• Drücken Sie innerhalb von 3 Sekunden die Taste MENÜ und anschließend die Taste #.
• Drücken Sie die Taste MENÜ und die rechte NAVIGATIONSTASTE gleichzeitig.
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• Drücken Sie die beiden SOFTKEYS gleichzeitig.

• Das Senden des stillen Notfallalarms ist erfolglos geblieben und die maximale Anzahl der Wiederholungen
wurde erreicht.

• Der Kontrollraum beendet das stille Mithören.

• Das Mithören wird aus einem anderen Grund unterbrochen.

Wenn Sie das Gerät im stillen Notfallmodus ausschalten, wechselt es in den Pseudo-Aus-Zustand. In diesem
Zustand erscheint das Gerät wie ausgeschaltet. Das Gerät ist jedoch weiterhin eingeschaltet und befindet sich im
stillen Notfallmodus. Wenn Sie das Gerät im Pseudo-Aus-Zustand einschalten, verhält sich das Gerät wie beim
Einschalten, und es befindet sich weiterhin im stillen Notfallmodus.

3.6.11 Verdeckter Notruf
Es ist möglich, dass der Dienstanbiete die visuellen und akustischen Aspekte eines Notrufs für ein Funkgerät
deaktiviert. Zweck dieser Option ist es, den Einsatz eines Notdienstes in kritischen Situationen (Beispiel: ein
direkter Angriff auf den Benutzer) zu verheimlichen und damit zusätzliche Sicherheit zu bieten.

3.6.12 Den Notfallmodus durch Wählen aufrufen
Mit dieser Funktion können Sie den Notfallmodus durch die Wahl einer vordefinierten Nummer auslösen. Dadurch
werden dieselben Notdienste wie durch einen Druck auf die NOTRUFTASTE ausgelöst. Das Funkgerät kann bis zu
acht Notrufnummern speichern.

HINWEIS

Wenn der Notfallmodus durch die Eingabe einer Notrufnummer ausgelöst wurde (nicht durch Drücken der
NOTRUFTASTE), können Sie den Notfallmodus durch Drücken der Taste ENDE wieder verlassen.

3.6.13 Notsignal
Ein Notsignalruf ist eine vom Funkgerät initiierte Notruf-Durchsage mit höchster Priorität, die alle innerhalb des
Sendebereichs empfangen können. Diese Funktion wurde speziell für Katastrophenfälle entwickelt, beispielsweise
Erdbeben, und hat höchste Priorität gegenüber allen anderen Anrufen. Alle Funkgeräte zeigen auf ihren
Bildschirmen die Notfallbenachrichtigung an. Die Warnmeldung, ihre Dauer und die Ziel-Gesprächsgruppe
können im Codeplug konfiguriert werden.

Um ein Notsignal zu senden, schalten Sie das Funkgerät in den Notsignal-Modus, und drücken Sie die Sprechtaste
(PTT). Wenn das Gespräch beendet wird, verlässt das Funkgerät den Notfallstatus.

Der Notfallmodus wirkt sich auf andere Funktionen aus:

• Im Notfallmodus werden alle sonstigen laufenden Dienste beendet.

• Kein anderer Dienst kann diesen Anruftyp unterbrechen.

• Die Notrufmikrofon-Funktion kann nicht verwendet werden.

• Sprache wird nur unverschlüsselt übertragen, auch wenn ein Verschlüsselungsdienst aktiv ist. Die einzige
Ausnahme ist die E2E-Verschlüsselung.
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3.6.14 Einen Katastrophenalarm-Anruf initialisieren

HINWEIS

Nicht alle Infrastrukturen unterstützen diese Funktion. Bitte wenden Sie sich an Ihren Dienstanbieter,
bevor Sie diese Funktion aktivieren.

3.6.14 Einen Katastrophenalarm-Anruf initialisieren
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Dienste → Katastrophenalarm.
Schrittergebnis: Das Gerät wechselt in den Katastrophenalarm-Modus und zeigt das Symbol für
Katastrophenalarm an.

3 Drücken Sie zum Einleiten des Anrufs auf PTT.
Schrittergebnis: Das Gerät zeigt KatastrophenalarmIn Verwendung an.

3.6.15 Beenden des Notfallmodus
Voraussetzung:
Stellen Sie sicher, dass sich Ihr Gerät im Notfallmodus befindet.

Durchzuführende Schritte

1 Wenn im Bildschirm Ihres Geräts Notrufmikro Ein angezeigt wird, drücken Sie auf Ende.

2 Drücken und halten Sie Ende.

HINWEIS

Wenn der Notfallmodus durch Eingabe einer Notrufnummer ausgelöst wurde (nicht durch Drücken der
NOTRUF-Taste), können Sie den Notfallmodus durch Drücken der Taste ENDE wieder verlassen.

3 Wenn Ihr Gerät die Meldung Notruf beenden? anzeigt, drücken Sie auf Ja, um den Modus zu beenden.

Ergebnis:
Ihr Funkgerät verlässt den Notfallmodus.

3.7 Repeater-Modus
Der Repeater-Modus bietet eine Repeater-Verbindung zwischen Geräten, die im DMO-Modus betrieben werden.
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HINWEIS

Nur Geräte derselben Gesprächsgruppe können über den Repeater miteinander kommunizieren.

Abbildung 3-3 Repeater-Modus-Betrieb

DMODMO

3.7.1 Aufruf Repeater-Modus
Um in den Repeater-Modus zu gelangen, verwenden Sie eine der folgenden Möglichkeiten:

• Wählen Sie auf dem Startbildschirm Option→ Repeater-Mod..

• Drücken Sie auf dem Startbildschirm die Taste MENÜ. Wählen Sie → Netze→ Repeater-Mod..
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3.7.2 Die Überwachungsoption einstellen

3.7.2 Die Überwachungsoption einstellen

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Drücken Sie auf Gespr.Optionen.

3 Wählen Sie eine der folgenden Optionen aus:
• Aus: Ihr Gerät fungiert lediglich als Repeater. Es ist kein Betrieb möglich.
• Nur Empfang: Bei Auswahl dieser Option können Sie nur zuhören.
• Empf u übertr: Bei Auswahl dieser Option können Sie durch einen Drück auf die PTT-Taste

zuhören/senden.

3.7.3 Verschlüsselung im Repeater-Modus
Im Repeater-Modus unterstützt das Funkmodul die Luftschnittstellenverschlüsselung und kann verschlüsselte
Anrufe und Nachrichten wiederholen.

Wenn die auf dem Funkmodul installierten SCK-Schlüssel ungültig sind:

• Das Funkgerät überträgt Anrufe und Nachrichten, ohne sie zu entschlüsseln (sofern die
Verschlüsselungsebene nicht die höchste ist).

• Die LED-Anzeige leuchtet orange.

• Nach dem Drücken der PTT-Taste erscheint die Nachricht Kanal besetzt oder DMSCK ungültig.

• Sie können keine Anrufe tätigen.

3.8 Gateway-Modus
Im Gateway-Modus kann Ihr Gerät als Gateway fungieren und somit eine Verbindung zwischen Geräten herstellen,
die im DMO- oder TMO-Modus betrieben werden.
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Abbildung 3-4 Gateway-Modus-Betrieb

DMO

TMO

TMO

Dies ist eine Verkaufsfunktion.

3.8.1 Den Gateway-Modus aufrufen
Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Wählen Sie Gateway.

HINWEIS

Wenn der Gateway-Modus aktiviert ist, können keine Anrufe getätigt werden.

3.8.2 Standby-Modus
Das Funkgerät wechselt in den Standby-Modus, wenn sich noch ein Gateway auf der gleichen DMO-Frequenz
befindet. Das Gateway-Symbol blinkt, und es wird keine Übertragung über den Gateway weitergeleitet. Um den
Standby-Modus zu verlassen, können Sie Folgendes tun:

• Wählen Sie eine andere DMO-Gesprächsgruppe aus.
• Warten Sie, bis sich das andere Gateway außerhalb des Empfangsbereichs befindet und nicht mehr in der
DMO-Gesprächsgruppe vorhanden ist.

3.8.3 Einen Gruppenanruf weiterleiten
Ihr Funkgerät zeigt die Quell- und Zielgesprächsgruppe des Gruppenanrufs an.
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3.8.4 Die Überwachungsoption einstellen

3.8.4 Die Überwachungsoption einstellen

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Drücken Sie auf Konfig. und dann auf eine der folgenden Optionen: Wählen Sie eine der folgenden Optionen
aus:

• Aus: Der Audio-Ausgang der Anrufe erfolgt nicht an den Lautsprechern des Gateways.
• Nur Empfang: Der Audio-Ausgang der Anrufe erfolgt an den Lautsprechern des Gateways.

3.8.5 Notrufe im Gateway-Modus
Drücken Sie die NOTRUF-Taste, um den TMO-Notrufmodus aufzurufen, und starten Sie einen Gruppennotruf.
Erkundigen Sie sich bei Ihrem Dienstanbieter, ob der Gruppennotruf in einer taktischen oder nicht-taktischen
Gesprächsgruppe startet. Wenn das Funkgerät, das sich im Gateway-Modus befindet, einen Gruppennotruf
empfängt, leitet es diesen an die jeweilige TMO/DMO-Gesprächsgruppe weiter, mit der es gerade verbunden ist.

3.8.6 Verschlüsselung im Gateway-Modus
Im Gateway-Modus unterstützt das Funkgerät drahtlose Verschlüsselung und kann verschlüsselte Anrufe zwischen
Geräten übertragen, die in TMO und DMO betrieben werden.

Wenn die auf dem Funkgerät installierten SCK-Schlüssel ungültig sind, kann das Funkgerät nicht als Gateway
funktionieren und Anrufe übertragen.
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4 GPS-Ortungsdienst
Der GPS-Ortungsdienst nutzt Informationen der Satelliten des Global Positioning System (GPS), welche die Erde
umkreisen, um den ungefähren geografischen Standort Ihres Funkgeräts zu bestimmen.

Die Verfügbarkeit des GPS-Ortungsdienstes, die Genauigkeit und die benötigte Zeit zur Positionsberechnung
hängen von der Umgebung ab, in der Sie das Funkgerät verwenden. Der GPS-Ortungsdienst kann Ihrem Dispatcher
oder Kollegen in vielen Bereichen helfen, wie beispielsweise effizienterer Einsatz von Ressourcen oder Auffinden
des Funkgeräts, wenn Sie einen Notruf auslösen.

Das Funkgerät kann die Standortinformationen direkt auf dem Display anzeigen oder über eine drahtlose Verbindung
an den Dispatcher senden, um sie in der Steuerzentrale anzuzeigen. Erfragen Sie die Konfigurationsdetails des
Funkgeräts bei Ihrem Dienstanbieter.

WICHTIG

Wo keine Signale von Satelliten verfügbar sind, funktioniert der GPS-Ortungsdienst nicht. Diese Situation
tritt meist auf, wenn das Funkgerät keinen ausreichend großen Bereich unter freiem Himmel hat, z. B. wenn
die GPS-Antenne abgedeckt ist oder zum Boden zeigt. Solche Situationen treten an folgenden Orten auf:

• An unterirdischen Standorten

• Innerhalb von Gebäuden, Zügen oder anderen geschlossenen Fahrzeugen

• Unter sonstigen Metall- und Betondecken oder -strukturen

• In der Nähe leistungsstarker Funk- oder Fernsehtürme

• Bei extremen Temperaturen außerhalb der Betriebsgrenzen Ihres Funkgeräts

Auch wenn die Positionsdaten in solchen Situationen errechnet werden können, dauert es unter Umständen
länger. Geben Sie daher in einer Notsituation immer die aktuelle Position an Ihren Dispatcher weiter. Wenn
ausreichende Signale von mehreren Satelliten verfügbar sind, ermittelt der GPS-Ortungsdienst einen Standort, der
sehr wahrscheinlich nahe bei Ihrem tatsächlichen Standort liegt. Die Leistung der GPS-Funktion unter idealen
Testbedingungen finden Sie in der Tabelle „GPS-Spezifikationen“.

Das Funkgerät kann eingestellt werden, um in verschiedenen Situationen Standortberichte zu senden, zum Beispiel:

• Auf Anfrage

• Den Notfallmodus aufrufen

• In festgelegten Zeitabständen

• In festgelegten Entfernungen

Die Standortberichte können auf zwei Arten gesendet werden:

• SDS

• Paketdaten

Wenn Standortberichte mit Paketdaten versendet werden, wird beim Senden der Nachricht ein Datensymbol
angezeigt.
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Ausführliche Bedienungsanleitung

Wenn Standortberichte per SDS mit dem benutzerdefinierten Datentyp -4 als Transportschicht versendet werden,
kommt entweder das ETSI LIP (Location Information Protocol (LIP) oder das Motorola LRRP (Location
Request/Response Protocol) GPS-Standortprotokoll zum Einsatz. Das LRRP GPS-Protokoll verwendet entweder
SDS-TL (für zusätzliche Zuverlässigkeit) oder einfaches GPS ohne SDS-TL (um Luftschnittstellen-Ressourcen zu
sparen). Zu den GPS Protokoll-IDs gehören:

• LRRP SDS TL = 131

• LRRP Simple GPS = 3

• LIP GPS = 10

Standortberichten werden in TMO versandt und können auch zur Versendung in DMO bereitgestellt werden.
Wenn das Funkgerät mit Anwendungshinweisen eingerichtet wurde, wird der Betriebszustand der Funktion auf
dem Display des Funkgeräts angezeigt.

Je nach Konfiguration des Funkgeräts ist die Anzeige der Funkgerätposition und des Status der sichtbaren
Satelliten verfügbar. Die Position kann aus Längen- und Breitengrad bestehen, nach britischen oder irischen
Rasterkoordinaten. Die GPS-Ortungsdienstfunktion kann über CPS komplett aktiviert oder deaktiviert werden. Es
ist möglich, die Funktionsparameter mit dem CPS oder per Funk zu konfigurieren. Die CPS-Konfiguration liefert ein
Standardprofil. Die per Funk empfangenen Befehle überschreiben möglicherweise die Standardprofilkonfiguration.
Das dem Funkgerät zugewiesene Profil bestimmt, wann Standortdaten gesendet werden, welche Daten mit welcher
Genauigkeit und an welche Adresse gesendet werden. Alle über Funk empfangenen Datenanforderungen und
Konfigurationsbefehle werden geprüft, um zu bestätigen, dass sie aus einer vertrauenswürdigen Quelle stammen.
Standortberichte werden nur von berechtigten ISSIs oder IPs angenommen, abhängig von der konfigurierten
Transportschicht (SDS, Paketdaten).

HINWEIS

Stellen Sie sicher, dass die Anwendung zum Empfang der Standortmeldungen und das Funkgerät
entsprechend konfiguriert sind. Andernfalls lehnt das Funkgerät alle System-GPS-Anforderungen ab.

Das Funkgerät unterstützt GPS-Auslöserfunktionen (mit LIP oder LRRP), um GPS-Positionen zu melden, wenn das
Gerät bestimmte Kriterien erfüllt. Folgende Auslöser können, zusammen mit ihren jeweiligen Parametern, vom
Dienstanbieter festgelegt werden:

Tabelle 4-1 GPS-Auslöser

Auslösertyp Trigger-Ereignis

Einschalten Das Gerät schaltet sich im TMO-Modus ein.

Ausschalten Das Gerät schaltet sich im TMO-Modus aus.

Notfallzustand Das Gerät wechselt in den Notfallmodus.

Periodisch Ein bestimmtes Zeitintervall ist seit dem letzten Standortbericht abgelaufen.

Verschoben Die Position des Funkgeräts hat sich um mindestens die definierte Strecke verändert (das
Gerät prüft regelmäßig die Entfernung von der letzten bekannten Position).

TMO EIN Erfolgreiche Registrierung nach Übergang zu TMO von DMO.

DMO EIN Vor der TMO-Abmeldung und vor dem Eintritt in den DMO-Modus.

Sendeverhin-
derungsmodus EIN

Das Funkgerät ist dabei, in den TXI-Modus zu wechseln.
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4.1 GPS-Leistung verbessern

Tabelle 4-1 GPS-Auslöser (Fortsetzung)

Auslösertyp Trigger-Ereignis

Sendeverhin-
derungsmodus
AUS

Das Funkgerät wurde nach dem Verlassen des TXI-Modus erfolgreich registriert.

Akkulade-
standswarnung

Das Funkgerät erkennt, dass der Akku-Ladezustand einen vom Dienstanbieter eingestellten
Wert erreicht oder unterschritten hat.

GPS-Ausfall Das Funkgerät erkennt einen GPS-Ausfall über eine bestimmte, vom Dienstanbieter
definierte Mindestdauer.

Wiederherstellung
der GPS-
Verfügbarkeit

Das Funkgerät erkennt eine erneute GPS-Verfügbarkeit über eine bestimmte, vom
Dienstanbieter definierte Mindestdauer.

Status
angenommen

Das Funkgerät sendet eine im CP vorprogrammierte Statusmeldung für die
Standorterfassung.

DCK verbunden Das Funkgerät erkennt, dass eine Freisprechanlage angeschlossen wurde.

DCK getrennt Das Funkgerät erkennt, dass die Verbindung zu einer Freisprechanlage getrennt wurde.

GPS EIN Das Standorterfassungsmodul wurde aktiviert.

GPS AUS Das Standorterfassungsmodul wird gleich deaktiviert.

Periodisches
Notfallprofil (nur
LRRP)

Das Funkgerät ist im Notfallmodus und meldet dies nach dem Ablauf eines bestimmten
Intervalls nach der letzten derartigen Meldung erneut.

Dies ist eine Verkaufsfunktion.

SIEHE AUCH

Standort

4.1 GPS-Leistung verbessern
Es kann vorkommen, dass die GPS-Funktion eine Positionsberechnung nicht erfolgreich abschließen kann. Es wird
ein akustisches Signal ausgegeben, dass das Funkgerät die Satelliten nicht finden kann.

Die GPS-Funktion funktioniert am besten, wenn sich kein Hindernis zwischen dem Funkgerät und viel freiem
Himmel befindet. Um dem Funkgerät das Bestimmen der Positionsdaten zu erleichtern, vermeiden Sie geschlossene
Räume, hohe Gebäude und dichtes Laub. Verwenden Sie, wenn möglich, kein GPS in unterirdischen Parkplätzen,
Tunneln, unter Brücken und in der Nähe von hohen Gebäuden.
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Ausführliche Bedienungsanleitung

4.2 GPS aktivieren
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Standort → Schnittstelle.

3 Wählen Sie Ein.

HINWEIS

Ihr Dienstanbieter kann diese Funktion aktivieren.

4.3 GPS-Symbol
Wenn das Funkgerät gültige GPS-Standortdaten empfängt, zeigt es ein GPS-Symbol an.

HINWEIS

Im Notfall-Modus zeigt das Funkgerät nicht das GPS-Symbol an, auch wenn GPS-Standortdaten
empfangen werden. Wenn gültige GPS-Standortdaten verfügbar sind, wenn Sie den Notfall-Modus
verlassen, wird das GPS-Symbol erneut angezeigt.

4.4 GPS Verschiedene Standortanzeigen
Tabelle 4-2 Verschiedene Standortanzeigen

Breite/Länge Britische
Koordinaten

Irische
Koordinaten

UTM-
Koordinaten

MGRS-
Koordinaten

Zeit Zeit Zeit Zeit Zeit

Breitengrad PIN mit zwei
Buchstaben

PIN mit einem
Buchstaben

PIN mit drei
Buchstaben

PIN mit drei
Buchstaben und PIN
mit zwei Buchstaben

Längengrad Easting- und
Northing-
Koordinate

Easting- und
Northing-
Koordinate

Easting- und
Northing-
Koordinate

Easting- und
Northing-
Koordinate

Höhe Höhe Höhe Höhe Höhe

Satelliten Satelliten Satelliten Satelliten Satelliten

• Zeit – gibt an, wann der Standort zuletzt berechnet wurde. Die Zeit wird in der koordinierten Weltzeit (Universal
Time Coordinated, UTC) angegeben.
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4.5 Ihre Position anzeigen

• Buchstaben-PIN – Gitterzone oder Quadrat auf der Karte für unterschiedliche Koordinatenstandards.

• Breitengrad – angegeben in Grad, Minuten und Sekunden.

• Längengrad – angegeben in Grad, Minuten und Sekunden.

• Anzahl der Satelliten – zur Berechnung des Standortes. Im Allgemeinen gilt: je mehr Satelliten, desto genauer ist
die Standortbestimmung. Der Empfang erfolgt von maximal zwölf Satelliten.

• Easting bezieht sich auf die Entfernung in Metern gen Osten.

• Northing bezieht sich auf die Entfernung in Metern gen Norden.

HINWEIS

Wird jede Ziffer der Easting- und Northing-Koordinate übersprungen, wird die Genauigkeit um den
Faktor 10 verringert.

4.5 Ihre Position anzeigen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Standort → Position.

3 Blättern Sie zum Anzeigen der Ergebnisse Ihrer letzten Standortberechnung.

HINWEIS

So aktualisieren Sie Ihre Position:

• Wählen SiePosition - das Funkgerät aktualisiert die Position automatisch

• Drücken Sie Auffr.

4.6 Hinweise zur Verwendung der GPS-Funktion
Wenn von mehreren Satelliten keine brauchbaren Signale verfügbar sind, funktioniert die GPS-Funktion des Geräts
nicht. Dies kann u. a. in folgenden Situationen der Fall sein:

• An unterirdischen Standorten

• Innerhalb von Gebäuden, Zügen oder anderen abgeschirmten Fahrzeugen

• Unter sonstigen Metall- und Betondecken oder -strukturen

• In der Nähe leistungsstarker Funk- oder Fernsehtürme

• Wenn die GPS-Antenne verdeckt wird (z. B. durch Ihre Hand oder ein anderes Objekt) oder zum Boden zeigt

• Bei extremen Temperaturen außerhalb der Grenzwerte für den Gerätebetrieb
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Ausführliche Bedienungsanleitung

Selbst wenn die Positionsdaten in derartigen Situationen berechnet werden können, wird dies unter Umständen
länger dauern. Melden Sie daher Ihren Standort in Notsituationen immer Ihrem Verteiler.

Berücksichtigen Sie außerdem, dass die GPS-Funktion, selbst wenn brauchbare Signale von mehreren Satelliten
zur Verfügung stehen, Ihren Standort nur ungefähr ermitteln kann. Abweichungen von 20 bis 100 Metern vom
tatsächlichen Standort sind möglich.
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5 Hauptmenü
Dieses Kapitel enthält Informationen zu den Optionen im Hauptmenü.

HINWEIS

Sie können das Menü während eines Anrufs aufrufen. Wenn Sie gerade ein Menü anzeigen, während ein
neuer Anruf startet, beendet das Funkgerät das Menü.

5.1 Durch das Menü blättern
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Blättern Sie zum gewünschten Menüpunkt durch Drücken der NAVIGATIONSTASTEN. Drücken Sie den
SOFTKEY, der alsWählen zugeordnet ist, oder die rechte NAVIGATIONSTASTE.
Wenn der Menüeintrag eine Reihe weiterer Menüoptionen enthält, wiederholen Sie Schritt 2.

HINWEIS

Sie können Tastenkombinationen zum Zugreifen auf häufig verwendete Elemente verwenden.

SIEHE AUCH

Verknüpfungen

5.2 Menüsymbole
Die folgenden Symbole ermöglichen das einfache Unterscheiden der Menüpunkte auf den ersten Blick.
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Ausführliche Bedienungsanleitung

Tabelle 5-1 Menüsymbole

Menüsymbol Beschreibung

Hauptmenü-Elemente / Kontextabhängiges Menü
Wird zum MENÜ zugeordnet, wenn die Hauptmenü-Elemente bzw. das Kontextmenü
aktiviert sind.

Nachrichten

Sendestatusmeldungen,

Senden von Textnachrichten (freier Text oder gemäß benutzerdefinierten bzw.
vordefinierten Vorlagen),

Empfangene Nachrichten im Eingang.

Kontakte
Hinzufügen, Suchen, Bearbeiten oder Löschen von Einträgen in der Kontaktliste.

Browser
Startet den WAP-Browser.

Sicherheit
Hier können Sie Sicherheitsfunktionen ein-/ausschalten und Kennwörter ändern.

Einstellungen
Erlaubt Ihnen die Anpassung Ihres Funkmoduls.

Gruppeneinstellungen
Enthält zusätzliche Menüpunkte für die Funktionen zum Scannen von Gesprächsgruppen.

Favoriten
Enthält Kurzbefehle für häufig verwendete Gesprächsgruppen und Kontaktnummern.

Meine Informationen
Zeigt Informationen über Ihr Funkgerät und Ihre Nummern an.

Aktuelle Anrufe
Enthält eine Liste der aktuellen Anrufe.

Verknüpfungen
Hier können Sie Verknüpfungen zu Menüoptionen anzeigen und verwalten.

RUI
Ermöglicht das Anmelden und Abmelden beim Funkmodul.

Netzwerke
Ermöglicht Ihnen, ein Netzwerk auszuwählen.

Standort
Zeigt die Position des Funkgeräts an.

Paketdaten
Ermöglicht das Senden von Daten von einem Funkmodul an andere Geräte.

Crypto-Menü
Verwalten der End-to-End-Verschlüsselung der SIM-Karte.

Services
Bietet Ihnen die Verwaltung von Broadcast-, Pannendienst- und Katastrophen-Alarmrufen.
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5.3 Nachrichten

5.3 Nachrichten
Mit dieser Funktion können Sie Textnachrichten senden und empfangen. Eine Nachricht kann je nach Einstellung
Ihres Dienstanbieters bis zu 1.000 Zeichen umfassen.

HINWEIS

Wenn Sie eine Nachricht empfangen, die nicht entschlüsselt werden kann, zeigt das Gerät eine
Benachrichtigung mit dem Titel Eingehendes SDS mit folgendem Inhalt an:

• ISSI-Adresse des Absenders.

• Entschlüsselung fehlgeschlagen: Meldung.

• Grund für das Fehlschlagen der Entschlüsselung: Falscher Schlüssel, Kein Schlüssel oder
SIM Fehler.

Drücken Sie zum Schließen der Benachrichtigung die rechte AUSWAHLTASTE oder die Taste ENDE.

Wenn Sie die PTT-Taste drücken, während eine Nachricht markiert ist, kann das eine der folgenden Aktionen
bedingen, je nach den Einstellungen Ihres Dienstanbieters:

• Das Funkgerät ignoriert den Druck der PTT-Taste.

• Das Funkgerät initiiert ein Privatgespräch mit dem Absender der Nachricht.

• Das Funkgerät initiiert einen Gruppenruf auf der aktuell gewählten Gesprächsgruppe.

5.3.1 Neue Nachricht
Über dieses Menüelement können Sie eine neue Nachricht erstellen.
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Ausführliche Bedienungsanleitung

5.3.1.1 Eine Nachricht an Privat/Telefon senden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Neue Nachr..

3 Geben Sie die Nachricht ein, und drücken Sie Senden.

4 Wählen Sie bei Bedarf Einzelruf/Telefon.

5 Geben Sie die Nummer des Empfängers ein, oder drücken Sie ABC zur Auswahl aus den Kontakten.

6 Drücken Sie Senden oder die SENDETASTE oder die PTT- Taste.

5.3.1.2 Eine Nachricht an Gruppe senden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Neue Nachr..

3 Geben Sie die Nachricht ein, und drücken Sie Senden.

4 Wählen Sie bei Bedarf Gruppe.

5 Wählen Sie eine Gruppe aus, um die Nachricht zu senden.

5.3.1.3 Eine Speichern-und-Weiterleiten-Nachricht senden
Voraussetzung:
Ihr Dienstanbieter aktiviert die Funktion Speichern und Weiterleiten.
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5.3.1.4 Übertragungsbericht

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen SieNachrichten → Neue Nachr..

3 Drücken Sie die Taste MENU, und wählen Sie Nachr.Setup → On/Offline-Benutzer.

4 Geben Sie die Nachricht ein, und drücken Sie Senden.

5 Wenn Sie zur Zielauswahl aufgefordert werden, wählen Sie eine der folgenden Optionen aus:
• Einzelruf: Geben Sie die private Nummer ein, oder drücken Sie ABC, um die Zieltelefonnummer aus

der Kontaktliste auszuwählen.
• Telefon: Geben Sie die Telefonnummer ein, oder drücken Sie ABC, um die Zieltelefonnummer aus

der Kontaktliste auszuwählen.

HINWEIS

Ihr Dienstanbieter kann das Senden einer Speichern-und-Weiterleiten-Nachricht an eine Gesprächsgruppe
aktivieren.

6 Wählen Sie Senden, oder drücken Sie SENDEN oder die PTT-Taste.

5.3.1.4 Übertragungsbericht

Beim Übertragungsbericht es handelt sich um eine Bestätigung, die das Funkgerät beim Senden einer Nachricht an
einen Empfänger anfordern kann. Sie können definieren, welche Art Übertragungsbericht Ihr Funkgerät anfordert,
oder diese Funktion ein-/ausschalten.

Geht der Übertragungsbericht kurz nach dem Senden der Nachricht ein, wird das Funkgerät:

• Ein Popup-Fenster mit einer der folgenden Meldungen anzeigen (je nachdem, welcher Übertragungsbericht
empfangen wurde): Nachricht gesendet, Nachricht zugestellt, Nachricht gelesen oder Nachricht
fehlgeschlagen.

• Den Übertragungsbericht im Postausgang zusammen mit einer Kopie der Nachricht speichern.

Geht der Übertragungsbericht erst nach einem längeren Zeitraum ein, geht das Funkgerät wie folgt vor:

• Es speichert den Übertragungsbericht im Postausgang zusammen mit einer Kopie der Nachricht.

• Wenn die Funktion für Benachrichtigungen zu Übertragungsberichten von Ihrem Dienstanbieter konfiguriert
ist, macht das Funkgerät außerdem Folgendes:

– Es speichert vorübergehend einen Übertragungsbericht im Posteingang. Die Benachrichtigung
wird ausgeblendet, nachdem sie gelesen wurde.

– Zeigt das Symbol Neue Nachricht an.

– Zeigt den Benachrichtigungsbildschirm Neuer Lieferstatus (wenn möglich) an.
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Ausführliche Bedienungsanleitung

5.3.1.5 Anzeigen von Übertragungsberichten
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang.

3 Suchen Sie die gewünschte Nachricht, und wählen Sie Lesen.

4 Drücken Sie die Taste MENÜ.

5 Wählen Sie Zusendestatus.

5.3.1.6 Die Zustellmeldung konfigurieren
Voraussetzung:
Ihr Dienstanbieter aktiviert die Konfiguration der Zustellmeldungen.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Neue Nachr..

3 Drücken Sie auf die Taste MENÜ, und wählen Sie Zustellungsbericht.

4 Wählen Sie eine der folgenden Optionen aus:
• Kein: Das Gerät fordert keine Zustellmeldung an.
• Empfangen: Das Gerät fordert eine Zustellmeldung für Nachrichten an, die empfangen wurden.
• Gelesen: Das Gerät fordert eine Zustellmeldung für Nachrichten an, die gelesen wurden.
• Beide: Das Gerät fordert eine Zustellmeldung für Nachrichten an, die empfangen und gelesen wurden.

5.3.2 Posteingang
Der Posteingang enthält bis zu 100 neue oder alte eingehende Nachrichten.

Tabelle 5-2 Posteingangssymbole

Symbol Beschreibung

Ungelesene (neue) Nachricht

Gelesene (alte) Nachricht
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5.3.2.1 Den Posteingang aufrufen

Tabelle 5-2 Posteingangssymbole (Fortsetzung)

Symbol Beschreibung

Absenderinformationen in Nachrichtenansicht: Name oder Nummer

Zeit- und Datumsstempel in Nachrichtenansicht: Uhrzeit und Datum des Eingangs

Empfangener Lieferstatus: Lieferstatus für gespeicherte und weitergeleitete Nachrichten

Nachrichten Das Untermenü zeigt die Anzahl der Nachrichten an. Lautet die Anzeige beispielsweise 2/4, bedeutet
dies, dass zwei ungelesene und vier gelesene Nachrichten im Eingang vorhanden sind.

5.3.2.1 Den Posteingang aufrufen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang.

HINWEIS

Der Status der Liste wird (falls vorhanden) einige Sekunden lang angezeigt:

• Keine alten/neuen Nachr.: Das Display wechselt nach einigen Sekunden wieder zur
vorherigen Anzeige.

• Eingang voll: Wählen Sie Ok.

5.3.2.2 Eine neue Nachricht empfangen

Durchzuführende Schritte

1 Eine neue Nachricht wurde empfangen.
Schrittergebnis: Ihr Funkgerät zeigt eine Animation an und spielt den Ton für Neue Mail empfangen ab.

2 Wählen Sie eine der folgenden Optionen aus:
• Lesen: Öffnet die ganze Nachricht.
• Zurück: Die Nachricht wird ausgeblendet. Sie können später über den Eingang auf die Nachricht

zugreifen.
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Ausführliche Bedienungsanleitung

5.3.2.3 Die Untermenüs im Posteingang und Postausgang
verwenden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang oder Ausgang.

3 Markieren Sie die gewünschte Nachricht, und drücken Sie die MENÜ-Taste.

4 Wählen Sie eine der folgenden Optionen aus:
• Speichern: Speichert eine Nachricht als Vorlage. Ändern Sie den Namen der Standardvorlage, und

drücken Sie Ok.
• Löschen: Löscht die ausgewählte Nachricht. Drücken Sie Ja, um die Einstellung zu bestätigen.
• Alle Löschen: Löscht alle Nachrichten im Eingang/Ausgang. Drücken Sie Ja, um die Einstellung zu

bestätigen.
• Antw. (nur für Eingang): Ruft den Bearbeitungsbildschirm mit der alten Nachricht als Standardtext

und den Absender der Nachricht als Empfänger auf. Drücken Sie nach dem Bearbeiten auf Senden, auf
die PTT-Taste oder die SENDETASTE, um zu senden.

• Erneut senden (nur für Ausgang): Ruft den Bearbeitungsbildschirm mit dem zuvor eingegebenen Text
mit dem gleichen Empfänger auf. Drücken Sie nach dem Bearbeiten auf Senden, auf die PTT-Taste
oder die SENDETASTE, um zu senden.

• Weiter: Ruft den Bearbeitungsbildschirm mit der alten Nachricht zum Senden an einen anderen
Teilnehmer auf. Drücken Sie nach dem Bearbeiten auf Senden, auf die PTT-Taste oder die
SENDETASTE, um zu senden.

• Auffr.: Ordnet die Nachrichtenliste neu an und zeigt die neuen Nachrichten an.
• Zusendestatus (nur für Ausgang): Zeigt Datum und Uhrzeit der gesendeten Nachricht an, wann

sie gesendet, zugestellt, gelesen wurde oder unübermittelt abgelaufen, ungelesen abgelaufen oder
unbekannt fehlgeschlagen ist.

5.3.2.4 Eingebettete Nummer
Mit dieser Funktion können Sie eine Nummer aus einer Nachricht anrufen oder einen Gruppenanruf für die
Absender-Gesprächsgruppe tätigen.

5.3.2.5 Eine Nummer aus einer Nachricht speichern
Voraussetzung:
Die Funktion „Eingebettete Nummer“ kann von Ihrem Dienstanbieter aktiviert werden.

Anwendungsgebiete:
Sie können die Nummer des Absenders oder eine in der Nachricht eingebettete Nummer bei einem neuen Kontakt
oder einem vorhandenen Kontakt speichern.
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5.3.2.6 Eine Telefonnummer in einer Nachricht anrufen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang.

3 Markieren Sie die gewünschte Nachricht, und wählen Sie Lesen.

4 Drücken Sie auf die PTT-Taste.

5 Das Gerät zeigt eine Liste der Nummern an (einschließlich der des Absenders).

6 Markieren Sie die gewünschte Nummer, und drücken Sie auf Speichern.

7 Markieren Sie den gewünschten Kontakt, und drücken Sie auf Zeigen.

HINWEIS

Wenn Sie eine Nummer für einen neuen Kontakt speichern möchten, wählen Sie [Neue Kurzwahl], und
füllen Sie die erforderlichen Felder aus. Drücken Sie auf Fertig, um die Angaben zu speichern.

8 Wählen Sie Bearb.

9 Wählen Sie den Typ der neuen Nummer aus, und drücken Sie auf Fertig.

5.3.2.6 Eine Telefonnummer in einer Nachricht anrufen
Voraussetzung:
Die Funktion „Eingebettete Nummer“ kann von Ihrem Dienstanbieter aktiviert werden.

Anwendungsgebiete:
Sie können einen Sprachanruf an den Absender einer Nachricht oder an eine im Nachrichtentext eingebettete
Nummer einleiten.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang.

3 Markieren Sie die gewünschte Nachricht, und wählen Sie Lesen.

4 Drücken Sie auf die PTT-Taste.

5 Das Gerät zeigt eine Liste der Nummern an (einschließlich der des Absenders).

6 Markieren Sie zum Einleiten des Anrufs die gewünschte Nummer, und drücken Sie die PTT-Taste oder die
SENDETASTE.

7 Wählen Sie R-Typ, um den Anruftyp auszuwählen (Einzelruf, Telefon oder NbSt).

8 Drücken Sie die PTT- oder die SENDETASTE.

5.3.2.7 Einen Gruppenanruf an die Gesprächsgruppe des
Absenders einer Nachricht tätigen

Voraussetzung:
Die Funktion „Eingebettete Nummer“ kann von Ihrem Dienstanbieter aktiviert werden.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Eingang.

3 Markieren Sie die gewünschte Nachricht, und drücken Sie die PTT-Taste.

5.3.2.8 Sofortmeldung
Wenn eine neue Sofortmeldung empfangen wird, spielt das Funkgerät den Ton für Neue Mail empfangen ab und
zeigt den Inhalt über dem vorherigen Bildschirm an. Alle Sofortmeldungen werden im Eingang gespeichert. Wenn
das Funkgerät im PIN-Sperrmodus ist, wird die Sofortmeldung angezeigt, nachdem die korrekte PIN eingegeben
wurde.

HINWEIS

Diese Funktion muss von Ihrem Dienstanbieter aktiviert werden.
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5.3.3 Postausgang

5.3.3 Postausgang
Im Postausgang werden alle gesendeten Nachrichten gespeichert.

Tabelle 5-3 Postausgangssymbole

Symbol Beschreibung

Zustellung läuft

Zustellung abgeschlossen

Zustellung fehlgeschlagen

Erfolgreich gesendete Nachricht

Nicht gesendete Nachricht

5.3.4 CO-Box
Die Vorf.Mld-Box enthält die chronologisch angeordneten Vorfall-Nachrichten (sowohl ein- als auch
ausgegangene), wobei die neueste Nachricht in der Liste ganz oben ist. Wenn Sie im Titel einer Vorfall-Nachricht
aufWählen klicken, so werden detaillierte Informationen zu dem Vorfall angezeigt.

Wenn das Funkgerät sich im normalen Modus befindet, können Sie alle Nachrichten in der Vorf.Mld-Box einsehen.
Wenn sich das Gerät aber im Vorfall-Modus befindet, können Sie nur die für die aktuelle Vorfall-Nachricht
relevanten Informationen einsehen.

SIEHE AUCH

Vorfall

5.3.5 RMS-Postfach
Das RMS-Postfach speichert alle eingehenden und ausgehenden RMS-Nachrichten (sowohl Statusmeldungen
als auch freie Textnachrichten).

5.3.6 WAP-Box
Jede WAP-Push-Nachricht kann sofort geladen werden oder als Nachricht in der WAP-Box gespeichert
werden. Anschließend kann sie über MENÜ → Nachrichten → WAP-Box aufgerufen werden. Alle
WAP-Push-Nachrichten werden an den Browser übergeben.
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SIEHE AUCH

WAP

WAP-Push

5.3.7 Vorlagen
Diese Funktion dient zur Speicherung von bis zu 100 vordefinierten und eigenen Nachrichtenvorlagen.
Die verschiedenen Nachrichten im Eingang und Ausgang können als Vorlagen gespeichert werden. Jeder
Vorlagenname und Text kann nachträglich bearbeitet werden.
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5.3.7.1 Eine benutzerdefinierte Vorlage senden

5.3.7.1 Eine benutzerdefinierte Vorlage senden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Vorlagen Menü.

3 Markieren Sie den gewünschten Vorlagennamen, und drücken Sie auf Senden.

4 Führen Sie einen der folgenden Schritte aus:
• Geben Sie die Nummer ein, oder drücken Sie auf ABC, um den Namen aus Ihrer Kontaktliste

auszuwählen. Drücken Sie auf Senden.
• Wählen Sie die gewünschte Gesprächsgruppe aus der Gruppenliste aus.

5.3.7.2 Benutzerdefinierte Vorlagen einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Vorlagen Menü.

3 Markieren Sie die gewünschte Vorlage, und drücken Sie auf MENÜ.

4 Wählen Sie eine der folgenden Optionen aus:
• Zeigen: Zeigt den Vorlagentext an.
• Löschen: Löscht die Vorlage.
• Text bearbeiten: Öffnet den Bearbeitungsbildschirm mit dem Vorlagentext. Bearbeiten Sie den Text,

und drücken Sie auf MENÜ. Wählen Sie Änderungen speichern, um die bearbeitete Vorlage zu
speichern, oder wählen Sie Speichern, um die bearbeitete Vorlage als neue Datei zu speichern.

• Name bearbeiten: Öffnet den Bearbeitungsbildschirm mit dem Vorlagennamen. Drücken Sie auf Ok,
um die Vorlage zu speichern.

5.3.8 Vordefinierte Vorlagen
In Ihrem Funkgerät sind vordefinierte Nachrichtenvorlagen programmiert. Sie können die vordefinierte Vorlage
begrenzt bearbeiten. Sie können sie senden, aber Sie können die bearbeitete Vorlage nicht speichern oder aus der
Liste der vordefinierten Vorlagen löschen.
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5.3.8.1 Vordefinierte Vorlagen anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Vordefiniert.

3 Markieren Sie die gewünschte Vorlage, und drücken Sie auf MENÜ.

4 Wählen Sie Zeigen.

5.3.8.2 Vordefinierte Vorlagen senden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Vordefiniert.

3 Markieren Sie die gewünschte Vorlage, und drücken Sie auf Senden, auf die PTT-Taste oder auf die
SENDETASTE.

HINWEIS

Sie können die vordefinierte Vorlage vor dem Senden bearbeiten. Drücken Sie die Taste MENÜ, und
wählen Sie Bearb. Der Bearbeitungsbildschirm mit dem Vorlagentext wird geöffnet. Sie können nur den
vorhandenen Text bearbeiten.

5.3.9 Status senden

5.3.9.1 Eine Statusmeldungsnummer anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Status senden.

3 Drücken Sie MENÜ, und wählen Sie Zeigen.
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5.3.9.2 Eine Statusmeldung an eine Gruppe senden

5.3.9.2 Eine Statusmeldung an eine Gruppe senden
Voraussetzung:
Wechseln Sie in die Gesprächsgruppe, an die Sie eine Statusmeldung senden möchten.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Status senden.

3 Führen Sie einen der folgenden Schritte aus:
• Markieren Sie die gewünschte Statusmeldung, und drücken Sie aufWählen, auf die PTT-Taste oder die

SENDETASTE.
• Geben Sie 5-stellige Statusmeldung ein, und drücken Sie auf Senden.

HINWEIS

Wenn das Gerät Statusliste leer anzeigt, können Sie eine 5-stellige Statusmeldung eingeben und auf
SendAn drücken.

5.3.9.3 Gezielter Status
Mit dieser Funktion können Sie die Statusmeldung an eine private Nummer oder eine vom Benutzer ausgewählte
Gesprächsgruppe übertragen.

HINWEIS

Ihr Dienstanbieter kann das Senden einer Statusmeldung an eine private Nummer, die nicht unter
Kurzwahlen steht, deaktivieren.
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5.3.9.4 Eine gezielte Statusmeldung senden
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → Status senden.

3 Führen Sie einen der folgenden Schritte aus:
• Markieren Sie die gewünschte Statusmeldung, und drücken Sie aufWählen, auf die PTT-Taste oder die

SENDETASTE.
• Geben Sie 5-stellige Statusmeldung ein, und drücken Sie auf Senden.

HINWEIS

Wenn das Gerät Statusliste leer anzeigt, können Sie eine 5-stellige Statusmeldung eingeben und auf
SendAn drücken.

4 Führen Sie einen der folgenden Schritte aus:
• Geben Sie die Nummer ein, oder drücken Sie auf ABC, um den Namen aus Ihrer Kontaktliste

auszuwählen. Drücken Sie auf Senden.
• Wählen Sie die gewünschte Gesprächsgruppe aus der Gruppenliste aus.

Ergebnis:
Das Display zeigt eine der folgenden Zustellmeldungen an:

• Status gesendet.
• Status missglückt.

5.4 Kontakte
Dieses Untermenü speichert alle Ihre Kontaktnummern. Jeder Eintrag erfordert die folgenden Informationen:

• Name: Wenn Sie mehr als eine Nummer für einen Kontakt speichern, so ist dieser Eintrag erforderlich.
• Typ: Jedem Kontakt muss einer der folgenden Typen zugewiesen werden:

Tabelle 5-4 Kontakttypen

Kontaktsymbol Beschreibung
Einzelruf
Kann keine Kurzwahlnummer haben.

Handy

Heim

Arbeit
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5.4.1 Einen Kontakt erstellen

Tabelle 5-4 Kontakttypen (Fortsetzung)

Kontaktsymbol Beschreibung
NbSt

Andere

Auswahl
Zeigt an, dass der Kontakt mehr als eine Nummer aufweist.

• # (Nummer): Jeder Kontakteintrag muss eine Nummer aufweisen.

• Schnellwahl#: Übernehmen Sie die Standard-Kurzwahlnummer oder ändern Sie sie.

5.4.1 Einen Kontakt erstellen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm auf KWlist.

2 Wählen Sie [Neue Kurzwahl].

3 Markieren Sie Name, und drücken Sie Ändern. Geben Sie den Namen Ihres Kontakt ein, und drücken Sie Ok.

4 Markieren Sie Typ, und drücken Sie Ändern. Wählen Sie den Kontakttyp aus.

HINWEIS

Sie können die linke oder rechte NAVIGATIONSTASTE verwenden, um den Typ des Kontakts aus
dem Bildschirm Angaben auszuwählen.

5 Markieren Sie # (Nummer), und drücken Sie Ändern. Geben Sie die Nummer Ihres Kontakt ein, und drücken
Sie Ok.

6 Falls erforderlich, markieren Sie Schnellwahl# und drücken Ändern. Geben Sie die Kurzwahlnummer (1
bis 1000) des Kontakts ein, und drücken Sie Ok.

HINWEIS

Wenn die eingegebene Nummer schon vorhanden ist, zeigt das Funkgerät Überschreiben? . Drücken Sie
Ja, um zu bestätigen, oder Nein, um die Kurzwahlnummer erneut einzugeben.

7 Drücken Sie auf Fertig.

Ergebnis:
Sie haben einen Kontakt mit einer Nummer erstellt. Um zusätzliche Nummern hinzuzufügen, wiederholen Sie
die Schritte 4 bis 6.
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5.4.2 Einen Kontakt bearbeiten

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf KWlist.

2 Markieren Sie den Kontakt, den Sie bearbeiten möchten.

3 Drücken Sie die MENÜTASTE.

4 Drücken Sie auf Bearb.

5 Markieren Sie eine der folgenden Optionen, und drücken Sie Ändern, um Folgendes zu bearbeiten:
• Name

• Typ

• # (Nummer)
• Schnellwahl#

6 Drücken Sie auf Fertig.

5.4.3 Eine Nummer löschen

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf KWlist.

2 Wählen Sie einen Kontakt aus, den Sie bearbeiten möchten.

3 Drücken Sie die NAVIGATIONSTASTEN nach links oder rechts, um die gewünschte Nummer auszuwählen.

4 Drücken Sie auf MENÜ.

5 Wählen Sie Num. löschen.

HINWEIS

Wenn ein Eintrag nur eine Nummer enthält, wird beim Löschen der Nummer auch der Eintrag gelöscht.

6 Drücken Sie auf Ja.
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5.4.4 Einen Kontakt löschen

5.4.4 Einen Kontakt löschen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm auf KWlist.

2 Markieren Sie einen Kontakt, den Sie löschen möchten.

3 Drücken Sie die MENÜTASTE.

4 Wählen Sie Kurzw.löschen.

5 Wählen Sie Ja.

5.4.5 Die Kapazität überprüfen
Anwendungsgebiete:
Erfahren Sie, wie viele Nummern im Funkgerät gespeichert sind.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm auf KWlist.

2 Drücken Sie die MENÜTASTE.

3 Wählen Sie Kapazität.

4 Wählen Sie eine der folgenden Optionen aus:
• Einzelruf

• Telef./ Nebenst.

• Kurzwahl

5.4.6 Nummern in der Kontaktliste wählen
Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf KWlist.

2 Verwenden Sie zum Markieren des gewünschten Kontakts die obere und untere NAVIGATIONSTASTE, oder
geben Sie bis zu 12 Zeichen des Kontaktnamens ein.

3 Wenn für einen Kontakt mehrere Nummern vorhanden sind, wählen Sie die gewünschte Nummer mithilfe
der linken und rechten NAVIGATIONSTASTE aus.

4 Drücken Sie die PTT-Taste, um einen Simplex-Anruf an eine Einzelruf Nummer einzuleiten. Verwenden Sie
anderenfalls die SENDETASTE, um einen Duplex-Anruf einzuleiten.

5.5 Browser
Dieses Menüelement aktiviert einen WAP-Browser, mit dem Sie auf Ihrem Funkgerät im Internet surfen können.

SIEHE AUCH

WAP

5.6 Sicherheitsbereich
Dieses Untermenü speichert alle Sicherheitseinstellungen.
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5.6.1 Die Tastensperre einrichten

5.6.1 Die Tastensperre einrichten
Die Tastensperrfunktion ermöglicht das Sperren der Tastatur, um ein versehentliches Drücken der Tasten zu
verhindern. Das Sperren/Entsperren der Tastatur kann über das Menü oder einen vordefinierten Menükurzbefehl
aufgerufen werden. Standardmäßig müssen Sie MENÜ und dann die Taste *.

Ihr Dienstanbieter kann bestimmen, welche der folgenden Elemente darüber hinaus nicht verfügbar sind, während
die Tastensperrfunktion aktiviert ist:

• Die PTT-Taste

• Seitliche Tasten

• Der DREHKNOPF

Die EIN/AUS/ENDE/HOME-Taste wird immer außer Betrieb gesetzt, und die NOTRUF-Taste funktioniert immer.

SIEHE AUCH

Die Tasten sperren/entsperren

5.6.1.1 Benachrichtigung der Tastensperre
Wenn die Tastatur gesperrt ist, kann Ihr Dienstanbieter eine der folgenden Anweisungen konfigurieren:

• Keine: Es wird keine Benachrichtigung angezeigt.

• Nur Benachrichtigung: Tasten gesperrt wird angezeigt.

• Benachrichtigung und Anleitung: Drücken Sie Menü * zum Sperren/Entsperren des Tastenfelds wird
angezeigt.
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5.6.1.2 Die automatische Tastensperrenverzögerung einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → Tastensp. Einst. → Verzögerung.

3 Verwenden Sie die NAVIGATIONSTASTE nach oben/unten, um die Minuten zu ändern, und drücken Sie
Fertig.

5.6.1.3 Die Tastensperre beim Start einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → Tastensp. Einst. → Beim Start sperren.

3 Wählen Sie Ein/Aus.

5.6.2 Drahtlose Verschlüsselung
Drahtlose Verschlüsselung ist eine Funktion, die die Verschlüsselung der gesamten Kommunikation zwischen
Funkgerät und Infrastruktur ermöglicht, was zu erhöhter Sicherheit bei Anrufen, Nachrichten und Daten führt.

Falls die Option von Ihrem Dienstanbieter konfiguriert wurde, gibt das Funkgerät einen Ton aus und zeigt Sprache
unverschlüsselt an, wenn die Verschlüsselung aktiviert ist und Sie einen unverschlüsselten Anruf erhalten. Diese
Funktion bietet Dienstvertraulichkeit zwischen Ihnen und dem System.

Wenn im TMO-Modus die drahtlose Verschlüsselung aktiviert ist, aber aufgrund eines Infrastrukturfehlers nicht
unterstützt werden kann, wird das folgende Symbol auf dem Display angezeigt: .
Wenn die Verschlüsselung im DMO-Modus nicht verfügbar ist, zeigt das Funkgerät Folgendes an: .

Mit diesem Menüpunkt können Sie nur den drahtlosen Verschlüsselungsstatus anzeigen.
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5.6.2.1 Den Status der drahtlosen Verschlüsselung anzeigen

SIEHE AUCH

Statussymbole

5.6.2.1 Den Status der drahtlosen Verschlüsselung anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → Verschlüsselung.

3 Ihr Funkgerät zeigt Folgendes an:
a. Verschlüsselung Aus.
b. Verschlüsselung Ein.

5.6.2.2 Den Schlüssel für die drahtlose Verschlüsselung löschen
Erkundigen Sie sich bei Ihrem Dienstanbieter, ob das Funkgerät mit Luftschnittstellenverschlüsselungs-Schlüsseln
geliefert wird. Sie können die Luftschnittstellenverschlüsselungs-Schlüssel durch folgende Eingabe löschen:
**00##.

HINWEIS

• Es dauert etwa eine Minute, bis alle Verschlüsselungsschlüssel aus dem Funkgerät gelöscht sind.

• Das Löschen erfolgt im TMO/DMO-Leerlauf oder im Notbetrieb.

VORSICHT

Bei Verwendung dieser Funktion wird das Funkgerät deaktiviert, und Ihr Dienstanbieter muss
es erneut aktivieren.

5.6.3 K-Gültigkeit
K (Key) ist ein geheimer Schlüssel, den die Infrastruktur zur Authentifizierung des Funkgeräts im System
verwendet. Es handelt sich um einen Teil des Authentifizierungsvorgangs, der die Dienstvertraulichkeit zwischen
Funkgerät und System garantiert.
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5.6.3.1 Die K-Gültigkeit überprüfen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → K-Prüfung.

3 Ihr Funkgerät zeigt Folgendes an:

• K gültig: die Infrastruktur kann das Funkgerät authentifizieren.

• K ungültig: die Infrastruktur kann das Funkgerät nicht authentifizieren. Bitte wenden Sie sich an den
Dienstanbieter zur Wiederherstellung der Schlüssels zu Ihrem Funkgerät.

5.6.4 TMSCK-Gültigkeit
SCK (Statischer Chiffrierschlüssel) ist ein geheimer Schlüssel, den die Infrastruktur zur Verschlüsselung von
Anrufen und Daten in TMO-Modus verwendet. Luftschnittstellenverschlüsselung bietet Dienstvertraulichkeit
zwischen dem Funkgerät und dem System. Das Funkgerät wird mit einem Satz SCKs geliefert.

5.6.4.1 Die TMSCK-Gültigkeit überprüfen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → TMSCK-Prüfung.

3 Ihr Funkgerät zeigt Folgendes an:

• TMSCK gültig: das Funkgerät kann im TMO-Modus verschlüsselt arbeiten.

• TMSCK ungültig: das Funkgerät kann im TMO-Modus nicht verschlüsselt arbeiten. Setzen Sie sich
mit Ihrem Dienstanbieter in Verbindung, um SCKs für Ihr Funkgerät wiederherzustellen.

5.6.5 DMSCK-Gültigkeit
Diese Funktion garantiert die Dienstvertraulichkeit für Ihre Anrufe und Datendienste im DMO-Modus.
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5.6.5.1 Die DMSCK-Gültigkeit überprüfen

5.6.5.1 Die DMSCK-Gültigkeit überprüfen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → DMSCK Prüfung.

3 Ihr Funkgerät zeigt Folgendes an:

• DMSCK gültig: das Funkgerät kann im DMO-Modus verschlüsselt arbeiten.

• DMSCK ungültig: das Funkgerät kann im DMO-Modus nicht verschlüsselt arbeiten. Setzen Sie sich
mit Ihrem Dienstanbieter in Verbindung, um SCKs für Ihr Funkgerät wiederherzustellen.

5.6.6 DMO SCK
Luftschnittstellenverschlüsselung bietet Dienstvertraulichkeit zwischen dem Funkgerät im Direktmodus und
einen anderen Funkgerät oder einer Gruppe von Funkgeräten im Direktmodus. Mit dieser Funktion können Sie
die Sicherheit verbessern.

HINWEIS

Diese Funktion muss von Ihrem Dienstanbieter aktiviert werden.
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5.6.6.1 DMO-SCK ändern
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → DMO SCK.

3 Drücken Sie Nächst..

4 Das Funkgerät zeigt Versionswechsel zu an.

5 Wählen Sie eine der folgenden Optionen aus:
• Ja: den Code ändern. Das Funkgerät zeigt Schlüsselversion geändert an.
• Nein: den Schlüssel beibehalten. Das Funkgerät zeigt PIN nicht geändert an.

5.6.7 Tarnmodus (Verdeckter Modus)
Diese Funktion ermöglicht es, alle visuellen und akustischen Alarme und Benachrichtigungen vollständig
auszustellen, sodass das Funkgerät auch in einer leisen und dunklen Umgebung nicht wahrnehmbar ist.

Wenn das Funkgerät im verdeckten Modus ist, können Sie die folgenden Menüoptionen des Einstellungen-Menüs
nicht aufrufen.

• Lautstärke einst.
• Töne
• Beleuchtung (Menüoption in Anzeige)

Wenn der verdeckte Modus eingeschaltet ist, gilt Folgendes:

• Alle Töne sind auf Aus gestellt (entspricht dem Menüeintrag Alle Töne).
• Der private Lautsprecher ist auf Aus gestellt.
• Des Dimmerstatus ist auf verdeckt eingestellt (dieser Status ist nicht mit der Taste
HINTERGRUNDBELEUCHTUNG wählbar).

• Das Hintergrundbild ist deaktiviert.
• Der Bildschirmschoner ist deaktiviert.
• Die Farbpalette für verdeckten Modus wird aktiviert.

Das Funkgerät startet im zuletzt eingestellten Modus vor dem Ausschalten des Geräts. Wenn also vor dem
Ausschalten der verdeckte Modus eingeschaltet war, schaltet sich das Funkgerät auch mit verdecktem Modus ein.

Wenn der verdeckte Modus deaktiviert wird, werden alle geänderten Einstellungen wieder auf den vorherigen
Zustand zurückgesetzt.

Bei Verwendung des verdeckten Modus sollte ein Audio-Zubehör mit niedriger Lautstärke an das Funkgerät
angeschlossen werden. Die richtige leise Zubehör ist der GCAI Handapparat oder ein älterer Handapparat,
verbunden über die Abzweigdose.

Diese Funktion kann als One-Touch-Taste verwendet werden.
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5.6.7.1 Den verdeckten Modus aktivieren

5.6.7.1 Den verdeckten Modus aktivieren

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → verdeckter Mod..

3 Wählen Sie eine der folgenden Optionen aus:
• Ein: Alle Töne sind deaktiviert, und die Hintergrundbeleuchtung und die LEDs sind sofort

ausgeschaltet. Gruppen-Audio wird an den Ohrhörer geleitet. Das Funkgerät zeigt verdeckter Modus
an an.

• Aus: Alle Einstellungen für Töne, Hintergrundbeleuchtung und Audio werden wiederhergestellt.
Das Funkgerät zeigt verdeckter Modus aus an.

5.6.8 SDS-Fernsteuerung
Die SDS-Fernsteuerung ist eine Funktion, dank der Funkgeräte über spezielle SDS-Nachrichten ferngesteuert und
-konfiguriert werden können. Die Nachrichten können sowohl im TMO- als auch im DMO-Modus von allen
Funkgeräten, die andere Geräte steuern können, gesendet werden. Während Fernsteuerungsnachrichten ausgeführt
werden, kann das Funkgerät, abhängig von den Einstellungen des Dienstanbieters, einen Ton abspielen, vibrieren
oder ein entsprechendes Symbol im Bereich der Statussymbole anzeigen.

Diese Funktion muss von Ihrem Dienstanbieter aktiviert werden.

5.6.8.1 Die SDS-Fernsteuerung einstellen
Anwendungsgebiete:
Mit dieser Funktion aktivieren/deaktivieren Sie die speziellen SDS-Nachrichten, die eine Fernsteuerung Ihres
Funkgeräts ermöglichen.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Sicherheit → Fernzugriff.

3 Wählen Sie Ein oder Aus, um die Fernsteuerung zu aktivieren/deaktiviert.

5.7 Einstellungen
Mit diesem Untermenü können Sie die Konfiguration Ihres Geräts ändern.
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5.7.1 Ruftonart
Dieses Untermenü ermöglicht die Anpassung des Klingeltons für eingehende Anrufe.

5.7.1.1 Den Klingelton einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Signalton Stil.

3 Wählen Sie eine der folgenden Optionen aus:
• Duplex: um den neuen Klingelton für alle Duplex-Anrufe zu verwenden.
• Simplex: um den neuen Klingelton für alle Simplex-Anrufe zu verwenden.

HINWEIS

Nach der Eingabe in diesem Untermenü zeigt das Display den aktuell verwendeten Klingelton an.

4 Blättern Sie zum gewünschten Ton, und drücken SieWählen.

HINWEIS

Der neue Klingelton wird sofort für einige Sekunden abgespielt. Wenn nötig, passen Sie die Lautstärke an.

5.7.2 Lautstärkeregelung
Über diesen Menüpunkt können Sie die Lautstärke für Sprache, Duplex, Simplex, Tastatur und Töne für
Lautsprecher und Ohrhörer anpassen.
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5.7.2.1 Die Lautstärke einstellen

SIEHE AUCH

Lautstärkereglermodus

5.7.2.1 Die Lautstärke einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Lautstärke einst..

3 Wählen Sie Lautsprecher oder Ohrhörer.

4 Wählen Sie eine der folgenden Optionen aus:
• Sprache: Einstellung der Lautstärke für Sprache.
• Duplex: Legt die Lautstärke für Duplex-Klingeltöne fest.
• Simplex: Legt die Lautstärke für Simplex-Klingeltöne fest.
• Tastatur: Einstellung der Lautstärke der Tastentöne.
• Töne: Legt die Lautstärke für Signaltöne fest.

HINWEIS

Wenn die Anzeige nur eine Option Lautstärke enthält, können Sie alle oben genannten Einstellungen
gemeinsam festlegen. Sie haben die Möglichkeit, die Einstellungen einzeln zu ändern, wennModus
"Lautst. einst."auf Individuell eingestellt ist.

5 Drücken Sie die rechte oder linke NAVIGATIONSTASTE, um den Wert zu ändern.

SIEHE AUCH

Den Lautstärkereglermodus einstellen

5.7.3 Sprache
In diesem Untermenü können Sie die Sprache des Funkgeräts ändern.
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5.7.3.1 Die Sprache einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Sprache.

3 Wählen Sie die gewünschte Sprache.

5.7.4 Dateneinstellungen
Über diesen Menüpunkt können Sie das Funkgerät zum Senden und Empfangen von Daten vom externen Gerät
einrichten.

Verwenden Sie ein Kabel vom Typ PMKN4104 um den Zubehöranschluss Ihres Funkgeräts mit dem externen Gerät
zu verbinden. Das externe Gerät muss eine Anwendung entsprechend der TETRA-Standards ausführen.

HINWEIS

• Datendienste sind nur im TMO-Modus verfügbar.
• Datendienste sind im TXI-Modus gesperrt.

5.7.4.1 Die Datenfunktion einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Dateneinstellung.

3 Wählen Sie eine der folgenden Optionen aus:
• Nur Sprache: Ihr Funkgerät empfängt und sendet nur Sprachanrufe.
• Nur Daten: Ihr Funkgerät dient als Modem. Es verweigert eingehende und ausgehende Sprachanrufe

(außer Notrufe) sowie Statusmeldungen und Textnachrichten.
• Sprache & Daten: Das Funkgerät dient als Modem, aber Sprachanrufe haben Vorrang vor

Datenanrufen und können diese unterbrechen.

5.7.5 Audio
Mit dieser Menüoption können Sie die Audio-Einstellungen des Funkgeräts vornehmen.

5-30 -



5.7.5.1 Lautstärkereglermodus

5.7.5.1 Lautstärkereglermodus
Sie können die Lautstärke auf Individuell oder Normal einstellen. Ist die Option auf Individuell gesetzt, kann die
Lautstärke für Sprache, Duplex, Simplex, Ohrhörer, Lautsprecher und Tastatur benutzerdefiniert eingestellt
werden. Bei der Einstellung Normal ist die Lautstärke für alle Elemente einheitlich.

SIEHE AUCH

Lautstärkeregelung

5.7.5.2 Den Lautstärkereglermodus einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Audio → Modus "Lautst. einst.".

3 Wählen Sie eine der folgenden Optionen aus:
• Individuell: Sie können Duplex, Simplex, Ohrhörer, Lautsprecher und Tastatur je nach Vorlieben

unterMENÜ → Einstellungen → Lautstärke einst. einstellen.
• Normal: Sie können einen Wert für alle Positionen unterMENÜ → Einstellungen → Lautstärke

einst. einstellen.

SIEHE AUCH

Die Lautstärke einstellen

5.7.6 Töne
In diesem Feld wird die Lautstärke für die Töne festgelegt.

5.7.6.1 Tastaturton
Sie können den Tastenton bei jedem Tastendruck aktivieren/deaktivieren.
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5.7.6.2 Den Tastenton einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → Tastaturton.

3 Wählen Sie eine der folgenden Optionen aus:
• Ein: Aktiviert den Tastenton.
• Aus: Deaktiviert den Tastenton.

5.7.6.3 Alle Töne
Sie können alle Töne aktivieren/deaktivieren.

5.7.6.4 Alle Töne einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → Alle Töne.

3 Wählen Sie eine der folgenden Optionen aus:
a. Ein: Aktiviert alle Töne.
b. Aus: Deaktiviert alle Töne.

5.7.6.5 Sprecherlaubnis
Sie können einen unterschiedlichen Ton nach dem Betätigen der PTT-Taste festlegen.
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5.7.6.6 Die Gesprächsgenehmigung einstellen

5.7.6.6 Die Gesprächsgenehmigung einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → Sprecherlaubnis.

3 Wählen Sie eine der folgenden Optionen aus:
• Kein Ton: Beim Betätigen der PTT-Taste ist kein Ton zu hören.
• Kurzer Ton: Beim Betätigen der PTT-Taste ist ein kurzer Ton zu hören.
• Normaler Ton: Beim Betätigen der PTT-Taste ist der werksseitige Standardton zu hören.

5.7.6.7 Sendebereit (CTS, Clear to Send)
Sie können den Ton des übertragenden Funkgeräts aktivieren/deaktivieren, dass das empfangende Funkgerät
bereit ist zur Annahme der Übertragung.

5.7.6.8 Clear to Send einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → Senden-OK.

3 Wählen Sie eine der folgenden Optionen aus:
• Ton Ein: Aktiviert den Sendebereit-Ton
• Ton Aus: Deaktiviert den Sendebereit-Ton

5.7.6.9 Periodischer Alarm
Sie können die periodische Tonanzeige für entgangene Anrufe und ungelesene Nachrichten aktivieren/deaktivieren.
Für jede Benachrichtigung erzeugt das Funkgerät einen Ton für ungelesene Nachricht mit gelbem LED-Farbhinweis.
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5.7.6.10 Den periodischen Alarm einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → Alarm für Dauer.

3 Wählen Sie eine der folgenden Optionen aus:
• Hinweis: Aktiviert/deaktiviert den periodischen Ton.
• Dauer: Gibt die Zeit zwischen jedem wiederkehrenden Ton an.

5.7.6.11 D-PTT-Töne
Diese Menüoption enthält Einstellungen für die Doppel-PTT-Funktion.

Mit der Doppel-PTT-Funktion können Sie ein Tonmuster (einzeln, doppelt oder dreifach) senden, wenn das
Funkgerät im Leerlauf oder im Gruppenanruf-Modus ist, indem Sie die PTT-Taste zweimal drücken.

Nach der Wiedergabe des D-PTT-Tons kann der Benutzer die PTT-Taste noch einmal gedrückt halten, um die
Genehmigung zum Sprechen zu erhalten. Wenn der Benutzer die PTT-Taste drückt, während der D-PTT-Ton
gespielt wird, wird sie ignoriert.

Die PTT-Taste gedrückt halten, nachdem der D-PTT-Ton gesendet wurde, führt zur Genehmigung zum Sprechen.
Der D-PTT-Ton ist auf dem sendenden Funkgerät nicht zu hören.

HINWEIS

Diese Funktion muss von Ihrem Dienstanbieter aktiviert werden.
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5.7.6.12 D-PTT-Töne einstellen

5.7.6.12 D-PTT-Töne einstellen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Töne → D-PTT Töne.

3 Wählen Sie eine der folgenden Optionen aus:
• D-PTT Modus: Aktiviert/deaktiviert den D-PTT-Ton.
• Tontyp: Gibt an, wie oft der D-PTT-Ton gespielt wird.

5.7.7 display
Über diese Menüoption können Sie die Audio-Einstellungen des Funkgeräts bearbeiten.

SIEHE AUCH

display

Datum und Uhrzeit auf dem Display einstellen

5.7.7.1 Die Schriftebene einstellen
Anwendungsgebiete:
Erhöhen/Verringern der Textgröße zum Anpassen der Lesbarkeit der Benutzeroberfläche an die bestehenden
Bedingungen.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Display → Schriftebene.

3 Wählen Sie eine der folgenden Optionen aus:
• 1: Die Standardtextgröße.
• 2: Die große Textgröße. Beachten Sie, dass bei großer Schrift weniger Text angezeigt werden kann.

In einigen Sprachen kann die Anzahl der verfügbaren Schriftebenen geringer sein.

5.7.7.2 Die Große Leerlaufschrift einstellen
Anwendungsgebiete:
So aktivieren/deaktivieren Sie die große Schrift auf der Startseite.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Anzeige → Standbytext, groß.

3 Wählen Sie Ein oder Aus, um bei inaktivem Bildschirm eine große Schrift zu aktivieren bzw. zu deaktivieren.

HINWEIS

In manchen Sprachen ist die große Leerlaufschrift nicht verfügbar.

5.7.7.3 Erweiterte Statussymbole einstellen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Anzeige → Erweiterte Statussymbolen.

3 Wählen Sie eine der folgenden Optionen aus:
• Deaktiviert: Das Funkgerät zeigt die Symbole immer in der Normalgröße an.
• Nur Standby: Das Funkgerät zeigt vergrößerte Symbole nur auf der Startseite an.
• Immer: Das Funkgerät zeigt vergrößerte Symbole auf der Startseite und beim Navigieren durch das

Menü an.

5.7.7.4 Den Bildschirmschoner einstellen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Anzeige → Bildschirmsch..

3 Wählen Sie eine der folgenden Optionen aus:
• Aktivieren: Zur Aktivierung/Deaktivierung dieser Funktion.
• Text: Zum Anzeigen von Text auf dem Bildschirmschoner, wenn diese Funktion aktiviert ist.

5.7.7.5 Die Hintergrundbeleuchtung einstellen
Durchzuführende Schritte
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5.7.7.6 Das Hintergrundbild einstellen

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Anzeige → Beleuchtung.

3 Wählen Sie eine der folgenden Optionen aus:
• Auto: Die Hintergrundbeleuchtung wird durch das Einschalten des Funkgeräts oder durch Drücken

einer beliebigen Taste auf dem Gerät oder auf dem daran angeschlossenen Zubehör ausgelöst.
Zudem aktiviert das der Eingang eines Dienstsignals, darunter Vorfall-Nachrichten, DGNA- und TX
Timeout-Signale bei Prioritätsrufen die Hintergrundbeleuchtung.

• Semi Auto: Die Hintergrundbeleuchtung wird eingeschaltet, wenn Sie das Funkgerät einschalten oder
die zugeordnete Taste für die Hintergrundbeleuchtungsfunktion drücken.

• Manuell: Die Hintergrundbeleuchtung kann durch Drücken der Taste BELEUCHTUNG ein- oder
ausgeschaltet werden.

• Ein: Die Hintergrundbeleuchtung ist immer aktiv.

HINWEIS

Einstellung der Helligkeit der Hintergrundbeleuchtung durch Betätigen der Taste BELEUCHTUNG
schaltet zwischen Intensität der Hintergrundbeleuchtung für LED, Tastatur-Hintergrundbeleuchtung
und NOTRUF-Taste um.

5.7.7.6 Das Hintergrundbild einstellen
Anwendungsgebiete:
Ändern der Darstellung des Leerlauf-Bildschirms.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Anzeige → Hgrdmuster

3 Wählen Sie eine der folgenden Optionen aus:
• Ein: Um diese Funktion zu aktivieren.
• Aus: Um diese Funktion zu deaktivieren.

5.7.8 Datum und Uhrzeit
Dieses Untermenü steuert die angezeigte Zeit und das Datum auf dem Startbildschirm.
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HINWEIS

Wenn die Funktion „Textnachricht auf dem Startdisplay“ aktiviert ist, können Uhrzeit und Datum nicht
angezeigt werden.

HINWEIS

Die Infrastruktur synchronisiert Zeit und Datum. Wenn Sie sich nicht innerhalb des Empfangsbereichs
der Infrastruktur befinden, können Sie die Werte manuell einstellen.

5.7.8.1 Datum und Uhrzeit auf dem Display einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Anzeige.

3 Wählen Sie eine der folgenden Optionen aus:
• Zeit & Datum: Das Funkgerät zeigt Uhrzeit und Datum an.
• Nur Zeit: Das Funkgerät zeigt nur die Uhrzeit an. Das Untermenü Datumsformat ist deaktiviert.
• Nur Datum: Ihr Funkgerät zeigt nur das Datum an. Das Untermenü Zeitformat ist deaktiviert.
• Aus: Ihre Funkgerät zeigt weder Datum noch Uhrzeit an. Das Menü Format ist deaktiviert.

SIEHE AUCH

display

display

5.7.8.2 Das Uhrzeitformat einstellen
Voraussetzung:
WennMENÜ→ Einstellungen → Zeit & Datum → Anzeige auf Zeit & Datum oder Nur Zeit eingestellt ist.
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5.7.8.3 Die Uhrzeit manuell einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Format → Zeitformat.

3 Wählen Sie eine der folgenden Optionen aus:
• 12-Stunden: Zeigt die Zeit mit am (vor 12 Uhr) oder pm (nach 12 Uhr) an.
• 24-Stunden.

5.7.8.3 Die Uhrzeit manuell einstellen
Anwendungsgebiete:
Wenn die Zeit nicht automatisch durch die Infrastruktur aktualisiert werden kann.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Einstellung → Zeiteinstellung.

3 Geben Sie die aktuelle Uhrzeit mithilfe der NAVIGATIONSTASTEN oder der Tastatur ein.

4 Drücken Sie auf Fertig.

5.7.8.4 Das Datumsformat einstellen
Voraussetzung:
WennMENÜ→ Einstellungen → Zeit & Datum → Anzeige auf Zeit & Datum oder Nur Datum eingestellt ist.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Format → Datumsformat.

3 Wählen Sie (D - Tag, M - Monat, Y - Jahr):
• TT/MM/JJ

• MM/TT/JJ

• TT/MON/JJ

• JJ/MM/TT

5.7.8.5 Das Datum manuell einstellen
Anwendungsgebiete:
Wenn die Zeit nicht automatisch durch die Infrastruktur aktualisiert werden kann.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Einstellung → Datum einstellen.

3 Geben Sie die aktuelle Zeit mithilfe der NAVIGATIONSTASTEN oder der Tastatur ein.

4 Drücken Sie auf Fertig.

5.7.8.6 Die Zeitverschiebung einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zeit & Datum → Einstellung → Zeitabweichung.

3 Geben Sie die Zeitverschiebung mithilfe der NAVIGATIONSTASTEN ein.

HINWEIS

Sie können den Zeitverschiebungswert in Schritten von 15 Minuten bis zu 14 Stunden vor oder zurück
anpassen.
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5.7.8.7 Die automatische Aktualisierung für Datum und Uhrzeit einstellen

4 Drücken Sie auf Fertig.

5.7.8.7 Die automatische Aktualisierung für Datum und Uhrzeit
einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen SieEinstellungen → Zeit & Datum → System Update.

3 Wählen Sie eine der folgenden Optionen aus:
• Aus: Alle Infrastrukturinformationen werden ignoriert. Das Radio verwendet die interne Zeit und

die Zeitverschiebung.
• Nur Zeit: Die angezeigte Zeit errechnet sich aus der vom Dienstanbieter programmierten

Zeitverschiebung, die zur Infrastrukturzeit addiert oder davon subtrahiert wird.
• Zeit: Zeit und Zeitverschiebung werden nach Erhalt von der Infrastruktur aktualisiert.

5.7.9 Aktive Zubehörart
Über diese Menüoption können Sie auswählen, welcher Zubehörauswahlmodus aktiviert ist.

5.7.9.1 Auswählen des aktiven Zubehörtyps
Anwendungsgebiete:
Mit dieser Menüoption können Sie festlegen, welches Mikrofon bei Verwendung des alternativen offenen Mikrofons
oder beim Mithören Vorrang hat.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Aktiver Zubehörtyp.

3 Wählen Sie eine der folgenden Optionen aus:
• Bedienkopfzubehör: Das am Bedienkopf angeschlossene Mikrofon hat eine höhere Priorität.
• Transceiver-Zubehör: Das am Transceiver angeschlossene Mikrofon hat eine höhere Priorität.
• Bedienkopfzubehör: Das am Bedienkopf angeschlossene Mikrofon hat eine höhere Priorität. Gilt

für RECH.
• Transceiver-Zubehör: Das am Transceiver angeschlossene Mikrofon hat eine höhere Priorität. Gilt

für RECH.
• Zubehör vorne: Das am vorderen Zubehöranschluss angeschlossene Mikrofon hat eine höhere

Priorität. Gilt für TSCH.
• Zubehör hinten: Das am hinteren Zubehöranschluss angeschlossene Mikrofon hat eine höhere

Priorität. Gilt für TSCH.

HINWEIS

Wenn die Taste PTT auf einem angeschlossenen Zubehörteil gedrückt wird, wird diesem Zubehörteil die
höchste Priorität zugewiesen.

5.7.10 Lautstärke-Strg (Steuerung)
Mit dieser Menüoption können Sie festlegen, welches Audio-Ausgabegerät, Lautsprecher oder Ohrhörer, angepasst
wird, wenn Sie den DREHKNOPF drehen.
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5.7.10.1 Die Lautstärke einstellen

5.7.10.1 Die Lautstärke einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Lautstärke-Strg,.

3 Wählen Sie eine der folgenden Optionen aus:
• Ohrhörer: Durch Drehen des DREHKNOPFS können Sie die Ohrhörerlautstärke einstellen.
• Lautsprecher: Durch Drehen des DREHKNOPFS können Sie die Lautsprecherlautstärke einstellen.

5.7.11 Zubehör einrichten
Über diesen Menüpunkt können Sie die manuelle Konfiguration von Audiozubehör vornehmen, das nicht
automatisch nach Einstecken der Geräte installiert wird. Das Zubehör für den Bedienkopf und den Transceiver ist
unterschiedlich und wird separat konfiguriert.

HINWEIS

Ein Bedienkopf kann gleichzeitig nur einen externen Lautsprecher unterstützen, und zwar entweder
einen an den Bedienkopf oder einen an den Transceiver angeschlossenen Lautsprecher . Wenn Sie einen
externen Lautsprecher wählen, wird die Auswahl des anderen gesperrt.

5.7.11.1 Bedienkopfzubehör konfigurieren
Anwendungsgebiete:
Verwenden Sie diese Menüoption, um Audio-Zubehör für den Bedienkopf zu konfigurieren.

- 5-43



Ausführliche Bedienungsanleitung

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zubehöreinst. → Zub.einst. Bedienteil.

3 Wählen Sie eine der folgenden Optionen aus:
• GCAI NGCH 10Pin: Enthält eine Liste vorkonfigurierter Zubehörteile, die an den vorderen Anschluss

des RECH angeschlossen werden können.
• Sekund. Zubehör: Enthält eine Liste vorkonfigurierter Zubehörteile, die an die HSM-Einheit (Hörer,

Lautsprecher, Mikrofon) angeschlossen werden können.
• GCAI NGCH 25Pin: Enthält eine Liste vorkonfigurierter Zubehörteile, die an den hinteren Anschluss

des RECH angeschlossen werden können.
• Freisprechmikro NGCH 25Pin: Enthält eine Liste vorkonfigurierter Visor-Mikrofone, die an den

hinteren Anschluss des RECH angeschlossen werden können.
• Ext. Lautspr. NGCH 25Pin: Enthält eine Liste vorkonfigurierter externer Lautsprecher, die an den

hinteren Anschluss des RECH angeschlossen werden können.
• Ext. Mikro TSCH 10Pin: Enthält eine Liste vorkonfigurierter Mikrofone, die an die TSCH-Ladestation

angeschlossen werden können.
• Ext. Lautsprecher TSCH 10Pin: Enthält eine Liste vorkonfigurierter Lautsprecher, die an die

TSCH-Ladestation angeschlossen werden können.

HINWEIS

Die Zubehörliste wird von Ihrem Dienstanbieter konfiguriert.

5.7.11.2 Transceiver-Zubehör konfigurieren
Anwendungsgebiete:
Verwenden Sie diese Menüoption, um Audio-Zubehör für den Transceiver zu konfigurieren.
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5.7.12 Anmelden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Zubehöreinst. → Zub.einst. Funkgerät.

3 Wählen Sie eine der folgenden Optionen aus:
• Freisprechmikro 26Pin: Enthält eine Liste vorkonfigurierter Visor-Mikrofone.
• Rück.-Zub.f.HApp.: Enthält eine Liste vorkonfigurierter Handsets.
• Faustmikro 26Pin: Enthält eine Liste vorkonfigurierter Handmikrofone.
• Ex. Lautsp. 26Pin: Enthält eine Liste vorkonfigurierter externer Lautsprecher.

Alle Zubehörteile der obigen Listen müssen am hinteren Anschluss des Transceivers angeschlossen werden.

HINWEIS

Die Zubehörliste wird von Ihrem Dienstanbieter konfiguriert. Listen, die keine Zubehörteile enthalten,
werden nicht in der Menüstruktur angezeigt.

5.7.12 Anmelden
Über dieses Menüelement können Sie RUA/RUI-Funktionseinstellungen vornehmen, um Einbuchanfragen
automatisch zu akzeptieren oder abzulehnen.
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SIEHE AUCH

RUA/RUI

RUI

5.7.12.1 Die Buchungseinstellungen bearbeiten
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie EinstellungenAnmelden-Setup.

3 Wählen Sie eine der folgenden Optionen aus:
• Anmelden akzeptiert: Das Gerät akzeptiert alle Buchungsanfragen.
• Anmelden abgewiesen: Das Gerät lehnt alle Buchungsanfragen ohne Benachrichtigung ab.

5.7.13 Drehknopf
Über dieses Menüelement können Sie die mit DREHKNOPF,.

5.7.13.1 Den Drehknopfmodus einstellen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Drehknopf → Drehkn.-modus.

3 Wählen Sie eine der folgenden Optionen aus:
• Dual: Beide Modi sind verfügbar. Drehen Sie den DREHKNOPF, um die Lautstärke anzupassen, oder

drücken und drehen Sie den Drehknopf, um eine andere Gesprächsgruppe auszuwählen.
• Lautstärke: Der Knopf dient nur zur Lautstärkeregelung. Drehen Sie ihn im Uhrzeigersinn, um

die Lautstärke zu erhöhen.
• Blättern: Der Knopf wird nur zum Wechseln der Gesprächsgruppe oder zum Durchsuchen des Menüs

nach Menüoptionen verwendet.

HINWEIS

Gehen Sie wie folgt vor, wenn Sie Blättern ausgewählt haben und das Display folgende Meldungen
anzeigt:

• Blättern gewählt: Zum Einstellen der Lautstärke zum Hauptmenü wechseln. Wählen Sie
Einstellungen → Lautstärke einst..
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5.7.13.2 Die Drehschaltersperre einstellen

• Funktionstasten regeln die Lautstärke: Sie können die Lautstärke über die
programmierbaren SEITENTASTEN einstellen.

5.7.13.2 Die Drehschaltersperre einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Drehknopf → Drehknopfmod..

3 Wählen Sie eine der folgenden Optionen aus:
• Gesperrt: Sperrt den DREHKNOPF. Um ihn zu entsperren, müssen Sie Entsperrt auswählen oder den

DREHKNOPF, den.
• Entsperrt: Entsperrt den DREHKNOPF, den.
• Deaktiviert: Die Sperrfunktion ist nicht verfügbar. Der DREHKNOPF, der sind immer entsperrt.

5.7.13.3 Die Tastensperre einstellen
Anwendungsgebiete:
Mit der Funktion wird das Verhalten des Drehknopfs bei gesperrter Tastatur festlegt.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Drehknopf → Bei Tastensper..

3 Wählen Sie eine der folgenden Optionen aus:
• Sperre keine: Blättern und Lautstärkeregelung sind verfügbar.
• Lautst. sperr.: DREHKNOPF>, und können nur zum Blättern verwendet werden.
• Blätt. sperren: DREHKNOPF, und können nur zum Einstellen der Lautstärke verwendet werden.
• Beide sperren: Blättern und Lautstärkeregelung sind nicht verfügbar.

5.7.13.4 Den Drehknopf für die Funktion „Durchsuchen“ einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.
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2 Wählen Sie Einstellungen → Drehknopf → Am Anf. forts..

3 Wählen Sie eine der folgenden Optionen aus:
• Ein: Das Durchsuchen der Gesprächsgruppenliste wird schleifenförmig oder im nächsten Ordner

fortgesetzt.
• Aus: Das Durchsuchen der Gesprächsgruppenliste wird gestoppt, nachdem die erste oder die letzte

Gesprächsgruppe des derzeit ausgewählten Ordners erreicht wurde.

HINWEIS

Nur dann, wenn Am Anf. forts. auf Ein und der Bereich blätt. auf Zum nächst. bl. eingestellt ist,
können Sie alle Gesprächsgruppen und Ordner durchsuchen.

5.7.13.5 Den Drehknopf-Suchbereich einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Drehknopf → Bereich blätt..

3 Wählen Sie eine der folgenden Optionen aus:
• Im Bereich bl.: Das Durchsuchen erfolgt nur in den Gesprächsgruppen des aktuellen Ordners.
• Zum nächst. bl.: Es werden alle Gesprächsgruppen und Ordner durchsucht.

HINWEIS

Nur dann, wenn Am Anf. forts. auf Ein und der Bereich blätt. auf Zum nächst. bl. eingestellt ist,
können Sie alle Gesprächsgruppen und Ordner durchsuchen.

5.7.13.6 Den Drehknopf für die Gesprächsgruppenauswahl
einstellen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Einstellungen → Drehknopf → Grpausw. best..

3 Wählen Sie eine der folgenden Optionen aus:
• Ein: Sie müssen die Auswahl der Gesprächsgruppe bestätigen, indem Sie aufWählen drücken oder die

PTT-Taste betätigen, um sofort einen Anruf in einer neuen Gesprächsgruppe zu starten.
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5.8 Gruppeneinstellungen

• Aus: Stellt ohne weitere Eingabeaufforderung eine Verknüpfung zur ausgewählten Gesprächsgruppe
her.

5.8 Gruppeneinstellungen
In diesem Untermenü können Sie den Scan und den Ordner Meine Gruppen einstellen.

5.8.1 Scannen
Diese Menüoption dient zum Aktivieren/Deaktivieren des Scannen, Anzeigen der aktiven Scan-Liste und
Bearbeiten der Scan-Listen. Diese Funktion steht nur im TMO-Modus zur Verfügung. Ihr Funkgerät nimmt an
allen Gruppenanrufen teil, solange diese Gruppe in der Scan-Liste definiert ist und das Scannen eingeschaltet ist.

SIEHE AUCH

Den Gesprächsgruppen-Scan aktivieren

5.8.1.1 Den Gesprächsgruppen-Scan aktivieren
Anwendungsgebiete:
Wenn Sie alle TMO-Gruppenanruf in der definierten Gesprächsgruppenliste überwachen möchten.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Gruppen-Einst. → Scan → Scannen.

3 Wählen Sie Liste wählen und danach einen Listenamen aus.
Schrittergebnis: Ihr Funkgerät zeigt den Listenamen als Gewählt an.

4 Wählen Sie Scannen → Ein.

Ergebnis:
Das Funkgerät scannt die vordefinierte Scan-Liste.
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SIEHE AUCH

Scannen

5.8.1.2 Gesprächsgruppen in der aktiven Scan-Liste einstellen
Anwendungsgebiete:
Gehen Sie wie folgt vor, um Gesprächsgruppen in der aktiven Scan-Liste zu bearbeiten:

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Gruppen-Einst. → Scan → Aktive Liste.

HINWEIS

Wenn Scannen Aus angezeigt wird, wechseln Sie zu Gruppen-Einst. → Scan → Scannen → Ein,
um das Scannen zu aktivieren.

3 Wählen Sie Zeigen, und markieren Sie die gewünschte Gesprächsgruppe.

4 Drücken Sie auf MENÜ.

5 Wählen Sie eine der folgenden Optionen aus:
• Löschen: Löscht die Gruppe aus der aktiven Scan-Liste.
• Priorit.: Wählen Sie eine neue Priorität aus: Niedr.,Mittel oder Hoch.

5.8.1.3 Scan-Listen einstellen
Anwendungsgebiete:
Gehen Sie wie folgt vor, um eine Scan-Liste einzurichten:
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5.8.2 Meine Gruppen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Gruppen-Einst. → Scan → Scan-Listen.

3 Markieren Sie die gewünschte Scan-Liste, und drücken Sie auf MENÜ, um weitere Einstellungen anzuzeigen:
• Umben.: Geben Sie einen neuen Namen für die Scan-Liste ein.
• Kapazität: Zeigt die Anzahl der zugewiesenen und nicht zugewiesenen Gesprächsgruppen für die

Scan-Liste an.
• ListeLö: Löscht alle Gesprächsgruppen, die dieser Scan-Liste zugewiesen sind.
• Grup. hinzuf.: Fügt eine Gesprächsgruppe zur Scan-Liste hinzu. Wählen Sie eine Gesprächsgruppe

aus Ihren Gesprächsgruppen-Ordnern aus, und weisen Sie ihr eine geeignete Priorität zu.
• Bearb: Ändert die Priorität der erforderlichen Gesprächsgruppe oder löscht sie.

VORSCHLAG

Um eine Gesprächsgruppe aus der Scan-Liste zu löschen, wählen Sie Bearb und drücken dann auf MENÜ.

5.8.2 Meine Gruppen
In der Version MR10.6.9 entsprichtMeine GruppenFavoriten (nächster Abschnitt). Beide Menüelemente
enthalten Verknüpfungen zu bevorzugten Gesprächsgruppen und Kontaktnummern und ermöglichen dieselben
Aktionen. Entsprechend finden Sie eine detaillierte Beschreibung der Funktion unter Favoriten.

5.9 Favoriten
Favoriten enthält Kurzbefehle für häufig verwendete Gesprächsgruppen und Kontaktnummern, die in
Favoriten-Ordnern organisiert sind.

Für den schnellen Zugriff auf Favoriten-Ordner klicken Sie auf der Startseite die NAVIGATIONSTASTE nach
oben. Zur Navigation zwischen den Favoriten-Ordnern können Sie die NAVIGATIONSTASTEN oder den
DREHKNOPF verwenden.

5.9.1 Favoriten-Ordner
Bevorzugte Gesprächsgruppen und Kontaktnummern werden in Favoriten-Ordnern gespeichert. Die Ordner sind
für alle Arten von Gesprächsgruppen und Kontaktnummern gleich, in einem Ordner können also Elemente in
verschiedenen Modi zur Verfügung stehen. Um den Typ des jeweiligen Elements anzuzeigen,zeigt das Funkgerät
neben dem Element ein kleines Symbol an.

Standardmäßig verfügen Funkgeräte über einen Favoriten-Ordner, der bis zu 128 Elemente aufnehmen kann. Sie
können in Favoriten aber zwei weitere Ordner erstellen und diesen Namen geben, die ihren Inhalt widerspiegeln.

Wenn Favoriten nur einen Favoriten-Ordner enthält und dieser leer ist, können Sie nur dem Ordner Elemente
hinzufügen, den Ordner umbenennen oder einen neuen Ordner erstellen.
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5.9.2 Bevorzugte Gesprächsgruppen
Sie können alle in das Funkgerät programmierten Gesprächsgruppen den Favoriten hinzufügen. Das Funkgerät
passt seinen aktuellen Modus der jeweils ausgewählten bevorzugten Gesprächsgruppe an. Beispiel: Wenn das
Funkgerät im DMO-Modus ist und Sie eine TMO-Gesprächsgruppe wählen, dann wechselt es in den TMO-Modus,
und umgekehrt.

Wenn Sie während eines laufenden Gruppenanrufs ihre bevorzugten Gesprächsgruppen durchgehen, so wird der
Anruf dadurch nicht beendet. Ebenso führt das Löschen der aktuell ausgewählten Gesprächsgruppe aus den
Favoriten während eines aktiven Anrufs nicht zum Abbruch des Anrufs.

Wenn die vor dem Ausschalten zuletzt gewählte Gesprächsgruppe zu den Favoriten gehörte, geht das Funkgerät
wie folgt vor:

• Wenn es im DMO-Modus startet, hängt es sich an die zuletzt ausgewählte bevorzugte
DMO-Gesprächsgruppe an.

• Wenn es im TMO-Modus startet, hängt es sich an die zuletzt ausgewählte bevorzugte TMO-Gesprächsgruppe
an.

Um einen Anruf auf einer bevorzugten Gesprächsgruppe durchzuführen, folgen Sie dem in diesem Dokument
beschriebenen Standardverfahren für Gruppenanrufe.

5.9.3 Bevorzugte Kontaktnummern
Sie können alle Kontaktnummern aus Kurzwahlen den Favoriten hinzufügen. Bei Kontakten mit mehreren
Kontaktnummern müssen Sie mit der rechten/linken NAVIGATIONSTASTE bestimmen, welche Kontaktnummer
hinzugefügt werden soll. Es gibt keine Einschränkungen bezüglich dem Hinzufügen von einzelnen
Kontaktnummern zu einem Kontakt. Sie können alle Kontaktnummern als einzelne Einträge hinzufügen. Das
Entfernen einer einzelnen Kontaktnummer aus Kurzwahlen entfernt diese automatisch auch aus Favoriten.
Entsprechend werden, wenn ein Kontakt aus Kurzwahlen entfernt wird, automatisch alle dazugehörigen
Kontaktnummern aus Favoriten entfernt.

Es ist nicht möglich, im Notfallmodus bevorzugte Kontaktnummern anzurufen.
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5.9.4 Tätigen eines privaten Anrufs einer bevorzugten Kontaktnummer

5.9.4 Tätigen eines privaten Anrufs einer bevorzugten
Kontaktnummer

Durchzuführende Schritte

1 Gehen Sie wie folgt vor, um die gewünschte Kontaktnummer vom Startbildschirm aus auszuwählen:
• Drücken Sie die rechte oder linke NAVIGATIONSTASTE.
• Gehen Sie zu Option → Grp nach Ord., wählen Sie den gewünschten Favoriten-Ordner, und

markieren Sie die Kontaktnummer.

2 Gehen Sie in den jeweiligen Modi folgendermaßen vor:
a. TMO: Drücken Sie zum Durchführen eines Simplex-Anrufs kurz die PTT-Taste. Sie hören ein

Rufzeichen. Halten Sie anderenfalls die PTT-Taste gedrückt. Warten Sie, bis das Zeichen für die erteilte
Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die PTT-Taste los, um
zuzuhören. Drücken Sie zum Durchführen eines Duplex-Anrufs kurz die SENDETASTE. Sie hören
ein Rufzeichen.

b. DMO: Nur Simplex-Anrufe sind möglich. Halten Sie die Sendetaste PTT gedrückt. Warten Sie, bis das
Zeichen für die erteilte Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die
PTT-Taste los, um zuzuhören.

3 Um den Anruf zu beenden, drücken Sie die Taste ENDE.

HINWEIS

Wenn Sie das erste Mikrofon oder das Telefon-Mobilteil verwenden, setzen Sie es nach Gebrauch wieder
fest in seinen Clip oder Halter ein.

5.9.5 Hinzufügen eines Ordners zu den Favoriten
Voraussetzung:
Favoriten enthält weniger als drei Favoriten-Ordner.

- 5-53



Ausführliche Bedienungsanleitung

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Favoriten → [Neuer Ordner].

3 Geben Sie den Namen ein, und wählen Sie Ok.

5.9.6 Hinzufügen einer Kontaktnummer zu den Favoriten
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kurzwahlen

3 Markieren Sie den Kontakt, den Sie zu Favoriten hinzufügen möchten, und wählen Sie mit der linken/rechten
NAVIGATIONSTASTE die gewünschte Nummer aus.

4 Drücken Sie MENÜ, und wählen Sie Zu Fav. hinzuf..

5 Wählen Sie den Ordner, dem Sie die Kontaktnummer hinzufügen wollen, und drücken SieWählen.

5.9.7 Hinzufügen einer Gesprächsgruppe zu den Favoriten
Voraussetzung:
Wenn Sie eine DMO-Gesprächsgruppe hinzufügen wollen, muss sich das Funkgerät im DMO-Modus befinden.
Wenn Sie eine TMO-Gesprächsgruppe hinzufügen wollen, muss sich das Funkgerät im TMO-Modus befinden.

Durchzuführende Schritte

1 Drücken Sie auf der Startseite die Taste Option.

2 Wählen Sie eine der folgenden Optionen aus:
• Grp nach Ord.: Enthält nach Ordnern organisierte Gesprächsgruppen.
• Grp n. ABC: Enthält alphabetisch geordnete Gesprächsgruppen.

3 Suchen und markieren Sie die Gesprächsgruppe, die Sie den Favoriten hinzufügen möchten.

4 Drücken Sie MENÜ, und wählen Sie Zu Fav. hinzuf..

5 Wählen Sie den Ordner, dem Sie die Gesprächsgruppe hinzufügen wollen, und drücken SieWählen.
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5.9.8 Verwalten von Favoriten-Ordnern

SIEHE AUCH

Den DMO-Modus aufrufen

5.9.8 Verwalten von Favoriten-Ordnern

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Favoriten.

3 Markieren Sie den gewünschten Ordner.

4 Drücken Sie die MENÜTASTE.

5 Wählen Sie eine der folgenden Optionen aus:
• Ordner umben.: Ändert den Namen des Ordners. Geben Sie einen neuen Ordnernamen ein, und

drücken Sie auf Ok.
• Ordner löschen: Entfernt den gewählten Ordner aus Favoriten. Drücken Sie Ja, um den Vorgang zu

bestätigen.

HINWEIS

Sie können den letzten Favoriten-Ordner oder einen Ordner, der mindestens ein nicht löschbares
Element enthält, nicht löschen.

5.9.9 Löschen eines Elements aus einem Favoriten-Ordner
Anwendungsgebiete:
So löschen Sie eine einzelne Kontaktnummer oder eine Gesprächsgruppe aus einem Favoriten-Ordner.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Favoriten.

3 Wählen Sie den Ordner, in dem sich das zu löschende Element befindet.

4 Markieren Sie das Element, und wählen Sie Löschen. Drücken Sie Ja, um den Löschvorgang zu bestätigen.

5.9.10 Löschen aller Elemente aus einem Favoriten-Ordner
Anwendungsgebiete:
So löschen Sie alle Kontaktnummern und Gesprächsgruppen in einem Favoriten-Ordner.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Favoriten.

3 Wählen Sie den relevanten Ordner.

4 Drücken Sie MENÜ, und wählen Sie Alle Löschen. Drücken Sie Ja, um den Löschvorgang zu bestätigen.

5.10 Meine Informationen
In diesem Untermenü können Sie Ihre persönlichen, Telefon- und Funkgerätinformationen anzeigen.
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5.10.1 Persönliche Informationen anzeigen und ändern

5.10.1 Persönliche Informationen anzeigen und ändern

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Meine Infos.

3 Wählen Sie eine der folgenden Optionen aus:
• Meine Einzelr.Nr.: Zeigt die Privatnummer Ihres Geräts an.
• Meine Tel.-Nr.: Zeigt die Telefonnummer Ihres Geräts an.

HINWEIS

Wählen Sie zum Ändern der angezeigten Telefonnummern die Option Bearb. Geben Sie die Nummer
ein, und drücken Sie auf Ok.

• Info Funkgerät: Zeigt Informationen zum Funkgerät an: Hersteller, Gerätetyp, ISSI, TEI,
Seriennummer und OPTA.

HINWEIS

Die OPTA-Informationen sind optional.

5.11 Letzte Anrufe
Sie können den Verlauf aller Anrufe anzeigen:

• Gewählt: Anrufe, die Sie initiiert haben.

• Empfangen: Anrufe, die Sie beantwortet haben.

• Verpaßt: Anrufe, die Sie zwar erhalten, aber nicht angenommen haben oder abgelehnt haben.

Eine Liste von Anrufen kann bis zu 50 Nummern enthalten, mit der neuesten am Anfang der Liste. Wenn die
Nummer eines kürzlichen Anrufs in der Kontaktliste gespeichert ist, wird der Name für die Nummer in der Liste
der letzten Anrufe angezeigt. Eine mehrmals gewählte Nummer wird nur einmal in der Liste angezeigt.

5.11.1 Anzeigen der letzten Anrufe

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Letzte Rufe.
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3 Wählen Sie eine der folgenden Optionen aus:
• Gewählt

• Empfangen

• Verpaßt

4 Wählen Sie den entsprechenden Anruf aus der Liste aus.

5 Drücken Sie die MENÜTASTE.

6 Wählen Sie Zeigen.

VORSCHLAG

Drücken Sie die NAVIGATIONSTASTE, um die ersten zwei Schritte zu überspringen.

HINWEIS

Informationen zur Gesprächsdauer sind nur dann verfügbar, wenn Uhrzeit und Datum im Gerät eingestellt
sind. Die Gesprächsdauer wird außerdem nicht in der Liste mit den entgangenen Anrufen aufgeführt.

5.11.2 Eine Nummer aus der Liste der letzten Anrufe
anrufen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Letzte Rufe.

3 Wählen Sie eine der folgenden Optionen aus:
• Gewählt (drücken Sie auf der Startseite auf die SENDETASTE, um die Liste Gew.Rufe aufzurufen)
• Empfangen

• Verpaßt

HINWEIS

Drücken Sie auf der Startseite auf die untere NAVIGATIONSTASTE, um die Option Letzte Rufe
aufzurufen.

4 Markieren Sie den gewünschten Anruf, und drücken Sie die PTT-Taste für private Anrufe, oder drücken Sie die
SENDETASTE, um einen Telefonanruf zu starten.

HINWEIS
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5.11.3 Die letzten Anrufe in den Kontakten speichern

Telefonanrufe sind nur im TMO-Modus verfügbar.

5.11.3 Die letzten Anrufe in den Kontakten speichern

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Letzte Rufe.

3 Wählen Sie Gewählt, Empfangen oder Verpaßt aus.

4 Drücken Sie auf Speichern.

HINWEIS

Wenn die Funktion Speichern nicht der linken AUSWAHLTASTE zugewiesen ist, ist die Nummer bereits
in Ihrer Kontaktliste gespeichert.

5 Wenn Sie die Nummer als neuen Eintrag speichern möchten, wählen Sie [Neue Kurzwahl]. Wenn Sie die
Nummer zu einem vorhandenen Eintrag hinzufügen möchten, wählen Sie diesen Eintrag aus, und drücken
Sie auf Zeigen. Wählen Sie anschließend Bearb.

6 Markieren Sie das Feld „Kontakttyp“, und blättern Sie nach links oder nach rechts, um den Kontakttyp
auszuwählen, dem Sie diese Nummer zuweisen möchten.

7 Wählen Sie anschließend Fertig.

5.11.4 Die letzten Anrufe löschen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Letzte Rufe.

3 Wählen Sie Gewählt, Empfangen oder Verpaßt aus.

4 Drücken Sie beim betreffenden Anruf auf MENÜ.

- 5-59



Ausführliche Bedienungsanleitung

5 Wählen Sie Löschen.

HINWEIS

Wählen Sie zum Löschen aller Anrufe die Option Alle Löschen.

5.12 Verknüpfungen
In diesem Untermenü richten Sie Verknüpfungen zum Zugreifen auf häufig verwendete Menüoptionen ein.

SIEHE AUCH

Durch das Menü blättern

5.12.1 Eine Menüverknüpfung erstellen
Anwendungsgebiete:
So erstellen Sie eine Verknüpfung für eine Menüoption.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Blättern Sie zu dem Element, für das Sie eine Verknüpfung erstellen möchten.

3 Halten Sie die Taste MENÜ gedrückt, während das Element markiert ist.

Beispiel:
Eine Verknüpfung für die Option Alle Töne erstellen:

1. Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2. Wählen Sie Einstellungen → Töne.

3. Markieren Sie Alle Töne, und halten Sie die Taste MENÜ gedrückt, bis Kurzbef. zuweisen für:: Alle
Töne angezeigt wird.

4. Wählen Sie Ja. Die Meldung KurzbefehleTaste::1 wird angezeigt.

5. Drücken Sie auf Fertig.

HINWEIS

Um diese Verknüpfung zu verwenden, drücken Sie auf der Startseite auf MENÜ und dann auf Taste 1.
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5.12.2 Eine Liste mit Menüverknüpfungen bearbeiten

5.12.2 Eine Liste mit Menüverknüpfungen bearbeiten

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kurzbefehle.

3 Markieren Sie die gewünschte Verknüpfung, und drücken Sie auf MENÜ.

4 Wählen Sie eine der folgenden Optionen aus:
• Bearb: Ändert die zugewiesene Taste. Geben Sie die gewünschte Zahl ein, und drücken Sie auf Ok.

HINWEIS

Geben Sie einen Wert zwischen 1 und 20 ein.
• Löschen: Die markierte Verknüpfung wird gelöscht. Wählen Sie Ja, um den Vorgang zu bestätigen.
• Alle Löschen: Löscht alle Verknüpfungen. Wählen Sie Ja, um den Vorgang zu bestätigen.

5.13 RUI
Über diesen Menüpunkt können Sie sich beim Funkgerät an-/abmelden.
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SIEHE AUCH

RUA/RUI

Anmelden

5.13.1 Anmelden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie RUI → Einloggen.

3 Markieren Sie Folgendes:
• Benutzer-ID, und drücken Sie aufWählen, um die Benutzer-ID-Liste einzugeben. Wenn Sie ein

neuer Benutzer des Geräts sind, wählen Sie [Neue Benutzer-ID], und geben Sie Ihre Benutzer-ID ein.
Wählen Sie anderenfalls Ihre Benutzer-ID aus der Liste aus.

• Die zweite Zeile, und drücken Sie auf Bearb, um die Benutzer-ID einzugeben, und drücken Sie auf Ok.

4 Wählen Sie Benutzer-PIN, geben Sie Ihre Anmeldeinformationen ein, und drücken Sie auf Ok.

5 Der Anmeldebildschirm wird angezeigt.

5.13.2 Abmelden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie RUI → Ausloggen.

3 Drücken Sie auf Akzeptieren.

5.14 Netzwerke
Diese Menüoption ermöglicht Ihnen das Wechseln zwischen den Betriebsmodi des Funkgeräts.
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5.14.1 Das Netzwerk auswählen

SIEHE AUCH

Den TMO/DMO-Modus aufrufen

Den Netzwerkbetriebsmodus verwenden

5.14.1 Das Netzwerk auswählen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze → Netzauswahl → Nur Heimnetz.

3 Ihr Funkgerät registriert sich beim ersten Netzwerk der Liste zulässiger Netzwerke.

5.14.2 Die Funktion „Netzregistrierung auswählen“
verwenden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze → Netzauswahl → Netz wählen.

3 Wählen Sie das gewünschte Netzwerk aus der Liste aus.

Ergebnis:
Ihr Gerät registriert sich beim ausgewählten Netzwerk.

5.14.3 Die Fremdnetzregistrierung verwenden
Anwendungsgebiete:
Mit dieser Funktion können Sie zu einem anderen vordefinierten Netzwerk migrieren, wenn Sie sich außerhalb der
Reichweite Ihres Netzwerks befinden und das Gerät die Meldung Kein Netz anzeigt.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze → Netzauswahl → ausl. Netzw..

5.14.4 Ein beliebiges Netzwerk verwenden
Anwendungsgebiete:
Wenn sich Ihr Gerät nicht mehr im Bereich seines ursprünglichen Netzwerks befindet, kann es sich bei einem
beliebigen anderen Netzwerk registrieren. Bei allen Netzwerken wird ausschließlich die klare Authentifizierung
unterstützt.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze → Netzauswahl → Alle Netze.

3 Das Gerät wählt automatisch ein Netzwerk aus der vordefinierten Liste aus und registriert sich dort.

5.14.5 Die Funktion „Zur Registrierung migrieren“
verwenden

Anwendungsgebiete:
Mit dieser Funktion können Sie zu einem anderen vordefinierten Netzwerk migrieren, wenn Sie sich außerhalb der
Reichweite Ihres Netzwerks befinden und das Gerät die Meldung Kein Netz anzeigt.
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5.14.6 Den Netzwerkbetriebsmodus verwenden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze → Netzauswahl und wählen Sie eine der folgenden Optionen:
• Migrieren nach...: Wählt das gewünschte Netzwerk aus der Liste aus. Drücken Sie zum Anzeigen der

Netzwerk-ID auf MENÜ und dann auf „Auswählen“.
• Auto: Das Gerät hängt sich automatisch an das vordefinierte Netzwerk an.

5.14.6 Den Netzwerkbetriebsmodus verwenden

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Netze.

3 Wählen Sie eine der folgenden Optionen aus:
• Trunk-Modus: Wechselt in den Modus, und verwendet dabei die Infrastruktur.
• Direkt-Modus: Wechselt in den Modus, ohne dabei die Infrastruktur zu verwenden.
• Repeater-Mod.: Wechselt in den Repeater-Modus.
• Gateway: Wechselt in den Gateway-Modus.
• TXI-Modus: Wählen Sie Aktivieren, um jegliche Funkübertragung zu stoppen.

HINWEIS

Wenn sich das Gerät im TXI-Modus befindet, ist es nicht möglich, vom Direkt-Modus in den
Trunk-Modus, den Repeater-Mod. oder den Gateway umzuschalten.

SIEHE AUCH

Netzwerke

Den TMO/DMO-Modus aufrufen

5.15 Standort
Weitere Informationen finden Sie unter dem GPS-Ortungsdienst.
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SIEHE AUCH

GPS-Ortungsdienst

5.15.1 Ihre Position anzeigen
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Standort → Position.

3 Blättern Sie zum Anzeigen der Ergebnisse Ihrer letzten Standortberechnung.

HINWEIS

So aktualisieren Sie Ihre Position:

• Wählen SiePosition - das Funkgerät aktualisiert die Position automatisch
• Drücken Sie Auffr.

5.15.2 Anzeigen der Testseite
Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Standort → Testseite.

3 Wählen Sie eine der folgenden Optionen aus:
• Standort: Zeigt detaillierte Informationen zum aktuellen Standort des Funkgeräts an: Uhrzeit, N

(Breite), E (Länge), H (Höhe), Verwendete Satelliten (Anzahl erfasster Satelliten), B (Kurs), HS
(horizontale Geschwindigkeit), LC (Zuverlässigkeit).

• Signalstärke: Zeigt detaillierte Informationen zu einem bestimmten Satelliten an: PRN-Code, Status,
Modus, C/N (Träger-Rauschabstand).

• Version: Zeigt detaillierte Informationen zur GPS-Version an: SW (Software-Version), HW
(Hardware-Version), ASIC (Application-Specific Integrated Circuit), RC (Freischaltcode).

5.16 Paketdaten
Der Paketdatendienst (PD) ermöglicht die Übertragung von Daten in einem TETRA-System mithilfe des Internet
Protocol (IP).

5-66 -



5.16.1 Statistiken anzeigen

HINWEIS

Zur Übertragung von Daten von einem standardmäßigen Computer per Funk verbinden Sie den Computer
mit einem Datenkabel vom Typ PMKN4104 mit Ihrem Funkgerät. Ihr Dienstanbieter muss zusätzliche
Anwendungen auf Ihrem Computer einrichten.

Sofern von Ihrem Dienstanbieter eingerichtet, können Sie die Übertragung durch Verwendung des MSPD-Dienstes
(Multi-Slot Packet Data) beschleunigen.

5.16.1 Statistiken anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Paketdaten.

HINWEIS

Datendienste sind nur im TMO-Modus verfügbar. Die Datenoption muss auf Sprache & Daten oder
Nur Daten gesetzt sein.

3 Wählen Sie eine der folgenden Optionen aus:
• Ges.Daten: Die Anzahl der gesendeten KB und der Durchsatz seit Aktivierung der aktuellen Paketdaten

werden angezeigt.
• Empfang.Daten: Die Anzahl der empfangenen KB und der Durchsatz seit Aktivierung der aktuellen

Paketdaten werden angezeigt..
• Bandbreite: Der Prozentsatz der aktiven Datensitzung wird angezeigt.
• Transfer fehlg.: Der Prozentzahl der Pakete, die nicht gesendet/empfangen wurden.

HINWEIS

N. z. : Standby-Paketdatensitzung.

5.16.2 Den Verschlüsselungsstatus anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen SieMehr . . . → Paketdaten → Verschlüsselg..
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3 Der Verschlüsselungsstatus der laufenden Paketdatensitzung wird angezeigt:
• Paketdatenkanal frei

• Paketdatenkanal verschlü.

• Verschlüsselg.n/z (löschen)

5.17 Kryptomenü
In diesem Untermenü können Sie die SIM-Karte basierend auf End-to-End-Verschlüsselung verwalten.

Die End-to-End Verschlüsselung wird verwendet für:

• Verschlüsselung von Sprachübertragung im DMO- und TMO-Modus.
• Verschlüsselung von Nachrichtenübertragungen im TMO-Modus.
• Verschlüsselung von Nachrichtenübertragungen im DMO-Modus (Funkgerät darf nicht im Anrufmodus
sein).

• Verschlüsselung der Übertragung von Positionsdaten (GPS) im DMO- und TMO-Modus.
• Übertragung der operativen taktischen Adresse (OPTA) im DMO- und TMO-Modus.
• Verwaltung von Verschlüsselungsschlüsseln im TMO-Modus.

SIEHE AUCH

End-to-End-Verschlüsselung der SIM-Karte

5.17.1 Die End-to-End-Verschlüsselung der SIM-Karte
aktivieren/deaktivieren

Voraussetzungen:

• Das Funkgerät führt keinen aktiven Anruf aus.
• Sie können die PTT- Taste nicht betätigen.

Aktivieren/deaktivieren Sie die End-to-End-Verschlüsselung der SIM-Karte mit einer der folgenden Möglichkeiten:

• Drücken Sie eine One-Touch-Taste zum Aktivieren/Deaktivieren der End-to-End-Verschlüsselung der
SIM-Karte.

• Drücken Sie im Startbildschirm auf MENÜ → Kryptomenü → Kryptofunktion. Wählen Sie
Verschlüsselung ein zum Aktivieren oder Verschlüsselung aus zum Deaktivieren der Verschlüsselung.

Ergebnis: Ihr Funkgerät zeigt Anweisungen zum aktuellen Verschlüsselungsstatus an: das entsprechende
Statussymbol und die Meldung Verschlüsselung ein oder Verschlüsselung aus.

5.17.2 Alarmton für unverschlüsselte Anrufe einstellen
Anwendungsgebiete:
Verwenden Sie diese Menüoption zur Konfiguration eines Alarmtons, der unverschlüsselte Übertragungen ankündigt.

5-68 -



5.17.3 Die Verschlüsselungsschlüssel aktualisieren

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → Unverschl. Ton.

3 Wählen Sie Halb-Duplex oder Voll-Duplex.

4 Wählen Sie eine der folgenden Optionen aus:
• Aus: Der Alarm ist deaktiviert.
• Einmalig: Der Alarm ertönt einmal am Anfang eines unverschlüsselten Anrufs.
• Ständig: Der Alarm ertönt während einem unverschlüsselten Anruf ununterbrochen.

5.17.3 Die Verschlüsselungsschlüssel aktualisieren
Anwendungsgebiete:
Verwenden Sie diese Menüoption, um alte oder falsche Verschlüsselungsschlüssel zu aktualisieren.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → Neue Schlüssel.

3 Wählen Sie Gruppenschlüssel, um die Aktualisierung zu starten.

HINWEIS

Sie können die Verschlüsselungsschlüssel aktivieren, wenn die durchgängige Verschlüsselung aktiviert ist. Die
Schlüssel können nicht aktualisiert werden, wenn sich das Gerät in einem Gespräch oder im DMO-Modus
befindet.

5.17.4 Die OPTA-Adresse anzeigen
Anwendungsgebiete:
Mit dieser Menüoption können Sie die OPTA-Adresse (Operational Tactical Address) anzeigen, die zusätzliche
Informationen zur Organisation und operativen Rolle eines Teilnehmers bietet.
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Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → OPTA anzeigen.

5.17.5 Den OPTA-Filter einstellen
Anwendungsgebiete:
Mit dieser Menüoption können Sie festlegen, welche Zeichen bei der Anzeige des OPTA-Namens ausgeblendet
werden sollen.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → OPTA Filter.

3 Markieren Sie die gewünschten Kontrollkästchen mithilfe der NAVIGATIONSTASTEN, und drücken Sie auf
Wählen, um festzulegen, welche Zeichen bei der Anzeige des OPTA-Namens ausgeblendet werden sollen.

4 Drücken Sie auf Fertig, um die Änderungen zu bestätigen.

5.17.6 Starten der Krypto-Registrierung
Voraussetzung:
Ihr Funkgerät darf aktuell weder einen Anruf tätigen noch im DMO-Modus sein.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → Registrierung.

3 Wählen Sie Registr.Starten, um die Registrierung zu starten.

5.17.7 Konfigurieren der Audioeinstellungen
Anwendungsgebiete:
Verwenden Sie diese Menüoption, um den Audio-Ausgang für einen Gruppenanruf zu ändern, wenn der Anruf
verschlüsselt, aber die durchgängige Verschlüsselung deaktiviert ist.
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5.17.8 Einstellung des DMO-Verschlüsselungsmodus

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → Audioeinstellung.

3 Wählen Sie Kr. Audio Ein zum Aktivieren oder Kr. Audio Aus zum Stummschalten des verschlüsselten
Audio-Ausgangs für den Klarmodus.

5.17.8 Einstellung des DMO-Verschlüsselungsmodus

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → DMO Verschl.Mod.

3 Wählen Sie DMO 1 oder DMO 2, um den gewünschten Modus zu aktivieren.

5.17.9 Einstellung der Verschlüsselungsschlüssel für
SDS-Nachrichten

Anwendungsgebiete:
Verwenden Sie diese Menüoption, um die Verschlüsselungsschlüssel für Gruppen- und Einzelnachrichten (SDS) zu
ändern.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Kryptomenü → SDS Schlüssel.

3 Wählen Sie Einzel SDS oder Gruppen SDS.

4 Wählen Sie Globaler Schl. oder Gruppen Schl..
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6 Funktionen

6.1 Privatanruf
Der Privatanruf, auch als Point-to-Point- oder individueller Anruf bezeichnet, ermöglicht Anrufe zwischen zwei
Personen. Keine anderes Funkmodul kann die Unterhaltung hören. Diese Anruftyp kann grundsätzlich über
zwei Wege erfolgen:

• Duplex-Anruf (sofern durch System zugelassen) im TMO-Modus. Beide Parteien können gleichzeitig
sprechen.

• Simplex-Anruf im TMO- oder DMO-Modus. Nur eine Seite kann sprechen.

Wenn ein DMO-Privatanruf erfolgt, empfangen Funkmodule, die nicht an diesem Anruf beteiligt sind, das
Besetztzeichen für den Kanal. Die Funkgeräte werden über die Funkgerätenummer identifiziert.

Zusammenspiel mit Zubehörgeräten:

• Erstes Mikrofon — falls Sie während des Privatanrufs das Mikrofon am Clip einhängen, wird das Gespräch
beendet oder die Sprachausgabe Audio schaltet auf die Lautsprecher (falls vorhanden) um. Das genaue
Verhalten hängt von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

• Telefon-Handapparat: Wenn Sie während des Privatanrufs den Handapparat in den Halter stecken, wird das
Gespräch beendet oder der Ton schaltet auf die Lautsprecher (falls vorhanden). Das genaue Verhalten hängt
von den von Ihrem Dienstanbieter vorgegebenen Einstellungen ab.

HINWEIS

Um den Privatanruf zu beenden, wenn die Sprachausgabe auf den Lautsprecher umgeschaltet wurde,
drücken Sie die Taste EIN/AUS/ENDE/BEENDEN.

Um einen Privatanruf anzunehmen, verwenden Sie eine der folgenden Methoden:

• Drücken Sie auf die PTT-Taste.

• Nehmen Sie das erste Mikrofon oder Telefon-Mobilteil ab. Wenn sich das Mobilteil nicht auf der Gabel
befindet, wird der externe Lautsprecher des Funkmoduls stummgeschaltet und der interne Lautsprecher
des Mobilteils aktiviert.

• Drücken Sie die Taste SENDEN am Bedienkopf. Sprache wird zu den Audio-Eingangsgeräten in der
folgenden Reihenfolge weitergeleitet, je nach Verfügbarkeit:

1. Gesichtsvisier-Mikrofon.

2. Mikrofon des Geräts, das abgenommen wurde.

3. Das Mikrofon, das zuletzt verwendet wurde (wenn zwei Geräte abgenommen wurden).
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SIEHE AUCH

MS-ISDN

Einzelrufe im Notfallmodus (Privat- oder MS-ISDN-Anrufe)

6.1.1 Durchführen eines Privatanrufs
Durchzuführende Schritte

1 Drücken/Halten Sie auf der Startseite und geben Sie die Nummer ein.

2 Wenn Einzelruf nicht als erster Anruftyp angezeigt wird, drücken Sie solange auf R-Typ, bis der gewünschte
Typ angezeigt wird, und wählen Sie ihn aus.

3 Gehen Sie in den jeweiligen Modi folgendermaßen vor:
a. TMO: Drücken Sie zum Durchführen eines Simplex-Anrufs kurz die PTT-Taste. Sie hören ein

Rufzeichen. Halten Sie anderenfalls die PTT-Taste gedrückt. Warten Sie, bis das Zeichen für die erteilte
Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die PTT-Taste los, um
zuzuhören. Drücken Sie zum Durchführen eines Duplex-Anrufs kurz die SENDETASTE. Sie hören
ein Rufzeichen.

b. DMO: Nur Simplex-Anrufe sind möglich. Halten Sie die Sendetaste PTT gedrückt. Warten Sie, bis das
Zeichen für die erteilte Gesprächsgenehmigung ertönt, bevor Sie anfangen zu sprechen. Lassen Sie die
PTT-Taste los, um zuzuhören.

4 Um den Anruf zu beenden, drücken Sie die Taste ENDE.

HINWEIS

Wenn Sie das erste Mikrofon oder das Telefon-Mobilteil verwenden, setzen Sie es nach Gebrauch wieder
fest in seinen Clip oder Halter ein.

6.2 Radio Messaging System (RMS)
Die RMS-Funktion ermöglicht es Funkgeräten, RMS-Nachrichten über ein TETRA-Netzwerk mithilfe des Short
Data Service zu empfangen und zu senden.

Es gibt zwei Arten von RMS-Nachrichten:

• RMS-Status: Ein vordefinierter Code, der bidirektional zwischen Funkgerät und Dienstanbieter übermittelt
wird. Das Funkgerät kann bis zu zehn Statuswerte aufweisen, denen die numerischen Tasten 0 bis
9 zugeordnet werden. Der aktuellste gesendete oder empfangene RMS-Status wird bis zum nächsten
Aus-/Einschalten auf der Startseite angezeigt. Ein empfangener RMS-Status wird auf der Startseite blau
angezeigt.

– Freier RMS-Text: Eine unidirektionale Nachricht mit Freitext, die vom Dienstanbieter an das Funkgerät
gesendet wird. Da dieser Nachrichtentyp länger ist, zeigt das Funkgerät nur ihren Beginn auf der
Startseite an. Um den verbleibenden Teil zu lesen müssen SieMenü → Nachrichten → RMS-Box

6-2 -



6.2.1 RMS-Symbole

aufrufen. Der neueste freie RMS-Text wird bis zum nächsten Aus-/Einschalten auf der Startseite
angezeigt.

Freie RMS-Textnachrichten und eingehende sowie abgehende RMS-Statusmeldungen (mit Ausnahme der
gesendeten RMS-Statuswerte) werden im RMS-Box gespeichert. Die Kapazität beträgt maximal zehn Einträge für
eingehende und ausgehende RMS-Nachrichten. Wenn das RMS-Box voll ist, überschreiben neue eingehende oder
ausgehende RMS-Nachrichten die jeweils älteste Meldung (gesendet/empfangen).

Das Funkgerät sendet und empfängt RMS-Nachrichten nur an die/von den vom Dienstanbieter vordefinierten
Nummern.

6.2.1 RMS-Symbole
Tabelle 6-1 RMS-Symbole

Symbol Beschreibung

RMS-Status empfangen
Zeigt an, dass gerade eine neue RMS-Statusmeldung
eingegangen ist.

RMS-Status gesendet

RMS-Postfach, Gelesene Nachricht

RMS-Postfach, Ungelesene Nachricht

6.2.2 Senden des RMS-Status
Voraussetzung:
Ihr Dienstanbieter hat diese Funktion aktiviert, und das Funkgerät ist im RMS-Modus.

Anwendungsgebiete:
So senden Sie einen vordefinierten RMS-Status unter Verwendung der Zifferntasten:

Durchzuführende Schritte

Drücken und halten Sie die gewünschte Taste. Wenn Sie die Taste zu kurz drücken, startet das Funkgerät einen
Privat-/Telefon-/TK-Anruf.

6.3 Kurzwahl
Mit dieser Funktion können Sie Anrufe durch Drücken und Halten einer der Tasten (1-9) tätigen.
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HINWEIS

Wenn die One-Touch-Tastenfunktion aktiviert ist, ist die Kurzwahl deaktiviert. Wenn einer Taste keine
Funktion zugewiesen ist, zeigt das Gerät die Meldung Taste ohne Zuweisung an..

6.4 Gesprächsgruppenwahl durch Index
Mit dieser Funktion können Sie an jeder Gesprächsgruppe durch Wahl des Index teilnehmen, statt sie im
Gesprächsgruppenordner oder in Listen auszuwählen.

HINWEIS

Dies wird auch als Gesprächsgruppen-Kurzwahl bezeichnet.

6.4.1 Die Nummer für die Gesprächsgruppen-Kurzwahl
anzeigen

Durchzuführende Schritte

1 Drücken Sie auf der Startseite auf Option.

2 Wählen Sie eine der folgenden Optionen aus:
• Grp nach Ord., wählen Sie den Ordner aus, und markieren Sie die gewünschte Gesprächsgruppe.
• Grp n. ABC: Geben Sie bis zu 15 Zeichen ein, um die Namen der Gesprächsgruppen einzugrenzen,

und markieren Sie die gewünschte Gesprächsgruppe.

3 Drücken Sie auf MENÜ → Zeigen.

Beispiel:
Das Gerät zeigt Schnellwahl1* an; das bedeutet, dass die Nummer für diese Gesprächsgruppen-Kurzwahl 1 ist.
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6.4.2 Die Gesprächsgruppe nach Index auswählen

6.4.2 Die Gesprächsgruppe nach Index auswählen

Durchzuführende Schritte

1 Geben Sie auf der Startseite die Gesprächsgruppen-Kurzwahl gefolgt von * ein.

2 Drücken Sie auf Anlage.

VORSCHLAG

Drücken Sie zum Starten eines Gruppenanrufs die PTT- Taste.

6.5 Telefon- und TK-Anrufe
Mit Telefonanrufen können Sie Festnetznummern oder ein Mobiltelefonnummern anrufen. Mit TK-Anrufen
(Nebenstellenanlage) können Sie lokale Nebenstellennummern (z. B. Büro) anrufen.

6.5.1 Einen Telefon- oder Nebenstellenanruf tätigen

Durchzuführende Schritte

1 Drücken/Halten Sie auf der Startseite und geben Sie die Nummer ein.

2 Wenn Telefon oder NbSt nicht als erste Anruftypen angezeigt werden, drücken Sie solange auf R-Typ, bis der
gewünschte Typ angezeigt wird, und wählen Sie ihn aus.

3 Drücken Sie die SENDETASTE.

6.6 Telefon/Nebenstellenanlagen-Kurzwahl
Mit dieser Funktion können Sie Telefonnummern/TK-Anlagen durch eine Kurzwahl von bis zu drei Ziffern statt der
gesamten Rufnummer wählen. Die Schnellwahl# für das Telefon/die Nebenstellenanlage wird zugewiesen, wenn
die gewählte Nummer zur Kontaktliste hinzugefügt wird.

HINWEIS

Diese Funktion steht nur im TMO-Modus zur Verfügung.
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6.6.1 Die Telefon/Nebenstellen-Kurzwahl verwenden

Durchzuführende Schritte

1 Geben Sie auf der Startseite die vordefinierte Telefon/Nebenstellen-Kurzwahlnummer ein, und drücken Sie
die #-Taste.

2 Drücken Sie die SENDETASTE.

6.7 MS-ISDN
Diese Funktion wird zur ISDN-Nummer des Funkgeräts hinzugefügt. Sie haben die Wahl zwischen MS-ISDN und
ISSI, um den Anruf vorzunehmen und die Nachricht oder vordefinierte Vorlagen zu senden. Es funktioniert sowohl
für Simplex- als auch für Duplex-Anrufe, basierend auf der zugewiesenen ISDN-Nummer.

SIEHE AUCH

Privatanruf

Einzelrufe im Notfallmodus (Privat- oder MS-ISDN-Anrufe)

6.8 MFV (Multifrequenz-Durchwahl)
Dank dieser Funktion können Sie mit einem automatischen Antwortdienst (Beispiele: Voicemail oder
Anrufbeantworter) im Rahmen eines laufenden Privat-, Telefon- oder TK-Anrufs kommunizieren.

Drücken Sie während eines laufenden privaten, Telefon- bzw. TK-Anrufs die DTMF-Tasten (0-9, *, #). Wenn Sie
diese Taste drücken, wird ein DTMF-Tastenton abgespielt, und die eingegebene Ziffer wird auf dem Bildschirm
angezeigt.

6.9 Eine Kurzwahlnummer wählen
Mit dieser Funktion können Sie einen Teil der vollständigen Nummer wählen, die Sie anrufen möchten. Das
Funkgerät vervollständigt automatisch die Nummer.

Beispiel:
Ihre Funkgerätnummer ist 4282564.

1. Wählen Sie 564 (statt 4282564, der vollständigen Nummer).

2. Um den Anruf zu tätigen, drücken Sie die PTT-Taste oder die Taste SENDEN.
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6.10 Doppelter Bedienkopf

6.10 Doppelter Bedienkopf
Mit dieser Funktion können Sie zwei Bedienköpfe mit einem Transceiver verwenden. Die Bedienköpfe sind
gleich wichtig und haben fast identische Funktionen; der einzige Unterschied ist das zweite PTT auf dem
Telefon-Bedienkopf.

Wenn Sie im Modus Doppelter Bedienkopf aufMENÜ → Einstellungen drücken, können Sie zwischen zwei
Bedienköpfen wählen: Bedienteil 1 und Bedienteil 2. Fast alle Menüpunkte gelten für beide Bedienköpfe
gleichzeitig, außer: Lautstärke einst., Zubehöreinst. und Textgröße (sofern die Bedienköpfe sich unterscheiden).
Diese Menüpunkte werden separat für jeden Bedienkopf konfiguriert.

HINWEIS

Wenn diese Funktion von Ihrem Dienstanbieter aktiviert ist, werden entsprechende Symbole auf dem
Display angezeigt.

Erkundigen Sie sich bei Ihrem Dienstanbieter nach der Standardzubehörauswahl und dem Funkverhalten für alle
Arten von Anrufen, da jeder Bedienkopf unterschiedlich eingerichtet sein kann.

SIEHE AUCH

Bedienelemente und Anzeigen

Menüstruktur

6.10.1 Interaktionen zwischen Bedienköpfen
Ihr Dienstanbieter kann eine Verbindung zu einem Transceiver entweder über zwei gleiche Bedienköpfe (zwei
Remote-Ethernet-Bedienköpfe oder zwei Telefon-Bedienköpfe), oder über zwei verschiedene Bedienköpfe (einen
Remote-Ethernet-Bedienkopf und einen Telefon-Bedienkopf) herstellen.

Sie können beide Bedienköpfe gleichwertig für dieselbe Tätigkeit verwenden (z. B. Schreiben einer Nachricht).
Wenn Sie eine Aktivität an einem Bedienkopf starten, können Sie sie auf dem zweiten fortsetzen, vorausgesetzt,
das Token ist frei.

Token bedeutet ein Recht zur Nutzung einer Taste für einen gewissen Zeitraum. Wenn Sie eine Taste auf einem
Bedienkopf drücken, wird das Token darauf aktiviert, und niemand kann eine Taste auf dem zweiten Bedienkopf
drücken, bis die Token-Zeit vorbei ist. Nach dem Loslassen der Taste ist das Token wieder verfügbar und kann vom
zweiten Bedienkopf genutzt werden. Wenn das Token aktiviert ist, wird das Symbol Token für Tastendruck auf dem
Display angezeigt. Standardmäßig ist die Token-Zeit auf 3 Sekunden eingestellt.

HINWEIS

Das Token gilt nicht für die NOTRUF-Taste und die EIN/AUS/ENDE/HOME-Taste. Diese können
jederzeit auf beiden Bedienköpfen betätigt werden.

Wenn die Bedienköpfe unterschiedlich sind und Sie einen Bedienkopf bedienen, zeigt das zweite Gerät den
Bildschirmschoner an.
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SIEHE AUCH

Bedienelemente und Anzeigen

6.10.2 Doppelbedienkopf-Verbindung
Die Doppelbedienkopf-Verbindung ist eine Verbindung, die auftritt, wenn beide Bedienköpfe ordnungsgemäß am
Transceiver angeschlossen sind und miteinander kommunizieren können.

Wenn die Doppelbedienkopf-Verbindung hergestellt wurde, geben die Bedienköpfe einen Ton aus und zeigen das
Symbol Doppelter Bedienkopf an. Volle Funktionalität ist auf beiden Geräten verfügbar.

Wenn ein Bedienkopf beim Einschalten keine Verbindung mit dem Transceiver herstellen kann, zeigt das Funkgerät
das Symbol Einzelner Bedienkopf an und schaltet in den einzelnen Bedienkopf-Modus.

Wenn ein Bedienkopf die Verbindung zum Transceiver während des Betriebs trennt:

• Zeigt der aktive Bedienkopf das Symbol Verbindungsfehler an.
• Zeigt der inaktive Bedienkopf das Symbol Verbindungsfehler und außerdem die Verbindungsfehler-Anzeige
(falls Strom anliegt) an.

Wenn Sie einen Bedienkopf ein-/ausschalten, wird der zweite Bedienkopf ebenfalls ein-/ausgeschaltet.

6.10.3 Audiozubehör
Je nach Anruftyp kann die Sprachausgabe an Bedienköpfe und daran auf verschiedene Art angeschlossenes
Audiozubehör durchgeschaltet werden.

Während eines ausgehenden Gruppenrufs, kann die Sprachausgabe entweder an einem oder an beiden Bedienköpfen
gehört werden (je nach Dienstanbieter-Einstellungen).

Bei einem eingehenden Gruppenanruf kann Sprache immer auf beiden Bedienköpfen gehört werden. Wenn jedoch
zwei Zubehörgeräte an einen Bedienkopf angeschlossen wurden (eines am vorderen und eines am rückseitigen
Anschluss), wird Sprache jeweils nur über eines davon übertragen, nämlich dasjenige mit höherer Priorität. Die
Prioritäten sind (beginnend mit der höchsten): Handapparat (muss abgenommen sein), HSM, externer Lautsprecher.

Private Anrufen werden immer an den Bedienkopf übertragen, der einen Anruf empfängt.

Nur ein Mikrofon/PTT kann jeweils geöffnet werden. Das Mikrofon, das zuerst gedrückt wird, darf die Übertragung
starten.

6.10.4 Tasteninteraktionen
Wenn eine beliebige Taste außer NOTRUF und EIN/AUS/ENDE/HOME auf einem Bedienkopf gedrückt wird,
wird das Symbol Tastendruck-Token angezeigt, und alle Tasten auf dem anderen Bedienkopf sind blockiert. Dieses
Verhalten wird als Token bezeichnet und bedeutet das Recht zur Nutzung einer Taste für einen gewissen Zeitraum.

HINWEIS

Ihr Dienstanbieter kann die Zeit anpassen, in der die Tastatur auf dem anderen Bedienkopf blockiert ist.
Auf beiden Bedienköpfen kann jederzeit die NOTRUF-Taste und die EIN/AUS/ENDE/HOME-Taste
gedrückt werden.
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6.11 End-to-End-Verschlüsselung der SIM-Karte

6.11 End-to-End-Verschlüsselung der SIM-Karte
Die nachstehende Tabelle zeigt Interaktionen zwischen Funkgeräten mit und ohne SIM-Karte. Die SIM-Karte
bietet End-to-End-Verschlüsselung.

Tabelle 6-2 Funkgerät-Interaktionen

Übertragungstyp Sendendes Funkgerät Empfangendes
Funkgerät

Ergebnis

Privatanruf SIM-Karte Keine SIM-Karte Anruf ist für das empfangende
Funkmodul nicht sichtbar.
Sendendes Funkgerät zeigt
Angerufener Teilnehmer nur
unverschlüsselt an.

Privatanruf Keine SIM-Karte SIM-Karte Warnung: Unverschlüsselter
Anruf wird angezeigt, und der
Anruf wird angenommen.

Gruppenruf SIM-Karte Keine SIM-Karte Anruf ist für das empfangende
Funkmodul nicht sichtbar.

Gruppenruf Keine SIM-Karte SIM-Karte Warnung: Unverschlüsselter
Anruf wird angezeigt, und der
Anruf wird angenommen.

Meldung SIM-Karte Keine SIM-Karte Übermittlung fehlgeschlagen
wird angezeigt, und die Nachricht
wird nicht empfangen.

Meldung Keine SIM-Karte SIM-Karte Nachricht wird empfangen.

HINWEIS

Zum Senden einer Nachricht oder Anrufen eines Funkgeräts ohne SIM-Karte schalten Sie die
End-to-End-Verschlüsselung der SIM-Karte aus.

SIEHE AUCH

Kryptomenü

6.12 RUA/RUI
Durch die RUA (Gerätebenutzerzuweisung, Radio User Assignment) und die RUI (Gerätebenutzerkennung) wird
der Logon-Authentifizierungsdienst aktiviert. Nur ein erfolgreiches Logon auf einem vorübergehend benutzten
Funkgerät bietet den uneingeschränkten Zugang und unterstützt Ihre permanente Funkfunktion, sodass Sie weiterhin
unter Ihrer permanenten Nummer erreicht werden können. Ein Fehler beim Logon führt zu einem limitierten Netz.

Sie können den RUA/RUI-Status nach der Farbe der Benutzeroberfläche unterscheiden:

• Blau – Sie sind angemeldet
• Grau – Sie sind nicht angemeldet
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Funkgerätstatus

• Vollbetrieb – Logon des Benutzers war erfolgreich. Ihr Funkgerät ist voll funktionsfähig.

• Eingeschränkter Dienst – Benutzer nicht eingeloggt. Vom Diensteanbieter angegeben.

• Pseudo-Logon – tritt nur beim lokalen Trunking (LST) auf. Ihr Funkgerät ist (abhängig von den Einstellungen des
Diensteanbieters) voll funktionsfähig, mit Ausnahme einiger Dienste wie der Rufweiterleitung. Das Symbole für
das RUI Pseudo-Logon wird angezeigt.

Anmelden

Ihr Diensteanbieter weist ein bestimmtes Funkgerät einer Person für eine vordefinierte Zeitdauer zu. Sie sehen nur
den Bildschirm mit Ihrer Anmeldung und der komplette Service wird bereitgestellt.

Erzwungene Abmeldung

Ihr Dienstanbieter kann Sie abmelden. Das Funkgerät zeigt Erzwungene Abmeldung an.

SIEHE AUCH

Anmelden

RUI

6.13 WAP
Wireless Application Protocol (WAP) ist ein Standard für die Anwendungsschicht-Netzwerkkommunikation in
drahtlosen Kommunikationsumgebungen, wie z. B. in einem TETRA-Netzwerk. Das Protokoll wird für den Zugriff
eines Geräts auf das mobile Netz über einen WAP-Browser verwendet.

Dies ist eine Verkaufsfunktion.

SIEHE AUCH

WAP-Push

WAP-Box

6.13.1 WAP-Browser
Der Openwave Mobile Browser ist ein WAP-kompatibler Benutzer-Agent. Der WAP-Browser bietet alle
Basisdienste eines Computer-basierten Web-Browsers. Jedes Mal, wenn eine vorrangige Anzeige die
Browser-Sitzung unterbricht, muss der Browser manuell reaktiviert werden. Der WAP-Browser unterstützt keine
Sprachen mit Schreibrichtung von rechts nach links, wie z. B. Arabisch oder Hebräisch. Die verwendete Sprache
ist Englisch. Für Inhalte in diesen Sprachen werden keine Zeichen angezeigt.
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6.13.2 Den Browser aufrufen und beenden

HINWEIS

Je nach Gerätekonfiguration und Zustand des Netzwerks zeigt der WAP-Browser Bilder möglicherweise
nicht richtig (oder erst nach einer Verzögerung) an.

6.13.2 Den Browser aufrufen und beenden
Voraussetzung:
Drücken Sie auf dem Startbildschirm die MENÜ-Taste. Setzen Sie Einstellungen → Dateneinstellung auf Nur
Daten oder Sprache & Daten.

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Browser.

6.13.3 Die Browser-Menüfenster aufrufen
Voraussetzung:
Sie befinden sich im Browser.

Durchzuführende Schritte

1 Drücken Sie Menu oder MENÜ.

2 Normalerweise wird das Navigationsfenster oder das letzte Browser-Menüfenster angezeigt.

HINWEIS

Wenn die Webseite, die Sie besucht haben, über zwei oder mehrere Funktionstasten/Optionen verfügt,
wird das Fenster Options geöffnet. Von hier können Sie mit der linken oder rechten Navigationstaste zu
anderen Fenstern blättern oder Browser Menu auswählen und dann zum gewünschten Bereich scrollen.

6.13.4 Tipps zum Durchsuchen
Erstellen und verwenden Sie Folgendes für eine einfachere Browser-Suche.

6.13.4.1 Ein Lesezeichen im Navigationsfenster erstellen

Durchzuführende Schritte
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1 Öffnen Sie den Browser, und navigieren Sie zur gewünschten Seite.

2 Drücken SieMenu , um das Browser-Menü aufzurufen.

3 Wählen Sie Mark Page.

4 Der Bildschirm zeigt den Titel und die URL der markierten Seite an.

5 Um die Einstellung zu speichern:
a. Drücken Sie Save (oder Select), um die Seite in den Lesezeichen zu speichern.
b. Wählen SieMenu und wählen Sie eine Option aus:

• Save - Bestätigt das Erstellen des Lesezeichens.
• Edit - Mit dieser Option können Sie Titel, Ordner, Auswahl und URL des erstellten Lesezeichens
bearbeiten.

6.13.4.2 Ein Lesezeichen im Lesezeichenfenster erstellen
Durchzuführende Schritte

1 Öffnen Sie den Browser.

2 Blättern Sie zum Bereich Bookmarks .

3 Wählen Sie Organise (wenn es keine gespeicherten Lesezeichen gibt), oderMore... .

4 Wählen Sie Menu.

5 Blättern Sie zu New Bookmark.

6 Geben Sie den Namen des Lesezeichens und eine URL ein, und wählen Sie dessen Position.

7 Drücken Sie Save.

6.13.4.3 Ein Lesezeichen verwenden
Durchzuführende Schritte

1 Öffnen Sie den Browser.

2 Blättern Sie zu Bookmarks .
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6.13.4.4 Eine Schnelltaste erstellen

3 Blättern Sie zum gewünschten Lesezeichen, und wählen Sie Go. Das Lesezeichen lädt die ausgewählte Seite
aus dem Internet herunter.

6.13.4.4 Eine Schnelltaste erstellen

Durchzuführende Schritte

1 Öffnen Sie den Browser.

2 Blättern Sie zu Bookmarks .

3 Blättern Sie zum gewünschten Lesezeichen.

4 Drücken Sie auf MENÜ. Wählen Sie Hotkeys.

5 Wählen Sie eine noch nicht zugewiesene Taste (0-9) aus.

6 Klicken Sie auf Assign. Das Display zeigt das Lesezeichen und seine zugeordnete Schnelltaste an.

6.13.4.5 Eine Schnelltaste verwenden

Durchzuführende Schritte

1 Öffnen Sie den Browser.

2 Drücken und halten Sie eine Schnelltaste, um die dem Lesezeichen entsprechende Seite aus dem Internet zu
laden.

6.13.4.6 Eine Seite speichern
Anwendungsgebiete:
Speichern Sie eine Seite für das Offline-Browsing.
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Durchzuführende Schritte

1 Öffnen Sie den Browser, und navigieren Sie zur gewünschten Seite.

2 Drücken Sie Menu.

3 Blättern Sie zu Tools .

4 Wählen Sie Save Page. Bearbeiten Sie den vorgeschlagenen Seitentitel, falls erforderlich. Blättern Sie nach
unten, und wählen Sie Save. Die Seite wird im Ordner Bookmarks Saved Pages gespeichert.

6.13.4.7 Eine gespeicherte Seite auswählen
Durchzuführende Schritte

1 Öffnen Sie den Browser.

2 Blättern Sie zu Bookmarks .

3 Wählen Sie Organise (wenn es keine gespeicherten Lesezeichen gibt), oderMore... .

4 Wählen Sie "Wechseln zu", um den Ordner mit den gespeicherten Seiten aufzurufen.

5 Wählen Sie eine gespeicherte Seite aus, und drücken Sie Ok. Das Display zeigt die gespeicherte Seite an. Je
nach gespeicherter Seite können Sie ggf. von hier aus im Internet surfen.

6.13.5 Deaktivierter Paketdatendienst
Wenn kein Paketdatendienst verfügbar ist, zeigt das Funkgerät Fehler:Kein Netz verfügbar beim erstmaligen
Aufrufen des Browsers an. Wählen Sie den linken SOFTKEY aus, um den Vorgang zu wiederholen, oder drücken
Sie den rechten SOFTKEY, um das Browser-Menü aufzurufen.

Beim erneuten Aufrufen des Browsers mit den zuvor verfügbaren Paketdaten zeigt das Funkgerät die letzte
aufgerufene Seite oder die letzte Seite, auf welcher Sie offline navigiert sind, an.

6.13.6 Deaktivierte Browsereingabe
Die Browsereingabe ist in folgenden Fällen deaktiviert:

• Während eines Sprachanrufs, außer beim Mithören von Umgebungsgeräuschen
• Im DMO-Modus
• Im Notrufmodus
• Bei PIN-Sperre
• Dienstanbieter hat diese Funktion nicht konfiguriert
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6.13.7 Tastenverwendung

• Funkgerät ist deaktiviert

HINWEIS

• Die Browsereingabe ist beim Mithören von Umgebungsgeräuschen aktiviert. Wenn Sie zu den
zuvor gespeicherten Seiten navigieren, bleibt der Mithörstatus erhalten.

• Wenn Sie Paketdaten erstmalig aktivieren, ist das Mithören nicht verbunden, und Sie haben den
Eindruck, als ob das Mithören von Umgebungsgeräuschen zuvor nicht eingeschaltet war.

6.13.7 Tastenverwendung
Wenn der Browser aktiv ist, erfolgt die nachfolgend beschriebene Verwendungsweise innerhalb oder außerhalb
des Editors.

Tabelle 6-3 Browser-Tastenverwendung

Gedrückte Taste Aktion
Taste 0-9 Im Editor: Hiermit kann je nach eingestelltem

Texteingabemodus eine Ziffer und/oder ein Buchstabe
eingegeben werden.

Außerhalb des Editors: Wählt in einer nummerierten
Liste die gewünschte Optionsliste aus.

Taste 0-9 (Halten) Im Editor: Standardverwendung.

Außerhalb des Editors: Kurztaste für die Navigation
zum nummerierten Lesezeichen.

*-Taste (Drücken oder halten) Im Editor: Fügt ein Leerzeichen ein.

#-Taste (Drücken oder halten) Im Editor: Ruft das Texteingabefenster auf. Andernfalls
ertönt ein Ton für einen falschen Tastendruck.

Linker oder rechter SOFTKEY Wählt die Option, die im Display direkt oberhalb des
linken und rechten Softkeys (Teil der Seite) erscheint.

NAVIGATIONSTASTE nach oben Bewegt sich in der Liste der Optionen eine Zeile nach
oben.

NAVIGATIONSTASTE Nach oben (Halten) Bewegt sich auf der Seite nach oben.

NAVIGATIONSTASTE nach unten Bewegt sich in der Liste der Optionen eine Zeile nach
unten.

NAVIGATIONSTASTE Nach unten (Halten) Bewegt sich auf der Seite nach unten.

Linke NAVIGATIONSTASTE Wechselt zum vorherigen Fenster.

Im Editor: Bewegt sich nach links.

Linke NAVIGATIONSTASTE (Halten) Wechselt rückwärts.

Rechte NAVIGATIONSTASTE Wechselt zum nächsten Fenster.

Im Editor: Bewegt den Cursor nach rechts und fügt am
Ende des Wortes ein Leerzeichen ein.
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Tabelle 6-3 Browser-Tastenverwendung (Fortsetzung)

Gedrückte Taste Aktion

Rechte NAVIGATIONSTASTE (Halten) Wechselt vorwärts.

Mittlere NAVIGATIONSTASTE (Halten) Automatisch wiederholen.

MENÜ-Taste Ruft das Browser-Menü auf.

ENDE-Taste Drücken Sie zum Deaktivieren des Browsers.

SENDETASTE Im aktiven Zustand des Browsers deaktiviert.

DREHKNOPF Lautstärke einstellen.

NOTRUF-Taste Deaktiviert den Browser. Das Funkgerät schaltet in den
Notfallmodus.

6.13.8 Übersicht über die Fensterbereiche im Browser-Menü
Das Browser-Menü enthält die folgenden Fensterbereiche:

Tabelle 6-4 Fensterbereiche im Browser-Menü

Menübereich Beschreibung

Navigieren Bietet Zugriff auf die Startseite und häufig verwendete Elemente.

Lesezeichen Bietet Zugriffs-, Bearbeitungs- und Speicheroptionen für gespeicherte
Lesezeichen und gespeicherte Seiten.

Verlauf Bietet Zugriff auf die zuletzt aufgerufenen Seiten und zeigt die Position der
aktuell geladenen Seite im Verlaufsstapel an.

Tools Ermöglicht den Zugriff auf Anwendungen und Dienstprogramme.

Die folgenden Fensterbereiche werden je nach Kontext angezeigt:

Tabelle 6-5 Zusätzliche Menübereiche

Menübereich Beschreibung

Optionen Wird nur angezeigt, wenn weitere Optionen für das Fenster oder die Seite
zur Verfügung stehen.

Bild Wird nur angezeigt, wenn ein Bild ausgewählt ist. Bietet Zugriff auf
Bilddetails, Speicher- und Anzeigeeinstellungen.

Texteingabe Wird nur im Texteingabemodus angezeigt. Bietet Zugriff auf den
Texteingabemodus (z. B. Symbol).

6.13.9 Navigationsfenster
Sie können eines der folgenden Elemente auswählen:

• Home – Für das Laden der Startseite.
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6.13.10 Erweitert...

• Open Page – Zur Eingabe der URL.
• Search – Element deaktiviert.
• Mark Page – Zum Erstellen (Speichern) eines Lesezeichens für das aktuelle Dokument. Es werden ein Titel
und eine URL für das Lesezeichen angezeigt, und der Stammordner für den Speicherort ist ausgewählt.

• Forward – Für die Navigation zum Dokument, das sich einen Schritt weiter im Navigationsverlauf befindet.
Wenn es keinen Vorwärtsverlauf gibt, ist diese Option deaktiviert.

• Reload – Für das erneute Laden des aktuellen Dokuments.
• Advanced... – Siehe nachfolgender Abschnitt.

6.13.10 Erweitert...
Wählen Sie im Lesezeichen-Bereich Advanced... , um die folgenden Optionen anzuzeigen:

• Settings...

– Downloads – Zum Festlegen der Download-Voreinstellungen. Sie können das Herunterladen von
Bildern und Objekten deaktivieren. Der Browser zeigt ein spezielles Symbol anstelle der Bilder und
Objekte an.

– Scroll Mode – Für die Einstellung von Bildlaufmodus und Geschwindigkeit.
– Key Press Timeout – Zum Einstellen der Zeitüberschreitung beim Tastendrücken. Diese
Zeitüberschreitung wird für die Texteingabe verwendet.

– Set Proxy – Wählen Sie den WAP-Proxy (1, 2, 3). Der Browser stellt eine Verbindung zum Web über
den ausgewählten Proxy oder ein Gateway her. Der Netzwerk-Provider installiert und konfiguriert den
Proxy. Um eine sichere Sitzung herzustellen, wählen Sie einen sicheren Proxy. Wenden Sie sich an
Ihren Provider, um sich zu informieren, welcher Proxy für eine sichere Sitzung konfiguriert ist. Obwohl
Sie Ihre Startseite auswählen können, kann der Mobilfunkanbieter seine eigene Homepage auf Ihrem
Terminal anzeigen lassen.

– Circuit Prompt – Zum Ein- und Ausschalten der Stromkreis-Aufforderung.
– Resend Data Prompt – Zum Ein- und Ausschalten der Aufforderung zum erneuten Senden von Daten.

• Security...

– Secure Prompt – Zum Aktivieren/Deaktivieren des Browsers, um Ihnen mitzuteilen, dass eine nicht
sichere Verbindung durch eine sichere Verbindung ersetzt wurde und umgekehrt.

– Current Certificate – Zur Anzeige des digitalen Zertifikats, das den Server identifiziert, welcher
das aktuelle Dokument liefert. Eine Zertifizierungsstelle (ZS) signiert und authentifiziert damit
dieses Zertifikat digital. Bis zu zehn weitere individuelle WTLS-Zertifikate können zur installierten
Standardliste der Zertifikate hinzugefügt werden. Bitte wenden Sie sich an Ihren Mobilfunkanbieter,
wenn Sie möchten, dass diese individuellen WTLS-Zertifikate hinzugefügt werden.

– CA Certificates – Zur Anzeige der im Browser installierten digitalen Zertifikate mit digitaler Signatur
von Zertifizierungsstellen (CA).

– Send Referrer – Zum Ein-/Ausschalten des Sendens der HTTP Referrer-Kopfzeile als Teil von
HTTP-Anforderungen. Die Referrer-Kopfzeile sendet die URL der Linkquelle an den Server.

– Authentication – Zum Ein-/Ausschalten des Zwischenspeicherns der
HTTP-Authentifizierungsanmeldedaten. HTTP-Authentifizierung schützt den Zugriff auf Inhalte auf
dem Server. Wenn Sie versuchen, auf geschützten Inhalt zuzugreifen, geben Sie Ihre Zugangsdaten
(Benutzername oder Kennwort) ein.

• Clear... – Zum Löschen von Browserdaten: Verlauf, Cache-Cookies oder automatisches Ausfüllen.
• Restart Browser – Zum Neustarten des Browsers.
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• About... – Für die Anzeige von Informationen über die aktuelle Version von Openwave Mobile Browser.

6.13.11 Lesezeichenfenster
Wenn sich Lesezeichen im Stammordner befindet, wählen SieMore... , um das Optionsfenster aufzurufen.
Wenn der Stammordner leer ist, wählen Sie Organise... , und betätigen Sie die Taste MENÜ, um das
Optionsfenster aufzurufen. Im Optionsbereich können Sie Lesezeichen verwalten. Der Ordner Saved Pages
enthält Momentaufnahmen der gespeicherten Seiten.

6.13.11.1 Das Optionsfenster für ein ausgewähltes Lesezeichen
verwenden

Durchzuführende Schritte

1 Wählen Sie im Lesezeichen-BereichMore... .

2 Blättern Sie zu einem Lesezeichen.

3 Drücken Sie MENÜ zum Öffnen des Optionsbereichs für das Lesezeichen.

4 Wählen Sie eine der folgenden Optionen aus:
• Back - Für die Darstellung der Seite, die zum Lesezeichen gehört (die Seite wird heruntergeladen,

wenn sie nicht im Cache verfügbar ist).
• Details - Zum Ändern des Lesezeichentitels und der URL.
• Delete - Zum Löschen des Lesezeichens.
• New Bookmark - Zum Erstellen eines neuen Lesezeichens.
• New Folder - Zum Erstellen eines neuen Ordners.
• Move - Zum Verschieben des Lesezeichens in einen neuen Ordner (oder in Lesezeichen).
• Delete All - Zum Löschen aller Lesezeichen.
• Hotkeys - Für das Zuordnen von Kurztasten zu verfügbaren Lesezeichen.

6.13.11.2 Den Ordner für gespeicherte Seiten verwenden
Durchzuführende Schritte

1 Wählen Sie im Lesezeichen-Bereich den Ordner Saved Pages .

2 Der Browser zeigt die Seite (eine Momentaufnahme) an, die über "Seite speichern" im Bereich "Tools"
gespeichert wurde.

3 Blättern Sie zu einer gespeicherten Seite.
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6.13.12 Verlaufsfenster

4 Drücken SieMenu , um den Optionsbereich für die gespeicherte Seite zu öffnen.

5 Wählen Sie eine der folgenden Optionen aus:
a. Back - Zum Anzeigen dieser im Cache gespeicherten Seite.
b. Details - Zum Ändern des Seitentitels und der URL der gespeicherten Seite.
c. Update Page - Zum Ersetzen der gespeicherten Version durch die aktuelle Version (durch Herunterladen

von Server).
d. Delete - Zum Löschen dieser Seite aus dem Cache.
e. Delete All - Zum Löschen aller gespeicherten Seiten aus dem Cache.
f. Cancel - Zum Beenden dieses Bereichs und Rückkehr zur letzten angezeigten Seite.

6.13.12 Verlaufsfenster
Dieser Bereich zeigt die Liste der kürzlich besuchten Seiten an (bis zu neun Verlaufseinträge können aufgeführt
werden). Jeder Verlaufseintrag zeigt den Titel an, falls vorhanden. Andernfalls wird No Title angezeigt.
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6.13.12.1 Zur zuletzt besuchten URL navigieren

Durchzuführende Schritte

1 Wählen Sie die URL.

2 Drücken Sie Ok.

6.13.13 Werkzeugfenster
Durchzuführende Schritte

1 Wählen Sie im Werkzeugfenster More...

2 Blättern Sie zu einem Dokument.

3 Wählen Sie MENÜ, um den Optionsbereich für dieses Dokument zu öffnen.

4 Wählen Sie eine der folgenden Optionen aus:
• Show URL - Zeigt die aktuelle Seiten-URL an.
• Save Page - Erstellt eine Momentaufnahme für das aktuelle Dokument.
• Find Text - Sucht nach einer Textfolge im aktuellen Dokument.
• Copy Text - Kopiert Text vom aktuellen Dokument in die Zwischenablage.

6.13.14 Optionsfenster
Dieser Bereich wird speziell für die Seite oder den Fensterbereich angezeigt.

6.13.15 Bildfenster
Dieser Bereich wird im Browserfenster angezeigt, wenn Sie das Herunterladen von Bildern im Navigationsfenster
aktiviert haben > Advanced... > Settings... .

Die folgenden Elemente sind verfügbar:

• Save – Für das Speichern des Bildes im Terminal.

• [Send] – Für das Senden des Bildes an ein Ziel Ihrer Wahl.

• Reload – Für das erneute Laden des Bildes.

• Details – Zur Anzeige der Bilddetails.

• Show Image – Zur Darstellung des Bildes auf einer separaten Seite.
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6.13.16 Texteingabefenster

6.13.16 Texteingabefenster
Voraussetzung:
Dieses Fenster wird angezeigt, wenn das Browser-Menü geöffnet ist und das Texteingabefeld aktiv ist.

Anwendungsgebiete:
So geben Sie einen Text für die URL ein:

Durchzuführende Schritte

1 Wählen Sie die URL.

2 Drücken Sie abc.
Schrittergebnis: Das Texteingabefenster wird geöffnet.

3 Wählen Sie www.

4 Blättern Sie durch die gewünschte Erweiterung (zum Beispiel: .com).

5 Drücken Sie .com. Der Bildschirm zeigt die URL mit der ausgewählten Erweiterung.

Tabelle 6-6 Browser-Texteingabesymbole

Modus Softkey Aktion

Alphabetische Zeichen -
Kleinbuchstaben

abc Geben Sie Text in Kleinschreibung
ein.

Alphabetische Zeichen -
Großbuchstaben

ABC Geben Sie Text in Großbuchstaben
ein.

Numerisch 123 Geben Sie Zahlen und Symbole ein.

HTTP-Modus www Eingabe

6.13.17 WAP-Push
WAP-Push ermöglicht das Weiterleiten von WAP-Inhalten an ein Funkgerät. Der sogenannte Push-Vorgang erfolgt
durch Senden eines speziell formatierten (Push Access Protocol) XML-Dokuments an das Push-Proxy-Gateway,
das wiederum das Dokument an das Funkgerät weiterleitet.

Eine WAP-Push-Nachricht ist eine verschlüsselte Nachricht mit einem Link zu einer WAP-Adresse. Bei Empfang
eines WAP-Push bietet ein WAP-fähiges Gerät automatisch eine Option zum Zugreifen auf den WAP-Inhalt an.
Der implementierte WAP-Push ist mit dem WAP 2.0-Standard kompatibel.

Dies ist eine Verkaufsfunktion.
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SIEHE AUCH

WAP

WAP-Box

6.13.17.1 Neue WAP-Nachrichten
Typen von WAP-Nachrichten und ihre Prioritäten:

HINWEIS

Ihr Dienstanbieter legt die Priorität der Nachricht fest.

• Push-Nachricht

– Hoch: Animation und das Symbol (blinkend) werden zusammen mit dem Ton für neueWAP-Nachrichten
angezeigt.

– Mittel: Animation und das Symbol werden zusammen mit dem Ton für neue WAP-Nachrichten
angezeigt.

– Niedrig: Symbol wird mit dem Ton für neue WAP-Nachrichten angezeigt.

– Löschen: Nur verfügbar, wenn Sie in der WAP-Box sind. Der TextWAP-Nachricht entfernt gelöscht
wird angezeigt, darüber hinaus gibt es keinen Hinweis.

HINWEIS

Die Animation wird nicht angezeigt, wenn Sie ein Gespräch führen oder im Notbetrieb oder
wenn Sie andere Teilnehmer anrufen oder im Nachrichten-Editor oder bei PIN-Sperre oder beim
Wechsel zu DMO.

• Push-Nachricht laden

– Hoch: Der Browser öffnet für den Benutzer mit dem Ton für neue WAP-Nachrichten.

– Niedrig: Das Symbol wird mit dem Ton für neue WAP-Nachrichten angezeigt.

HINWEIS

Der Browser wird nicht geöffnet, wenn Sie ein Gespräch führen oder im Notbetrieb oder wenn Sie andere
Teilnehmer anrufen oder im Nachrichten-Editor oder bei PIN-Sperre oder beim Wechsel zu DMO.
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6.13.17.2 Eine WAP-Nachricht anzeigen

6.13.17.2 Eine WAP-Nachricht anzeigen

Durchzuführende Schritte

1 Drücken Sie auf dem Startbildschirm die MENÜ-Taste.

2 Wählen Sie Nachrichten → WAP-Box.

3 Wählen Sie die gewünschte Nachricht aus.

4 Wählen Sie Go to , um die Nachricht im Browser anzuzeigen.

6.14 Vorfall
Mit dieser Funktion erhalten Sie Vorfall-Alarme. Wenn Vorfall-Nachrichten empfangen werden, unterbricht das
Funkgerät den aktuellen Dienst und schaltet unverzüglich zum Vorfall-Alarm. Nachdem der Vorfall-Alarm gelöscht
wurde, verlässt das Funkgerät den Vorfall-Modus und kehrt zum normalen Modus zurück. Im Vorfall-Modus
können Sie nur Notrufe empfangen.

HINWEIS

Um eine Vorfall-Nachricht ganz zu lesen, blättern Sie im Bildschirm durch Drücken der entsprechenden
NAVIGATIONSTASTE nach unten. Die Länge der Nachricht wird durch den senkrechten roten Balken
auf der linken Seite des Bildschirms angezeigt.

Abbildung 6-1 Vorfall-Nachricht

SIEHE AUCH

CO-Box

6.14.1 Typen von Vorfall-Alarmen
Es gibt vier Typen von Vorfall-Alarmen:

• Normale Vorfälle: Eine Alarmnachricht, die von einem Dispatcher an ein einzelnes oder an eine Gruppe von
Funkgeräten gesendet wird.
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• Sturmplan: Eine Alarmnachricht, die von einem Dispatcher an eine Gruppe von Funkgeräten gesendet wird.
Um die Zuverlässigkeit zu steigern, wird die Nachricht mehrmals gesendet. Sie können nicht auf die
Nachricht reagieren,und ein Druck auf eine beliebige Taste startet die Informationsphase.

• Fallback-Modus: Eine Alarmnachricht, die auf Sprachkommunikationen beschränkt ist. Um diesen
Anruftyp zu aktivieren,müssen Sie eine von Ihrem Dienstanbieter vordefinierte Direktwahltaste drücken.
Kann manuell gelöscht werden.

HINWEIS

Fallback ist nur möglich, wenn das Funkgerät im Local Site Trunking-Modus ist.

• Testvorfall: Eine besondere Alarmnachricht, die von einem Dispatcher zum Test der Funktion gesendet
wird. Bei Eingang eines Testvorfalls gibt das Funkgerät einen Signalton aus und zeigt Vorfallmeldung
testen an. Um zu reagieren und die Warnung zu löschen,drücken Sie den SOFTKEY Test OK.

6.14.2 Interaktionen im Vorfall-Modus
Die Vorfall-Funktion funktioniert in anderen Modi anders:

• TXI-Modus: Sie können Nachrichten lesen, sie aber nicht beantworten. Sie können den TXI-Modus
beenden, indem Sie den Softkey drücken oder die Vorfall-Nachricht ablehnen.

• DMO-Modus: Vorfall-Funktion wird nicht unterstützt.

• Notrufmodus: Alle Vorfall-Alarme werden ignoriert.

6.14.3 Vorfall-Dienstphasen
Im Vorfall-Modus gibt es folgende Phasen:

• Alarmphase: empfängt eine Vorfall-Nachricht. Der Alarmton zeigt eine Nachricht an. Text wird angezeigt,
und Sie haben folgende Optionen zur Verfügung: Akzeptieren, Abweis oder MENÜ. Wenn Sie die
Nachricht annehmen, kann ab diesem Zeitpunkt kein anderer Dienst mehr übernehmen.

HINWEIS

Sie können den Signalton durch Drücken der PTT-TASTE oder eines beliebigen Softkeys beenden.

• Informationsphase: Sie befinden sich weiterhin im Vorfall-Modus und können detaillierte Informationen
über den Vorfall empfangen, (durch eine nachfolgende Text- oder Sprachnachricht). Sie können weitere
Informationen mithilfe eines Sprach-Gruppenanrufs oder der Textfunktion anfordern, durch die Sie
Textnachrichten versenden können. Sie können immer antworten und den Text oder die Sprachnachricht
mithilfe des Sprach-Gruppenanrufs zurücksenden.
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Anhang A: Töne

HINWEIS

Das Funkgerät hat zwei Tonpakete - Neue Töne (Standard) und klassische Töne. Ihr Diensteanbieter
bestimmt, welcher Satz aktiviert wird.

Um die Beispiele für Audiosignale anzuhören, klicken Sie auf .

Tabelle A-1 Signaltöne

Neuer Ton Klassischer
Ton Tonbeschreibung

Standard-Signalton: Wird beim Drücken einer Taste wiedergegeben.

Duplex Lautstärkeeinstellung: Wird wiedergegeben, wenn Sie die
Duplex-Lautstärke anpassen.

Ungültige Aktion

Beispiele:

• Drücken einer falschen Taste.

• Wählen einer ungültigen Zahl.

• Gespräch untersagen.

Systembenachrichtigung

Beispiele:

• Das Funkgerät hat seinen Status von außerhalb des
Empfangsbereichs auf in Betrieb geändert.

• Das Funkgerät ist zum Heimnetz zurückgekehrt.

• Umschalten zwischen TMO- und DMO-Modus.

Systemfehler

Beispiele:

• Das Funkgerät hat seinen Status von in Betrieb auf außerhalb des
Empfangsbereichs geändert.

• Anruf wurde getrennt.

Allgemeine Benachrichtigung

Beispiele:

• Aufrufen des Local Site Trunking.

• Aufrufen der Sendesperre.

Positive Benachrichtigung: Senden der Nachricht erfolgreich.
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Tabelle A-1 Signaltöne (Fortsetzung)

Neuer Ton Klassischer
Ton Tonbeschreibung

Negative Benachrichtigung: Senden der Nachricht fehlgeschlagen.

Pos. empfangen: Neue Nachricht empfangen.

Gesprächsgenehmigung: Der Funkgerätbenutzer darf seine Nachricht
übertragen (nach dem Drücken der PTT-Taste).

Sendebereit: Die Datenübertragung kann beginnen.

Notfall: Notruf empfangen.

Drahtlos 1: Einfacher D-PTT-Ton.

Drahtlos 2: Doppelter D-PTT-Ton.

Drahtlos 3: Dreifacher D-PTT-Ton.

Telefon besetzt: Das angerufene Funkgerät ist besetzt.

Telefonrückruf: Wird bei der Einrichtung des Telefonanrufs auf dem
initiierenden Telefon abgespielt.

Privater Rückruf: Wird bei der Einrichtung des privaten Anrufs auf dem
initiierenden Telefon abgespielt.

Klingelton 1.

Klingelton 2.

Klingelton 3.

Klingelton 4.

Klingelton 5.

Simplex Lautstärkeeinstellung: Wird wiedergegeben, wenn Sie die
Simplex-Lautstärke anpassen.

BSI-Schlüsselverhandlung: Wird während der BSI-Schlüsselverhandlung
abgespielt.

Fernsteuerung: Wird wiedergegeben, wenn das Funkgerät eine neue
Fernsteuerungsnachricht empfängt.
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Anhang B: LED-Anzeigen
Tabelle B-1 LED-Anzeigen

Anzeige Status
Grünes Dauerlicht In Verwendung

Anrufwiederholung

Blinkt grün In Betrieb

Rotes Dauerlicht Außer Betrieb

Blinkt rot Verbindung zu einem Netz wird hergestellt

Wechsel in den Direktmodusbetrieb

Orangefarbenes Dauerlicht Sendesperre in Betrieb

Kanal belegt in DMO

Blinkt orange Eingehender Anruf

Keine Anzeige Ruhemodus

Funkgerät ausgeschaltet
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Anhang C: Fehlerbehebung
Ihr Funkgerät zeigt folgende Meldungen an:

Tabelle C-1 Angezeigte Meldungen

Meldung Meldungsbeschreibung
... -Empfangen Anruf empfangen aber nicht angenommen, oder abgelehnt.

Zuweisung fehlgeschlagen Ihr Funkgerät konnte keine Gesprächsgruppenzuweisung
durchführen. Es versucht es weiter. Wenn dies nicht erfolgreich ist,
versuchen Sie es mit einer anderen Gesprächsgruppe.

Fehler beim Authentifizieren Ihr Funkgerät konnte nicht auf einem authentifizierten System
registriert werden (Authentifizierungsschlüssel ist möglicherweise
falsch, oder Authentifizierung ist deaktiviert).

Anruf abgebrochen Sie haben den Anruf abgebrochen.

Anruf beendet • Fehlerhafter Kanal. Bitte versuchen Sie es später noch
einmal.

• Sie haben den Anruf beendet.

Rufweiterleitung Das angerufene Funkgerät ist nicht verfügbar, und der Anruf wird
an ein anderes Funkgerät weitergeleitet.

Anruf geändert Der Anruf, an dem Sie teilnehmen, wurde geändert.

Anruf vorzeitig beendet Kanal wird für Priorität verwendet.

Entschlüsselung fehlgeschlagen: Fehler bei der Entschlüsselung einer Nachricht oder eines Anrufs.

Notruf verwendet
Warten auf Mik

Die Funktion „Hot Mic“ ist aktiv, aber die Kanalübertragungs-
genehmigung wurde an einen anderen Notruf in der gleichen
Gesprächsgruppe vergeben. Das Mikrofon Ihres Funkgeräts ist
während dieser Zeit nicht aktiv, aber versucht automatisch, nach
einer festgelegten Zeit wieder eine Gesprächsgenehmigung zu
erhalten.

Notruf-Mik beendet Der Timer für „Hot Mic“ ist automatisch abgelaufen, oder Sie haben
die PTT-Taste gedrückt, um die Funktion „Hot Mic“ abzubrechen.

Notruf-Mik an Die Funktion „Hot Mic“ ist aktiv, und das Funkgerät überträgt
automatisch Freisprechfunktion-Notfall-Audio.

Leerer Eintrag Die gewählte Kurzwahlnummer existiert nicht, oder die Nummer
ist vorhanden, aber die Gruppe ist nicht wählbar.

Defekte Einheit
Fehler

Selbsttest ist fehlgeschlagen. Im Funkgerät wurde ein Betriebsfehler
erkannt. Notieren Sie den Fehlercode. Schalten Sie das Funkgerät
aus und wenden Sie sich an den Kundendienst.

Gateway verfügbar Ihr Funkgerät hat eine Verbindung zu einem Gateway.

Gateway nicht verfügbar Das Funkgerät ist nicht mit einem Gateway verbunden, oder die
Verbindung wurde unterbrochen.

Diese Gruppe ist bereits vorhanden Die Gruppe, die Sie versuchen hinzuzufügen, ist bereits im Ordner
Meine Gruppen vorhanden.

Nur Einzelrufe Sie können nur einzelne (private) Anrufe vornehmen.
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Tabelle C-1 Angezeigte Meldungen (Fortsetzung)

Meldung Meldungsbeschreibung
Nicht genügend sichtbare Daten Das Funkgerät versucht den Standort zu bestimmen. Dieser

Vorgang kann mehrere Minuten in Anspruch nehmen.

Nicht genügend sichtbare Satelliten Das Funkgerät versucht den Standort zu bestimmen. Dieser
Vorgang kann mehrere Minuten in Anspruch nehmen.

Ungültige ID Die eingegebene Nummer ist ungültig.

Ungültige Verknüpfungsposition Die eingegebene Nummer ist ungültig.

Eingeschränkter Service Notrufe, Notfallalarme und Mobilitätsvorgänge (wie beispielsweise
für Gruppenzuweisung) sind zulässig. Alle anderen eingehenden
und ausgehenden Anrufe und Datendienste sind gesperrt.

Liste leer Es sind keine programmierten Einträge in der angezeigten Liste.
Geben Sie einen Eintrag ein.

Liste nicht zugewiesen Alle Gesprächsgruppen in der Scan-Liste sind nicht zugewiesen.

Liste teilweise zugewiesen Die Scan-Liste ist aktiv, aber nicht alle Gesprächsgruppen sind
zugewiesen.

Nachricht zugestellt Mail wurde erfolgreich zugestellt.

Nachricht fehlgeschlagen Zeigt einen Mail-Zustellungsfehler an.

Neuer Lieferstatus Sie haben einen neuen Lieferstatus erhalten.

Kein Dienst Das Funkgerät ist außerhalb der Abdeckung. Kehren Sie in den
abgedeckten Bereich zurück.

Meine Gruppen
Ist leer

Sie können Gruppen anzeigen/löschen, wenn der OrdnerMeine
Gruppen leer ist.

Meine Gruppen
Ist voll

Sie sind nicht berechtigt, eine Gruppe zum OrdnerMeine Gruppen
hinzuzufügen, da er bereits die maximal zulässige Anzahl von
Gruppen enthält.

Netzwerkprobleme Netzwerkprobleme. Versuchen Sie es später erneut.

Keine Antwort Der Teilnehmer meldet sich nicht.

Keine Einträge Diese Meldung wird angezeigt, wenn Sie auf eine leere Liste
zugreifen.

Keine Gruppe • Zuweisung ist fehlgeschlagen. Ihr Funkgerät ist von der
aktuellen Gesprächsgruppe losgelöst. Bitte warten Sie, bis
es erneut an die aktuelle Gesprächsgruppe anschließt.

• Wird angezeigt, wenn Sie außerhalb der normalen
Reichweite der ausgewählten Gesprächsgruppe sind.
Wählen Sie eine neue Gesprächsgruppe, die für Ihren
Arbeitsort geeignet ist.

• Zeigt an, dass eine Favoritengruppe aus dem OrdnerMeine
Gruppen entfernt wurde.

Keine Liste Die Netzwerkliste ist leer.

C-2 -



Anhang C Fehlerbehebung

Tabelle C-1 Angezeigte Meldungen (Fortsetzung)

Meldung Meldungsbeschreibung
Keine neuen oder alten Nachrichten Zeigt an, dass keine neuen oder alten Nachrichten im Posteingang

vorhanden sind.

Keine ausgewählte Scan-Liste Sie haben eine leere Netzwerkliste ausgewählt.

Kein Dienst Das Funkgerät befindet sich außerhalb des Empfangsbereichs.

Keine Genehmigung zum Anruf starten Sie sind nicht berechtigt, eine Nummer zu wählen, die nicht im
Adressbuch gespeichert ist.

Keine Übertragung zulässig Lassen Sie die PTT-Taste los und versuchen Sie es später
erneut. Sie sind nicht zum Senden einer Textnachricht oder
einer Statusmeldung an eine Nummer, die nicht im Adressbuch
gespeichert ist, berechtigt.

Nur einzelne Gesprächsgruppe Es gibt nur einen programmierten Eintrag in der angezeigten Liste.

Überhitzung, schalten Sie das Funkgerät
aus

Ihr Funkgerät schaltet sich aus. Lassen Sie das Gerät für 5 Minuten
ausgeschaltet.

Teilnehmer besetzt Das angerufene Funkgerät ist besetzt.

Teilnehmer nicht verfügbar Das angerufene Funkgerät ist außerhalb des Empfangsbereichs oder
ausgeschaltet. Versuchen Sie es später erneut.

Versuchen Sie es erneut Anruf war nicht möglich.

Auf Verbindung warten Eine Nachricht während des Systemstarts.

Registrierungsfehler Ihr Funkgerät konnte nicht im System registriert werden. Versuchen
Sie es später erneut.

Repeater verfügbar Ihr Funkgerät hat eine Verbindung zu einem Repeater.

Repeater nicht verfügbar Das Funkgerät ist nicht mit einem Repeater verbunden, oder die
Verbindung wurde unterbrochen.

Dienst verweigert Ungültige Nummer. Wenden Sie sich an den Dienstanbieter.

Dienst nicht verfügbar Dieser Dienst ist im aktuellen Netz nicht verfügbar.

Dienst ist eingeschränkt Dieser Dienst wird von Ihrem Dienstanbieter optional zur Verfügung
gestellt. Er wurde nicht erworben oder ist nicht verfügbar.

GesprGrp ... kann nicht gelöscht werden Ihr Dienstanbieter hat diese Gruppe festgelegt, Sie können sie nicht
aus dem Favoritenordner für Gesprächsgruppen löschen.

Versuchen Sie es später erneut Der angeforderte Dienst ist vorübergehend nicht verfügbar.

Funkgerät deaktiviert Wenden Sie sich an Ihren Dienstanbieter.

Gerät ist OK
Warnung:

Selbsttest-Fehler. Eine geringfügige Störung wurde erkannt. Das
Funkgerät ist immer noch voll funktionsfähig. Wenn dieser Fehler
wiederholt auftreten sollte, notieren Sie sich den Fehlercode, und
wenden Sie sich an den Service.
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Tabelle C-1 Angezeigte Meldungen (Fortsetzung)

Meldung Meldungsbeschreibung
Gerät nicht angeschlossen Das Funkgerät konnte keine Verbindung zum System herstellen.

Die Gesprächsgruppe ist möglicherweise nicht im System definiert.
Versuchen Sie es mit einer anderen Gruppe.

Nicht zugewiesene Taste Die Meldung wird angezeigt, wenn einer Taste keine Funktion
zugewiesen ist.

C-4 -


	English
	Contents
	List of Figures
	List of Tables
	1 General Information
	1.1 Safety Information
	1.2 Copyrights
	Disclaimer
	Trademarks
	European Union (EU) Waste of Electrical and Electronic Equipment (WEEE) directive

	1.3 Icon Conventions
	1.4 Using this Guide

	2 Getting Started
	2.1 Product Technical Information
	2.2 Controls and Indicators
	New Generation Control Head (NGCH) / Remote Ethernet Control Head (RECH)
	Telephone Style Control Head (TSCH)
	Cradle

	2.3 Display
	2.3.1 Display Orientation

	2.4 Status Icons
	2.5 Powering On the Radio
	2.6 PIN Code Authentication
	2.6.1 Unblocking Your Radio

	2.7 Locking/Unlocking the Keys/Buttons
	2.8 Entering TMO / DMO Mode
	2.9 Transmit Inhibit Mode
	2.10 Selecting a Talkgroup
	2.11 Using Timed Talkgroup Change
	2.12 Activating Talkgroup Scanning
	2.13 Broadcast Call
	2.14 Ambience Listening (AL) Call
	2.15 One-Touch Button Feature
	2.16 Terminal Temporary Disable/Enable
	2.17 Terminal Permanent Disable
	2.18 During the Call
	2.19 Writing Text
	2.19.1 Selecting Text Entry Mode
	2.19.2 Selecting Text Entry Method and Language
	2.19.3 Text Entry Icons
	2.19.4 Keys Usage
	2.19.5 Writing in iTAP Alphanumeric
	2.19.6 Writing in TAP Alphanumeric
	2.19.7 Word Locking
	2.19.8 Adding Words to the Dictionary

	2.20 Home Display Text Message

	3 Modes
	3.1 Using Networks
	3.2 Trunked Mode Operation
	3.2.1 Entering TMO Mode
	3.2.2 Selecting a Talkgroup
	3.2.3 Making a Group Call in TMO
	3.2.4 Receiving a Group Call in Idle
	3.2.5 Receiving a Group Call during an Ongoing Group Call
	3.2.6 Dynamic Group Number Assignment (DGNA)
	3.2.7 DGNA Reception
	3.2.8 DGNA Auto Select Group
	3.2.9 DGNA Auto Reselect Group
	3.2.10 Viewing DGNA Talkgroups
	3.2.11 Broadcast Call Initiated by User
	3.2.12 Initializing Broadcast Call
	3.2.13 Phone and PABX Calls
	3.2.14 Private Call
	3.2.15 Making a Private Call
	3.2.16 Assistance Call
	3.2.17 Call Modification
	3.2.18 Enabling/Disabling SIM Card End-to-End Encryption

	3.3 Local Site Trunking
	3.3.1 Entering Local Site Trunking
	3.3.2 Exiting Local Site Trunking

	3.4 Direct Mode Operation
	3.4.1 Entering DMO Mode
	3.4.2 Selecting a Talkgroup
	3.4.3 Making a Group Call in DMO
	3.4.4 Receiving a Group Call in Idle
	3.4.5 Private Call
	3.4.6 Making a Private Call
	3.4.7 Private Call With Presence Check
	3.4.8 Talkgroup for Individual Calls
	3.4.9 Communication through Repeater
	3.4.10 Communication through Gateway
	3.4.11 Selecting DMO Group Call Options

	3.5 Transmit Inhibit Mode
	3.6 Emergency Operations
	3.6.1 Emergency Group Call
	3.6.2 Making an Emergency Group Call
	3.6.3 Receiving an Emergency Group Call
	3.6.4 Non-Tactical Emergency
	3.6.5 Emergency Individual Calls (Private or MS-ISDN)
	3.6.6 Emergency Alarm
	3.6.7 Emergency SDS Status
	3.6.8 Emergency Hot Microphone
	3.6.9 Alternating Hot Microphone
	3.6.10 Silent Emergency Mode
	3.6.11 Invisible Emergency
	3.6.12 Emergency Mode by Dialing
	3.6.13 Disaster Alert
	3.6.14 Initializing Disaster Alert Call
	3.6.15 Exiting Emergency Operations

	3.7 Repeater Mode
	3.7.1 Entering Repeater Mode
	3.7.2 Setting Monitor Option
	3.7.3 Encryption in Repeater Mode

	3.8 Gateway Mode
	3.8.1 Entering Gateway Mode
	3.8.2 Standby Mode
	3.8.3 Forwarding a Group Call
	3.8.4 Setting Monitor Option
	3.8.5 Emergency Calls in Gateway Mode
	3.8.6 Encryption in Gateway Mode


	4 GPS Location Service
	4.1 Enhancing GPS Performance
	4.2 Enabling GPS
	4.3 GPS Icon
	4.4 GPS Different Location Displays
	4.5 Viewing Your Position
	4.6 GPS – Things to Keep in Mind

	5 Main Menu
	5.1 Scrolling through the Menu
	5.2 Menu Icons
	5.3 Messages
	5.3.1 New Message
	5.3.1.1 Sending a Message to Private/Phone
	5.3.1.2 Sending a Message to Group
	5.3.1.3 Sending a Store and Forward Message
	5.3.1.4 Delivery Report
	5.3.1.5 Viewing Delivery Report
	5.3.1.6 Configuring Delivery Report

	5.3.2 Inbox
	5.3.2.1 Entering the Inbox
	5.3.2.2 Receiving New Message
	5.3.2.3 Using Submenu in Inbox and Outbox
	5.3.2.4 Embedded Number
	5.3.2.5 Storing a Number from a Message
	5.3.2.6 Calling a Number in a Message
	5.3.2.7 Making a Group Call on a Talkgroup of the Message Sender
	5.3.2.8 Immediate Message

	5.3.3 Outbox
	5.3.4 CO Box
	5.3.5 RMS Box
	5.3.6 WAP Box
	5.3.7 Templates
	5.3.7.1 Sending a User-Defined Template
	5.3.7.2 Setting User-Defined Templates

	5.3.8 Predefined Templates
	5.3.8.1 Viewing Predefined Templates
	5.3.8.2 Sending Predefined Templates

	5.3.9 Send Status
	5.3.9.1 Viewing a Status Message Number
	5.3.9.2 Sending a Status Message to a Group
	5.3.9.3 Targeted Status
	5.3.9.4 Sending a Targeted Status Message


	5.4 Contacts
	5.4.1 Creating a Contact
	5.4.2 Editing a Contact
	5.4.3 Deleting a Number
	5.4.4 Deleting a Contact
	5.4.5 Checking Capacity
	5.4.6 Dialing through the Contact List

	5.5 Browser
	5.6 Security
	5.6.1 Keylock Setup
	5.6.1.1 Keypad Lock Notification
	5.6.1.2 Setting Automatic Keylock Delay
	5.6.1.3 Setting Keylock on Startup

	5.6.2 Air Encryption
	5.6.2.1 Viewing Air Encryption State
	5.6.2.2 Air Encryption Key Deletion

	5.6.3 K Validity
	5.6.3.1 Verifying K Validity

	5.6.4 TMSCK Validity
	5.6.4.1 Verifying TMSCK Validity

	5.6.5 DMSCK Validity
	5.6.5.1 Verifying DMSCK Validity

	5.6.6 DMO SCK
	5.6.6.1 Changing DMO SCK

	5.6.7 Covert Mode
	5.6.7.1 Activating Covert Mode

	5.6.8 SDS Remote Control
	5.6.8.1 Setting SDS Remote Control


	5.7 Setup
	5.7.1 Ring Style
	5.7.1.1 Setting Ring Style

	5.7.2 Set Volume
	5.7.2.1 Setting Volume

	5.7.3 Language
	5.7.3.1 Setting Language

	5.7.4 Data Setup
	5.7.4.1 Setting Data Function

	5.7.5 Audio
	5.7.5.1 Volume Adjustment Mode
	5.7.5.2 Setting Volume Adjustment Mode

	5.7.6 Tones
	5.7.6.1 Keypad Tone
	5.7.6.2 Setting Keypad Tone
	5.7.6.3 All Tones
	5.7.6.4 Setting All Tones
	5.7.6.5 Talk Permit
	5.7.6.6 Setting Talk Permit
	5.7.6.7 Clear to Send
	5.7.6.8 Setting Clear to Send
	5.7.6.9 Periodic Alert
	5.7.6.10 Setting Periodic Alert
	5.7.6.11 D-PTT Tones
	5.7.6.12 Setting D-PTT Tones

	5.7.7 Display
	5.7.7.1 Setting Font Level
	5.7.7.2 Setting Large Idle Font
	5.7.7.3 Setting Extended Status Icons
	5.7.7.4 Setting Screen Saver
	5.7.7.5 Setting Backlight
	5.7.7.6 Setting Wallpaper

	5.7.8 Time and Date
	5.7.8.1 Setting Time and Date on the Display
	5.7.8.2 Setting Time Format
	5.7.8.3 Setting Time Manually
	5.7.8.4 Setting Date Format
	5.7.8.5 Setting Date Manually
	5.7.8.6 Setting Time Offset
	5.7.8.7 Setting Automatic Update for the Time and Date 

	5.7.9 Active Accry (Accessory) Type
	5.7.9.1 Selecting Active Accessory (Accry) Type

	5.7.10 Volume Cntrl (Control)
	5.7.10.1 Setting Volume Cntrl (Control)

	5.7.11 Accry (Accessory) Setup
	5.7.11.1 Configuring Control Head Accessories
	5.7.11.2 Configuring Transceiver Accessories

	5.7.12 Book On
	5.7.12.1 Editing Book On Settings

	5.7.13 Rotary Knob
	5.7.13.1 Setting Rotary Knob Mode
	5.7.13.2 Setting Rotary Lock
	5.7.13.3 Setting In Keypad Lock
	5.7.13.4 Setting Rotary Knob Wrap Around
	5.7.13.5 Setting Rotary Knob Scroll Range
	5.7.13.6 Setting Rotary Knob Talkgroup Selection


	5.8 Group Setup
	5.8.1 Scan
	5.8.1.1 Activating Talkgroup Scanning
	5.8.1.2 Setting Talkgroups in the Active Scan List
	5.8.1.3 Setting Scan Lists

	5.8.2 My Groups

	5.9 Favorites
	5.9.1 Favorite Folders
	5.9.2 Favorite Talkgroups
	5.9.3 Favorite Contact Numbers
	5.9.4 Making a Private Call to a Favorite Contact Number
	5.9.5 Adding a Folder to Favorites
	5.9.6 Adding a Contact Number to Favorites
	5.9.7 Adding a Talkgroup to Favorites
	5.9.8 Managing a Folder in Favorites
	5.9.9 Deleting an Item from a Favorite Folder
	5.9.10 Deleting All Items from a Favorite Folder

	5.10 My Info
	5.10.1 Viewing/Modifying Personal Information

	5.11 Recent Calls
	5.11.1 Viewing Recent Calls
	5.11.2 Calling from Recent Calls
	5.11.3 Storing Recent Calls to Contacts
	5.11.4 Deleting Recent Calls

	5.12 Shortcuts
	5.12.1 Creating a Menu Shortcut
	5.12.2 Editing a Menu Shortcut List

	5.13 RUI
	5.13.1 Logging On
	5.13.2 Logging Off

	5.14 Networks
	5.14.1 Selecting Your Network
	5.14.2 Using the Select Net Registration
	5.14.3 Using the Foreign Network Registration
	5.14.4 Using Any Network
	5.14.5 Using the Migrate To Registration
	5.14.6 Selecting Network Operation Mode

	5.15 Location
	5.15.1 Viewing Your Position
	5.15.2 Viewing Testpage

	5.16 Packet Data
	5.16.1 Viewing Data Statistics
	5.16.2 Viewing Encryption Status

	5.17 Crypto Menu
	5.17.1 Enabling/Disabling SIM Card End-to-End Encryption
	5.17.2 Setting Clear Call Alarm
	5.17.3 Updating Encryption Keys
	5.17.4 Viewing OPTA
	5.17.5 Setting OPTA Filter
	5.17.6 Starting Crypto Registration
	5.17.7 Configuring Audio Settings
	5.17.8 Setting DMO Encryption Mode
	5.17.9 Setting Encryption Keys for SDS Messages


	6 Features
	6.1 Private Call
	6.1.1 Making a Private Call

	6.2 Radio Messaging System (RMS)
	6.2.1 RMS Icons
	6.2.2 Sending an RMS Status

	6.3 One-Touch Dial
	6.4 Talkgroup Dialing by Index
	6.4.1 Viewing Talkgroup Speed Number
	6.4.2 Selecting Talkgroup by Index

	6.5 Phone and PABX Calls
	6.5.1 Making a Phone or PABX Call

	6.6 Phone/PABX Speed Dial
	6.6.1 Using Phone/PABX Speed Dial

	6.7 MS-ISDN
	6.8 DTMF Overdial
	6.9 Short Number Dial
	6.10 Dual Control Head
	6.10.1 Interactions between Control Heads
	6.10.2 Dual Control Head Link
	6.10.3 Audio Accessories
	6.10.4 Keys Interactions

	6.11 SIM Card End-to-End Encryption
	6.12 RUA/RUI
	Radio States
	Book On
	Force Off

	6.13 WAP
	6.13.1 WAP Browser
	6.13.2 Entering/Exiting the Browser
	6.13.3 Entering the Browser Menu Panes
	6.13.4 Tips for Browsing
	6.13.4.1 Creating a Bookmark through Navigate Pane
	6.13.4.2 Creating a Bookmark through Bookmarks Pane
	6.13.4.3 Using a Bookmark
	6.13.4.4 Creating a Hotkey
	6.13.4.5 Using a Hotkey
	6.13.4.6 Saving a Page
	6.13.4.7 Selecting a Saved Page

	6.13.5 Disabled Packet Data Service
	6.13.6 Disabled Browser Entry
	6.13.7 Keys Usage
	6.13.8 Browser Menu Panes Overview
	6.13.9 Navigate Pane
	6.13.10 Advanced...
	6.13.11 Bookmarks Pane
	6.13.11.1 Working with the Options Pane for a Selected Bookmark
	6.13.11.2 Working with the Saved Pages Folder

	6.13.12 History Pane
	6.13.12.1 Navigating to the Recently Visited URL

	6.13.13 Tools Pane
	6.13.14 Options Pane
	6.13.15 Image Pane
	6.13.16 Text Input Pane
	6.13.17 WAP Push
	6.13.17.1 New WAP Messages
	6.13.17.2 Viewing a WAP Message


	6.14 Call-Out
	6.14.1 Types of Call-Out Alerts
	6.14.2 Call-Out Modes Interaction
	6.14.3 Call-Out Service Phases


	Appendix A Tones
	Appendix B LED Indications
	Appendix C Troubleshooting

	Deutsch
	Inhalt
	Abbildungsverzeichnis
	Tabellenverzeichnis
	1 Allgemeine Informationen
	1.1 Sicherheitshinweise
	1.2 Copyright
	Haftungsausschluss
	Marken
	WEEE-Richtlinie der EU

	1.3 Verwendete Symbole
	1.4 Dieses Handbuch verwenden

	2 Inbetriebnahme des Geräts
	2.1 Technische Produktinformationen
	2.2 Bedienelemente und Anzeigen
	NGCH (New Generation Control Head, Bedienkopf der neuesten Generation)/RECH (Remote Ethernet Control Head, Remoter Ethernet-Bedienkopf)
	Bedienteil in Telefonausführung (TSCH)
	Ladestation

	2.3 display
	2.3.1 Display-Ausrichtung

	2.4 Statussymbole
	2.5 Das Funkgerät einschalten
	2.6 PIN-Code-Authentifizierung
	2.6.1 Die Blockierung des Geräts aufheben

	2.7 Die Tasten sperren/entsperren
	2.8 Den TMO/DMO-Modus aufrufen
	2.9 Sendesperrenmodus
	2.10 Eine Gesprächsgruppe auswählen
	2.11 Den zeitgesteuerten Gesprächsgruppenwechsel verwenden
	2.12 Den Gesprächsgruppen-Scan aktivieren
	2.13 Ansageanruf
	2.14 Mithöranruf
	2.15 One-Touch-Tastenfunktion
	2.16 Das Terminal vorübergehend aktivieren/deaktivieren
	2.17 Terminal dauerhaft deaktivieren
	2.18 Während des Anrufs
	2.19 Text schreiben
	2.19.1 Den Texteingabemodus auswählen
	2.19.2 Den Texteingabemodus und die Sprache auswählen
	2.19.3 Texteingabesymbole
	2.19.4 Tastenverwendung
	2.19.5 Text im alphanumerischen iTAP-Modus schreiben
	2.19.6 Text im alphanumerischen TAP-Modus schreiben
	2.19.7 Wörter sperren
	2.19.8 Wörter zum Wörterbuch hinzufügen

	2.20 Textnachricht auf dem Startdisplay

	3 Modi
	3.1 Netzwerke verwenden
	3.2 Bündelfunkbetrieb
	3.2.1 Den TMO-Modus aufrufen
	3.2.2 Eine Gesprächsgruppe auswählen
	3.2.3 Einen Gruppenanruf im TMO-Modus tätigen
	3.2.4 Einen Gruppenanruf im inaktiven Zustand empfangen
	3.2.5 Einen Gruppenanruf während eines laufenden Gruppenanrufs empfangen
	3.2.6 Dynamische Gruppennummernvergabe (DGNA)
	3.2.7 DGNA-Empfang
	3.2.8 DGNA Automatische Gruppenauswahl
	3.2.9 DGNA Gruppe automatisch neu auswählen
	3.2.10 DGNA-Gesprächsgruppen anzeigen
	3.2.11 Broadcast-Anruf durch Benutzer eingeleitet
	3.2.12 Einen Ansageanruf initialisieren
	3.2.13 Telefon- und TK-Anrufe
	3.2.14 Privatanruf
	3.2.15 Durchführen eines Privatanrufs
	3.2.16 Supportruf
	3.2.17 Rufänderung
	3.2.18 Die End-to-End-Verschlüsselung der SIM-Karte aktivieren/deaktivieren

	3.3 Lokales Trunking
	3.3.1 Local Site Trunking (Bündelfunk in der lokalen Funkzelle) aufrufen
	3.3.2 Bündelfunk in der lokalen Funkzelle beenden

	3.4 Direktmodusbetrieb (DMO)
	3.4.1 Den DMO-Modus aufrufen
	3.4.2 Eine Gesprächsgruppe auswählen
	3.4.3 Einen Gruppenanruf im DMO-Modus tätigen
	3.4.4 Einen Gruppenanruf im inaktiven Zustand empfangen
	3.4.5 Privatanruf
	3.4.6 Durchführen eines Privatanrufs
	3.4.7 Privatgespräch mit Präsenzprüfung
	3.4.8 Gesprächsgruppe für Einzelrufe
	3.4.9 Kommunikation über Repeater
	3.4.10 Kommunikation über Gateway
	3.4.11 Optionen für DMO-Gruppenanruf auswählen

	3.5 Sendesperrenmodus
	3.6 Notfallmodus
	3.6.1 Gruppennotruf
	3.6.2 Einen Gruppennotruf absetzen
	3.6.3 Einen Gruppennotruf empfangen
	3.6.4 Nicht-Taktischer Notfall
	3.6.5 Einzelrufe im Notfallmodus (Privat- oder MS-ISDN-Anrufe)
	3.6.6 Notsignal
	3.6.7 Notfall SDS-Status
	3.6.8 Notrufmikrofon
	3.6.9 Notrufmikrofon umschalten
	3.6.10 Stiller Notfallmodus
	3.6.11 Verdeckter Notruf
	3.6.12 Den Notfallmodus durch Wählen aufrufen
	3.6.13 Notsignal
	3.6.14 Einen Katastrophenalarm-Anruf initialisieren
	3.6.15 Beenden des Notfallmodus

	3.7 Repeater-Modus
	3.7.1 Aufruf Repeater-Modus
	3.7.2 Die Überwachungsoption einstellen
	3.7.3 Verschlüsselung im Repeater-Modus

	3.8 Gateway-Modus
	3.8.1 Den Gateway-Modus aufrufen
	3.8.2 Standby-Modus
	3.8.3 Einen Gruppenanruf weiterleiten
	3.8.4 Die Überwachungsoption einstellen
	3.8.5 Notrufe im Gateway-Modus
	3.8.6 Verschlüsselung im Gateway-Modus


	4 GPS-Ortungsdienst
	4.1 GPS-Leistung verbessern
	4.2 GPS aktivieren
	4.3 GPS-Symbol
	4.4 GPS Verschiedene Standortanzeigen
	4.5 Ihre Position anzeigen
	4.6 Hinweise zur Verwendung der GPS-Funktion

	5 Hauptmenü
	5.1 Durch das Menü blättern
	5.2 Menüsymbole
	5.3 Nachrichten
	5.3.1 Neue Nachricht
	5.3.1.1 Eine Nachricht an Privat/Telefon senden
	5.3.1.2 Eine Nachricht an Gruppe senden
	5.3.1.3 Eine Speichern-und-Weiterleiten-Nachricht senden
	5.3.1.4 Übertragungsbericht
	5.3.1.5 Anzeigen von Übertragungsberichten
	5.3.1.6 Die Zustellmeldung konfigurieren

	5.3.2 Posteingang
	5.3.2.1 Den Posteingang aufrufen
	5.3.2.2 Eine neue Nachricht empfangen
	5.3.2.3 Die Untermenüs im Posteingang und Postausgang verwenden
	5.3.2.4 Eingebettete Nummer
	5.3.2.5 Eine Nummer aus einer Nachricht speichern
	5.3.2.6 Eine Telefonnummer in einer Nachricht anrufen
	5.3.2.7 Einen Gruppenanruf an die Gesprächsgruppe des Absenders einer Nachricht tätigen
	5.3.2.8 Sofortmeldung

	5.3.3 Postausgang
	5.3.4 CO-Box
	5.3.5 RMS-Postfach
	5.3.6 WAP-Box
	5.3.7 Vorlagen
	5.3.7.1 Eine benutzerdefinierte Vorlage senden
	5.3.7.2 Benutzerdefinierte Vorlagen einstellen

	5.3.8 Vordefinierte Vorlagen
	5.3.8.1 Vordefinierte Vorlagen anzeigen
	5.3.8.2 Vordefinierte Vorlagen senden

	5.3.9 Status senden
	5.3.9.1 Eine Statusmeldungsnummer anzeigen
	5.3.9.2 Eine Statusmeldung an eine Gruppe senden
	5.3.9.3 Gezielter Status
	5.3.9.4 Eine gezielte Statusmeldung senden


	5.4 Kontakte
	5.4.1 Einen Kontakt erstellen
	5.4.2 Einen Kontakt bearbeiten
	5.4.3 Eine Nummer löschen
	5.4.4 Einen Kontakt löschen
	5.4.5 Die Kapazität überprüfen
	5.4.6 Nummern in der Kontaktliste wählen

	5.5 Browser
	5.6 Sicherheitsbereich
	5.6.1 Die Tastensperre einrichten
	5.6.1.1 Benachrichtigung der Tastensperre
	5.6.1.2 Die automatische Tastensperrenverzögerung einstellen
	5.6.1.3 Die Tastensperre beim Start einstellen

	5.6.2 Drahtlose Verschlüsselung
	5.6.2.1 Den Status der drahtlosen Verschlüsselung anzeigen
	5.6.2.2 Den Schlüssel für die drahtlose Verschlüsselung löschen

	5.6.3 K-Gültigkeit
	5.6.3.1 Die K-Gültigkeit überprüfen

	5.6.4 TMSCK-Gültigkeit
	5.6.4.1 Die TMSCK-Gültigkeit überprüfen

	5.6.5 DMSCK-Gültigkeit
	5.6.5.1 Die DMSCK-Gültigkeit überprüfen

	5.6.6 DMO SCK
	5.6.6.1 DMO-SCK ändern

	5.6.7 Tarnmodus (Verdeckter Modus)
	5.6.7.1 Den verdeckten Modus aktivieren

	5.6.8 SDS-Fernsteuerung
	5.6.8.1 Die SDS-Fernsteuerung einstellen


	5.7 Einstellungen
	5.7.1 Ruftonart
	5.7.1.1 Den Klingelton einstellen

	5.7.2 Lautstärkeregelung
	5.7.2.1 Die Lautstärke einstellen

	5.7.3 Sprache
	5.7.3.1 Die Sprache einstellen

	5.7.4 Dateneinstellungen
	5.7.4.1 Die Datenfunktion einstellen

	5.7.5 Audio
	5.7.5.1 Lautstärkereglermodus
	5.7.5.2 Den Lautstärkereglermodus einstellen

	5.7.6 Töne
	5.7.6.1 Tastaturton
	5.7.6.2 Den Tastenton einstellen
	5.7.6.3 Alle Töne
	5.7.6.4 Alle Töne einstellen
	5.7.6.5 Sprecherlaubnis
	5.7.6.6 Die Gesprächsgenehmigung einstellen
	5.7.6.7 Sendebereit (CTS, Clear to Send)
	5.7.6.8 Clear to Send einstellen
	5.7.6.9 Periodischer Alarm
	5.7.6.10 Den periodischen Alarm einstellen
	5.7.6.11 D-PTT-Töne
	5.7.6.12 D-PTT-Töne einstellen

	5.7.7 display
	5.7.7.1 Die Schriftebene einstellen
	5.7.7.2 Die Große Leerlaufschrift einstellen
	5.7.7.3 Erweiterte Statussymbole einstellen
	5.7.7.4 Den Bildschirmschoner einstellen
	5.7.7.5 Die Hintergrundbeleuchtung einstellen
	5.7.7.6 Das Hintergrundbild einstellen

	5.7.8 Datum und Uhrzeit
	5.7.8.1 Datum und Uhrzeit auf dem Display einstellen
	5.7.8.2 Das Uhrzeitformat einstellen
	5.7.8.3 Die Uhrzeit manuell einstellen
	5.7.8.4 Das Datumsformat einstellen
	5.7.8.5 Das Datum manuell einstellen
	5.7.8.6 Die Zeitverschiebung einstellen
	5.7.8.7 Die automatische Aktualisierung für Datum und Uhrzeit einstellen 

	5.7.9 Aktive Zubehörart
	5.7.9.1 Auswählen des aktiven Zubehörtyps

	5.7.10 Lautstärke-Strg (Steuerung)
	5.7.10.1 Die Lautstärke einstellen

	5.7.11 Zubehör einrichten
	5.7.11.1 Bedienkopfzubehör konfigurieren
	5.7.11.2 Transceiver-Zubehör konfigurieren

	5.7.12 Anmelden
	5.7.12.1 Die Buchungseinstellungen bearbeiten

	5.7.13 Drehknopf
	5.7.13.1 Den Drehknopfmodus einstellen
	5.7.13.2 Die Drehschaltersperre einstellen
	5.7.13.3 Die Tastensperre einstellen
	5.7.13.4 Den Drehknopf für die Funktion „Durchsuchen“ einstellen
	5.7.13.5 Den Drehknopf-Suchbereich einstellen
	5.7.13.6 Den Drehknopf für die Gesprächsgruppenauswahl einstellen


	5.8 Gruppeneinstellungen
	5.8.1 Scannen
	5.8.1.1 Den Gesprächsgruppen-Scan aktivieren
	5.8.1.2 Gesprächsgruppen in der aktiven Scan-Liste einstellen
	5.8.1.3 Scan-Listen einstellen

	5.8.2 Meine Gruppen

	5.9 Favoriten
	5.9.1 Favoriten-Ordner
	5.9.2 Bevorzugte Gesprächsgruppen
	5.9.3 Bevorzugte Kontaktnummern
	5.9.4 Tätigen eines privaten Anrufs einer bevorzugten Kontaktnummer
	5.9.5 Hinzufügen eines Ordners zu den Favoriten
	5.9.6 Hinzufügen einer Kontaktnummer zu den Favoriten
	5.9.7 Hinzufügen einer Gesprächsgruppe zu den Favoriten
	5.9.8 Verwalten von Favoriten-Ordnern
	5.9.9 Löschen eines Elements aus einem Favoriten-Ordner
	5.9.10 Löschen aller Elemente aus einem Favoriten-Ordner

	5.10 Meine Informationen
	5.10.1 Persönliche Informationen anzeigen und ändern

	5.11 Letzte Anrufe
	5.11.1 Anzeigen der letzten Anrufe
	5.11.2 Eine Nummer aus der Liste der letzten Anrufe anrufen
	5.11.3 Die letzten Anrufe in den Kontakten speichern
	5.11.4 Die letzten Anrufe löschen

	5.12 Verknüpfungen
	5.12.1 Eine Menüverknüpfung erstellen
	5.12.2 Eine Liste mit Menüverknüpfungen bearbeiten

	5.13 RUI
	5.13.1 Anmelden
	5.13.2 Abmelden

	5.14 Netzwerke
	5.14.1 Das Netzwerk auswählen
	5.14.2 Die Funktion „Netzregistrierung auswählen“ verwenden
	5.14.3 Die Fremdnetzregistrierung verwenden
	5.14.4 Ein beliebiges Netzwerk verwenden
	5.14.5 Die Funktion „Zur Registrierung migrieren“ verwenden
	5.14.6 Den Netzwerkbetriebsmodus verwenden

	5.15 Standort
	5.15.1 Ihre Position anzeigen
	5.15.2 Anzeigen der Testseite

	5.16 Paketdaten
	5.16.1 Statistiken anzeigen
	5.16.2 Den Verschlüsselungsstatus anzeigen

	5.17 Kryptomenü
	5.17.1 Die End-to-End-Verschlüsselung der SIM-Karte aktivieren/deaktivieren
	5.17.2 Alarmton für unverschlüsselte Anrufe einstellen
	5.17.3 Die Verschlüsselungsschlüssel aktualisieren
	5.17.4 Die OPTA-Adresse anzeigen
	5.17.5 Den OPTA-Filter einstellen
	5.17.6 Starten der Krypto-Registrierung
	5.17.7 Konfigurieren der Audioeinstellungen
	5.17.8 Einstellung des DMO-Verschlüsselungsmodus
	5.17.9 Einstellung der Verschlüsselungsschlüssel für SDS-Nachrichten


	6 Funktionen
	6.1 Privatanruf
	6.1.1 Durchführen eines Privatanrufs

	6.2 Radio Messaging System (RMS)
	6.2.1 RMS-Symbole
	6.2.2 Senden des RMS-Status

	6.3 Kurzwahl
	6.4 Gesprächsgruppenwahl durch Index
	6.4.1 Die Nummer für die Gesprächsgruppen-Kurzwahl anzeigen
	6.4.2 Die Gesprächsgruppe nach Index auswählen

	6.5 Telefon- und TK-Anrufe
	6.5.1 Einen Telefon- oder Nebenstellenanruf tätigen

	6.6 Telefon/Nebenstellenanlagen-Kurzwahl
	6.6.1 Die Telefon/Nebenstellen-Kurzwahl verwenden

	6.7 MS-ISDN
	6.8 MFV (Multifrequenz-Durchwahl)
	6.9 Eine Kurzwahlnummer wählen
	6.10 Doppelter Bedienkopf
	6.10.1 Interaktionen zwischen Bedienköpfen
	6.10.2 Doppelbedienkopf-Verbindung
	6.10.3 Audiozubehör
	6.10.4 Tasteninteraktionen

	6.11 End-to-End-Verschlüsselung der SIM-Karte
	6.12 RUA/RUI
	Funkgerätstatus
	Anmelden
	Erzwungene Abmeldung

	6.13 WAP
	6.13.1 WAP-Browser
	6.13.2 Den Browser aufrufen und beenden
	6.13.3 Die Browser-Menüfenster aufrufen
	6.13.4 Tipps zum Durchsuchen
	6.13.4.1 Ein Lesezeichen im Navigationsfenster erstellen
	6.13.4.2 Ein Lesezeichen im Lesezeichenfenster erstellen
	6.13.4.3 Ein Lesezeichen verwenden
	6.13.4.4 Eine Schnelltaste erstellen
	6.13.4.5 Eine Schnelltaste verwenden
	6.13.4.6 Eine Seite speichern
	6.13.4.7 Eine gespeicherte Seite auswählen

	6.13.5 Deaktivierter Paketdatendienst
	6.13.6 Deaktivierte Browsereingabe
	6.13.7 Tastenverwendung
	6.13.8 Übersicht über die Fensterbereiche im Browser-Menü
	6.13.9 Navigationsfenster
	6.13.10 Erweitert...
	6.13.11 Lesezeichenfenster
	6.13.11.1 Das Optionsfenster für ein ausgewähltes Lesezeichen verwenden
	6.13.11.2 Den Ordner für gespeicherte Seiten verwenden

	6.13.12 Verlaufsfenster
	6.13.12.1 Zur zuletzt besuchten URL navigieren

	6.13.13 Werkzeugfenster
	6.13.14 Optionsfenster
	6.13.15 Bildfenster
	6.13.16 Texteingabefenster
	6.13.17 WAP-Push
	6.13.17.1 Neue WAP-Nachrichten
	6.13.17.2 Eine WAP-Nachricht anzeigen


	6.14 Vorfall
	6.14.1 Typen von Vorfall-Alarmen
	6.14.2 Interaktionen im Vorfall-Modus
	6.14.3 Vorfall-Dienstphasen


	Anhang A Töne
	Anhang B LED-Anzeigen
	Anhang C Fehlerbehebung




